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Important Notice

This chapter provides information about Copyright, Trademarks and
warranty.

Click any of the following links to jump to the corresponding section of
this chapter:

» Copyrights
e Trademarks

* Warranty

Copyrights

Metrowerks CodeWarrior copyright ©1993-2003 by Metrowerks, Inc. and
its licensors.

All rights reserved.

Documentation stored on the compact disk(s) may be printed by licensee
for personal use. Except for the foregoing, no part of this documentation
may be reproduced or transmitted in any form by any means, electronic or
mechanical, including photocopying, recording, or any information storage
and retrieval system, without permission in writing from Metrowerks, Inc.

Trademarks

Metrowerks, the Metrowerks logo, CodeWarrior, PowerPlant, and
Metrowerks University are registered trademarks of Metrowerks Inc.
CodeWarrior Constructor, Geekware, PowerParts, and Discover
Programming are trademarks of Metrowerks Inc.

PowerPC® is aregistered trademark of IBM, Inc.
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Warranty

All other trademarks and registered trademarks are the property of their
respective owners.

ALL SOFTWARE AND DOCUMENTATION ON THE COMPACT
DISK(S) ARE SUBJECT TO THE LICENSE AGREEMENT.

While every effort has been made to ensure the accuracy of all information
in this document, Metrowerks assumes no liability to any party for any loss
or damage caused by errors or omissions or by statements of any kind in
the Simulator/Debugger user’s guide, its updates, supplements, or special
editions, whether such errors are omissions or statements resulting from
negligence, accident, or any other cause. Metrowerks further assumes no
liability arising out of the application or use of any product or system
described here; nor any liability for incidental or consequential damages
arising from the use of this document and the related product.

Metrowerks disclaims all warranties regarding the information contained
herein, whether expressed, implied or statutory, including implied
warranties of merchantability or fitness for a particular purpose.

Metrowerks reserves the right to make changes without further notice to
any products herein to improve reliability, function or design.
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Overview

This chapter provides an overview of the structure from the debugger
documentation.

About This Guide

This document includes information to become familiar with the
Simulator/Debugger, to use al functions and help you understand how to
use this environment. This document is divided into the following chapters:

The Introduction chapter introduces the Simulator/Debugger concept.

The Simulator/Debugger User Interface chapter provides al details
about the Simulator/Debugger user interface environment i.e., menus,
toolbars, status bars and drag and drop facilities.

The Framework Components chapter contains descriptions of each
basic component and visualization utility.

The Debugger Commands chapter describes and provides examples of
all Commands line Commands.

The True Time 1/O Stimulation chapter explains the principle and
provides examples on the Stimulation component.

The Real Time Kernel Awareness chapter contains descriptions of the
Real Time concept and related applications.

The Environment chapter containsinformation for defining the
application environment.

The Control Points chapter is dedicated to the control points and
associated dialogs.

The How To ... chapter provides answers for common questions and
describes how to use advanced features of the Simulator/Debugger.

The CodeWarrior Integration chapter explains how to configure the
Simulator/Debugger for use with CodeWarrior.

The Debugger DDE capabilities describe the debugger DDE features.

The Synchronized debugging through DA-C IDE chapter explains the
use of tools with the DA-C IDE from RistanCase

For More Information: www.freescale.com
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Highlights

The Appendix contains information about all the Simulator/Debugger
messages, the EBNF notation and how to get Technical Support.

The“Index” contains all keywords for the Simulator/Debugger.

True 32-hit application

Powerful features for embedded debugging

Special features for real time embedded debugging

Powerful features for True Time Simulation

Various and Same look Target Interfaces

User Interface

Versatile and intuitive drag and drop functions between components
Folding and unfolding of objects like functions, structures, classes
Graphical editing of user defined objects

Visualization functions

Smart interactions with objects

Extensibility function

Both Powerful Simulation & Debugger

Show Me How Tool

GUI (graphical user interface) version including command line
Context sensitive help

Configurable GUI with Tool Bar

Smooth integration into third party tools

Supports HIWARE and EL F/Dwarf Object File Format and Motorola
S-Records

Read the Release Notes

Before you use atool such as the Debugger, read the release notes. They
contain important |ast-minute information about new features and technical
Issues or incompatibilities that may not be included in the documentation.

Document Conventions

In this section, you will find terms and styles used in this document.

DM-20
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General terms
¢ Choose.

Thisterm is used to select an item from a menu or alist/combo box.
* Check.

Thisterm is used to select a check box item.
* Uncheck.

Thisterm is used to deselect a selected check box item.

All keyboard keys are given as |A |Z | Cirl ! T Ente \ F1 |
etc. ' =

Also the left mouse button is \-/Ej and considered as akey.
* Keyl+ Key2.

When you have to press two keys at the same time. The“+ * sign means
that Key1 is held down while Key2 is pressed. Example: [ +

]

Mouse operations
» Click

The word “click” means click the left mouse button once.
* Right-click
This“click” operation is done with the right mouse button.

* Double-click

Thisisadouble “click” operation.

. x/Ej + Key, example: x/Ej + Ll

This means that you press and hold down the left mouse button while you
press the specified key. When the key has been pressed, you can unclick.

* Drag.
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NOTE

This means that you press and hold down the left mouse button while you
drag the mouse. If you perform this operation on an object that has been
designed to be dragged, this object will move with the mouse arrow and
drop when you unclick the mouse.

e Unclick.

When you release the |eft mouse button after a drag operation or when you
have completed a“-/Ej + Key” operation.

Font styles
* Bold

Words in bold are menu items and entries.
 Courier

Thisfont is used for filenames and pathnames, commands, command
syntaxes and examples.

Examples

C. \ H WAVE\ PRQJECT. | NI
in>Memory < ADR on

Menu Paths

When asked to follow specific selectiong/entries in menus and submenus,
the following selections are given in alist of items separated by the “>”
separator. Example: Choose Window > Options > Autosize. Here you
click Window in the Simulator/Debugger main menu bar, drag the mouse
to the Options submenu then check or uncheck Autosize.

Others

Notes provide important and helpful information on any subject.
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This chapter is an introduction to the Simulator/Debugger from
Metrowerks used in 8/16 bit embedded applications.

Click any of the following links to jump to the corresponding section of
this chapter:

» What Isthe Simulator/Debugger?

e What Is a Simulator/Debugger Application?

» What Isa Simulator/Debugger Execution Framework?
» Understanding the Simulator/Debugger Concept

What Is the Simulator/Debugger?

The Simulator/Debugger is a member of the tool family for Embedded
Development. It isaMultipurpose Tool that you can use for various tasks
in the embedded system and industrial control world. Some typical tasks
are:

» Simulation and debugging of an embedded application.

» Simulation and debugging of real time embedded applications.

» Simulation and/or cross-debugging of an embedded application.

» Multi-Language Debugging: Assembly, C and C++

* True Time Stimulation

» User Components creation with the Peripheral Builder

» Simulation of a hardware design (e.g., board, processor, 1/0 chip).

» Building atarget application using an object oriented approach.

» Building a host application controlling a plant using an object oriented
approach.

For More Information: www.freescale.com
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What Is a Simulator/Debugger Application?

What Is a Simulator/Debugger Application?

A Simulator/DebuggerSimulator/Debugger Application contains the
Simulator/Debugger Engine and a set of debugger components bound to
the task that they should perform (for example a simulation and debugging
session). The Simulator/Debugger Engine is the heart of the system. It
monitors and coordinates the tasks of the components. Each Simulator/
Debugger Component has its own functionality (e.g., source level
debugging, profiling, 1/0 stimulation).

Y ou can adapt your Simulator/Debugger application to your specific needs.
Integrating or removing the Simulator/Debugger Componentsisvery easy.
Y ou can also choose a default configuration, refer to Figure 3.1.

Y ou can add additional Simulator/Debugger Components (for example, for
simulation of a specific 1/0 peripheral chip) and integrate them with your
Simulator/Debugger Application.

Y ou can also open several components of the same type.
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Figure 3.1 Example of Simulator/Debugger Application for Simulation and
Debugging

Sassion Hmﬂfder
&

ugor Defingy
YO & Hardya
Simulatigp,
Pougen sasn

Yo nung
UBMpp 9 O

ax. of HI-WAVE Applcalion for Simulation and Debugging

What Is a Simulator/Debugger Execution
Framework?

Since the Simulator/Debugger is a Multipurpose Tool you have to use the
components according to the task you want to run. In other words, you
either build a Simulator/Debugger Execution Framework or use a default
one.

Each Execution Framework is built with selected components. Since the
Simulator/Debugger is an open and extendable system, you can write and
add your own debugger components if needed (for example a debugger
component for a specific 1/0O simulation).
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Understanding the Simulator/Debugger Concept

Figure 3.2

This section provides an overview of the Simulator/Debugger concept.

The Simulator/Debugger Execution Framework

Any Simulator/Debugger based task you create (for example: testing and
debugging atarget application, running a visualization application), has a
specific debugger “ Execution Framework”. A Simulator/Debugger
Execution Framework is a set of user selected and configured Framework
Components, such as shown in Figure 3.2 and Figure 3.3. The debugger
engine is always present.

Example of Execution Framework for Simulation.

Stimulation rdd ON

Assembly
Debug Debug
Recorder
overage & Player
o
Add ON

CPU I&M
A warenes Simulator
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Figure 3.3

Example of Execution Framework for Cross Debugging.

Software ST artg et User
Trace stem Add ON

State g
Analyser ource
& Tracer Debug

Assembly Recorder
Debug & Player

Momtor, BDM Cross
or Emulator Debug

Objects and Services

An object provides one or more services. For example an object of a
variable type holds values in a specific range. An object like the Bus
Analyzer component graphically displays the bus state. An 1/0 Simulation
object provides the behavior of the corresponding hardware peripheral.
Providing servicesis the ultimate goal of objects and that is why they are
created and used. An object has a state, behavior and identity.

Framework Components

A Simulator/Debugger Framework Component is an object that you can
integrate or remove from an Execution Framework. Each Framework
component belongs to a service class.

Examples of Framework Components:

» Simulator/Debugger Engine

» CPU Simulator

» Source Level Debug Component

» Assembly Debug Component

* Profiler

* BusAnayzer

* 1/O Simulation Components

* True Time Stimulation Components

Debugger Manual
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If any hardware component is present (e.g., target board, 1/O peripheral,
emulators), it is also considered to be a Framework component.

Demo Version Limitations Components

When the Simulator/Debugger is started in demo mode or with an invalid
engine license, then al components that are protected with FLEXIm arein
demo mode. The limitations of all components are described in their
respective chapter.
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Simulator/Debugger User
Interface

This chapter describes the Simulator/Debugger User Interface.

Click any of the following links to jump to the corresponding section of
this chapter:

* Introduction

» Application Programs

o Start the Debugger

» Simulator/Debugger Main Menu Bar

» Simulator/Debugger Status Bar

o Simulator/Debugger Status Bar

» Object Info Bar of the Simulator/Debugger Components
 Function of the Main Menu Bar

e Component Associated Menus

e Highlights of the User Interface

Introduction

The Simulator/Debugger main window acts as a container for windows of
all other components. Additionally, it provides agloba menu bar, atool
bar, a status bar for status information, and object information bars for
several components.

The main window manages the layout of the different component windows
(Window menu of the Simulator/Debugger application). Component
windows are organized as follows:

» Tiled arrangement

For More Information: www.freescale.com
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Application Programs

* Auto tiled, component windows are autometically resized when the
main window isresized

» Overlapped
* Icon (windows that are currently minimized).

Application Programs

After installation, all executable programs are placed in the "pr og'
subdirectory, e.g. if you installed the softwarein "C: \ Met r ower ks'ona
PC, al program filesarelocated in C. \ Met r ower ks\ PROG (for details
refer to installation guide).

The following list provides an overview of the files used for C/C++
debugging.

hi wave. exe Debugger executable file

hi base. dl | Debugger main function dll
el fl oad. dl | Debugger loader dil

* . wnd Debugger component

*. tgt Debugger target file

*. cpu Debugger CPU awarenessfile

Start the Debugger

This section explains how to start the debugger from the IDE or a
command line.

Start the debugger from the IDE

Y ou can start the debugger from the IDE by clicking the Debug button
(Figure 4.1) from the project window.
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Start the Debugger

Figure 4.1 IDE Debug button.
By @

Starting the Debugger from a Command Line

Y ou can start the HI-WAV E debugger from a (DOS) command line. The
command syntax is shown below:

H WAVE. EXE [ <AbsFi | eName> {-<options>}]

where AbsFileNameisthe name of the application to load in the debugger.
Options may be introduced by a minus character.

Options are:

» -T=<time>: test mode. The debugger will terminate after the specified
time (in seconds). The default value is 300 seconds, e.g:

c:\ Met rower ks\ prog\ hi wave. exe -T=10

The debugger will terminate after 10 seconds.
» -Target=<targetname> sets the specified target, e.g.:

C.\ Metr ower ks\ pr og\ hi wave. exe
c:\ Metrower ks\ deno\ hc12\si M fi bo. abs -w - Target=sim

Starts the debugger, sets the smulator target, and loads fibo.abs file.

* -W: wait mode - will wait even when a <exeName> is specified, e.g. -
W

* -Instance=%currentTargetName: defines a build instance name.
When a build instance is defined, the same one will be used e.g.

c:\ Metrower ks\ prog\ hi wave. exe -Instance=%urrent Tar get Nane

now if you attempt to start the debugger again, the existing instance of the
debugger is brought to the foreground.

Debugger Manual DM-31

For More Information: www.freescale.com



{ Freescale Semiconductor, Inc.

simulator/Debugger User Interface
Start the Debugger

» -Prod: specifiesthe project directory and/or project file to be used at
start-up: -Prod = <fileName> e.g.

c:\ Metrower ks\ prog\ hi wave. exe -Prod=c:\denoproject\test.pjt

* -Nodefaults: will not load the default layout (see section 4 of the
Project file Activation) e.g.

c:\ Metrower ks\ prog\ hi wave. exe -nodefaults

* -Cmd specifies acommand to be executed at start-up: -cmd ="
{characters} e.g.

c: \ Met rower ks\ pr og\ hi wave. exe -cmd="open recorder"

» -C: specifiesa command file to be executed at start-up: -¢ <cmdFile>
e.g.

c:\ Metrower ks\ prog\ hi wave. exe -c c\temp\mycommandfile.txt

» -ENVpath: "-Env" <Environment Variable> "=" <Variable Setting>,
this option sets an environment variable. This environment variable
may be used to overwrite system environment variables e.g.

c:\ Metrower ks\ prog\ hi wave. exe - EnvOBJPATH=c:\sources\obj

NOTE  Options are not case sensitive.

Order of commands

Commands specified by options are executed in the following order:

1. Load (activate) the project file (see below). If the project file is not
specified, “project.ini”is used by default.

2. Load <exeFile> if available and start* running unless option |(W)
was specified

3. Execute command file <cmdFile> if specified
4. Execute command if specified
5. *Start running unless option |(W) was specified
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NOTE * Inversion 6.0 of the debugger, the loaded program is started after all
command and command files are executed.

WARNING!  The function Open in the File menu will interpret any file without an
. 1 ni extension as acommand file and not a project file.

Example

C:\Metrowerks\PROG \DEMO\TEST.ABS -w -d

Simulator/Debugger Main Menu Bar

ThisMenu Bar, shown in Figure 4.2 is associated with the main function of
the debugger application, target, and selected windows.

Figure 4.2 Debugger Main Menu Bar

__ True-Time Simulator & Real-Time Debugger

File “iew Hun Target Component Data  wWindow  Help

NOTE  You can select menu commands by pressing the ALT key to select the
menu bar and press the key corresponding to the underlined letter in the
menu command.

Simulator/DebuggerSimulator/Debugger Toolbar

Thistoolbar isthe default toolbar. Most menu commands have arelated
shortcut icon on the debugger toolbar.

Figure 4.3 identifies each default icon.
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Figure 4.3 The Debugger Toolbar

leilﬁll e 2|8 ||| 1] 2
| | | | | | | | | | | | | |

A G O A N SR s ST A
% . g . o G %
@, ? J?éb S

A tool tip is available when you point the mouse at an icon.

Simulator/Debugger Status Bar

The status bar at the bottom of the debugger window, shown in Figure 4.4
contains a context sensitive help line for target specific information, e.g.,
number of CPU cycles for the Simulator target and execution status. All

messages that appear in the status bar are described in Messages in Status
Bar.

Figure 4.4 The Debugger Status Bar

For Help, press F1 |50139 |HALTED v

Object Info Bar of the Simulator/Debugger
Components

The object info bar of the debugger window, as shown in Figure 4.5,
provides information about the selected object.
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Figure 4.5 Object Info Bar of Debugger Window Components

i Data:1 [_ (O =]

|Address: 800 Size: 2 [fibo.c | Aute  |Symb | Global

fiboCount 41581 unsigned int
counter 20 unzigned int lI

Function of the Main Menu Bar

Table 4.7 describes menus entries available in the menu bar (Figure 4.6).

Figure 4.6  Debugger Main Menu

__ True-Time Simulator & Real-Time Debugger

File “iew Bun Target Component Data ‘Window Help

Table 4.1 Description of the Main Menu Entries

Menu entry Description

File Contains entries to manage debugger
configuration files.

View Contains entries to configure the toolbar.

Run Contains entries to monitor asimulation or
debug session.

Target Contains entries to select the debugger
target.

Component Contains entries to select and configure
extra component window

Data Contains entries to select Data component
functions,
Window Contains entries to set the component
windows.
Debugger Manual DM-35
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Menu entry Description

Help A standard Windows Help menu.

File Menu
The File menu shown in Table 4.8 is dedicated to the debugger project.

Figure 4.7 File Menu

e (Bt

Load Application...

#ohautotesthBIM \restart abs
#hautotesthBIM Yawait. abs

Dpen Configuration. .. Ctrl+0
Save Configuration

Save Configuration As, ..

Configuratian. ..

1 project.ini

2w Nhiwavehreleasehproject.ini

3 C\Metrowerk shdemo\MuFraject. pit
4 Bank.ini

E xit

Table 4.2 describes File Menu entries.

Table 4.2 File Menu Description

Menu entry Description

New Creates a new project.

Load L oads an executable file (or debugger target if
Application nothing is selected).
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Menu entry

Description

.\restart.abs
..\await.abs

Open
Configuration

Save
Configuration

Save Project As

Configuration

1.Project.ini
2.Test.ini
3.

Exit

Recent applications list

Opens the debugger project window. Y ou can
load aproject file .PJT or .INI. Additionally
you can load an existing HWC file
corresponding to a debugger configuration file.
Y ou can load a project .INI file containing
component names, associated window
positions and parameters, window parameters
(fonts, background colors, etc.), target name
e.g., Simulator and the ABS application fileto
load.

Saves the project file

Opens the debugger project window to save the
project file under a different path and name,
and format (PJT; INI...).

Opens the Preferences dialog to set
environment variables for current project.

Recent project file list

Quits the Simulator/Debugger.

Y ou can shortcut some of these functions by clicking toolbar icons (refer to
the Simulator/Debugger Simul ator/Debugger Toolbar section).

Preferences dialog

With thisdialog (Figure 4.8) it is possible to set up environment variables
for the current project. New variables will be saved in the current project
file after clicking the OK button.
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NOTE  The corresponding menu entry (Fi | e>Confi gur ati on)isonly
enabled if aproject file isloaded.

Figure 4.8 Preferences Dialog

Preferences E3 |

E rviranment |

[3eneral Path

Object Path

Test Path

Abzolute Path

Header File Path

YWariouz Ervironment Y ariables

|${INS TALLPATHMIE$ACPU ehib |

Lo |Ehange| Deletel [ | Dn:nwnl

$INSTALLPATH Mib\$4CPL bl
FINSTALLPATH MBS CPU charc

The preference panel contains the following controls:

* A list box containing all environment variables, you can select a
variable with the mouse or Up/Down buttons.

» Command Line Arguments: Command line options are displayed. Y ou
can add, delete, or modify options, and specify adirectory with the
browse button (...).

» A second list box containing all variables defined in the corresponding
Environment section. Select a variable with the mouse or Up/Down
buttons.

» OK: Changes are confirmed and saved in current project file.
» Cancd: Closes dialog box without saving changes.
* Help: Opensthe helpfile.
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Figure 4.9

Table 4.3

View Menu

In thismenu (Eigure 4.9) you can choose to show or hide the toolbar, status
bar, window component titles and headlines (headlines are also called
Object Info Bar of the Simulator/Debugger Components in this document).
Y ou can select smaller window borders and customize the toolbar. Table
4.3 describes the View Menu entries.

View Menu

v Toolbar

v Statuz Bar
Hide Title
Hide Headline
Small Border
Cuztomize

View Menu Description

Menu entry  Description

Toolbar Check / uncheck Toolbar if you want to
display or hideit.

Status Bar Check / uncheck Status Bar if you want to
display or hideit.
Hide Tile Check / uncheck Hide Title if you want to hide

or display the window title.

Hide Headline  Check / uncheck Hide Headline if you want to
hide or display the headline.

Small Borders. Check / uncheck Small Border if you want to
display or hide small window borders.

Customize Opens the debugger Customize Toolbar
window.
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Figure 4.10

Customize Toolbar

Ayalable buttons:

Customizing the Toolbar
Y ou can customize the toolbar of the Simulator/Debugger, adding and
removing component shortcuts and action shortcuts. Y ou can also insert

separators to separate icons. Almost all functionsin View, Run and
Window menus are available as shortcut buttons, as shown in Figure 4.10.

Customize Toolbar Dialog

Toolbar buttans:

Separator

3 |Load Application

o=
gll:lpen Component

Ell‘ﬂemnry
h-'lu:u:lule

I.-’-'-.sseml:ull,l
4

KHE
Cloge I
- — -
=r Step Over —I Feset |
& |Step Out
Al [Step Oul
a5 _ Hop |
4' o [Azzembly Step
<-Eemnve| =1 [Halt
e |
. =y [ e B
_>IJ Kl :

Select the desired shortcut button in the Available buttons list box and
click Add toinstal it in the toolbar.

Select a button in the Toolbar buttonslist box and click Removeto
remove it from the toolbar.

Demo Version Limitations

The default toolbar cannot be configured.

Examples of view menu options

Figure 4.11 shows a Typica component window display.
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Figure 4.11 Typical component window display

B Source [_ |0
|C:hivearet DEMONS &MPLES Miboe  |Line: 25
i =2 [
while (i <= n) {[
fihl + fibhZ:

fibl =

fibz;
fibz fibo; J
it++:
1
returni(fiba) ; -
| |

Figure 4.12 shows a component window without atitle and headline.

Figure 4.12 Component window without title and headline

]
fibo = fibl + Fib2;
fibl = fib:Z:
fibz = fibo: _I
i++;
(1
return(fiba) ;
[}
void main(woid) il
1| | v

Figure 4.13 shows a component window without atitle and headline, and
with asmall border.
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Figure 4.13 Component window without title and headline, and with small

border
i=2: ﬂ
while (i EESER®]
fibo = fibl + fih2;
fibl = fih2:
£ibz = fiba; [
i++:
M}
return(fibal ;
=T}
vold maini(woid) -
o o

Figure 4.14 shows a component window without headline and small border

Figure 4.14 Component window without headline and small border

I Source !EE
i=2; :I‘
while [i & [

fibo = £ibl + £ibkZ;
fibl = fihz:
fibZ = fiho: _I
it++:
&}
returni(fiba) ;
[} -
KN LIJ
Run Menu

This menu, shown in Figure 4.15 is associated with the simulation or a
debug session. Y ou can monitor a simulation or debug session from this
menu. Run menu entries are described in Table 4.4.

DM-42 Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Simulator/Debugger User Interface
Function of the Main Menu Bar

Figure 4.15 Run Menu

Start/Continue F&

R eztart Clrl+Shift+F5
Hait F&

Single Step F11

Step Owver F10

Step Out Shift+F11

Azzembly Step Chrl+F11
Azzembly Step Ower Chl+F10
Azzembly Step Out  Crrl+5Shift+F11

Breakpoints...
Watchpoints. ..

Table 4.4  Run Menu Description

Menu entry Description

Start/Continue Starts or continues execution of the loaded application from the
current program counter (PC) until a breakpoint or watchpoint
isreached, runtime error is detected, or user stopsthe
application by selecting Run -> Halt.

Shortcut: [F5 |

Restart Starts execution of the loaded application from its entry point.
Shortcut: | Ctri ! + |7 Shift I + [F5 |
Halt Interrupts and halts arunning application. Y ou can examine the

state of each variable in the application, set breakpoints,
watchpoints, and inspect source code.

Shortcut: EI
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Menu entry

Description

Single Step

Step Over

Step Out

Assembly Step

Assembly Step Over

If the application is halted, thiscommand performsasingle step
at the source level. Execution continues until the next source
referenceisreached. If the current statement is a procedure call,
the debugger “stepsinto” that procedure. The Single Step
command does not treat a function call as one statement,
therefore it stepsinto the function.

Shortcut: [F11

Similar to the Single Step command, but does not step into
called functions. A function call istreated as one statement.

Shortcut: Hl

If the application is halted inside of a function, this command
continues execution and then stops at the instruction following
the current function invocation. If no function calls are present,
then the Step Out command is not performed.

Shortcut: |7 Shift I+ FHI

If the application is halted, thiscommand performsasingle step
at the assembly level. Execution continues for one CPU
instruction from the point it was halted. This command is
similar to the Single Step command, but executes one machine
instruction rather than a high level language statement.

Shortcut: | ctrl ! + F'I'Il

Similar to the Step Over command, but steps over subroutine
cal instructions.

Shortcut: | Ctrl ! + F]I]I

DM-44
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Menu entry

Description

Assembly Step Out  If the application is halted inside a function, this command

continues execution and stops on the CPU instruction following
the current function invocation. This command is similar to the
Step Out command, but stops before the assignment of the
result from the function call.

Shortcut: | Cirl ! +: |7 Shift I + F'I'Il

Breakpoints... Opens the Breakpoints Setting dialog and displays the list of
breakpoints defined in the application (refer to Control Points
chapter).

Watchpoints... Opens the Watchpoints Setting dialog box and displays the list

NOTE

of watchpoints defined in the application (refer to Control
Points chapter).

Y ou can provide shortcuts for some of these functions using the toolbar
(refer to Simulator/Debugger Simulator/Debugger Toolbar section and
Customizing the Toolbar section).

Y ou can set breakpoints and watchpoints in Source and Assembly
component windows.

For more information about breakpoints and watchpoints, refer to the
Control Points chapter.

Target Menu

This menu entry (Figure 4.16) appears between the Run and Component
menus when no target is specified in the PRQJECT. | NI file and no target
has been set. The Target name is replaced by an actual target name when
thetarget is set. To set thetarget, select Component>Set Tar get... Refer to
the Component Menu section.
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Figure 4.16

Table 4.5

Menu entry

Target Menu

Load... Chrl+L
Reset Crl+R

Table 4.5 describes the Target Menu entries.

Target Menu Description

Description

Load

Reset

Figure 4.17

Loads a Simulator/Debugger target.

Resets the current Simulator/Debugger target.

Loading a Target

Use the Target menu to load a debugger target.
1. Choose Target>Load...

The message shown in Figure 4.17 is displayed:

Load Target Dialog

Load Executable File E |

There iz currently no Target installed.
Do you want to install it now?

At this point, the target is not set and you cannot load any application
((AABS)file.

2. Click Yesto install atarget in the debugger.

The debugger searchesfor all targetsinstalled. The dialog shown in Figure
4.18 is opened. Click Cancel to stop the process and skip target detection.

DM-46

Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Simulator/Debugger User Interface
Function of the Main Menu Bar

Figure 4.18 Scan Target Dialog

Pleaze wait._.. |

Searching for inztalled Target Interfaces. .
a0

HNRRNER

The Set Target dialog shown in Figure 4.19 is opened.

Figure 4.19  Set Target Dialog

Set Target |

Processar

(R | o

T arget Interface

I Sirmulator Target [nberface j Carnicel

Thiz T arget Interface lets you simulate ﬂ Help
the core of the selected CPU

[

3. Use the Processor list popup to select the desired processor.
4. Use the Target Interface list popup to select the desired target.

A text panel displaysinformation about the selected Target.

WARNING!  When atarget can not be loaded, the combo box displays the path where
you should install missing dll.

5. Click Ok to load target in debugger.
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NOTE

Figure 4.20

Table 4.6

For more information about which target to load and how to set/reset a
target, refer to the Simulator/Debugger target manualse.g., “SIMULATOR
Target, CPU Awareness & True-Time Simulation”.

Targets file
All targets are associated with awindow file with .tgt extension.
Example: The Simulator Target

The default target of the Simulator/Debugger is the Simulator (in
Configuration of the Default Layout for the Simulator/Debugger: the
PROJECT.INI File: TARGET=SIM). However, choose Component>Set
Target... if you want to open the dialog to set a different target.

Simulator Menu
This menu, shown in Figure 4.20 is associated with the simulator target,

and allows you to load an application in the Simulator/Debugger. Table 4.6
describes the Simulator menu entries.

Simulator Menu

Chrl+L
Chil+H

Configure...
Rezet Rt
Feszet MEM
Fiezet Statiztic

Load [Os...
Cloge [0z...

Command Files...

Simulator Menu Description

Menu entry  Description

Load Opens the Load Executable Window menu.
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Menu entry  Description

Reset Resets the ssmulator target.
Configure Opens the Memory Configuration Window.
Reset Ram Resets the RAM to “undefined'

Reset Mem Resets al configured memory to “undefined'
Reset Statistic  Resets the statistical data

Load I/0Os Opens I/O components

Close 1/Os Closes |/0O components

Command Files Opens the Command File Dialog

Simulators File

The simulator is associated with awindow with a.sim extension.

Load Executable File dialog

Choose Simulator>L oad... to open the Load Executable File window,
shown in Figure 4.21, then set the load options and choose a Simulation
Execution Framework (a. ABS application file).
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Figure 4.21 Load Executable File dialog

Load Executable File EHE |
Lookin | - =EE
8] calc. abs! quick.absz

flbDabS sieve. abs
io_stirmu, abs bovers. abs
leds. abs

perm. abs

queensz.abs

File name:; || Open I
Files of type: IE:-:E::utaI:uIes [* abs; *.elf] j Cancel |

— Load Optionz
% Load Code + Symbol:  © Load Symbolz only 7 Load Code anly

— Code Verification Options
* Mone " Firstbytez only O Allbgtes € Read back only

Description of the Load Options.

These three Radio buttons allow you to select which part of the executable
filewill be loaded:

» Load Code + Symbols. Thiswill load the application code followed by

the debug information (symbols) to allow debugging of the application.

» Load Symbolsonly. If thisoption is selected, only debugging
information isloaded. This can be used if the code is already |oaded
into the target system or programmed into a non-volatile memory
device (ROM/FLASH).

» Load Code only. Only the application code will be loaded into the
target system. This option can be used if no debugging is needed.

Description of the Code Verifications Options.

These four Radio buttons allow you to choose between four levels of code
verification.

* None. The loader does not verify anything. The loader behaves the
same as previous versions of the debugger.
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NOTE

TIP

Figure 4.22

» First bytes. The loader reads back a maximum of the first four bytes of
ablock that have been written to memory. This option is not as secure
as the next option but is faster.

* All bytes. The loader reads back all bytes of a block that have just been
written to memory. File loading is almost twice as long. However,
verification is done on the wholefile.

» Read back only. With this option the loader does not |oad data to
memory. However, it reads back the current data matching the same
areas from the target memory and compares all datawith the datafrom
the selected file.

If "Load Symbolsonly"” is selected, verification radio buttons are grayed
and NO verification is performed.

If verification fails, amessage is displayed, giving the address where a
difference occurred.

For more detail s on the Simulator functions, consult the True Time
Simulator Manual.

Dialog Load 1/Os

This dialog box, shown in Figure 4.22 alows you to open an 1/O device
(peripheral) simulation. The Browse button allows you to specify a
location for the 1/0O.

Open IO Dialog

Open |0 Component Ed |

B aszic -
Flash —
Hec0Baz60

He0Baz60

Hel2ad Cancel
Heolz2d1:28
[rter

R andarn

S amplels
Sampleds Help
Sample11

Samplel?
Samplels LI

Browse...

F L
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NOTE

Figure 4.23

I/O simulation components are either designed by Metrowerks and
delivered with the tool-kit installation or designed by the user with the
Peripheral Builder.

Target Interface Command File Dialog

Each page of this property sheet dialog, shown in Figure 4.23 corresponds
to an event on which a command file (refer toAbout startup.cmd,
reset.cmd, preload.cmd, postload.cmd)can be automatically run from the
Simulator/Debugger: Startup Command File,Reset Command File, Preload

Command File, Postload Command File, Setcpu Command File, Vppon
Command File and V ppoff Command File.

Target Interface Command File Dialog
Simulator Target Interface Command Files E2 |

Startup |Heset I F'reln:nau:ll F'n:nstln:nau:ll Setcpul ‘Jppn:nnl ‘Jppn:nffl

The Startup command file iz executed ko zet up the target sustem right

after the connection haz been established.
Browsze... |

v Enable Command File

k. I Cancel Help |

The command file in the edit box is executed when the corresponding
event occurs.

Click the Browse button to set the path and name of the command file.

The Enable Command File check box alows you to enable/disable a
command file on an event. By default, all command files are enabled:

* the default Startup command fileis STARTUP. CNVD,
 thedefault Reset command fileis RESET. C\VD,

» thedefault Preload command file is PRELOAD. C\VD,

* the default Postload command file is POSTLQAD. C\VD.
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* the default Setcpu command fileis SETCPU. CVD.
» thedefault Vppon command fileis VPPON. CVD.
* the default Vppoff command file is VPPOFF. C\VD.

Startup settings performed in this dialog are stored for subsequent
debugging sessionsin the [Simulator] section of the PROJECT file using
the variable CM DFILEO.

When a CPU is set, the settings performed in this dialog are stored for
subsequent debugging sessionsin the [Simulator XXX] (where XXX is
the processor) section of the PROJECT file using variables CM DFILEQ,
CMDFILEL,... CMDFILEN.

Startup Command File

The Startup command file is executed by the Simulator/Debugger after
the Target Interface has been |oaded.

The Startup command file full name and status (enable/disable) can be
specified either with the CMDFILE STARTUP Command Line
command or using the Startup property page of the Target Interface
Command File Dialog dialog.

By default the STARTUP. CVDfile located in the current project directory
is enabled as the current Startup command file.

Reset Command File

The Reset command file is executed by the Simulator/Debugger after the
reset button, menu entry or Command Line command has been selected.

The Reset command file full name and status (enable/disable) can be
specified either with the CMDFILE RESET Command Line command or
using the Reset property page of the Target Interface Command File

Dialog dialog.

By default the RESET. CMVD file located in the current project directory is
enabled as the current Reset command file.
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Preload Command File

The Preload command file is executed by the Simulator/Debugger before
an application isloaded to the target system through the Target Interface.

The Preload command file full name and status (enable/disable) can be
specified either with the CM DFILE PREL OAD Command Line
command or using the Preload property page of the Target Interface
Command File Dialog dialog.

By default the PRELOAD. CVD file located in the current project directory
isenabled as the current Preload command file.

Postload Command File

The Postload command file is executed by the Simulator/Debugger after
an application has been loaded to the target system through the Target
Interface.

The Postload command file full name and status (enable/disable) can be
specified either with the CMDFILE POSTLOAD Command Line
command or using the Postload property page of the Target Interface
Command File Dialog diaog.

By default the POSTLOAD. CVDfile located in the current project
directory is enabled as the current Postload command file.

Setcpu Command File

The Setcpu command file is executed by the Simulator/Debugger after a
CPU has been set or modified in the simulator (this occurs when the setcpu
command is used or when afileisloaded in the ssmulator and the
corresponding cpu is not set).

The Setcpu command file full name and status (enable/disable) can be
specified either with the CM DFILE SETCPU Command Line command
or using the Setcpu property page of the Target Interface Command File

Dialog.

By default the SETCPU. CVDfilelocated in the current project directory is
enabled as the current Setcpu command file.
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Vppon Command File

The Vppon command file is executed by the Simulator/Debugger before
"Non Volatile Memory" is erased or before afile is programmed in "Non
Volatile Memory" to the target system through the target interface Non
Volatile Memory Control dialog (Flash... menu entry) or FLASH
PROGRAM/ERASE commands from Flash Programming utilities.

The Vppon command file full name and status (enable/disable) can be
specified either with the CMDFILE VPPON Command Line command or
using the Vppon property page of the Target Interface Command File

Dialog dialog.

By default the VPPON. CMVD file located in the current project directory is
enabled as the current V ppon command file.

This command file can be used, for example, to enable a programming
voltage by software.

NOTE  Thiscommand fileisnot available for al target interfaces.

Vppoff Command File

The Vppoff command fileis executed by Simulator/Debugger after a"Non
Volatile Memory" has been erased or after afile has been programmed in
"Non Volatile Memory" to the target system through the target interface
Non Volatile Memory Control dialog (Flash... menu entry) or FLASH
PROGRAM/ERASE commands from Flash Programming utilities.

The Vppoff command file full name and status (enable/disable) can be
specified either with the CMDFILE VPPOFF Command Line command
or using the Vppoff property page of the Target Interface Command File

Diaog dialog.

By default the VPPOFF. CVDfile located in the current project directory is
enabled as the current Vppoff command file.

NOTE  Thiscommand fileisnot available for al target interfaces.
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Component Menu

Select Component>Open... to load an extracomponent window, shown in
Figure 4.24, that has not been loaded by the Simulator/Debugger at startup.
The popup dialog presents aset of different componentsthat areintroduced
in Framework Components.

Figure 4.24 Component Menu
Componett
Open...
Set Target...
Faonts...
Background Caolar. .
Table 4.7 describes the Component Menu entries.
Table 4.7 Component Menu Description
Menu entry  Description
Open L oads an extra component window that has
not been loaded by the Simulator/Debugger at
startup. The popup dialog presents a set of
different components that are introduced in
Components Window.
Set Target Sets the Simulator/Debugger target e.g.,
Simulator.
Fonts Opens a standard Font Selection dialog, where
you can set the font used by Simulator/
Debugger components.
Background  Opens astandard Color Selection dialog,
Color where you can set the background color used
by the Simulator/Debugger component
windows.
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TIP

Figure 4.25

Figure 4.26

Figure 4.27

For areadable display, we recommend using a proportional font (e.g.,
Courier, Terminal, etc.).

Demo Version Limitations

Only 2 1/0O components can be loaded at atime.

Window Menu

In this menu, shown in Figure 4.25, you can set the component windows
general arrangement. The Submenu Window>Optionsis shown in Figure
4.26 and the Submenu Window>L ayout in Figure 4.27.

Window Menu
ﬂir'l do
LCazcade
Tile
Arrange lcohg
Ophions k
Layout r

Window>Options SubMenu

v Autosize
v LComponent Menu

Window>Layout SubMenu
Load
Store

Table 4.8 specifies the Window Menu entries.
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Table 4.8 Window Menu Description

Menu entry  Description

Cascade Option to arrange all open windowsin cascade
(so they overlap).
Tile Option to display all open windowsintile

format (non overlapping).
Arrangelcons  Arrangesicons at the bottom of windows.

Options - Component windows awaysfit into the
Autosize debugger window whenever you modify the
debugger window size.

Options - When a component window is selected, the

Component associated menu is displayed in the main

Menu menu. For example if you select the Source
window, the Source menu is displayed in the
main menu.

Layout - Load/ Optionto Load / Store your arrangements
Store froma. HAL file.

NOTE  Autosize and Component Menu are checked by default.

Help Menu

Thisis the debugger help menu (Figure 4.28). Table 4.9 shows menu
entries.

Figure 4.28 Help Menu
Help Topicz
Sbout...
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Table 4.9

Help Menu Description

Menu entry Description

Help Topics Choose Help Topics in the menu for online
help or if you need specific information about a

Simulator/Debugger topic.
About HI- Information about the debugger version and
WAVE copyright, and license information is displayed.

About Box

Select Help>about to display the about box, shown in Figure 4.29. The
about box lists directories for the current project, system information,
program information, version number and copyright. It contains
information to send for Registration: you can copy thisinformation and
sendtol i cense@ret r ower ks. com
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Figure 4.29  About Box

L

Yerzion 6.1
E (c] COPYRIGHT METROWERKS 1987-2002

hikbp: A vy, retrowerks, com

maitolicense europe@imetrowerks. com I E tended Infarmation

Drirectony: E:% -
E nwiranment file: E:\project.ini

GEMPATH=

LIEPATH=

DEJPATH=

ABESPATH=

TEXTPATH=

Wehn <http: A dwian, metrowerk s, com:

LM_LICEMSE_FILE= o
Lizenze File: Maone or default FLE=Im location [LM_LICEMSE_FILE, 'C:\flexlmblice
Application FLEXIm License Version: 2 000, 071

Wendar daemon: metrowlks =
) N Ias R E a0 e G
4 f | 3

For more information on all components, click on the Extended
I nfor mation button.

Two hypertext links allow you to send an E-mail for alicense request or
information, and open the Metrowerks internet home page.

Click on OK to close this dialog.
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Component Associated Menus

Figure 4.30

Each component loaded by default or that you have loaded has two menus.
One menu isin the Simulator/Debugger main menu and the other oneisa
popup menu (also called “ Associated Popup Menu”) that you can open by
right-clicking in awindow component. Note that before right-clicking, the
component window has to be active.

Component Main Menu

This menu, shown in Figure 4.30 is always between the Component entry
and the Window entry of the Simulator/Debugger main menu. It contains
general entries of the current active component. Y ou can hide this menu by
unchecking Window>Options>Component Menu.

Example of Component Main Menu

& HI-WAVE - [project.ini]

Fil= “iew BRun Simulator  Component Belaiie-l window  Help

Dlﬁlnl 35"%'3' ?lﬂl Open Source File...

R S
C\DEMDNSAMPLES \fibo.c HoToline.. B
_ _ Find... d
WhE (1 I { - Find Procedure...
o = £ibl + £ibZ;
fibl = f£ibkz: Folding ¥
fihz = f£ihno:
itt: Markz J
E}
returni(fibo) ;
=10 hd
[« | 2w

Components File

Each component is awindows file with a.wnd extension

Component Popup Menu

The popup menu is a dynamic context sensitive menu. It contains entries
for additional facilities available in the current component. Depending on
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the position of the mouse in the window and what is being pointed to,
popup menu entries will differ.

Figure 4.31 Example of Component Popup Menu

i Source M=l B3
|C:vhiveare DEMOS4MPLES Mibo. o |Line: 26
while (i <= n} {[F Set Breakpaint :I
e + Lib2; Fun Ta Cursor
i = fihZ; .
fibz - fibos g:uw Ereak.pu:unts
s o Location
S Open Source File...
returtn(fibo) ;
= LCopy Chl+C _I
void main(woid) {[E Go ToLine...
int i: Find...
Find Procedure. ..
EnabhleInterrupts; )
while (TRUE] { [ Folding ¢
Enunf,n.ar =HEI:_ o Marks -
[ | ay

For example, if you point the mouse to a breakpoint, menu options allow
you to delete, enable, or disable the breakpoint.

However some entries are identical with entries in the main menu.

Highlights of the User Interface

This section describes the main features of the Debugger user interface.

Smart User Interface: Activating Services with
Drag and Drop

Y ou can activate services by dragging objects from one component to
another. Thisis known as drag and drop, an example is shown in Figure
4.32.
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Figure 4.32 Drag and Drop Example

B Source H=] E
|E:\DE MONibo.c |Line: 26
i =2 [

while (1 <= n) {[E

fibo = f£ibl + £ibhZ;
fibZ = fibo: %;g _I
i++:
[T}
returni(fiba) ;
) hd

When the destination of adracaed item is not possible, the following
cursor symbol is displayed: @

Example:
Y ou can activate the display of coverage information on assembler and C

statements by dragging the chosen procedure name from the Coverage
Component to the Source and Assembly components (Figure 4.33).

Figure 4.33 Dragging the chosen procedure name from the “Coverage
Component,” to the Source.

i Source O] =
|E:ADE MO termpart.c |Line: 26
(E ~l
GCI.ACDE = ch; _I
B} %
Ehak: -
el TS+ rdrnarl o Fotrh
(7] [
I Coverage M=l B3
H calc.c 66.0 » I 3“
Ewval 95,5 & I
Echo 0.0 %1 |
terminal.c 3Z.3 & I
LErmpOrt. C 59.1 ; I |

Y ou can display the memory layout corresponding to the address held in a
register by dragging the address from the Register Component to the
Memory Component.
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To Drag and Drop an Object
Select the component containing the object you want to drag.

2.  Makesurethedestination component where you want to drag the
object isvisible.

Select the object you want.

Pressand hold the left mouse button, drag the object onto the
destination component and then release the mouse button.
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Drag and Drop Combinations

Dragging and dropping objects is possible between different component
windows and are introduced in each component description section.

See below, the possible combinations of drag and drop between
components and associated actions. When additional components are
available, new combinations might be possible and described in the
component’ s information manual.

Dragging from the Assembly Component

Table 4.10 summarizes dragging from the Assembly Component.

Table 4.10 Dragging from the Assembly Component

Destination Action
compo.
Command Line The Command Line component appends the address of the

pointed to instruction to the current command.

Memory Dumps memory starting at the selected instruction PC. The
PC location is selected in the memory component.

Register L oads the destination register with the PC of the selected
instruction.

Source Source component scrolls up to the source statements and
highlightsit.

Dragging from the Data Component

Table 4.11 summarizes dragging from the Data Component.

Table 4.11 Dragging from the Data Component
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Destination
compo.

Action

Command Line

Memory

Register

Source

Dragging the name appends the address range of the variableto
the current command in the Command Line Window. Dragging
the value appends the variable value to the current command in
the Command Line Window.

Dumps memory starting at the address where the selected
variableislocated. The memory areawherethe variableis
located is selected in the memory component.

Dragging the name loads the destination register with the
address of the selected variable. Dragging the value loads the
destination register with the value of the variable.

Dragging the name of a global variable in the source Windows
display the module where the variable is defined and the source
text is searched for the first occurrence of the variable and
highlighted.

NOTE Itisnot possible to drag an expression defined with the Expression Editor.
The “forbidden” cursor is displayed.
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Dragging from the Source component

Table 4.12 summarizes dragging from the Source Component.

Table 4.12 Dragging from the Source component

Destination Action
compo.
Assembly Displays disassembled instructions starting at the first high

level language instruction selected. The assembler instructions
corresponding to the selected high level language instructions
are highlighted in the Assembly component

Register L oads the destination register with the PC of the first
instruction selected.
Memory Displays the memory area corresponding with the high level

language source code selected. The memory area
corresponding to the selected instructions are greyed in the
memory component.

Data A selection in the Source window is considered an expression
in the Datawindow, asif it was entered through the Expression
Editor of the Data component. (please see Data Component and
Expression Editor)

Dragging from the Memory component

Table 4.13 summarizes dragging from the Memory Component.

Table 4.13 Dragging from the Memory component

Destination Action
component.
Assembly Displays disassembled instructions starting at the first address

selected. Instructions corresponding to the selected memory
area are highlighted in the Assembly component.
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Destination Action

component.

Command Line Appends the selected memory range to the Command Line
window

Register L oads the destination register with the start address of the
selected memory block.

Source Displays high level language source code starting at the first

address selected. Instructions corresponding to the selected
memory area are greyed in the source component.

Dragging from the Procedure component

Table 4.14 summarizes dragging from the Procedure Component.

Table 4.14 Dragging from the Procedure component

Destination Action

compo.

Data > Local Displayslocal variables from the selected procedurein the data
component

Source Displays source code of the selected procedure. Current
instruction inside the procedure is highlighted in the Source
component.

Assembly The current assembly statement inside the procedureis

highlighted in the Assembly component.

Dragging from the Register component

Table 4.15 summarizes dragging from the Register Component.
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Table 4.15 Dragging from the Register component

Destination Action

compo.

Assembly Assembly component receives an address range, scrollsto the
corresponding instruction and highlightsiit.

Memory Dumps memory starting at the address stored in the selected
register. The corresponding address is selected in the memory
component.

Dragging from the Module component

Table 4.16 summarizes dragging from the Register Component.

Table 4.16 Dragging from the Module component

Destination Action

compo.

Data> Global Displays global variables from the selected module in the data
component

Memory Dumps memory starting at the address of the first global

variable in the module. The memory areawhere thisvariableis
located is selected in the memory component.

Source Displays source code from selected module.

Selection Dialog Box

This dialog box is used in the Simulator/Debugger for opening general
components or source files. Y ou can select the desired item with the arrow
keys or mouse and then the OK button to accept or CANCEL to ignore
your choice. The HEL P button opens this section in the Help File.

Thisdialog box is used for the following selections:
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Set Target

Open 1O component

Open Source File

Open Module

Components Window
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Framework Components

This Chapter introduces the concepts of the Debugger Components.

Click any of the following links to jump to the corresponding section of
this chapter:

e Component Introduction

e Components Window

e Genera Component

e Visualization Utilities

Component Introduction

The Simulator/Debugger kernel includes various components.

CPU component

CPU components handle processor specific properties such as register
naming, instruction decoding (disassembling), stack tracing, etc. A specific
implementation of the CPU module has to be provided for each processor
type that is supported in the ssimulator/debugger. The CPU related
component is not introduced in this section. However, this system
component is reflected in the Register component, Memory component,
and all other Target dependent components. The appropriate CPU
component is automatically loaded when loading aframework ((ABSfile).
Therefore it is possible to mix frameworks for different MCUs. The
Simulator/Debugger automatically detects the MCU type and loads the
appropriate CPU component, if available on your environment.

Window components

The Simulator/Debugger window components are small applications
loaded into the debugger framework at run-time. Window components can

For More Information: www.freescale.com
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Components Window

NOTE

access all global facilities of the debugger engine, such as the target
interface (to communicate with different targets), and the symbol table.
The Simulator/Debugger window components are implemented as
dynamic link libraries (DLLs) with extension.WND. These components
are introduced in this section.

Target components

Different debugger targets are available. For example, you can set a CPU
Simulator to simulate your . ABS application files, and also set a
background debugger.

Onetarget shall be loaded at any time. Either asimulator or adriver
implements the link to the target system. The simulator implements the
CPU and memory simulation and may be extended by 1/0 simulation.
Different targets are available to connect the target system (hardware) to
the Simulator/Debugger on the Host computer. For example, the target
may be connected using an Emulator, a ROM monitor or any other
supported device.

Target components are introduced in their respective manual.

Components Window

Use the Component menu to load all framework components.
1. Choose Component>Open...
2. Inthe dialog shown in Figure 5.1, select the desired component.
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Figure 5.1 Open Window Component Dialog

Open Window Component

leon  List | Dretails |
FEJ Azzembly K.
ﬂ Coverage

_EJ Inzpect

.ﬁ'l Procedure
ﬂ Profiler
E= Register Help

3; Source

Cancel

Pl ]

Browveze

TIP  To open more than one component, select multiple components.

3. Click OK to open the selected component.
The I con panel shows you components with large icons.
The List panel shows you components with small icons.
The Details panel shows you components with their description.
Demo Version Limitations

Maximum number of components opened at atimeislimited to 8.

General Component

This chapter describes features of the debugger components.
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Adc_Dac component

The Adc_Dac component window, shown in Figure 5.2 consists of a
Digital to Analogic and an Analogic to Digital converter.

Figure 5.2 Adc_Dac Component

mADC/DAC M|
=ADC/DAC =
INPUT

OUTPUT

Description

This component is made of 4 units as shown in Figure 5.3:
* A signal generator
* Ananalogic to digital converter (ADC)
» A digital to anaogic converter (DAC)
* A visualization unit

DM-74 Debugger Manual

For More Information: www.freescale.com



Freescale Semiconductor, Inc.

Framework Components
General Component

Figure 5.3 Internal converter module organization and coupler
connections.
Sinsoidal
Signal —— | Viualization |
Generator SCrEEn DAC
44— Timer
ADC
[ [ds] ds[de [ ds | dafch|dh] L [-[-T-[-[-[-[Rey|] [dr]ds[ds|c]ds]ci[ch[dh]
AT Port AT State Port DAC Port

The 4th unit shows the value of the initial analogic signal and value of the
DAC output analogic signal.

Communication with the mainframe is done through 3 parallel ports of 8
bits:
» aport with 1 significant bit to indicate the conversion state.

* aninput port to recover the ADC values
* anoutput port to send values to the DAC in order to visualize them

The signal generator

It only generates a sinus signal. The generator output is connected to the
ADC visualization screen.

The visualization screen

A 200 point horizontal resolution screen. The sinus signal period is
deployed by default in red, in the upper part of the screen, and the signal
generated by the DAC is displayed in blue in the lower part.
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The ADC

An 8 bit resolution converter generating unsigned values. Aswe can seein
the figure below, its entry is directly connected to the signal generator. On
the other hand, the conversion order will be given by atimer not connected
to the data bus (it can not be set by software).

At the end of aconversion, it setsthe state bit. This bit is automatically
reset after read.

The DAC

Also an 8 bit resolution converter whose output is connected to the
visualization screen.

Its useis smplified, we only have to send a byte into its data port to have
its conversion displayed on the visualization screen. This screen only hasa
200 point resolution; it is useless to send more than 200 bytes to the
converter.

Menu

The Adc-Dac menu shown in Figure 5.4 contains all functions associated
with the Adc-Dac component. These entries are described in Table 5.1.

Figure 5.4 Adc-Dac menu

Setup....

Rezet

LCorversion parameters. ..

Start conversian

Dizplay properties. ..

Table 5.1 Adc-Dac Menu Description
Menu entry  Description
Setup Opens the dialog box allowing you to set the
port addresses.
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Figure 5.5

Menu entry  Description

Reset This function erases the visualization screen
and re-initializes the display properties.

Conversion Opens the dialog box allowing you to set the

parameters signal frequency

Start Runs the conversion process

conversion

Display Opens the dialog box alowing you to set the

properties display properties

Adc_Dac Setup dialog

Thisdialog shown in Figure 5.5 allows you to define the port and address
or select one port of the five proposed. These are used when this
component functions with the Programmable 1O_Ports component.

Adc-Dac Setup dialog

ADC / DAC - Setup

— Portz address

Select a part ar tupe an address [in hex)

End of conversian indicatar IfEEIEIEIEI vI
A-x0 conversion result IfEEIEIEIE vI

Dizplay digital datas

o]

Adc_Dac Conversion parameters dialog

This dialog box shown in Figure 5.6 allows you to choose the analogic
signal frequency generated by the sinusoidal generator and the sampling
frequency.
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Figure 5.6

The choice of these two frequencies will internally initialize the timer,
which will give the conversion orders.

Adc_Dac Conversion parameters dialog

Conversion parameters E |

;@; For the Real values, use the paint, nat the: comma.

#nalogic sighal frequency [Hz] ; a0

Sampling freguency [Hz] : I'I ood

Now you can start the conversion with Start conversion menu entries,
Adc_Dac Display properties dialog

Thisdialog box shown in Figure 5.7 allows you to modify the display
properties form the Adc_Dac component. The Up and Down buttons allow
you to define the vertical position of the input and output curves. Two
control buttons allow you to change the axes scales.
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Figure 5.7 Adc_Dac Display properties dialog

Iloves the curve up Dizplay properties |

\\_ Vertical position ———

Moves
The inpat curve

% The output curve

IMovres the curve doun

\‘ 1
Increases or decreases the
toamber of period displayed \

~ Ais soales
Incteases or decteases
Harizartal c j " the graphic amplitude
it the display Wertical ﬂ
settings

Operations

To convert asigna from an example application:

L oad the application and the Adc_Dac component.
Choose the ports address

Definetheinput signal frequency

Define the sampling frequency

Start the application

© g k~ w D P

Choose Start Conversion
Drag out

Nothing can be dragged out.
Drag into

Nothing can be dragged in.
Demo Version Limitations

No limitations
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Associated Commands

Following commands are associated with the Adc_Dac component:

ADCPORT, LINKADDR

Assembly Component

The Assembly component window, shown in Figure 5.8 displays program
code in disassembled form.

Description

The Assembly component has a function very similar to that of the Source
component window but on a much lower abstraction level. Thusitis
therefore possible to view, change, monitor and control the current location
of execution in a program.

Figure 5.8 Assembly Component
i Azsembly M=l
|Fibonacei
hle crfh, 0x003E£c290 il
mflr ra
st rd, 4{rl)
imih] rl, -1a(rl)
atw r3l, 1Z(rl)
nop
1i rd, 0 ﬂ
The window contains al on-line disassembled instructions generated by
the loaded application. Each displayed disassembled line in the window
can show the following information: the address, machine code, instruction
and absolute address in case of abranch instruction. By default, the user
can see the instruction and absolute address.
If breakpoints have been set in the application, they are marked in the
Assembly component with a special symbol, depending on the kind of
breakpoint.
DM-80
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If execution has stopped, the current position is marked in the Assembly
component by highlighting the corresponding instruction.

The Object Info Bar of the Simulator/Debugger Components contains the
procedure name, which contains the currently selected instruction. When a
procedure is double clicked in the Procedure component, the current
assembly statement inside this procedure is highlighted in the Assembly
component.

Setting Breakpoints

Breakpoints can be set, edited and deleted when using the popup menu.
Right-click on any statement in the Source component window, then
choose Set Breakpoint, Delete Breakpoint, etc., as explained below.

NOTE  For information on using breakpoints, see Define Breakpoints chapter.

Menu

The Assembly menu shown in Figure 5.9 contains all functions associated
with the assembly component. Theses entries are described in Table 5.2.

Figure 5.9 Assembly Menu

Set Breakpoint
Fun To Cursor
Shaow Breakpaoints
Show Location

Address. .
Digplay Code
Dizplay Symbolic
Dizplay Addreszs
v Dizplay Absolute Address

Table 5.2  Assembly Menu Description

Menu entry  Description

Address... Opens adialog box prompting for an address:
Show PC.
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Menu entry  Description

Display Code  Displays machine code in front of each
disassembled instruction.

Display Displays symbolic names of objects.
Symbolic

Display Displaysthe location address at the beginning
Address of each disassembled instruction.

Display In abranch instruction, displays the absolute
Absolute address at the end of the disassembled
Address instruction.

Show PC Dialog

If an hexadecimal addressis entered in the Show PC Dialog shownin
Figure 5.10, memory contents are interpreted and displayed as assembler
instructions starting at the specified address.

Figure 5.10 Show PC Dialog
Show PC Ed
Show PC: | hie
¥ Hex Farmat Ok Cancel | Help |
Associated Popup Menu
To open the popup menu right-click in the text area. The popup menu
contains default menu entries for Assembly component (see above). It also
contains some context dependent menu entries described in Table 5.3;
depending on the current state of the simulator/debugger.
DM-82 Debugger Manual
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Table 5.3 Assembly Popup Menu Description

Menu entry

Description

Set Breakpoint

Delete
Breakpoint

Enable
Breakpoint

Disable
Breakpoint

Run To Cursor

Show
Breakpoints

Appears only in the popup menu if no
breakpoint is set or disabled on the pointed to
instruction. When selected, sets a permanent
breakpoint on thisinstruction. When program
execution reaches thisinstruction, the program
is halted and the current program state is
displayed in all window components.

Appearsin popup menu if abreakpoint is set
or disabled on the specified instruction. When
selected, deletes this breakpoint.

Appearsonly in popup menu if abreakpoint is
disabled on an instruction. When selected,
enables this breakpoint.

Appearsin the popup menu if a breakpoint is
set on an instruction. When selected, disables
this breakpoint.

When selected, sets atemporary breakpoint on
aspecified instruction and continues execution
of the program. If there isadisabled
breakpoint at this position, the temporary
breakpoint will also be disabled and the
program will not halt. Temporary breakpoints
are automatically removed when they are
reached.

Opens the Breakpoints setting dialog box and
displays list of breakpoints defined in the
application (refer to Control Points).
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Menu entry  Description

Show Location When selected, highlightsthe source statement
that generated the pointed to assembler
instruction. The assembler instruction is also
highlighted. The memory range corresponding
to thisassembler instruction isaso highlighted
in the memory component.

Retrieving Source Statement

» Point to an instruction in the Assembly component window, drag and
drop it into the Source component window. The Source component
window scrolls to the source statement generating this assembly
instruction and highlightsiit.

. \./Ej + |k | Highlights a code range in the Assembly component

window corresponding to the first line of code selected in the Source
component window where the operation is performed. Thisline or code
range is also highlighted.

Drag Out
Table 5.4 shows the drag and drop actions possible from the Assembly
component.

DM-84 Debugger Manual

For More Information: www.freescale.com



} { Freescale Semiconductor, Inc.

Framework Components
General Component

Table 5.4 Drag and Drop possible from the Assembly Component.

Destination
component

Action

Command Line

Memory

Register

Source

The Command Line component appends the address of the
pointed to instruction to the current command.

Dumps memory starting at the selected instruction PC. The PC
location is selected in the memory component.

L oads the destination register with the PC of the selected
instruction.

Source component scrolls to the source statements and
highlightsit.

Drop Into

Table 5.5 shows the drag and drop actions possible in the Assembly
component

Table 5.5 Drop Into Assembly Component

Source
component

Action

Source

Memory

Register

Displays disassembled instructions starting at thefirst high level
language instruction selected. The assembler instructions
corresponding to the selected high level language instructions
are highlighted in the Assembly component

Displays disassembled instructions starting at the first address
selected. Instructions corresponding to the selected memory
area are highlighted in the Assembly component.

Displays disassembl ed instructions starting at the address stored
in the source register. The instruction starting at the address
stored in the register is highlighted.
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Source

component

Action

Procedure

Figure 5.11

The current assembly statement inside the procedure is
highlighted in the Assembly component.

Demo Version Limitations

No limitation

Associated Commands

Following commands are associated with the Assembly component:

ATTRIBUTES, SMEM, SPC.

Command Line Component

The Command component shown in Figure 5.11 interprets and executes all
Simulator/Debugger commands and functions. The command entry always
occursin thelast line of the Command component. Characters can be input
or pasted on the edit line.

Command Line Component

@ Command A=l

inz|

Description

This section explains functions of the Command component.

Command key in.

Y ou can type Simulator/Debugger commands after the “in>" terminal
prompt in the Command Line Component window.
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Recalling a line from the Command Line history.

To recall acommand in the DOSwindow use either | T | | | F3|(to

Scrolling the Command Component Window Content

Use q—l and | — | to move the cursor on the line, H“”EI to move the

cursor to the beginning of the line, EHDI to move the cursor to the end of

theline.

NOTE  Toscroll apage, use the PgDn (scroll down a page) or PgUp keys (scroll
up a page).

Clear the line or a character of the Command Line

Selected text can be deleted by pressing

To clear the current line type Escl.

Command interpretation

The component executes the command entered, displays results or error
messages, if any. Ten previous commands can be recalled using Jl_l to
scroll up or Jl_l to scroll down. Commands are displayed in blue.
Prompts and command responses are displayed in black. Error messages
are displayed in red.

When a command is executed and running from the Command Line
component, the component cannot be closed. In this case, if the Command
Line component is closed with the window close button (X) or with the
Close entry of the system menu, the following message is displayed:

“Command Conponent is busy. Closing will be
del ayed”
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Figure 5.12

The Command Line component is closed as soon as command execution is
complete. If the CLOSE command is applied to this Command Line
component (for example, from another Command Line component), the
component is closed as soon as command execution is finished.

Variable checking in the Command Line

When specifying a single name as an expression in the command line, this
expression isfirst checked as alocal variablein the current procedure. If
not found, it is checked as a global variable in the current module. If not
found, it is checked asaglobal variable in the application. If not found, itis
checked as afunction in the current module. If not found, it is checked asa
function in the application, finally if not found an error is generated.

Closing the Command Line during an execution

When acommand is executed from a Command Line component, it cannot
be closed. If the Command Line component is closed with the close button
or with the 'Close’ entry of the system menu, the following messageis
displayed 'Command Conponent is busy. Closing will be
del ayed' and the Command component is closed as soon as command
execution is complete. If the'Close' command is applied to this Command
component, the Command component is closed as soon as command
execution is complete.

Menu and popup menu
Figure 5.12 shows the Command component menu and popup menu.

Command Component Menu and popup menu

Execute File

[Eay
Pazte

Cache Size

Clicking Execute File opens adialog where you can select afile
containing Simulator/Debugger commands to be executed. Theses files
generaly have a.cmd default extension.

Selected text in the Command Line window can be copied to the clipboard
by:
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Figure 5.13

* selecting the menu entry Command>Copy.
e pressing | Ctrl ! + |C |
» clicking the%l button in the toolbar.

The Command>Copy menu entry and the%l button are only enabled if
something is selected in the Command Line window.

Thefirst line of text contained in the clipboard can be pasted where the
caret is blinking (end of current line) by:

* selecting the menu entry Command>Paste

* pressing |ctr !+ v |
* clicking the |§| button in the toolbar.

Cache Size

Select Cache Size in the menu to set the cache sizein lines for the
Command Line window, as shown in Figure 5.13.

Cache Size Dialog

Size of the Cache |

IV Limited Size of Cache

Mumber of ines ta be cached: I'I aaa
K, I Cancel | Help |

This Cache Size dialog is the same for the Terminal Component and the
TestTerm Component.

Drag Out

Nothing can be dragged out.
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Drop Into
Memory range, address, and value can be dropped into the Command Line

Component window, as described in Table 5.6. The command line
component appends corresponding items of the current command.

Table 5.6  Drop Into the Command Component

Source Action
component
Assembly The Command Line component appends the address of the

pointed to instruction to the current command.

Data Dragging the name appends the address range of the variable to
the current command in the Command Line Window. Dragging
the value appends the variable value to the current command in
the Command Line Window.

Memory Appends the selected memory range to the Command Line
window
Register The address stored in the pointed to register is appended to the

current command.

Demo Version Limitations

Only 20 commands can be entered and then command component is closed
and it isno longer possible to open a new one in the same Simulator/
Debugger session.

Command files with more than 20 commands cannot be executed.

Associated Commands

NOTE For more details about commands, refer to Debugger Commands.
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Coverage Component

The Coverage component window, shown in Figure 5.14 contains source
modules and procedure names as well as percentage values representing
the proportion of executed code in a given source module or procedure.

Figure 5.14 Coverage Component
= Coverage M=l B3
calc. o 62.3 5 NN | =
terminal.c 12,9 x 0
CErmport.C 8.2 %
FetlChar 22.2 3 W
PutChar 0.0 %I
Putitring 0.0 %
InitTermIO TZ2.7 % I
inout.c 0.0 x| j
Description
The Coverage component window contains percentage numbers and
graphic bars. From this component, you can split views in the Source
component window and Assembly component window, as shown in Figure
5.15. A mark +' isdisplayed in front of each source or assembler
instruction that has been executed. Split views are removed when the
Coverage component is closed or selecting Delete in the split view popup
menu.
Figure 5.15 Coverage Splitting views
i Source B[] BT ||l Azzembly _ O] x|
| ASources\ibo.c |Line: 21 |Fibonacci
' i=2; il ' addo. r5h, 7, tb ;I
W while (1 <= 1nl W mr. r7, kb
W fibo = £ibl + W nk. rG, kS
v fibl = fibZ; - addi
o fihZ = fibo: o cuplu crfs, r4d, r3
o i+4: o hle crfh, Ox003£czt
[} J o mr. r3, k& 4
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Operations

Click the folded/unfolded icons EE to unfold/fold the source module
and display/hide the functions defined.

Menu

The coverage menu is shown in Figure 5.16 and submenusin Figure 5.17
and Figure 5.18.

Figure 5.16 Coverage Menu
Rezet
Detailz... »
v Graphics
Timer Update
Output File... #
Figure 5.17 Coverage Details Submenu
Source
Azzembly
Figure 5.18 Coverage Output File Submenu
Filter...
Sawve As.
Table 5.7 Coverage Menu Description
Menu entry Description
Reset Resets al simulator statistic information.
Details Opens a split view in the chosen component
(Source or Assembly).
Graphics Toggles the graphic bars.
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Menu entry  Description

Timer Update  Switches the periodic update on/off. If
activated, statistics are updated each second.

Output File Opens the Output File options.

Output File

Y ou can redirect Coverage component results to an output file by selecting
Output File...> Save As... inthe menu or popup menu.

Output File Filter

Select Output Filter... to display the dialog shown in Figure 5.19. Select
what you want to display, i.e. modules only, modules and functions, or

modules, functions and code lines. Y ou can also specify arange of
coverage to be logged in your file.

Figure 5.19  Output File Filter

Output File Filter E|
— Content
i bodules

™ badules + Functions

% tdodules + Functions + Code Lines

—Fange to dump

From:; IEI % To: [100 %

Cancel | Help |

Output File Save

The Save As... entry opens a Save As dialog where you can specify the
output file name and location, an exampleis shown in Listing 5.1.
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Listing 5.1 Example of an output file with modules and functions:

Cover age ltem
94.4 % Application
FULL fibo.c
FULL Fi bonacci ()
FULL mai n()
86.0 % startup.c
80.5 % Init()
FULL _Startup()

Associated Popup Menu
Identical to menu.
Split view associated Popup Menu

The popup menu for the split view (Figure 5.20) contains the Delete entry,
which is used to remove the split view.

Figure 5.20 Coverage Split view associated Popup Menu

B Source =] E3
|C:ADEMONSAMPLE Sibo.c |Line: 26
20,914 % while (i SESER=0 4]
19,986 % fiho = fikl + fihZ:
1z. Delete | fibl = f£ibZ: _|
[T o fibz = fibo:
15,986 % itt: -
B B W
Drag Out

All displayed items can be dragged into a Source or Assembly component.
Destination component displays marksin front of the executed source or
assembl er instruction.

Drop Into

Nothing can be dropped into the Coverage Component window.
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Demo Version Limitations
Only modules are displayed and the Save function is disabled.

Associated Commands

DETAILS FILTER, GRAPHICS, OUTPUT, RESET, TUPDATE
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Figure 5.21

NOTE

Figure 5.22

Table 5.8

Menu entry

DAC Component

The DAC component shown in Figure 5.21 is an interface modul e between
the DA-C IDE.

DAC Component

S DA-C Link |

Description

The DAC component is an interface module between the DA-C IDE
(Development Assistant for C - from RistanCASE GmbH) alowing
synchronized debugging features.

Operation

When the DAC component is loaded, communication is established with
DA-C (if open) in order to exchange synchronization information.

The Setup entry of the DA-C Link main menu allows you to define the
connection parameters.

For related information refer to the Chapter Synchronized debugging
through DA-C IDE.

Menu

DAC Menu
D Link

Setup... |

DAC Menu Description

Description

Setup

Opens the connection setup Window.
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Connection Specification

In the dialog shown in DAC Connection Specification, you can set the DA-
C debugger name.

Figure 5.23 DAC Connection Specification

Connection Specification Ed |

Diebugger Mame: |HIW.&FEE HI*w&WE B.0

Cancel Help

[~ Show Protocal |

The DA-C debugger name must be the same as the one selected in the DA-
C IDE. Check the “ Show Protocol” checkbox to display the
communication protocol in the Command component of the Simulator/
Debugger. To validate the settings, click the OK button. A new connection
is established and the "Connection Specification” is saved in the current
Project.ini file. The HEL P button opens the help topic for this dialog.

NOTE If problemsexist, refer to the Troubleshooting section in the DA-C
documentation.

Drag Out

Nothing can be dragged out.

Drop Into

Nothing can be dropped into the DAC Component window.
Demo Version Limitations

None.
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Data Component

The Data Component window shown in Figure 5.24 contains the names,
values and types of global or local variables.

Figure 5.24 Data Component
I Data:1 =] E3
|address: 8030 Size: 24 |startup.c | Ao |Symb | Global
startuplata <24  tagitartup
flags 0 unsigned int
main 0x5084 PFunc
stack0ffset 8190 unsigned int
nofZerofuts 1 unsigned int
B pZerolut 0x504f * _FRahge
*nZeraolut <4= Rahge
toCopylownEeqg Ox&0ae * Copy
noflibInits 32851 unzigned int ;I
Description
The Data Component window shows all variables present in the current
source module or procedure. Changed values arein red.
The Object Info Bar of the Simulator/Debugger Components contains the
address and size of the selected variable. It also contains the module name
or procedure name where the displayed variables are defined, the display
mode (automatic, locked, etc.), the display format (symbolic, hex, bin,
etc.), and current scope (global, local or user variables).
Various display formats, such as symbolic representation (depending on
variable types), and hexadecimal, octal, binary, signed and unsigned
formats may be selected.
Structures can be expanded to display their member fields.
Pointers can be traversed to display data they are pointing to.
Watchpoints can be set in this component. Refer to Control Points chapter.
Operations
* Double-click avariable line to edit the value.
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 Click the folded/unfolded bitmaps BE to unfold/fold the structured
variable.

» Double-click ablank line: Opens the Expression editor to insert an
expression in the Data Component window.

» Select avariable in the Data component, and \-/Ej +|R Jtoseta

“Read” watchpoint on the selected variable. A green vertical bar is
displayed on the left side of the variables on which a read watchpoint
has been defined. If aread access on the variable is detected during
execution, the program is halted and the current program state is
displayed in all window components.

» Select avariable in the Data component, and \-/Ej + |W | toseta

“Write” watchpoint on the selected variable. A red vertical bar is
displayed on the |eft side of the variables on which awrite watchpoint
has been defined. If write accessis detected on the variable during
execution, the program is halted and the current program state is
displayed in all window components.

» Select avariable in the Data component, and-/Ej+ B Itoseta

“Read/Write” watchpoint on the selected variable. A yellow vertical
bar is displayed for the variables on which a read/write watchpoint has
been defined. If the variable is accessed during execution, the program
is halted and the current program state is displayed in all window
components.

» Select avariable on which awatchpoint was previously defined in the

Data component, and + |D | to delete the watchpoint on the

selected variable. The vertical bar previously displayed for the
variablesis removed.

» Select avariable in the Data component, and\-/Ej+ S Itoseta

watchpoint on the selected variable. The Watchpoints Setting dialog
box isopened. A grey vertical bar is displayed for the variables on
which an watchpoint has been defined.

Expression Editor

To add your own expression (EBNF Notation) double-click ablank linein
the Data component window to open the Edit Expression dialog shown in
Figure 5.26, or point to a blank line as shown below and right-click to
select Add Expression... in the popup menu shown in Figure 5.25.
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Figure 5.25 Expression Editor Dialog
i Data:1 _ (O] x|

[ |fibo.c | &uto |Symb | Global

fiboCount 17711 unsigned int
counter 23 unsigned int

Open Module...

Add Expression...

£oom in
£oom out

Scope... r

FEormat. . k

Mode. .. 3

O ptions. . 3

Y ou may enter alogical or numerical expression in the edit box, using the
Ansi-C syntax. In general, this expression is afunction of one or severd
variables from the current Data component window.

NOTE  Thedefinition of expression and examples are in the Appendix EBNF
Notation

DM-100 Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Framework Components
General Component

Figure 5.26

NOTE

Edit Expression Dialog

m Data:2 _ O] x|
[ |Fibonacci | Auto [Symb | Local
n 24 unsimned int ﬂ
fibl 233 unsigned int
fib2 377 unsigned int
fibo 377 unsigned inc
i 1ld int
fibl4+fibZ2 610
Edit Expresszion |
|

Cancel |

Example: with2 variablesvariable 1, variable 2;

expression entered: (variable l1<<variable 2)+ OxFF) <= 0x1000 will
result in a boolean type.

expression entered: (variable 1>>~variable 2)* 0x1000 will result in an
integer type.

It is not possible to drag an expression defined with the Expression Editor.
The“forbidden” cursor is displayed.

Expression Command file

Thisfileisautomatically generated when a new application is loaded or
exiting from the Simulator/Debugger. User defined expressions are stored
in this command file. The name of the expression command file isthe
name of the application with a .xpr extension (.XPR file). When loading a
new user application, the debugger executes the matching expression
command file to load the user defined expression into the data component.

Example: When loading f i bo. abs, the debugger executes Fi bo. xpr
Menu

Figure 5.27 shows the Data component menu, the Data Scope submenu is
shown in Figure 5.28, the Data Format submenu in Figure 5.29, the Data
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Mode submenu in Figure 5.30 and the Data Options submenu in Figure
5.31. Menu entries are described in Table 5.9.

Figure 5.27 Data Menu

Zoom ik

Zoom aut

Scope... »
Format... k
Mode... »
O ptions. .. r

Figure 5.28 Data Scope Submenu

v [Globa
Local

I zer

Figure 5.29 Data Format Submenu

v Syumbalic
Hex
Ot
Bin
Dec
Dec

BitFeverse

Figure 5.30 Data Mode Submenu

¥ Automatic
Periodical...
Locked
Frozen
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Figure 5.31

Table 5.9

Table 5.10

Data Options Submenu

Puointer &z Armray...
M arne Yidth...

Data Menu Description

Menu entry Description

Zoomin Zooms in the selected structure. The member
field of the structure replaces the variable list.

Zoom out Returnsto the previous level of development.
Scope... Opens avariable display submenu.
Format... Symb, Hex (hexadecimal), Oct (octal), Bin

(binary), Dec (signed decimal), UDec
(unsigned decimal) display format.

Mode... Switches between Automatic, Periodical,
Locked, and Frozen update mode.

Options... Opens an options menu for data, for example,
Pointer as Array facility.

Scope Submenu

The Table 5.10 describes the Scope submenu entries.

Data Scope Submenu

Menu entry Description

Global Switchesto Global variable display in the Data
component.
Local Switches to L ocal variable display in the Data
component.
Debugger Manual DM-103
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Table 5.11

Menu entry

Description

User

Switchesto User variable display in the Data
component. Displays user defined expression
(variables are erased).

If the data component mode is not automatic, entries are greyed (because it
is not allowed to change the scope).

In Local Scope, if the Data component isin Locked or Periodical mode,
values of the displayed local variables could be invalid (since these
variables are no longer defined in the stack).

Format Submenu

Table 5.11 describes the Data Format submenu entries.

Data Format Sub Menu

Menu entry Description

Symbolic Select the Symboalic (display format depends
on the variabletype) display format. Thisisthe
default display.

Hex Select the hexadecimal data display format

Bin Select the binary data display format

Oct Select the octal data display format

Dec Select the signed decimal data display format

UDec Select the unsigned decimal data display
format

Bit Reverse Select the bit reverse data display format (Each

bit is reversed).
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Table 5.12

NOTE

Mode Sub Menu

The Table 5.12 describes the Data M ode Sub Menu entries.

Data Mode Sub Menu

Menu entry

Description

Automatic

Periodical

Locked

Frozen

Switches to Automatic mode (default),
variables are updated when the target is
stopped. Variables from the currently executed
module or procedure are displayed in the data
component.

Switches to Periodical mode: variables are
updated at regular time intervals when the
target is running. The default update rateis 1
second, but can be modified by steps of up to
100 ms using the associated dialog box (see
below).

Switchesto L ocked mode, value from
variables displayed in the data component are
updated when the target is stopped.

Switchesto Frozen mode: value from
variables displayed in the data component are
not updated when the target is stopped.

In Locked and Frozen mode, variables from a specific module are
displayed in the data component. The same variables are aways displayed

in the data component.

Update Rate window

This dialog box shown in Figure 5.32 alows you to modify the default
update rate by steps of 100 ms.
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Figure 5.32

Figure 5.33

Update Rate Dialog

Update Rate E3 |

Fiate: =100 me

Cancel |

Pointer as Array option

In the Data component menu or popup menu, choose Options...>Pointer
asArray... to openthe dialog shown in Figure 5.33.

Pointer as Array Dialog

Pointer Az Amray E2 |

v Dizplay Painter &z dray

|1 ] Mumber of [tems in Amray [1..7000]
ok, I Cancel | Help |

Within this dialog, you can display pointers as arrays, assuming that the
pointer pointsto thefirst item (pointer[0]). Note that this setup isvalid for
all pointers displayed in the Data window. Check the Display Pointer as
Array checkbox and set the number of itemsthat you want to be displayed
asarray items.

Name Width Option

Choose Options... > Name Width... to open the window shown in Figure
5.34.
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This dialog allows you to adjust the width of the variable name displayed

Opens the dialog Open Module.

Appears only in the popup menu if no
watchpoint is set or disabled on the pointed to
variable. When selected, sets aread/write
watchpoint on this variable. A yellow vertical
bar is displayed for the variables on which a
read/write watchpoint has been defined. If the
variable is accessed during execution, the
program is halted and the current program state
isdisplayed in all window components.

Appears only in the popup menu if a

Figure 5.34  Edit Name Width Dialog
Edit Name Width H|
Mame width: I'IE
Cancel | Help |
in the Data window. This string will be cut off if it islonger than 16
characters. Thus, by enlarging the value you can adapt the window to
longer names.
Associated Popup Menu
Table 5.13 specifies the Data Popup Menu entries.
Table 5.13 Data Popup Menu
Menu entry  Description
Open Module...
Set Watchpoint
Delete
Watchpoint

watchpoint is set or disabled on the pointed to
variable. When selected, deletes this
watchpoint.
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Menu entry  Description

Enable Appears only in the popup menu if a

Watchpoint watchpoint is disabled on the pointed to
variable. When selected, enables this
watchpoint.

Disable Appears only in the popup menu if a

Breakpoint breakpoint is set on the pointed to instruction.
When selected, disables this watchpoint.

Show Opens the Watchpoints Setting dialog box and

Watchpoints allows you to view the list of watchpoints
defined in the application. (Refer to Control
Points).

Show location  Forces al open components to display

information about the pointed to variable (e.g.,
the Memory component selects the memory
range where the variable is located).

SUBMENU Open Module

The dialog shown in Figure 5.35 lists al source files bound to the
application. Global variables from the selected module are displayed in the
data component. Thisis only supported when the component isin Global
scope mode.

Figure 5.35 Open Modules Dialog

Modules E |
fibo.c

shartup.c

Help

=N
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Drag Out
Table 5.14 describes the Drag and Drop actions possible from the Data
component.

Table 5.14 Dragging Data Out

Destination Action

compo.

Command Line Dragging the name appends the address of the variable to the
current command in the Command Line Window. Dragging the
value appends the variable value to the current command in the
Command Line Window.

Memory Dumps memory starting at the address where the selected
variable islocated. The memory area where the variable is
located is selected in the memory component.

Source Dragging the name of aglobal variable in the source Window
displays the module where the variable is defined and first
occurrence of the variable is highlighted.

Register Dragging the name loads the destination register with the
address of the selected variable. Dragging the value loads the
destination register with the value of the variable.

WARNING!  Itisimportant to distinguish between dragging a variable name and
dragging avariable value. Both operations are possible. Dragging the name
drags the address of the variable. Dragging the variable value drags the
value.

NOTE Expressionsare evaluated at run time. They do not have alocation address,

SO you cannot drag an expression hame into another component. Values of
expressions can be dragged to other components.
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Table 5.15

Source
component

Drop Into

Table 5.15 describes the Drag and Drop actions possible in the Data
component.

Drop Into Data

Action

Source

Module

A selection in the Source window is considered an expressionin
the Datawindow, asif it was entered through the Expression
Editor of the Data component. Refer to Data Component,
Expression Editor.

Displays the global variables from the selected module in the
data component.

Demo Version Limitations

Only 2 variables can be displayed.

Only 2 members of a structure are visible when unfolded.
Only 1 expression can be defined.

Associated Commands

ADDXPR, ATTRIBUTES, DUMP, PTRARRAY, SMOD, SPROC,
UPDATERATE, ZOOM.
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Memory Component

The Memory Component window shown in Figure 5.36 displays
unstructured memory content or memory dump, i.e. continuous memory
words without distinction between variables.

Figure 5.36 Memory Component

B Memory =] E3
||r'|it 2000 - 802C

00008018 FE 80 47 EC ..G. iI
0000801C 31 27 OD ED  1'..
00008020 31 18 04 30 1..0
ooooaoz4 ERPEERor o1 ..
00008028 26 F7 20 EF 4. .
000080ZC 3D FC 80 -- =

Description

Various data formats (byte, word, double) and data displays (hexadecimal,
binary, octal, decimal, unsigned decimal) can be specified for the display
and edition of memory content.

Watchpoints can be defined in this component.

NOTE Refer to Watchpoints setting dialog for more information about
watchpoints.

A memory areacan beinitialized with afill pattern using the Fill Memory
Dialog box.

An ASCII dump can be added/removed on the right side of the numerical
dump when checking/unchecking ASCI | in the Display menu entry.

The location address may also be added/removed on the left side of the
numerical dump when checking/unchecking Addressin the Display menu
entry.

To specify the start address for the memory dump use the Addr ess menu
entry.
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TIP

The Object Info Bar of the Simulator/Debugger Components contains the
procedure or variable name, structure field and memory range matching the
first selected memory word.

"uu" memory value means. not initialized.

--" memory values mean: not configured (no memory available)

Memory valuesthat have changed since the last refresh status are displayed
in red. However, if amemory item is edited or rewritten with the same
value, the display for this memory item remains black.

Operations

* Double-click amemory position to edit it. If the memory is not
initialized, this operation is not possible.

» Drag the mouse in the memory dump to select amemory range.

. x/Ej + |A | to jump to amemory address. The pointed to valueis

interpreted as an address and the memory component dumps memory
starting at this address.

» Select amemory range, and \-/Ej + |R | to set a“Read” watchpoint

for the selected memory area. Memory ranges where aread watchpoint
has been defined are underlined in green. If read access on the memory
areais detected during execution, the program is halted and the current
program state is displayed in all window components.

» Select amemory range, and ~/Ej + |W | to set a“Write” watchpoint

on the selected memory area. Memory ranges where awrite watchpoint
has been defined are underlined in red. If write access on the memory
areais detected during execution, the program is halted and the current
program state is displayed in all window components.

« Select amemory range, and x/Ej + B | to set a*“Read/Write”

watchpoint on the selected memory area. Memory ranges where a read/
write watchpoint has been defined are underlined in black. If the
memory area is exceeded during execution, the program is halted and
the current program state is displayed in al window components.

DM-112

Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Framework Components
General Component

» Select amemory range on which awatchpoint was previously defined,

and \-/Ej + (D | to delete the watchpoint on the selected memory
area. The memory areais no longer underlined.

» Select amemory range, and x/Ej + |8 | to set awatchpoint on the

selected memory area. The Watchpoints Setting dialog box is opened.
Memory ranges where a watchpoint has been defined are underlined in

black.

Menus

The Memory Menu shown in Figure 5.37 provides access to memory
commands. Table 5.16 describes the menu entries.

Figure 5.37 Memory Menu

Set W atchpoint
[ elete triatehmait
S how W atchpointz
Show Location

Word Size
FEormat
Mode
Dizplay

T ¥ v

Fill...
Address. .

Table 5.16 Memory Menu Description

Menu entry

Description

Word size

Format

Mode

Display

Opens a submenu to specify the display unit
size.

Opens a submenu to select the format to
display items.

Opens a submenu to choose the update mode.

Opens a submenu to toggle the display of
addresses and ASCII dump.
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Menu entry  Description

Fill... Opensthe Fill Memory Dialog to fill amemory
range with a bit pattern.

Address... Opens the memory dialog and prompts for an
address.

CopyMem Opens the CopyMem dialog that allows you to
copy memory range values to a specific
location.

Word Size Submenu

With the Word Size submenu shown in Figure 5.38, you can set the
memory display unit. Table 5.17 describes the menu entries.

Figure 5.38  Word Size Submenu
v Bute
Wword
Liw'ord
Table 5.17 Word Size Submenu Description
Menu entry  Description
Byte Sets display unit to byte size.
Word Sets display unit to word size (=2 bytes).
Lword Sets display unit to Lword size (=4 bytes).
Format Submenu
With the Format Submenu shown in Figure 5.39, you can set the memory
display format. Table 5.18 describes the menu entries.
DM-114 Debugger Manual
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Figure 5.39

Table 5.18

Figure 5.40

Format Submenu

v Hex
Ot
Bin
Dec
Dec

BitReverse

Format Submenu Description

Menu entry Description

Hex Selects the hexadecimal memory display
format

Bin Selects the binary memory display format

Oct Selects the octal memory display format

Dec Selects the signed decima memory display
format

UDec Selects the unsigned decimal memory display
format

Bit Reverse Selects the bit reverse memory display format

Mode Submenu

(each bit isreversed).

With the M ode submenu shown in Figure 5.40, you can set the memory
mode format. Table 5.19 describes the menu entries.

Mode Submenu

v Automatic
Perindical...
Frozen
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Table 5.19 Mode Submenu Description

Menu entry

Description

Automatic

Periodical

Frozen

Displays Submenu

Selects Automatic mode (default), memory
dump is updated when the target is stopped.

Selects the Periodical mode, memory dump is
updated at regular time intervals when the
target isrunning. The default update rateis 1
second, but it can be modified by steps of up to
100 ms using the associated dialog box (see
below).

Selects the Fr ozen mode, memory dump
displayed in the memory component is not
updated when the target is stopped.

With the Displays submenu shown in Figure 5.41, you can set the memory
display (address/ascii). Table 5.20 describes the menu entries.

Figure 5.41 Displays Submenu

v Address
v ASC

Table 5.20 Displays Submenu Description

Menu entry

Description

Address

ASCI|

Allows you to toggle the display of address
dump.

Allows you to toggle the display of ASCII
dump.
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Figure 5.42

NOTE

Figure 5.43

Fill Memory Dialog
Thisdialog shown in Figure 5.42 allows you to fill amemory range (from

Address edit box and to Address edit box) with a bit pattern (value edit
box).

Fill Memory Dialog

i Memory =]

| | Auto
Y

gooooson A3 A3 AZ AZ il Fill Memory | j

ooooosos -- -- -- ==

00000810 A3 A3 A3 A3 . from Address: [300 b

00000818 A3 A3 AT A3 .

Q0000820 A3 AS AT AT . to Address: |83IZI hiex

oooooeze A3 A3 AZ AZ

oooooss0 A3 15 DA 30 W alLe: I.-'l'-.3 hes

goooosss Ze F7 20 EF

ooooosdn 26 03 FF 05 | W Hex Format 0k I Cancel |

goooosds FBE 00 04 201

NOONNeCn as O PR OO0 N2 ST = = j

If “Hex Format” is checked, numbers and letters are interpreted as
hexadecimal numbers. Otherwise, expressions can be typed and Hex
numbers should be prefixed with “Ox” or “$”. Refer to Constant Standard
Notation.

Display Address Dialog

With the dialog shown in Figure 5.43, the memory component dumps
memory starting at the specified address.

Display Address Dialog

Display Address Ed
Address: |B.-’-‘-.FEI hew

¥ Hex Format Ok I Carizel | Help |
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NOTE

Figure 5.44

WARNING!

The Show PC dialog box isthe same asthe Display Addressdialog box. In
this dialog, the Assembly component dumps assembly code starting at the
specified address.

CopyMem Dialog

The dialog shown in Figure 5.44 allows you to copy a memory range to a
specific address.

CopyMem Dialog

— Source
from Address: I hes
to Address: | hiex
— Desztination
fram Address: I hiex
¥ Hex Format
] I Cancel | Help

To copy amemory range to a specific address, enter the source range and
the destination address. Press the OK button to copy the specified memory
range. Pressthe Cancel button to close the dialog without changes. Press
the Hel p button to open the help file associated with this dialog.

If "Hex Format" is checked, all given values are in Hexadecimal Format.
Y ou don't need to add "0x". For instance type 1000 instead of 0x1000.

If you try to read or write to an unauthorized memory address, an error
dialog box appears.

Update Mode

Thisdialog box shown in Figure 5.45 allows you to modify the update rate
in steps of 100ms.
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Figure 545 Update Mode

Update Rate E3 |
Fiate: =100 me

] I Cancel |

NOTE Periodical modeisnot availablefor all hardware targets or some additional
configuration may be required in order to make it work.

Associated Popup Menu

The memory popup menu shown in Table 5.21 allows you to execute
memory associated commands.

Table 5.21 Memory Associated Popup Menu Description

Menu entry Description

Set/Delete Appears only in the Popup Menu if no

Watchpoint watchpoint is set or disabled on the selected
memory range. When selected, sets a Read/
Write watchpoint at this memory area. Memory
ranges where a read/write watchpoint has been
defined are underlined in yellow. If the
memory area is accessed during execution of
the application, the program is halted and the
current program state is displayed in al
window components.

Delete Appears in the Popup Menu if awatchpoint is
Watchpoint set or disabled on the selected memory range.
When selected, deletes this watchpoint.

Enable Appearsin the Popup Menu if awatchpoint is
Watchpoint disabled on the selected memory range. When
selected, enables this watchpoint.
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Menu entry  Description

Disable Appears in the Popup Menu if a breakpoint is

Breakpoint set on the selected memory range. When
selected, disables this watchpoint.

Show Opens the Watchpoints Setting dialog box and

Watchpoints allowsyou to view the list of watchpoints

Show location

defined in the application and modify their
properties (See “ Control Points’ chapter).

Forces all opened windows to display
information about the selected memory area.

Drag Out
Table 5.22 Drag and Drop describes the actions possible from the Memory
component.

Table 5.22 Drag and Drop possible from the Memory component.

Destination  Action

compo.

Assembly Displays disassembled instructions starting at
the first address selected. The instructions
corresponding to the selected memory area are
highlighted in the Assembly component.

Command Line Appends the selected memory range to the
Command Line window

Register L oads the destination register with the start
address of the selected memory block.

Source Displays high level language source code
starting at the first address selected.

I nstructions corresponding to the selected
memory area are greyed in the source
component.
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Table 5.23

Drop Into

Table 5.22 shows the Drag and Drop actions possible in the Memory
component.

Drag and Drop into the Memory component.

Source comp. Action

Assembly Dumps memory starting at the selected PC
instruction. The PC location is selected in the
memory component.

Data Dumps memory starting at the address where
the selected variable islocated. The memory
areawhere the variable islocated is selected in
the memory component.

Register Dumps memory starting at the address stored in
the selected register. The corresponding
address is selected in the memory component.

Module Dumps memory starting at the address of the
first global variable in the module. The
memory areawherethisvariableislocated is
selected in the memory component.

Demo Version Limitations
No limitation
Associated Commands

ATTRIBUTES FILL, SMEM, SMOD, SPC, UPDATERATE.
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IT_Keyboard

The IT_Keyboard component shown in Figure 5.46 is a 20 key keyboard
that generates an interruption when akey is pressed.

Figure 5.46 IT_Keyboard Component
i IT Keyboard |

] 1 2 3

4 5 b 7

8 9 A B

C D E F

=] =>| Z
Description
The IT_Keyboard consists of a 20 key keyboard, as shown in Figure 5.47.
These 20 keys are positioned at the intersection of the five lines X0 to X4
and the 4 columns YO to Y 3. The resistor R connected to the positive
supply givesalogical level 1 when thereis no connection (key not
pressed). The activation of aline (or column) will give alogical level O,
and akey pressed on thisline (or column) will place the column (or the
line) corresponding on the low level. For example, if line X2 is activated,
column Y 3 will decrease from logical level 1 to logical level 0 when the «
B » key is pressed.
Aninterruption is raised when an active key (line or column activated) is
pressed.
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Figure 5.47 IT_Keyboard constitution
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Scanning is one method to read such keyboards. Typically, we can proceed
asfollows (the line being in output and the column in input):

* PutaOatline X4 (X3, X2, X1, X0 being at 1).

Read the column successively, from Y3 to YO.

Put a0 at line X3 (X4, X2, X1, X0 being at 1).

Read the column again from Y3to YO.

...till the last column of the last line, and restart at the beginning

All keyboard keys are scanned until we find one that is activated. During
the scanning process, it is easy to update a counter representing the number
of the key pressed. Raising an interruption when akey ispressed is
interesting when scanning. This one could work only when akey is
activated and not continually.

Menu

Figure 5.48 showsthe IT_Keyboard menu and described in Table 5.24.

Figure 5.48 IT_Keyboard menu

Setup... |
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Table 5.24 IT_Keyboard Menu Description
Menu entry Description
Setup Opens the Interrupt keyboard setup dialog.
Interrupt keyboard setup dialog
Thisdialog shown in Figure 5.49 allows you to set the address of the lines
port, the columns port and the number of the interruption vector.
Figure 5.49 IT_Keyboard Setup
Interruption keyboard - Setup |
— Portz addre=zs — Kepz label
Select an address or inzert a value [hex] 0 i o 3
Lines g ]
I
Col Part B
S F'n:ut C S (BN U
Part D
— Intenuption vectar—{ Port E cC|D|E]|F
Vectar number (hes) |4|:| =]l =] =
Cancel |
In the Port address section, for each two ports you can insert an address
(in hexadecimal) in the Linesfield or select one of the five portslisted in
the Columnsfield. These are used when the component works with the
Programmable |O_Ports component.
The Vector number filed allows you to specify an interruption vector
number (in hexadecimal).
The Keyslabel buttons permit you to change the symbols displayed on the
keyboard keys.
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Drag Out

Nothing can be dragged out.

Drop Into

Nothing can be dropped into the IT_Keyboard Component window.
Demo Version Limitations

No limitations

Associated Commands

Following commands are associated with the IT_Keyboard component:

ITPORT, ITVECT, LINKADDR
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Figure 5.50

Keyboard

The Keyboard component shown in Figure 5.50 is a 20 key keyboard.

Keyboard Component
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Description

The Keyboard consists of a 20 key keyboard, as shown in Figure 5.47.
These 20 keys are positioned at the intersection of the five lines X0 to X4
and the 4 columns YO to Y 3. The resistor R connected to the positive
supply givesalogical level 1 when thereis no connection (key not
pressed). The activation of aline (or column) will give alogical level 0,
and a key pressed on thisline (or column) will have the effect of placing
the column (or line) corresponding with the low level. For example, if line
X2 isactivated, column Y 3 will decrease from logical level 1 to logical
level 0 when the « B » key is pressed.
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Figure 5.51  Keyboard constitution

O

D 1 2(|F 3| ¢
Al Al A A

¢ JEVED Gin S i SD Gin S0 i 4 209
a1 Al A]l B

) CJEVED Gin S Gin SD Gin SV Gia 4 209
&1 Bl A £

y CJEVED Gin S Gin D Gin SV Gia 4 209
gl 2] A =

PV Gin (D ia G0 Gin S i S5
SN
Y0 ¥1 Y2 Y3

Scanning is one method to read such keyboards. Typically, we can proceed
asfollows (the line being in output and the column in input):

* PutaOattheline X4 (X3, X2, X1, X0 being at 1).

Read the column successively, from Y3 to YO.

Put a0 at the line X3 (X4, X2, X1, X0 being at 1).

Read again the column from Y3 to YO.

...till the last column of the last line, and restart at the beginning

All keyboard keys are scanned until we find one that is activated. During
the scanning process, it is easy to update a counter representing the number
of the key pressed. Raising an interruption when akey ispressed is
interesting for scanning. This one could work only when akey is activated
and not continually.

Menu

Figure 5.52 shows the Keyboard menu and its entry is described in Table
5.25.
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Figure 5.52 Keyboard menu

Setup... |

Table 5.25 Keyboard Menu Description

Menu entry Description

Setup Opens the Keyboard setup dialog.

keyboard setup dialog

This dialog shown in Figure 5.49 allows you to set the address of the lines
port and columns port.

Figure 5.53 Keyboard Setup

Keyboard - Setup |

— Portz address

Select an addrezs or ingert a value [hex]

Lines IfE!EIEIEIE - I
Columnz Im - I

Part &,
Part C
Part E

In the Ports address section, for each two ports you can insert an address
(in hexadecimal) in the Linesfield or select one of the five portslisted in
the Columnsfield. These are used when the component works with the
programmable Programmable |O_Ports component.

Drag out

Nothing can be dragged out.
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Drop Into

Nothing can be dropped into the Keyboard Component window.
Demo Version Limitations

No limitations

Associated Commands

Following commands are associated with the Keyboard component:

KPORT, LINKADDR
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LCD Display Component

The LCD Display component shown in Figure 5.54 isthe LCD display
utility, which can display 1 or 2 lines of 16 characters and show or hide the
position cursor.

Figure 5.54 LCD Display Component
Ready...
Description
The display module consists of 2 eight-bit-width parallel couplers: adata
port and a control port, as shown in Figure 5.55. These ports communicate
with the mainframe.
Figure 5.55 The LCD display module ports
Data Fort Control Port
dy |ds | ds|de|ds|ds[di|do - -1 -[-1-1&] [&w &

Start data readfemite -

Select read or write” : -
0 Write in the FAT Select register : -4

1 : Fead from the FANM 0 : Byte dp-dy willbe considered as an instruction

1 : Byte dp-d,y willbe considered as an & SCII code

* Thiz version doesn’t allow the read access. The FW should nesrer worth 1.

The bits d7-dO represent an ASCII code to display charactersor an
instruction code. The RS bit defines the status of bits d7-dO.

Operation

The LCD Display device can display 1 or 2 lines of 16 characters and show
or hide the position cursor.
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To manage the display, this device contains a controller: the DDRAM
(Display DataRAM). The DDRAM stores the ASCI| codes of characters
written during awrite operation. Only two lines of 16 characters each can
be displayed but up to 64 characters can be stored.

This RAM can be seen as organized in 2 lines: the first one starting at the
address 00h, ending at 1Fh and the second one starting at 40h, ending at
5Fh. Figure 5.56 illustrates this arrangement.

Figure 5.56 .The DDRAM controller

Eﬁ“mml 2|3 a5 |6 |78 ] ]33
o] KN KW KN K K 5 K il e A 33
B L v a8 K8 R 1 e E L
B Y ko W N KA 2 e o e A

The Address Counter (AC) isan interna register of the display controller
pointing at the current address. In the default configuration AC is
initialized at 00Oh and isincreased when an ASCI| character is stored at the

address AC is pointing to. When AC isequal to 1Fh, the next increased
value will not be 20h but 40h.

For example, if we send a 48 character string after initialization, the bytes
will be stored at addresses 00h to 1Fh and 40h to 4Fh.

NOTE  Only characters having their ASCII codesin the visible interval of the 16
characters (positions 1 to 16) of RAM are displayed.

Sending information to the display

Two steps are necessary to send a character to the display:

1. Put thebitsE and RSat 1 and the bit R/W at 0 (control word
00000100b)

2. Writethecharacter ASCII code on thedata port. Put bit E at O (this
validates bits d7-d0)
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For aninstruction, only step 2 isdifferent: the Byte to write on the data port
isthe instruction code the display controller should execute.

Instruction listing

Figure 5.57 lists the instructions available for the LCD Display

Component.
Figure 5.57 LCD Component Instruction listing
Instricti Code Descripti
nstraction escription
G | o [ D5 [ oy [ o5 [ o [ i
Clear Display n n n n n n n Erases the display and st AC at 0.
Feturn Home 0 q q q q q i Puts Fhe address 00h into AT and re-init
the display.
Entty Wode Set 1] 0 0 0 0 1 | 1D Fixes the moving direction of the cursor
Display On/OfF Contral | 0 0 0 0 ! ol e Lights on or off the display and shows or
not the cursor.
Curzor or Display Shift | 0 0 0 1 | & | RFL Mloves the cursor and shifts the display.
Bet DDREAM A ddress 1 ag | A5 | a as an a Fixes the AC <ahie.
Function Set 0 0 1 loee | Eixes the data ex.change width and the
lirne amber to display.
Instruction description
Clear Display
* Completely fillsthe DDRAM with the code 20h (space character)
» Putsthe address 00h into AC (address counter)
* Re-initializes the display if shifts occurred.
* Putsthe cursor in position 1 on the display first line.
Return Home
* AC =00h and re-initialize the display.
* Putsthe cursor in position 1 on the display first line.
» The DDRAM isunchanged.
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Entry Mode Set

Increases AC (if I/D = 1) or decreases AC (if I/D = 0) after an ASCI|I
code iswritten into RAM

Moves the cursor to theright if ID = 1 or to theleft if I/D =0

Display On/Off Control

- Thedisplay isonif D = 1 and off if D = O (data still stay in RAM)
- If C =1 the cursor will be shown.

Cursor or Display Shift

Doesn't change the DDRAM content.
AC isunchanged in case of a screen shift.

Moves and/or shiftsthe cursor to theright or left. The cursor goesto the
second line if it exceeds the 32nd position of the first line. It also goes
to the first line when it exceeds the 32nd position of the second line.

During a screen shift the two lines only move horizontally, the first line
will never pass to the second one.

Figure 5.58 describes how to choose the moving direction.

Figure 5.58 Left Right choice

E/L

0 | Moves the cursor to the left {decreases AC)

Iloves the cursor to the right (increases A

._L._..:..:.@
2

1
0 | Moves the full screen to the left. The cursor follows this mowe.
1 | Mowes the full screen to the right. The cursor follows this move.

Set DDRAM Address

Puts the address indicated by a6abada3a2ala0 into AC.

When the number of linesis 2, the address goes from 00h to 1Fh for the
1st line, and from 40h to 5Fh for the 2nd line.

The a6 hit indicates the line: a6=0 to indicate the 1st lineand 1 to
indicate the 2nd one.

Function Set

If DL =1, the data exchange is 8 bits wide.

If N =0, the display will take place on oneline. If N = 1, the display
will take place on two lines.
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The initialization step

Initialization needs essentially 7 steps.

The Function Set instruction must be sent 3 times successively to fix the
exchange data width, and a 4th time to fix the number of lines used.

The example shown in Figure 5.59 configures the display module in 8 bit
mode, 2 lines, with the cursor visible and an increase of AC (the cursor

moves to the right).

Figure 5.59 The LCD display initialization

| RS |RW| dy | s | s [ o [ s [ o [ o

Ifofo]Jofo] ] 1] -] e Punction Szt & bits Mode.
-':-\"‘\-\.._,.ﬂ""?

2| 0 | 1] | 0 | 1] | 1 | 1 | - | | - Funecfion Sef 8 hita Mode.
t‘“‘w—"?

gl oflofJofo] 1t ][ 1] -] e Punction Sef & bits Mode.
T-\""'\-\.p""?

4| 1] | 0 | 1] | 0 | 1 | 1 | 1 | | - Frvcfion Sef @ 2 lines display.
t‘“‘w—"?

sloloJoflo]Joflo] 1] [ 1 Sereen on and cursor visible,
T-\""'\-\.p""?

6| ] | I | ] | I | ] | I | ] | | ] Sereen erased.
1{"'\-\.\_,.:-""?

FloJo |l of]Jolo]ol] o] [ 1 Enfry Mode Sef - AC will e increasec
--\:"'\-\.\_,.;-"’?

End of mitialization
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Menu

Figure 5.60 shows the LCD Display menu and its entry is described in
Table 5.29.

Figure 5.60 The LCD display menu

Setup... |

The 7-segments display menu contains the Setup function to launch the 7-
Segments Display dialog box.

Table 5.26 LCD display Menu Description

Menu entry  Description

Setup Opensthe Lcd display dialog.

Lcd display dialog

Thisdialog shown in Figure 5.49 allows you to set the address of the lines
port and columns port.

Figure 5.61 LCD Setup

LCD Display ]|

— Portz addrezs

Select an address or inzert a value [hes]

Data: IfEEIEIEIEI - I
Cottral ; Im - I

Part B
Part C

Part D
k. I Pt B Cancel |

In the Ports address section, for each two ports you can insert an address
(in hexadecimal) in the Linesfield or select one of the five portslisted in
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the Columnsfield. These are used when the component works with
Programmable |O_Ports.

Drag out

Nothing can be dragged out.

Drop Into

Nothing can be dropped into the Lcd display Component.

Demo Version Limitations

No limitations

Associated Commands

Following commands are associated with the Lcd display component:

LCDPORT, LINKADDR
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Monitor components

The Monitor component shown in Figure 5.67 is a basis oscilloscope that
can display the result of debugger objects.

Figure 5.62  Monitor Component

i Monitor

Description

The purpose of this component isto display in agraphical format (similar
to an oscilloscope) the results of debugger objects observation. The
monitor component can save the list of state modifications and associated
timein afile.

Menu

Figure 5.63 shows the Monitor menu and its entry is described in Table
5.29.

Figure 5.63 The monitor menu

Add Channel
Delete Channel
Show Control
Change Colors
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Table 5.27

Figure 5.64

Monitor Menu Description

Menu entry Description

Add Channel Opens the dialog box to create a new Channel
in the Monitor.

Delete Channel Deletesthe Selected Monitor Channel (click on
it in the monitor view)

Show Control ~ Opens the Settings dialog box to change the
time base.

Change Colors  Changes colors from the selected Channel.

Add Channel dialog

Thisdialog shown in Figure 5.64 allowsyou to create anew Channel in the
monitor.

Add Channel dialog

Add Channel

Cbject to monitar: I

k. I Cancel | Help |

In the text area Object to monitor, enter the object name and bit e.g
TIM12.PORTT bit 0 and click OK to validate or Cancel to exit.

Monitor Settings dialog
This dialog shown in Figure 5.65 allows you to change the time base.

Select the object namein the list, enter in the Ticks field a CPU timer
proportional value and a number of pixelsin the Pixelsfield to define the
horizontal scale. Click OK to validate or Cancel to exit.
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Figure 5.65  Settings dialog

Settings |

— Timebaze

Ticks I'I Qono
Fixels : |-|—

# rezolution

|‘I 00004 = 10000.00 or 200000

ILeds.F'l:urt_Fi eqgizter bit ¥ j

k. I Eancell Help |

Change colors dialog

Thisdialog shown in Figure 5.66 allows you to change the colors from the
selected Channel.

Figure 5.66 Change colors dialog

Change colors

— categaories
" background

. line Carcel |

 cursar

i~ text Ok |
" gnd Help |

Select the intended element in the categoriesfield and click Change to
open the standard color selection dialog, click on OK to validate or Cancel
to exit.

Drag out

Nothing can be dragged out.
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Drop Into

Nothing can be dropped into the Monitor Component.

Demo Version Limitations

No limitations

Associated Commands

Following commands are associated with the Monitor component:

ADDCHANNEL, DELCHANNEL, SETCOLORS, SETCONTROL
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Figure 5.67

Figure 5.68

Table 5.28

Push Buttons components

The Push Buttons component shown in Figure 5.67 isabasis input device.

Push Buttons Component

= Push Buttons [ |

] el e] g 2] 2o

Menu

Figure 5.68 shows the LCD Display menu and its entry is described in
Table 5.29.

The Push Buttons menu

Setup... |

The Push Buttons Menu Description

Menu entry Description

Setup Opens the Push Buttons Setup dialog.

Push Buttons Setup dialog

This dialog shown in Figure 5.69 alows you to specify (in hexadecimal
format) the port address or select the port in the list.
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Figure 5.69

NOTE

Figure 5.70

Push Buttons Setup dialog

Setup E |

Part Addresz
Select a port or inzert an addrezs [hex).

Ok E':": E Cancel |
ar

The port should be an output port for the LEDs component.

Use with the I0_Ports

The address defined in the Push Buttons Setup dialog is used when the
component works with the Programmable |O_Ports.

Use with the Leds component

The Bytes sent to the LEDs component coming from the Push Button
component are described in Figure 5.70.

Push Buttons Input port

Fush Buttons

Input Port
BY [ b6 | B | bd | B3| B2 | b1 | BO
FET| FBG | FBS | FB4 | FB3 | FEZ| FEI | FBD

Vaue 1 for ahit, lights on the corresponding led on the LEDs device. For
example, if button 3 is pressed, a read access at the address of the
component port will return the value 00001000b (08h).

Drag out

Nothing can be dragged out.
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Drop Into

Nothing can be dropped into the Push Buttons Component.

Demo Version Limitations

No limitations

Associated Commands

Following commands are associated with the Push Buttons Component.

PBPORT, LINKADDR
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Figure 5.71

NOTE

WARNING!

MicroC Component

The MicroC component shown in Figure 5.71 is an interface module for
RHAPSODY in MicroC, the analysis, design and implementation tool for
embedded systems and software developers from [-LOGI X.

MicroC Component

| MicroC |

Operations

The MicroC component establishes a communication with Rhapsody in
MicroC to activate its design-level debugging capabilities. Rhapsody in
MicroC drives its debugging animation that communicates with the
Simulator/Debugger environment over TCP/IP. Thisallowsyou to
execute, stop and run the application, to set step commands, breakpoints,
events, and idle states to perform control over the application.

Communication isrealized by selecting the Connect entries of the MicroC
Link menu. The Setup entry allows you to define the connection
parameters.

The functions available allow you to start the currently loaded application,
to stop it, to execute a single step in the application, to set and clear a
breakpoint, to evaluate an expression and to quit the application interface.

For more information, refer to the RHAPSODY in MicroC documentation
from I-Logix.

In order to work, MicroC needs to have a copy of the
anc_conmmuni cation_dl | .dl | inthepr og directory from the
current installation.

Menu

Figure 5.72 shows the MicroC menu and its entries are described in Table
5.29.
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Figure 5.72  MicroC Menu
b icroC Link,

Setup...
Connect

Table 5.29  MicroC Menu Description

Menu entry  Description

Setup Opens the communication setup Window.
Connect Establishes communication with RHAPSODY
in MicroC.

Communication Specification

Within this dialog shown in Figure 5.73, you can set the MicroC Host and
ID for communication between the Simulator/Debugger and RHAPSODY
in MicroC. A checkbox allows you to see the communication protocol.

Figure 5.73  MicroC Communication Specification

Communication Specification [E3 |

MicroC Host: [CSC

ID: {1066

¥ Show Pratacol

Cancel |

Drag Out
Nothing can be dragged out.
Drop Into

Nothing can be dropped into the MicroC Component window.

Debugger Manual DM-145

For More Information: www.freescale.com



V¥ ¢
i

Freescale Semiconductor, Inc.

rramework Components

General Component

Demo Version Limitations
The MicroC Component is not available in demo mode.
MicroC Component DLLs

The RIMC (or MicroC.wnd) component has been updated to make use of
the new features that come of the latest rel ease of the communication DLL
from I-Logix.

To ensure proper communication between Rhapsody in MicroC and the
external debugger/simulator (HI-WAVE) from Metrowerks (formerly
HIWARE), two files have to be installed in the 'prog' subdirectory of the
CodeWarrior installation:

microc.wnd

Thisisthe HI-WAVE component that has to be loaded in order to
configure the communication parameters and mode of operation. This
component requires the amc_communication_dll.dll to be loaded properly
(if thisDLL ismissing, there will be an error message that alibrary is
missing).

amc_communication_dll.dll

ThisDLL implements the actual protocol (over TCP/IP). ThisDLL is
delivered together with the RiMC and has to be copied into the 'prog'
subdirectory of the CodeWarrior installation (thisDLL will not beinstalled
with the CodeWarrior product).

The 'Product Version' of thisDLL hasto be 'RiMC 3.0 of higher.

Changes and new features

The new DLL from I-Logix allows now implementing the Graphical Back
Animation with fewer resources on the target system; so only one single
breakpoint is required in synchronous mode and even nonein
asynchronous mode!

» There are now two modes of operation:
Synchronous

This mode corresponds to the legacy implementation and lets

RiM C update the state whenever achange of state is detected on the
target system. Thisisimplemented by setting a breakpoint on the
target on afunction that is called whenever that state of the
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Figure 5.74

Communication Specification il

—Link Parameters

application is changed. When hit, the state is sent to RiMC and the
application is resumed immediately. By concept, this procedure
will slow down execution of the target application dramatically.
Compared to the previous releases, only one single breakpoint is
required for this mode.

Asynchronous

Thisis anew mode introduced in this release. The state of the
application will only sampled from time to time. Thus, this mode
allowsthe application to run at full speed but will not update RiMC
about each change of state. Also, it does not require any resources
on the target system except that the target memory hasto be
accessible while the application is running. The targets that support
this mode are the simulator and any Host Target Interface (HTI)
that uses the BDM of features dual-ported RAM.

» The Setup dialog was extended to reflect that additional modes:

Communication Specification

kicroC Hozk: ]Hu:ustN am] Theze parameters have to
match the definition in
IC: ]EEEE Rhapsody in Microl [RikC)

[ Show Protocol  [use for roublezhooting only)]

— State Reparting Mode

¥ Syunchronous: whenever a state changes. it iz reported back to RikC,
Thiz mode reguires a breakpoint to be zet on the target system and
zlows down execution of the tanget application dramatically.

" Aszpnchronous: reporting the state iz done at regular intervals as
defined below. Thiz mode repumes access bo the target memany while
the target iz running.

I 500 s [rounded boonext 100ms boundary]

1] 4 I Cancel

In Asynchronous mode, the interval for updating the state can be
specified in increments of 100ms. All the settings from this dialog
are saved in the current project file and will be used in future
sessions automatically.
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* There are now command line commands to setup the communication

parameters:

MCPROTOCOL [ON|OFF]

Switched on and off the protocol to the Command window (when
open at all).

M CM ODE (SYNC|ASYNC [interval])

Sets the reporting mode to synchronous or asynchronous. If
asynchronous is specified, the interval can be specified too. If the
interval is not specified, the previous value will be maintained.

MCCONNECT [HostName] [portNumber]

Thiscommand triesto connect to RiMC. The name of the computer
where RIMC is expected and/or its port number can be can be
specified. If not specified, the previous value will be used.

Each of these commands will close any pending communication
and re-establish communication with the new parameters.

in the Synchronous mode, the states are reported not faster than every
10ms. Thiswill avoid overruns in the communication to RiMC when
using the simulator as a target.
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Module Component

The module component shown in Figure 5.75 gives an overview of source
modules building the application.

Figure 5.75 Module Component
= Module =] E3

FY
calc.c

terminal.c
Lermport.c
inout.c
s3tartup.c
printf.c
rta.c

Description

The module component displays all source files (source modules) bound to
the application. The Module Component window displays all modulesin
the order they appear in the absolute file.

Operations

Double-clicking a module name forces all open windows to display
information about the module: the Source Component window shows the
modul€e's source and the global Data Component window displays the
module's global variables.

Menu

The Module Component window has no menu.
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Drag Out

Table 5.30 shows the Drag and Drop actions possible from the Module
component.

Table 5.30 Drag and Drop possible from the Module component.

Destination compo.  Action

Data > Global Displays the global variables from the selected module in the
data component
Memory Dumps memory starting at the address of the first global

variable in the module. The memory areawhere thisvariableis
located is selected in the memory component.

Source Displays the source code from the selected module.

Drop Into
Nothing can be dropped into the Module Component window.
Demo Version Limitations

Only 2 modules are displayed
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Procedure Component

The Procedure Component shown in Table 5.43 displays the list of
procedure or function calls that have been made so far (up to the moment
the program was halted). Thislist is known as the procedure chain or the
call chain.

Figure 5.76  Procedure Component
B Procedure M=l E3

[libo.c  Addiess S055

main [ j

_dtartup ()

[

Description

In the Procedure Component, entriesin the call chain are displayed in
reverse order from the last (most recent on top) call to the first call (initial
on bottom).

Types of procedure parameters are also displayed.

The Object Info Bar of the Simulator/Debugger Components contains the
source module and address of the selected procedure.

Operations

Double-clicking on a procedure name forces al open windows to display
information about that procedure: the Source Component window shows
the procedure's source, the local Data Component window displays the
local variables and parameters of the selected procedure. The current
assembly statement inside this procedure is highlighted in the Assembly
component.

NOTE  When aprocedure of alevel greater than O (the top most) is double clicked
in the Procedure Component, the statement corresponding to the call of the
lower procedure is selected in the Source Window and Assembly
Component.
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Menu

Figure 5.77 shows the Procedure menu and its entries are described in
Table 5.31.

Figure 5.77 Module Menu
v Show Yalues
Show Types
Table 5.31 Module Menu Description
Menu entry Description
Show Values  Switchesto the display of function parameter
values in the procedure component.
Show Types Togglesto the display of function parameter
types in the procedure component.
Associated Popup Menu
Identical to menu.
Drag Out
Table 5.32 shows Drag and Drop actions possible from the Procedure
component.
Table 5.32 Drag and Drop possible from the Procedure component.
Destination  Action
component
Data > Local Displaysthe local variables from the selected
procedure in the data component
Source Displays source code of the selected procedure.
Current instruction inside the procedureis
highlighted in the Source component.
DM-152 Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Framework Components
General Component

Destination Action

component
Assembly The current assembly statement inside the
procedure is highlighted in the Assembly
component.
Drop Into

Nothing can be dropped into the Procedure component.
Demo Version Limitations

Only the last two procedures are displayed.
Associated Commands

ATTRIBUTES, FINDPROC
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Profiler Component

The Profiler Component shown in Figure 5.78 provides information on
application profile.

Figure 5.78  Profiler Component

= Profiler =] E3
B fibo.co 99,072 % | 3‘
Fibonacci o0, 186 5 —
nain o.786 s
B startup.c o.025 s
Init 0.0z4 s
_Startup o.o04 s
hd
Description

The Profiler component window contains source module and procedure
names and percentage values representing the time spent in each source
module or procedure. The Profiler component window contains
percentages and also graphic bars.

The Profiler component window can set a split view in the Source and
Assembly components (Figure 5.79).

Figure 5.79  The Profiler split view in the Source and Assembly components

i Source =] I Assembly =]

|..%Sourceshfibo.c |Line: 21 |Fibonacci

5.103 % i = 2Z: ;I 6,391 % addo. r5, r?, k6 ;I

15.833 % while (i <= 1l 6.391 % .

6.391 % Fibo = £ibl + 6.391 %

B.391 % fFihl = £ihZ: 6.391 %

5.391 % fibhZ = fibho; 5.391 % cmp 1w crEh, rd, r3

5.391 % i+t 5.391 % ble crEh, O0x003fczZct
=} 3.051 % mr ri, r5
return(fibo): T 3.051 3 blr :I

3.051 % (4] | | ||| n.o00 = mflr ra -

Percentage values representing the time spent in each source or assembler
instruction are displayed on the |eft side of the instruction. The split view
can also display graphic bars. Split views are removed when the Coverage
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Figure 5.80

Figure 5.81

Figure 5.82

Figure 5.83

component is closed or if you open the split view Popup Menu and select
Delete.

The value displayed may reflect percentages from total code or percentages
from module code.

Operations

Click the fold/unfold icon to unfold/fold the source module.

Menu

Figure 5.80 showsthe Profiler Menu entries, Figure 5.81 showsthe Profiler
Details submenu, Figure 5.82 the Profiler Base submenu, and Figure 5.83
the Profiler Output File submenu, which are described in Table 5.33.

Profiler Menu

Fezet

Details... b

Baze... k
v [Graphics

Timer lpdate

Cutpuk File, ., #

Profiler Details Submenu

| Source
Azzembly

Profiler Base Submenu

- v Total Code
M adule

Profiler Output File Submenu

Filker. ..
Save As...
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Table 5.33  Profiler menu entries Description
Menu entry Description
Reset Resets all statistics.
Details Sets a split view in the chosen component
(Source or Assembly)
Base Sets the base of percentage (total code or
module code).
Graphics Toggles the display from graphics bar.
Timer Update  Switches on/off the periodic update of the
Coverage component. If activated, statisticsare
updated each second.
Output File Setup the Profiler Output File functions.
Split view associated Popup Menu
Figure 5.84 shows the Profiler popup menu, the Delete and Graphics
menu entries are described in Table 5.34.
Figure 5.84  Profiler Split view associated Popup Menu
Delete
Graphics
Table 5.34  Profiler Split view associated Popup Menu Description
Menu entry Description
Delete Removes the split view from the host
component.
Graphics Toggles the graphic bars display in the split
view.
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Profiler Output File functions

Y ou can redirect the Profiler component resultsto an output file by
choosing Output File...> Save As... in the menu or popup menu.
Output File Filter

By choosing Output Filter..., the dialog shown in Figure 5.85 lets you
select what you want to display, i.e. modules only, modules and functions,

or modules and functions and code lines. Y ou can also specify arange of
coverage to be logged in your file.

Figure 5.85  Output File Filter

Output File Filter B
— Content
& Modules

" Modules + Functions

& todules + Functions + Code Lines

—FRange to dump

From: IEI % To: [100 %

Cancel | Help |

Output File Save

The Save As... entry opens a Save As dialog where you can specify the
output file name and location.

Associated Popup Menu
Identical to menu.
Drag Out

All displayed items can be dragged out. Destination windows may display
information about the time spent in some codesin asplit view.

Drop Into

Nothing can be dropped into the Profiler Component window.
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Demo Version Limitations

Only modules are displayed and the Save function is disabled.

Associated Commands:

GRAPHICS, TUPDATE, DETAILS, RESET, BASE.
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Programmable IO_Ports

The Programmable |O_Ports component shown in Figure 5.86 consistsof 5
IO_Portswith 8 configurable bitsin input or output. In the default
configuration all couplersarein input. The graphical interface suggests the
state of each one.

Figure 5.86 Programmable I0_Ports Component

: i 10_Ports
I A part I B port I C part I D part I E part
I [t I [ npLat I [ nipLat I [t I [t
Description

The data exchange between the processor and peripheras are done by the
intermediary of some circuits called «input / output couplers». The
peripherals are connected to the data bus and are in parallel in an electrical
point of view. A concerned output circuit will catch information on the data
bus and save it (in alatch) until the next data reception.

The input/output couplers are perceived by the processor as memory cases
with awired fixed address. The capability exists to do input/output actions
at aknown address. In the C language, access is done by forced pointersto
these addresses.

A read operation where the coupler isin input mode, activates thisinput
during all the read steps. A write operation where the coupler isin output
mode activates the output latch during all write steps.

The programmable 10 _Ports alows you to define the coupler in input and
output. This configuration can be modified during program execution. The
first step in the test program is to configure the used couplers.

Menu

Figure 5.60 shows the Programmable |O_Ports menu and itsentry is
described in Table 5.29.
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Figure 5.87 The Programmable I0_Ports menu
Setup... |
Table 5.35 Programmable IO_Ports menu Description
Menu entry Description
Setup Opens the Programmable |O_Ports Port
Address dialog.
Programmable I0_Ports Port Address dialog
This dialog shown in Figure 5.88 allows you to set the port address and
control port address.
Figure 5.88 Programmable IO_Ports Port Address dialog

By Fll:lft [hEH] 5 Im

B part [hex] :  [202

Cport [hex] @ 204 Cancel |

D Port (hex] : |205

E Port [hex] - [202 Help |

Control port [hex] : 20a
Y ou can enter the addressfor the 5 ports A,B,C,D,E and the addressfor the
Control port. Click OK to validate.
The coupler Control register allowsyou to configure the port type: for
each port, set abit to 1 to configure the port as output and set to 0 to
configure the port as input, as shown in Figure 5.89.
DM-160
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Figure 5.89 Programmable IO_Ports Address dialog
Control register Way
BEits |8} |13 |8 bed b3 k2 k1 |10 Input
Ports - - - E D i E A Cutput 1
Drag Out

Nothing can be dragged out.

Drop Into

Nothing can be dropped into the Programmable 10_Ports Component.
Demo Version Limitations

No limitations

Associated Commands:

CPORT, LINKADDR
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Recorder Component

The Recorder component shown in Figure 5.90 provides record and replay
facilities for debug sessions.

Figure 5.90 Recorder Component

W Recoder K|

|OFF

> @ (=] [
(w [ (o [m [

Description
The Recorder Component window enables the user to record and replay
command files. The recorded file may also contain the time at which the
command is executed.
Click the buttons to record, play, pause and stop.

| Play. E Record.

B stop. E Pause.
An animation occurs during recording, replaying and pausing.
The current action (record, play or pause) and path of the involved file are
displayed in the Object Info Bar of the Simulator/Debugger Components.
Operations
When thereis no record or play session (e.g., when the window is open),
only the record and play buttons are enabled.
When you click the record button, the debugger prompts you to enter afile
name. Then arecord session starts and the stop button is enabled. Click the
stop button to end the record session.
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Figure 5.91

Clicking the replay button promptsfor afile name. Command files have a
. I ec default extension and can be edited. A replay session starts and only
the stop and pause buttons are enabled. When the pause button is clicked,
file execution stops and the play and stop buttons are enabled. When the
play button is clicked, file execution continues from the point it has been
stopped. When the stop button is clicked, the replay session stops.

Terminal and TestTerm record

Datatyped in the Terminal component and TestTerm component is
recorded during arecord session. The resulting file can be replayed only if
thetimeis also recorded (Record Time menu entry of the recorder has to
be checked before recording).

Menu

The recorder menu shown in Figure 5.91 changes according to the current
session. The menu items are described in Table 5.36.

Recorder Menu

Record
Replay

Record Time
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Table 5.36  Recorder Menu Description

Menu entry Description

Record Starts recording from a debug session.

Replay Starts replaying from a debug session.

Pause Replay Suspends replay in a debug session.

End Replay Stops replay in a debug session.

End Record Stops recording from a debug session.

Record Time If set, the evolution timeis a so recorded. Instant O corresponds

to the beginning of the recording.

InListing 5.2, a.absfileisloaded, a breakpoint is set, the assembly
component is configured to display the code and addresses. The Datal
component display is switched to local variables, and the application is
started and stopped at the breakpoint.

Listing 5.2 Record File example

at 4537 | oad C:\ Metrower ks\ DEMD fi bo. abs
at 9424 bs 0x1040 P

at 11917 Assenbly < attributes code on
at 14481 Assenbly < attributes adr on

at 20540 Data:1 < attributes scope | ocal

at 24425 ¢
wait ;s
Drag Out
Nothing can be dragged out.
Drop Into
Nothing can be dropped into the Recorder Component window.
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Demo Version Limitations

Only 20 commands will be recorded and replayed.
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Register Component

The Register Component window shown in Figure 5.92 displays the
content of registers and status register bits of the target processor.

Figure 5.92 Register Component
i Reqizter [_ (O]
|FPC |CPU Cycles: 1236097 | Auta
PC JFFCZ9C CE 40000245 #EFR. 45 Juk=12 2000
3F IFOAES Status | NPZ30C CTR 1] LE 3FCZF4
RO 3FC1ES RS 1] Rla 1] R24 1]
El JFRAES RS 1] R17 1] R25 1]
| 2 ] R10 1] R15 1] RZ6 1]
| 20 7 R11 1] R19 1] R27 1]
R4 7 R1Z 1] R20 1] RZ8 1]
E5 I R13 1] B2l 1] R=% 1]
E& D El4 1] RZZ 1] B30 1]
24 g R15 1] R23 1] B3l &
FPACER ]
FROD | 0 FELG | 0
FROL | 0 FR17 | 0
FROZ | 0 FR1E | 0
FRO3 | i FR19 | o
FRO4 | 0 FRZ0 | 0
FROS | 0 FRZ1 | 0
Description
Register values can be displayed in binary or hexadecimal format. These
values are editable.
Status register bits
Set bits are displayed dark, whereas reset bits are displayed grey. Double-
click abit to toggle the bit.
During program execution, contents of registers that have changed since
the last refresh are displayed in red, except for status register bits.
The Object Info Bar of the Simulator/Debugger Components contains the
number of CPU cycles as well as the processor's name.
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Editing Registers

Double-click on aregister to open an edit box over the register, so that the
value can be modified.

Pressthe [Esc] key to ignore changes and retain previous content of the

register.

f & \ Is pressed or clicking outside the edited register, the new
+1 Enter

value is validated and the register content is changed.

If |Tak 5 ! is pressed, the new value is validated and the register content

is changed. The next register value is selected and may be modified.

Double-clicking a status register bit togglesit.

-/Ej + Jﬂ_l . Contents of Source, Assembly and Memory components
change. The Source component shows the source code located at the
address stored in the register. The Assembly component shows the
disassembled code starting at the address stored in the register. The
Memory component dumps memory starting at the address stored in the

register.
Right-click: Opens the Register component Popup Menu.

Menu

The register menu contains the items shown in Figure 5.93. Table 5.37
describes the menu entries.
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Figure 5.93 Register Menu

v Her

— Bin
Ot
Dec
UDec:
Elmat
At
BitR everze

Table 5.37 Register Menu Description

Menu entry Description

Hex Selects the hexadecimal register display format

Bin Selects the binary register display format

Oct Selects the octal register display format

Dec Selects the signed decimal register display
format

UDec Selects the unsigned decimal register display
format

Float Selects the float register display format (all 32/
64 bit registersare displayed asfloats, all others
as hex)

Auto Selects the auto register display format (all
floating point 32/64 bit registers are displayed
asfloats, all others as hex)

Bit Reverse Selects the bit reverse data display format
(Each bit isreversed).

Associated Popup Menu
Identical to menu.
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Drag Out
Table 5.38 contains the Drag and Drop actions possible from the Register
component.
Table 5.38 Drag and Drop possible from the Register component.
Destination Action
component
Assembly Assembly component receives an address range, scrolls up
to the corresponding instruction and highlightsiit.
Memory Dumps memory starting at the address stored in the selected

register. The corresponding address is selected in the
memory component.

Command Line The address stored in the pointed to register is appended to

the current command.

Drop Into

Table 5.39 shows the Drag and Drop actions possible in the Register
component.

Table 5.39 Drag and Drop possible in the Register component.

Source Action

component

Assembler L oads the destination register with the PC of the
selected instruction.

Data Dragging the name |loads the destination register with
the start address of the selected variable. Dragging the
value loads the destination register with the value of the
variable.

Source L oads the destination register with the PC of the first

instruction selected.
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Source Action
component
Memory L oads the destination register with the start address of

the selected memory block.

Demo Version Limitations
No limitation
Associated Commands

ATTRIBUTES.
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Seven segments display component

The Seven segments display component shown in Figure 5.94 consists of 8
"7-segment” display systems.

Figure 5.94  Seven segments display component

B 7 segments displa ]

Description

Operation of the Seven segments display component is based on the
display scanning principle. Only one display can be activated
simultaneously for the purpose of limiting consumption of the set.

Common connection of the segmentsis the power of the component, the
other connections serve as code input, so the same code is applied to al
seven, as shown in Figure 5.95.

Scanning consists of selecting a display and activating its segments with
adequate code to the input terminals and then attend to the next display.
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Figure 5.95 Seven segments display component constitution

Menu

Figure 5.96 shows the Seven segments display component menu and the
menu entry is described in Table 5.40.

Figure 5.96  Seven segments display component menu

Setup... |

Table 5.40 Seven segments display component Menu Description

Menu entry Description

Setup Opens the Seven segments display component
setup dialog.

Seven segments display component setup dialog

This dialog shown in Figure 5.97 allows you to select the display and
related value.
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Figure 5.97 Seven segments display component setup dialog
7-Segmentz Display |
— Ports address
Select an address or insert a value [hex]
Select a dizplay IfEEIEIEIEI vI
Segmentz activatian
In the Select a display section, you can insert an address (in hexadecimal)
to select the display. In the Segment Activation field, you can set the value
of thisdisplay. The predefined port is the one used when the component
works with the Programmable |O_Ports.
Control bits configuration
The 2 bytes sent to the 7 segments must be composed as shown in Figure
5.98.
Figure 5.98 Seven segments display control bits
SELAFF SELEEC
Select of display Zelect of segments
b7 | b6 | b5 | bd [ B3 | b2 [ bl [ b0 |[ b7 [ b6 [ b5 [ bd [BI [ b2 [ bl | b0
AfT | AR | AR | A A (A2 (AR (A0 || - [ g [ F | e [d | c| v a
NOTE  The Seven segments display component is much slower than itsreal

equivalent. So in simulation you don’t need to insert delays between each
display scan (for segments light on and observer eye perception).

Drag out

Nothing can be dragged out.
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Drop Into

Nothing can be dropped into the Seven segments display Component
window.

Demo Version Limitations
No limitations
Associated Commands

Following commands are associated with the Seven segments display
Component:

SEGPORT, LINKADDR
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Figure 5.99

SoftTrace Component

The SoftTrace Component window shown in Figure 5.99 records and
displaysinstruction frames and time or cycles.

SoftTrace Component

i SoftTrace M=l B3
| 10000 frames | Fibohacci
434417 ocycles IFCZ90  addo. r&, 7, k6 ﬂ
434415 cycles JFC294d  mr. r?7, k6
434419 cycles JFCZ98 nmr. r6, k&
434420 oycles IFCZ9C  addi rd, rd, 1
434421 cycles FFCZAD  cmplw crfh, rd, r3
434422 cycles JFCZAd hle crfh, =20
434423 cycles IFCZAE wmr. r3, k&
434424 cycles JFCZAC blr
434425 cycles IFC2Fd lis rd, 64
4344-6 cycles IFCEFS  stuw ri, -26624(rd)

434427 cycles JFC2FC addi r3l, r3l, 1
434428 oycles IFC300  cmpwi crfh, r3l, 2%
434429 cycles FFC304 ble crfh, -45 _:J

Description

The Object Info Bar of the Simulator/Debugger Components displays the
number of recorded frames and the name of the function where the selected
frameis located.

Operations

Pointing at aframe and dragging the mouse forces all open windows to
show the corresponding code or location. Time and cycles of all other
frames are evaluated relative to this base.
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J@ + |2 | setsthe zero base frame to the pointed frame.

x/Ej + |D | forces all open component windows to show the code
matching the pointed to frame.

Menu

The SoftTrace Menu shown in Figure 5.100 contains the functions

described in Table 5.41.

Figure 5.100 SoftTrace Menu
v Record
Clock Speed...
M ax Frames...
v Cyclesz
ms
Rezet
Table 5.41  SoftTrace Menu Description
Menu entry  Description
Record Switches recording on and off.
Clock Speed Sets the clock frequency.
Max Frames Sets the maximum number of recorded frames.
Therefore you can minimize the amount of
memory required to display frames.
Cycles Displays cyclesinstead of time (in ms).
ms Displays time (in ms) instead of cycles.
Reset Removes all recorded frames.
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Associated Popup Menu

The SoftTrace popup menu shown in Figure 5.101 contains functions
(described in Figure 5.101) associated with the pointed to frame.

Figure 5.101 SoftTrace Associated Popup Menu

Set Zem Baze
Show Location

v FHecaord
Clock Speed...
b ax Frames...

v Cucles
ms

Reszet

Table 5.42 SoftTrace Associated Popup Menu Description

Menu entry Description

Set ZeroBase  Setsthe zero base frame to the pointed to
frame.

Show Location Forces open component windows to show the
code corresponding to the pointed to frame.

Drag Out

Nothing can be dragged out.

Drop Into

Nothing can be dropped into the SoftTrace component window.
Demo Version Limitations

The number of framesislimited to 50.

Associated Commands

CLOCK, CYCLE, FRAMES, RECORD, RESET.
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Figure 5.102

Source Component

The Source Component window shown in Figure 5.102 displays the source
code of your program, i.e. your application file.

Source Component

I Source M=l B3
|E:ADEMONfibo.c |Line: 18

unsigned int Fibonacei (unsigned int n) -:J
{ [

unsigned fibhl, f£ibZ, fibo:

int i:

fibl
fibhZ
fibno
i=2;
while (i <= n) {[E
fibo fibl + f£ibZ:
fibl fibhZ:
fibZ fiho:
i++;
S
return(fiba) ;

=}

L

wold main(woid)

{0} =]

Description

The Source Component allows you to view, change, monitor and control
the current execution location in the program. The text displayed in the
Source Component window is chroma-coded, i.e. language keywords,
comments and strings are emphasized with different colors (respectively
blue, green, red). A word can be selected by double-clicking it. A section
of code can be selected by \-/Ej + dragging the mouse.

The object info bar displays the line number in the source file of the first
visibleline that is at the top of the source.

Source code can be folded and unfolded. Marks (places where breakpoints
may be set) can be displayed.
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The source statement matching the current PC is selected (e.g., inaC
source: jhERENH ). The matching assembler instruction in the
Assembler component window is also selected. Thisinstruction isthe next
instruction to be executed by the CPU.

If breakpoints have been set in the program, they will be marked in the
program source with a special symbol depending on the kind of breakpoint.

A temporary breakpoint has the following symbol: _[;:I
A permanent breakpoint has the following symbol: _H
A disabled breakpoint looks like: ---%é

A counting breakpoint has the following symbol: -I-H
A conditional breakpoint has the following symbol: '['H

If execution has stopped, the current position is marked in the source
component by highlighting the corresponding statement.

The complete path of the displayed source file is written in the Object Info
Bar of the Simulator/Debugger Components.

NOTE  You cannot edit the visible text in the Source component window. Thisisa
file viewer only.

Tool Tips features

The Debugger source component provides tool tips to display variable
values. Thetool tip isasmall rectangular pop-up window that displaysthe
value of the selected variable (shown in Figure 5.103) or the parameter
value and address of the selected procedure. A parameter or procedure can
be selected by double-clicking it.
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Figure 5.103 ToolTips features

Eﬁuurce !Em
|C:MhivaretDEMO4S AMPLES ibo.c |Lire: 21
fibz = 1; :I
fibo = n;
i=2; _I

while (i <= n) {H

fibo = fibl + [ERE:

£ibl = f£ib2:

£ibh2 = fibo:

toto = Ccounter + 1bholount;

i++; hd

Select Tool Tips>Enable from the source menu entry to enable or disable
the tool tips feature.

Select Tool Tips>M ode from the source menu entry to select normal or
details mode, which provides more information on a selected procedure.

Select Tool Tips>For mat from the source menu entry to select the tool tip
display format (Decimal, Hexadecimal, Octal, Binary or ASCII).

On Line Disassembling

For information about performing on line disassembly, refer to section
How to Consult Assembler |nstructions Generated by a Source Statement.

» Select arange of instructions in the source component and drag it into
the assembly component. The corresponding range of codeis
highlighted in the Assembly component window, as shown in Figure
5.104.

. \./Ej + (T | Highlights a code range in the Assembly component

window corresponding to the first line of code selected in the Source
component window where the operation is performed. Thisline or code
range is also highlighted.
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Figure 5.104 On Line Disassembling
I Source M =] E3|| = Azzembly M=l E3
| NS ounces\fibo.c |Line: 21 |Fibonacci
=l
i< { mr. r?, ro
= fihl + fibhZ; mr. rb, 5
= fFihZ:; addi rd, rd, 1
= fibao: cip 1w crfh, rd, r3
ble crfh, Ox003fcz290
mr. ri, 5
blr
mflr ra -

< |

Setting Temporary Breakpoints

For information on how to set breakpoints refer to sectionsin the Control

Points chapter.

* Point to an instruction in the Source component Window and click the
right mouse button. The Source Component popup menu is displayed.
Select Run To Cursor from the popup menu. The application
continues execution and stops at this location.

. -/Ej + T | Sets atemporary breakpoint at the nearest code position

(visible with marks) thereafter the program runs and breaks at this

location, as shown in Figure 5.105.
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Figure 5.105 Setting Breakpoints
I Source M=]lE3 || = Azzembly M=l E3
|. NS ources\fibo.c |Line: 21 |Fibonacci
i=Z; LI ;I
while (i <= n) {[F mr. r7, L&
= fihl + f£ihZ; mr. ra, r5
fibl = fihZ; _| = addi rd, rd, 1
fikz = fiho: cup 1w crfh, rd, r3
=] i+ ble crfh, Ox003£cZ90
=} wr. r3, r5
return(fiba) ; - blr
ll_l 2 mflr ra j
Setting Permanent Breakpoints
» Point to an instruction in the Source component Window and click the
right mouse button. The Source Component popup menu is displayed.
Select Set Breakpoint from the popup menu. The permanent
breakpoint icon _H isdisplayed in front of the pointed to source
Statement.
. -/Ej + |P | Sets a permanent breakpoint at the nearest code position
(visible with marks). The permanent breakpoint icon _H is
displayed in front of the pointed to source statement.
Folding and Unfolding
Use this feature to show or hide a section of source code (e.g., source code
of afunction). For example, if asection isfree of bugs, you can hideit. All
text isunfolded at loading.
Sections of code that can be folded are enclosed between[k] and [ .
Sections of code that can be unfolded are hidden under [H] .
« Double-click afolding mark [®] or [4] tofold the text located
between the marks.
« Double-click an unfolding mark [M] to unfold the text that is hidden
behind the mark.
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Figure 5.106 and Figure 5.107 shows the functions associated with the
Source component. Table 5.43 describes these functions.

Figure 5.106  Source Associated Pop - Up Menu

Set Breakpaint
Fun To Curgor
Show Breakpoints
Show Location

Open Source File...

Sy (Bl

Go ToLine...
Find...
Find Procedure...

Falding »

Marks

ToolTips »

Figure 5.107 Second Source Associated Pop - Up Menu

Delete Breakpoint
Dizable Breakpoint
Fun To Cursor
Show Breakpaints:
Show Location

Open Source File...

By [Etr{+E

Go ToLine...
Find...
Find Procedure..

Falding »

Marks

ToolTips »
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Table 5.43 Associated Pop - Up Menu Description

Menu entry Description

Set Breakpoint  Appears only in the Popup Menu if no
breakpoint is set or disabled at the nearest code
position (visible with marks). When selected,
sets a permanent breakpoint at this position. If
program execution reaches this statement, the
program is halted and the current program state
isdisplayed in al window components.

Delete Appears only in the Popup Menuif a

Breakpoint breakpoint is set or disabled at the nearest code
position (visible with marks). When selected,
deletes this breakpoint.

Enable Appears only in the Popup Menu if a
Breakpoint breakpoint is disabled at the nearest code
position (visible with marks). When selected,

enables this breakpoint.
Disable Appears only in the Popup Menu if a
Breakpoint breakpoint is set at the nearest code position
(visible with marks). When selected, disables
this breakpoint.

Run To Cursor When selected, sets atemporary breakpoint at
the nearest code position and continues
program execution immediately. If thereisa
disabled breakpoint at this position, the
temporary breakpoint will also be disabled and
the program will not halt. Temporary
breakpoints are automatically removed when
they are reached.

Show Opens the Breakpoints Setting dialog box and

Breakpoints allowsyou to view the list of breakpoints
defined in the application and modify their
properties (See Control Points chapter).
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Menu entry

Description

Show Location

Open Source
File

Copy
(CTRL+C)

GotoLine

Find...

Find Procedure

Foldings

Marks

ToolTips

Highlights a code range in the Assembly
component window matching the line or
selected source code. The line or the source
code range are highlighted as well.

Opens the Source File Dialog if aCPU is
loaded (see chapter below).

Copies the selected area of the source
component into the clipboard. Y ou can select a
word by double-clicking it. Y ou can select a
text area with the mouse by moving the pointer
to the left of the linesuntil it changesto aright-
pointing arrow, and then drag up or down;
automatic scrolling is activated when the text is
not visible in the windows.

Opens adialog box to scroll the window to a
number line (see chapter below).

Opens adialog box prompting for a string and
then searches the file displayed in the source
component. To start searching, click Find
Next, the search is started at the current
selection or at thefirst linevisible in the source
component (see chapter below).

Opens adialog box for searching a procedure
(see chapter below).

Opens the folding window (see chapter below)

Toggles the display of source positions where
breakpoints may be set. If this switch ison,
these positions are marked by small triangles.

Allows you to enable or disable the source tool
tipsfeature, to set up the tool tip mode, and tool
tip format.
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NOTE

Figure 5.108

If some statements do not show marks although the mark display is
switched on, the following reasons may be the cause:

- The statement did not produce any code due to optimizations done by the
compiler.

- The entire procedure was not linked in the application, becauseit is never
used.

Open Source File Dialog

The Open Source File dialog shown in Figure 5.108 allows you to open
SourceFile (if aCPU isloaded). A sourcefileisafilethat has been used to
build the currently loaded absolute file. Assembly file (*.dbg) is searched
in the directory given by the OBJPATH and GENPATH variables. C, C++
files(*. c, *. cpp, *. h, ..) are searched in the directories given by the
GENPATH variable.

Open Source File Dialog

Source Files E |
fibo.c
rtzhic.c
shart.c
Cancel |
Help |

Go to Line Dialog

This menu entry isonly enabled if asourcefileisloaded. It opensthe
dialog shown in Figure 5.109.

Enter the line number you want to go to in the source component, the
selected line will be displayed at the top of the source window. If the
number is not correct, a message is displayed.
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Figure 5.109 Go to Line Dialog

Go To Line E2

Enter Line Mumber: IE

] I Cancel | Help |

When this dialog is open, the line number of thefirst visible linein the
source is displayed and selected in the Enter Line Number edit box.

Find Dialog

The Find Dialog, shown in Figure 5.110 is used to perform find operations
for text in the Source component. Enter the string you want to search for in
the Find what edit box. To start searching, click Find Next, the search
starts at the current selection or first line visible in the source component,
when nothing is selected.

Use the Up / Down buttons to search backward or forward. If the string is
found, the source component selection is positioned at the string. If the
string is not found, a message is displayed.

Figure 5.110 Find Dialog
Find HE|

Find what  ta_find

Cancel |

" Up & Down

[+ tdatch whale word onle Directiar
[T Match caze ’7

The dialog box alows you to specify the following options:

» Match wholeword only: If thisbox is checked, only strings separated
by special characters will be recognized.

* Match case: If thisbox is checked, the search is case sensitive.
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NOTE

Figure 5.111

If an item (single word or source section) has been selected in the Source
component window before opening the Find dialog, the first line of the
selection will be copied into the “Find what” edit box.

Find Procedure Dialog

The Find Procedure dialog, shown in Figure 5.111 is used to find the
procedure name in the currently loaded application. Enter the procedure
name you want to search for in the Find Procedur e edit box. To start
searching, click OK, the search starts at the current selection or at the first
line visible in the source component, when nothing is selected.

Find Procedure Dialog
Find Procedure |

Enter Procedure Mame

[ =
] 4 I Cancel Help |

If avalid procedure nameis given as a parameter, the source file where the
procedure is defined is opened in the Source Component. The procedure’s
definition is displayed and the procedure’ stitle is highlighted.

The drop-down list allows you to access the last searched items (classified
from first to older input). Recent search items are stored in the current
project file.

Folding Menu

The Folding Menu shown in Figure 5.112 allows you to select the Fold
functions described in Table 5.44.
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Figure 5.112  Folding Menu

Unfald
Fold

[nfald Al Tesxt
Fold All Text

All Text Folded At Loading

Table 5.44  Folding Menu Description

Menu entry  Description

Unfold Unfolds the displayed source code
Fold Folds the displayed source code
Unfold All Text Unfolds all displayed source code
Fold All Text Folds all displayed source code

All Text Folded Folds all source code at load time
At Loading

Drag Out

Table 5.45 shows the Drag and Drop actions possible from the Source
component.

Table 5.45 Drag and Drop possible from the Source component

Destination Action
compo.
Assembly Displays disassembled instructions starting at the first high

level language instruction selected. The assembler instructions
corresponding to the selected high level language instructions
are highlighted in the Assembly component
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Destination Action

compo.

Register L oads the destination register with the PC of thefirst instruction
selected.

Data A selection in the Source window is considered as an

expression in the Data window, asif it was entered through the
Expression Editor of the Data component. (please see Data
Component or Expression Editor)
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Drop Into

Table 5.46 shows the Drag and Drop actions possible into the Source
component.

Table 5.46 Drag and Drop possible into the Source component.

Source compo. Action

Assembly Source component scrolls to the source statements
corresponding with the pointed to assembly instruction and
highlightsit.

Memory Displays high level language source code starting at the first

address selected. Instructions corresponding to the selected
memory area are greyed in the source component.

Module Displays source code from the selected module.

Demo Version Limitations
Only one source file of the currently loaded application can be displayed.
Associated Commands

ATTRIBUTES, FIND, FOLD, FINDPROC, SPROC, SMOD, SPC,
SMEM, UNFOLD.
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Figure 5.113

Figure 5.114

Table 5.47

Stimulation Component

The Simulator/Debugger also supports |/O Stimulation. Using thisfeature
you can generate (stimulate) interrupts or memory access generated by an
external 1/0O device.

Description

The Stimulation component shown in Figure 5.113 isawindow component
that provides the basic functionality of the ssmulator debugger. It servesto
execute timed action and raise exception events. The Stimulation
component displays and executes I/O stimulation described in atext file.

Stimulation Component
[ Stimulation Hi=] E3

def a
def b
def ¢
10000

Targetibiject. #1FA0;
TargetlObject. #1FEQO;
TargetObject. #1FCO.B[7:3]:

Popup menu

Figure 5.114 shows functions associ ated with the Source component. Table
5.47 describes these functions.

Stimulation Popup menu

Open File...
Execute
v Dizplay

Cache Size

Stimulation Popup menu

Menu entry Description

Open File Opens adiaog to load a stimulation file.
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Menu entry Description

Execute Starts execution of the input file.
Display Switches display of stimulated file on or
off.

Cachesize Opens the 'Size of Cache' diaog.

Cache Size Dialog

Thisdialog shown in Figure 5.115, allows you to define the number of
lines displayed in the Stimulation component. If the 'Limited Size of
Cache' checkbox is unchecked, the number of linesis unlimited. If the
‘Limited Size of Cache' check box is checked, the number of linesis
limited to the value displayed in the edit box. This value should be between
10 and 1000000. By default, the number of linesis 1000.

Figure 5.115 Cache Size Dialog

Size of the Cache Ed |

v Limited Size of Cache

MHumber of lines ta be cached: I'I Qoo
] I Canizel | Help |

NOTE  Thebigger the cache size, the Slower new lines are logged.

Example of a Stimulation File

Using an editor, open the file named | O_VAR. TXT located in the project
directory. Listing 5.3 isan examplefile.

Listing 5.3  Stimulation File example

def a = Target Obj ect. #210. B;

PERI ODI CAL 200000, 50:
50000 a = 128;
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150000 a =
END
10000000 a = O;

4;

NOTE

In the first line, the stimulated object is defined. This object islocated at
address 0x210 and is 1 byte wide.

Once 200000 cycles have been executed, the memory location 0x210 is
accessed periodically 50 times (line 3). First the memory location is set to
128 and then 100000 cycles latter, it is set to 4.

For more information about Stimulation, refer to the True Time
Stimulation document.

Drag Out

Nothing can be dragged out.

Drop Into

Nothing can be dragged into.

Demo Version Limitations

Only 15 interrupts and memory access will be generated.
Associated Commands

ATTRIBUTES, EXECUTE, OPENFILE,

For more information about commands, refer to Debugger Commands.
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TestTerm Component

The TestTerm component shown in Figure 5.116 isauser-friendly terminal
input/output. It provides asimple SCI (Serial Communication Interface)
interface, which is target independent.

Figure 5.116 TestTerm Component
I TestTerm =] E3

Calculator
41 ¥ g9 = 28529

The TestTerm component emulates a serial communication interface based
at the address 200 hex, therefore providing 5 ssmulated memory mapped
registers described in Table 5.48.

Table 5.48 TestTerm simulated memory mapped registers

Register Name Function Register Address
BAUD Baud Rate Control 0x0200
SCCR1 Serial Communication Control Register 0x0201
SCCR2 Serial Communication Control Register 0x0202
SCSR Serial Communication Status Register 0x0203
SCDR Serial Communication Data Register 0x0204

In the Serial Communication Status Register, the bits used are described in
Table 5.49.

Table 5.49 TestTerm Serial Communication Status Register

Bit Name (flag) Function Bit Mask Value
TDRE Transmit Data Register Empty 0x80
RDRF Receive Data Register Full 0x20
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However, reading and writing in the BAUD, SCCR1, SCCR2 or SCSR
registers has no effect in the TestTerm component, but are required to
make the component compatible with specific SCI interfaces.

Simulated 1/0s of the TestTerm component do not need initiaization. In
theterminal interfacefilet er m o. ¢, BAUD and SCSR registers are
initialized to be compatible with real SCI interfaces.

NOTE SeeasoTerminal Component section.

The SCDR register isvalid for reading or writing data. When reading a
value from the SCDR register, the RDRF flag is cleared in the SCSR
register. Also when the user enters a character on the keyboard while
TestTerm is active, the RDRF flag is set in the SCSR register and the
ASCII code of the typed key is put into the SCDR register.

Conceptually when anew value is written in the SCDR register by the
target application, the TDRE flag is cleared in SCSR. When the
transmission isfinished, the TDRE flag is set again. As TestTerm isonly
an 1/0O emulation, no delay is simulated and writing into SCDR sets the
TDRE flag in the SCSR register.

Output Redirection

Outputs can be redirected to a TestTerm component window, afile, or to
both at the same time.

File output is monitored by the target system and cannot be specified
interactively.

Redirection is handled through “ Escape” sequences of the output data
stream. Table 5.50 illustrates the different possible redirections and
associated Escape sequences.

Table 5.50 Redirections and associated Escape sequences

Escape Sequence Function

ESC*“h” “1” Output to Terminal window only.
ESC“h” “2” filename Output to both Terminal window and file.
ESC“h” “3” filename Output to file only.
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Escape Sequence Function

ESC“h” “4” Read from keyboard

ESC“h” “5” filename Read input from file 'fileName'

ESC“h” “6” filename Output to Terminal window and append to file
ESC“h” “7” filename Append to file only

where filename is a sequence of characters terminated by a control
character (e.g., CR) and isavalid filename.

ESC isthe ESC character (ASCII code 27 decimal).
These commands can be used anywhere in the output stream.
How to redirect

By default, an output redirection is set to the TestTerm component
window.

The Term_Direct function declared int er m nal . h isused to redirect
an output. The sourcecodeint er m nal . c isgivenin Listing 5.4.

Listing 5.4 Term_Direct source code

void TermDirect(int what, char *fil eNane)

{
iIf (what < 1 & what > FROM FILE) return;
Wite(ESC); Wite('h");
Wite(what + '0");
i f (what !'= TO W NDOW && what != FROM KEYS) {
PutString(fileNane); Wite(CR);
}
}
where “what” is one of the following items: TERM_TO_WINDOW
(sends output to terminal window), TERM_TO_BOTH (send output to
fileand window), TERM_TO_FILE (send output to file 'fileName),
TERM_FROM_KEYS (read from keyboard), TERM_FROM _FILE
(read input from file 'fileName’), TERM_APPEND_BOTH (append
output to file and window), TERM_APPEND_FILE (append output to
file'fileName). Seealsot er m nal . h for more information.
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How to Use TestTerm

Listing 5.5 showsthefunctionsdefinedint er npor t . h that can be called
to access the TestTerm component:

Listing 5.5 Functions to access the TestTerm component

char Get Char(void);

voi d Put Char (char ch);
void PutString(char *str);
void InitTerm Q(void);

Source code for the functionsin termport.cisgivenin Listing 5.6.

Listing 5.6  Source code of the functions to access the TestTerm
component in termport.c

typedef struct {
unsi gned char BAUD;
unsi gned char SCCRI;
unsi gned char SCCR2;
unsi gned char SCSR;
unsi gned char SCDR;
} SCI Struct;

#define SCI (*((SCl Struct*)(0x0200)))
char Get Char (voi d)

{
while (! (SCl.SCSR & 0x20)); /* wait for input */
return SCl. SCDR;
}
voi d Put Char (char ch)
{
while (! (SCl.SCSR & 0x80)); /* wait for output buffer
enpty */
SCl . SCDR = ch;
}
void PutString(char *str)
{
while (*str) {
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Put Char (*str);

str++;
}
}
void InitTerm Q(voi d)
{
SCl . BAUD = 0x30; /* baud rate 9600 at 8 MHz */
SCl . SCCR2 = 0x0C; /* 8 bit, TE and RE set */
}
Example
The calc.abs example needs Terminal Component.
Menu
The TestTerm component menu and popup menu shownin Figure5.117 let
you set the Cache Size in lines of the Testterm window in the dialog shown
in Figure 5.118.
Figure5.117 TestTerm Menu
Cache Size
Select Cache Size in the menu.
Figure 5.118 TestTerm cache Size Dialog

Size of the Cache |

¥ Limited Size of Cache

Mumber af linez to be cached: I'I Qo0
] I Cancel | Help |

Drag Out

Currently, nothing can be dragged out of the TestTerm component.
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Drop Into

Currently, nothing can be dropped into the TestTerm component.

Demo Version Limitations

No limitation
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Terminal Component

The Terminal component shown in Figure 5.119 can be used to ssmulate
input and output. It can receive characters from severa input devices and
send them to other devices.

Figure 5.119 Terminal Component

B Teminal [_ [O] %]

ZH 06 test (file: ZH_06.C)
Date: Oct 04 1996, 15:Z8:10

You can use avirtual SCI (Serial Communication Interface) port provided
by the framework for communication with the target, but it is also possible
to use the keyboard, the display, some files or even the serial port of your
computer as I/O-devices.

To control and configure aterminal component use the context menu of the
terminal shown in Figure 5.120.

Figure 5.120 Terminal Context Menu

C) Terminal =10] %]

lear

Input File .,
Zlase Inpuk File
Cukpuk File ..
Zlase Gukpok Fle

Configure Conneckions ...
Cache Size ...

To open the menu just right click in the terminal window.
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Figure 5.121

Connections

The terminal window is very flexible and can redirect characters received
from any available input device to any available output device. Y ou can
specify these connections by choosing Configur e Connections... in the
context menu of the terminal component. This opens the dialog shown in
Figure 5.121.

Configure Terminal Connections Dialog

Configure Terminal Connections x|

Deout Contguaton: [T EC R - |

— Connections

From; j To: I j Edd

[nput File - Wirtual SCI Add Al
Kevboard --» “irtual SCI
Yirtual SC1 - Dizplay Femawve Al
Yirtual SCI - Output File

e

Hemove

— Serial Port —Yirtual SC

|EEIM1 j YWirtual SCI [nput Part; |5-:iEI.SeriaIEI utput

Baud Fate: I'IEIEEIEI vI

™| Show Protocol

Yirtal SCI Output Part: ISciD.Seriallnput

aF. Cancel | Help |

Y ou can ssmply choose one of the default configurationsin the “Default
Configuration” combo box. In the “ Connections’ section all active
connections are listed in alist box. There you can customize which input
deviceswill be redirected to which output devices by adding and removing
connections.

To add a connection specify the source and target devices using the “ From”
and “To” combo boxes and then pressthe “Add” button. The new
connection will then appear in the list below, which shows all active
connections.
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To remove connections, select them in the list of active connections and
press the “Remove” button.

In the “ Serial Port” section you can specify which serial port to use and its
properties. Thisisonly possible if there is at least one connection from or
to the serial port.

If a connection from or to the virtual SCI port has been chosen it isaso
possibleto specify inthe“Virtual SCI” section which portswill be taken as
virtual SCI ports. This enables you to make a connection to any port in the
simulator framework.

Input and Output File

It isalso possible to take afile as an input stream for the terminal
component or redirect the output to afile.

If you want to use afile as an input stream, make sure that there exists at
least one connection from the input file to any output device. Then you can
open an input file by simply choosing I nput File... from the context menu.
Assoon asyou pressthe“OK” button in the“File Open” dialog, input from
thefilewill start. Thefile will be closed as soon asthe end of fileisreached
or you choose Close I nput File from the context menu.

When the inpuit file has reached itsend a CTRL-Z character (ASCII code
26 decimal) will be sent to all output devices receiving characters from the
input file to notify them that the file transfer has been finished.

If you want to redirect some input devices to an output file, you have to
proceed similarly. Make sure that you have chosen your connections from
input devices to the output file. Then you can open or create your output
file by choosing Output File... from the context menu. If the file does not
exist it will be created. Otherwise you can choose to overwrite or append
the existing file. To stop writing to the output file you can choose Close
Output File from the context menu.

File Control Commands

It is also possible to open and close input and output files through special
“Escape” sequencesin the data stream from serial port or virtual SCI.
Table 5.51 illustrates the different possible commands and associated
Escape sequences:
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Table 5.51 Terminal File Control Commands

Escape Sequence Function

ESC*“h” “1” Close output file.

ESC“h” “2” filename Open output file.

ESC“h” “3” filename Open output file and suppress output
to terminal display.

ESC“h” “4” Closeinput file

ESC“h” “5” filename Open input file.

ESC“h” “6” filename Append to existing output file.

ESC“h” “7” filename Append to existing output file and
suppress output to terminal display.

where filename is a sequence of characters terminated by a control
character (e.g. CR) and isavalid filename.

ESC isthe ESC Character (ASCII code 27 decimal).

These commands can be given in the data stream sent from the serial port
or virtual SCI port, but not from the input file or the keyboard. They only
have an effect if there are any connections reading from the input file or
writing to the output file.

The TERM _Direct function declaredint er mi nal . h isused to send
such commands from atarget via SCI to the terminal. The source codein
term nal . cisgiveninListing 5.7,

Listing 5.7 TERM_Direct source code

void TERM Direct (TERM Di rect Ki nd what, const char* fil eNane) {
/* sets direction of the termnal */
if (what < TERM TO WNDOW || what > TERM APPEND FI LE) return;
TERM Wite(ESC); TERM Wite('h');
TERM Wite((char)(what + '0"));
if (what !'= TERM TO W NDOW && what ! = TERM FROM KEYS) ({
TERM WiteString(fileNane); TERMWite(CR);
}

}
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TIP

where the parameter what is one of the following constants:

* TERM_TO_WINDOW: send output to terminal window

» TERM_TO _BOTH: send output to file and window

* TERM_TO_FILE: send output to file ‘fileName'

* TERM_FROM_KEYS: read from keyboard (close input file)
« TERM_FROM _FILE: read input from file 'fileName'

« TERM_APPEND_BOTH: append output to file and window
« TERM_APPEND_FILE: append output to file 'fileName'

Seealsot er mi nal . h for further details.
How to Use Virtual SCI

Initsdefault “Virtual SCI” configuration the terminal component accesses
the target through the Object Pool interface.

To make the terminal component work in this default configuration, the
target must provide an object with the name "Sci0". If no SciO object is
available, no input or output happens. It is possible to check, through the
Inspector component, if the environment currently provides an SciO object.

Only some specific smulator target components currently have a SciO
object. For all other ssimulator target components the default virtual SCI
port does not work unless a user defined SciO object with the specified
register name is loaded.

Write access to the target application is done with the Object Pool function
"OP_SetValue" at the address "Sci0.Seriall nput™”.

Input from the target application is handled with a subscription to an
Object Pool register with the name Sci0.SerialOutput. When this register
changes (sends a notification), anew valueis received.

For implementations of thisregister with help of the "l OBase" class, the
flag "1OB_NotifyAnyChanges' should be used. Otherwise only the first
of two identical characters are received.

It isalso possible to configure the terminal to use another object in the
Object Pool instead of SciO with which to communicate. Please refer to
Connections for informations about where you can do this.
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Figure 5.122

Example

Pleaserefer tothe Cal c. abs and Ter m deno. abs examplesinstalled
with your Simulator/Debugger environment in the demo directory.

Other Information

Cache Size

Theitem Cache Size... in the context menu allows you to set the number of
linesin the terminal window with the dialog shown in Figure 5.122.

Terminal Cache Size Dialog

Size of the Cache |

¥ iLimited Size of Cache

Mumber of lines to be cached: |1 aaa
] I Cancel | Help |

Drag Out

Currently, nothing can be dragged out of the Terminal component.

Drop Into

Currently, nothing can be dropped into the Terminal component.

Demo Version Limitations

No limitations

DM-206
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Wagon Component

The Wagon component shown in Figure 5.123 simulates a tool machine
wagon functionality.

Figure 5.123 Wagon Component

e

WaEIH
b

RUNI

Description

At first, the wagon is at the left border position, when you click the RUN
button, the wagon goes to the right side. Upon arriving at the right border,
the wagon returnsto the left side. The RESET button also positions the
wagon at the left border. The STOP button stops the wagon at the current
position.

Menu

Figure 5.124 shows the Wagon menu and is described in Table 5.52.

Figure 5.124 Wagon menu

Setup... |

Table 5.52 Wagon Menu Description

Menu entry Description

Setup Opensthe Wagon setup dialog shown in Figure
5.125.
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Wagon setup dialog

Figure 5.125 Wagon setup dialog
[ ports audress selecton 3|
Matar part (Dutput] {80000 =]
Senzor port [[npt]
Chooze a port or insert & Port C
Port D
Port E
Cancel |
In the Motor Port section, you can insert an address (in hexadecimal) to
select the Wagon direction, in the Sensor Port field you can insert an
address (in hexadecimal) to select the Wagon position. Predefined ports are
fixed when the component operates with the Programmable |O_Ports.
Control bits configuration
The 2 bytes sent to the 7 segments must be composed as shown in Figure
5.126.
Figure 5.126  Wagon Control bits Description
Mlotor port SENZOT pott
b7 [ b6 | BS | b4 [ B3 | b2 | b1 | BO ([ B7 | b6 | b5 [bd | B3| b2 | bl | kO
{ - - - - - - r Bl - - | &t = | - - | Er
To move the wagon to the right, set bit r and to move the wagon to the left,
set bit I
The sensor port sets the bl bit when the wagon is at the left border, sets bit
br when the wagon is at the right border; sets bit st when START buttonis
clicked with left mouse button, and sets stp when STOP button is clicked.
DM-208
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Drag out

Nothing can be dragged out.

Drop Into

Nothing can be dropped into the Wagon Component.

Demo Version Limitations

No limitations

Associated Commands

Following commands are associated with the Wagon component:

WPORT, LINKADDR
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Visualization Utilities

Besides components that provide the Simulator/Debugger engine awell-
defined service dedicated to the task of application development, the
debugger component family includes utility components that extend to the
productive phase of applications, such as, the host application builder
components, process visualization components, etc.

Among these components, there are visualization utilities that graphically
display values, registers, memory cells, etc., or provide an advanced
graphical user interface to ssmulated 1/O devices, program variables, and so
forth.

The following components of the continuously growing set of visualization
utilities belong to the standard Simulator/Debugger installation.

DM-210
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Analog Meter Component

The Analog Meter shown in Figure 5.127 is atemplate component that can
be used as a basis for user provided debugger extension components. It
displays several input and output controls that can be manipulated with the
mouse.

Figure 5.127 Analog Meter Component

R
I
SNy 2
1\‘.,' Fa)
N s
63 %0 |

Description

The Analog Meter contains four controls: an analog gauge in the middle, a
vertical level bar to the |eft, a horizontal level bar on top, and a turning
‘knob’ in the top left corner. Click in any of these controlsto adjust the
value of the meter. The Analog Meter is assigned to address 0x210.

Operations

In the vertical bar, the value can be tracked vertically, in the gauge and
horizontal bar, the value can be tracked horizontally, and in the knob, the
value is adjusted when tracking the mouse around the center.

Menu

The Analog Meter does not have a menu.
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Drag Out

Nothing can be dragged out of the Analog Meter component.
Drop Into

Nothing can be dropped into the Analog Meter component.
Demo Version Limitations

No limitation.
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Figure 5.128

Inspector Component

The Inspector shown in Figure 5.128 displays information about several
topics. It displays |loaded components, the visible stack, pending events,
pending exceptions and loaded 1/O devices.

Inspector Component

i Inzpect _ O] =]
e [T Components A1 Mame Walue Address Inity alue
b Stack I0_Reg_1 0 Q1000 00
-85 Symbol Table I0_Reg 2 0=0 0=1001 0=0
----- Events
~-#7 Evceptions

=% Object Paal
=-FF TargetObject

Description

The hierarchical content of the itemsis displayed in atree structure. If any
item is selected on the | eft side, then additional information is displayed on
theright side.

In the figure above, for example, the Object Pool is expanded. The Object
Pool contains the TargetObject, which contains the Leds and Swap
peripheral devices. The Swap peripheral device is selected and registers of
the Swap device are displayed.

Components

When the componentsicon is selected, as shown in Figure 5.129, the right
side displays various information about all loaded components. A
Component is the “unit of dynamic loading”, therefore all windows, the
CPU, the target and maybe the target-simulator are listed.
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Figure 5.129 Inspector components icon
i Inspect _ (O]
I Componients [Name | Type
b Stack HiwaveBase Undefired
B8 Symbol Table Source "wWindaow
- Events Agzembly indom
_____ 4 Exceptions Procedure Windows
B Obiect Pool Reqister W!ndnw
=y I _ b ernany Wiindow
?L'E TargetObject Data Ywindo
- {d Swap Data2 Yfindow
Ll Leds Inzpect Window
Target Target
EfLoader Object File Loader
Swap 0D evice
[0_Led Windawm
Command Window
Stack
The Stack shown in Figure 5.130 displays the current stack trace. Every
function on the stack has a separate icon on the trace. In the stack-trace, the
content of alocal variableis accessible.
Figure 5.130 Inspector Stack

i Inzpect

- ] Components

EI? Stack

I__—_I@ Fibonacci
@ n

fibl

fib2

fibo

- main

----- _Startup

m B0 cobnd T ok

]
]

A MName | Walue

Type

Addresz

IS [=] E3

Size

hn a

[

ungigned int

D=bef

=2

Symbol Table

The symbol table shown in Figure 5.131 displays all loaded symbol table
information in raw format. There are no stack frames associated with

functions. Therefore the content of local variablesis not displayed. Global
variables and their types are displayed.
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Figure 5.131

i Inzpect [_ O] x|

Inspector Symbol Table

— [T] Components Mame ReturnT ype Addrezs Size | Caling.. | Protolype
Stack, Fibohaczi  unsigned ink +266 0=2f  Marmal ungigned int Fibonaccilu
=44 Symbol Table
El fibio.c
: EF Fibonacei
..... a n
i i [m ] f||:,‘|
""" A | KT | 1
Events
The eventsicon shownin Figure 5.132 shows all currently installed events.
Events are handled by peripheral devices, and notified at agiventime. The
Event display shows the name of the event and remaining time until the
event occurs.
Figure 5.132 Inspector Events

i Inzpect [_ O]
[ Components Mame Time |
F-g Stack COF event 16777216

-85, Symbol Table

€3 Ewvents

------ 7 Exceptions

Iél---ﬂ;f Object Poal

------ {# TargetOhject

. {F CMolify12

Events are only used in the Simulator. Thisinformation is used for
simulation 1/0O device development.

When simulating a watchdog/COP, an event with the remaining timeis
displayed in the Event View.

Exceptions

The exception icon shown in Figure 5.133 shows all currently raised
exceptions. Exceptions are pending interrupts.
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Figure 5.133

i Inspect

. ] Components
Stack.
-85, Symbol Table
----- Ewvents
----- é E xcephions
#- &8 Object Pool

Inspector Exceptions

M=l k3
M ame Wechor Pricrity ArbitPriority | Auto..
Feal Time Interrupt =7 =1 =0 Falze

Figure 5.134

i Inspect

-4 Exceptions
=-&# Object Pool
EI%F' TargetObject
o Leds
- Swap

Events are only used in the Simulator. Thisinformation is used for
simulation 1/O device development.

Since interrupts are usualy simulated immediately when they are raised,
the Exceptions are usually empty. Only when interrupts are disabled or an
interrupt is handled, something isvisible in thisitem.

When simulating a watchdog/COP, an Exception israised as soon as the
watchdog time el apses.

Object Pool
The Object Pool shown in Figure 5.134 is a pool of objects. It can contain

any number of Objects, which can communicate together and also with
other parts of the Simulator/Debugger.

Inspector Object Pool

H=] E3
M ame Walue Addrezs Irit alue
Port_Reqizter =0 0x210 0=
Drata_Direction_Fegister  Ox0 e b 000

The most common use of Objectsisto simulate special hardware with the
I/0O development package, however, other targets also use the Object Pool.
For example, the Terminal Component exchanges its input and output by
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the Object Pool. The Terminal Component also operates with some
hardware targets.

For the Simulator, the Object Pool usually contains the TargetObject,
which represents the address space. All Objects that are |loaded are
displayed in the Object Pool. The TargetObject additionally shows the
objects that are mapped to the address space.

Operations

Click the folded/unfolded icons B2 to unfold/fold the tree and display/
hide additional information.

Click on any icon or name to see the corresponding information displayed
on the right side.

On the right side, some value fields can be edited by double clicking on
them. Only values that are accessible can be edited. Usually, if avalueis
displayed, it can be changed. 1/0 Devices in the Object Pool do not accept
al new values, depending on the I/O Device. Values can be entered in
hexadecimal (with preceding 0x), in decimal, in octal (with preceding 0),
or in binary (with preceding & ).

To seethe 10O_Led in the Inspector, as shown in Figure 5.135, open the
IO_L ed with the context menu Component-Open and then open the
Inspector. If the Inspector is aready loaded, select Update from the
context menu in the Inspector. Then click on the Componentsicon to see
the Component list, which now includesthe “1O_Led” component.
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Figure 5.135 How to see the IO_Led in the Inspector
i Inzpect [_ (O] x|
o [T Components M ame: Type
- Stack HiwaveBase Undefined
o 18, Symbol Table Inzpect Window
- Events ElfLoader Object File Loader
- #r Exceptions Targel T el
Iél---ﬂ;-?zf't Object Poal W0
E TargetObject
- E Leds
10 _Led
Gee @ 9@
PORT=66 LDR=EE
Expand Object Pooal, to see the Ledsicon. Click on the Ledsicon. On the
right side, the Port_Register and Data_Direction_Register are displayed
with their current value. Double click on the values to change them (Figure
5.136).
Figure 5.136 Changing “Data_Direction_Register” value
i Inspect [_ O]
~{Z] Components Hame Yalue Address Iri
- Stack Part_Feqgister En Ox210 O
..... b nﬁn Symbal Table Drata_Direction_Fegister Owxeb Ow12 s
- Ewents
47 Ewceplions
E---ﬂgﬂ Object Poal
-{d TargetDbject
e ﬁ Leds 4| | _'I
I 10_Led x|
L @ 8
PORT=80 DDR=EE
Menu
The Inspector menu contains entries described in Table 5.53.
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Table 5.53 Inspector Menu Entries:

Menu entry Description

Update All displayed information is updated
Items that no longer exist are removed and new items are added.

Associated Popup Menu

Commands in the Inspector context menu depend on the selected item. It
can contain entries described in Table 5.54.

Table 5.54 Inspector Menu Entries Description

Menu entry Context Description

Update al items All displayed information is updated
Items that no longer exist are
removed and new items are added.

Max. al items Todisplay large arrays element by

Elements... element, the maximum number can
be configured. It isalso possible to
display adialog that prompts the
user.

Format al items Numerical values can be displayed
in different formats.

Close single Closes the corresponding component
selected
Compone
nt only
Drag Out

Items that can be dragged, depends on whichicon is selected. Table 5.55
gives a brief description.
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Table 5.55 Inspector Possible Drag Out

Dragging Description
ltem

Components The components cannot be dragged

Stack The Stack Icon itself cannot be dragged.
All subitems can be dragged the same way as
the Symbol Table subitems, described below.

Symbol Table  The Symbol Table icon cannot be dragged out.
Subitems can be dragged depending on their
type:

Modules: Modules can be dragged to the
source and global data window to specify a
specific module.

Functions: Functions can be dragged to display
the function or code range.

Variables: Variables can be dragged to display
their content in memory.

Indirections: Indirections can be dragged to
display their content in memory.

Drop Into
Nothing can be dropped into the Inspector Component window.
Demo Version Limitations

Only 5 items can be expanded at each location. For remaining items, an
icon with the text “Demo Limitation” is displayed, as shown in Figure
5.137.
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Figure 5.137

Inspector Demo Version Limitations

i Inzpect

e 'ﬁ Exceptions

=-&# Object Pool
- TargetObject

-
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IO LED Component

The 1O LED Component shown in Figure 5.138 contains 8 leds used to
manipulate and display the values of memory at an address specified in the
related dialog box. Led colors are set at the PORT address (red or green)
and the leds states are switched on/off at the DDR address (symbolic
values).

Figure 5.138 10 LED Component
L@ ee e
PORT=54  DDR=5i
Description
When you change the state of leds in this window, the value of the
corresponding bit at the DDR address will change in the Memory
Component window.
Operations
By clicking and changing the state of one led will change the value of the
byte at the DDR address.
If you want to change the color of the leds, you must change the value of
the byte at the PORT address in the Memory Component window.
Thelocation is specified with a string in the form obj ect.value. Possible
objects and their values can be listed in the Inspector component.
Menu
The 10 LED Menu shown in Figure 5.139 contains the Setup command.
This command opens the Led setup dialog shown in Figure 5.140 and
allows you to specify the PORT and DDR addresses.
Figure 5.139 10 LED Menu
_ sew |
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Figure 5.140 10 LED Setup Dialog

Led Setup E3 |

Configure Addresses

FORT |2-||:|
LOR 12

Set Target
Target

ak. I Cancel

Associated Popup Menu
Identical to menu.

Drag Out

Nothing can be drag out.
Drop Into

Nothing can be dropped into.
Associated Commands
.None.

Demo Version Limitations

No limitation
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LED Component

The LED component shown in Figure 5.141 isavisual utility that displays
an arbitrary 8 bit value by means of a LED bar.

Figure 5.141 LED Component
G@ei00v0
PORT=4D
Description
The LED component displays the value in a bit-wise manner with the most
significant bit to the left, and the least significant bit to the right. Bits with
value 0 are shown using agreen LED, and bitswith value 1 useared LED.
The user can click aLED to toggleits state. The underlying valueis
changed accordingly.
Operations
If you click aLED, its state toggles between green (0) and red (1). The
corresponding bit in the underlying value is changed as well.
Right-click within the component, a popup menu appears with the same
menu entries as listed in the Led menu in the main menu bar.
Menu
The Led menu contains asingle item Setup... that opens the Led Setup
Dialog shown in Figure 5.142.
Led Setup Dialog
Figure 5.142 Led Setup Dialog
Led Setup |
S pecify location
Ok, I Cancel
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In the text field, the user can specify which value should be displayed by
the LED bar. The location is specified with a string in the form

obj ect.value. Possible objects and their values can be listed in the

I nspector Component.

Click OK to accept the specified location. Click Cancel to discard changes
and retain the previous location.

Example

If the specified location is Tar getObject.#210 the LED bar displays the
memory byte at address 0x210.

Drag Out

Currently, nothing can be dragged out of the LED component.
Drop Into

Currently, nothing can be dropped into the LED component.
Demo Version Limitations

No limitation

Associated Command

PORT
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The Phone Component

The phone component shown in Figure 5.143 is an input utility that
provides a graphical keyboard pad that allows you to interactively modify
the value of amemory cell.

Figure 5.143 The Phone Component
& Phone |
900
D66
€00
Features
The phone component displays the front panel of a cellular phone with a
numeric keypad and LCD display. Keys on the keypad can be clicked to
store the corresponding value into the configured memory location. If the
mouse is on top of an active key, the arrow shape of the cursor changesto a
pointing hand. Currently, the LCD component is not operational.
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Operations

Click aphone key and the matching ASCI | character of the label on the key
is stored at the configured memory cell.

Right-click within the component to display a popup menu with the same
menu entries as the Phone menu in the main debugger menu.

Menu

The Led menu contains the Addr ess... command, which opens the Phone
Address dialog shown in Figure 5.144.

Phone Address Dialog

In the text field, the user can specify the address of the memory cell where
keypad characters will be stored. The location is specified with a
hexadecimal number.

Figure 5.144 Phone Address Dialog

Phone Address E3 |

[ Hex Farmat | k. I Eancell Help |

Click OK to accept the specified address. Click Cancel to discard changes
and retain the previous address.

Example

If the specified address is 210, the Phone component keypad is associated
with the memory byte at address 0x210.

Drag Out
Currently, nothing can be dragged out of the Phone component.
Drop Into

Nothing can be dropped into the Phone component.
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Demo Version Limitations

No limitation
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VisualizationTool

The VisualizationTool isavery convenient tool to present your data. For
software demonstration, or for your own debugging session, take
advantage of all itsvirtual instruments.

Not only isthe VisualizationTool fully configurable, but itisalso very easy
to use. Y ou can create your own visualization within afew minutes.

The tool consists of a plain workspace that can be equipped with many
different instruments (See Figure 5.145).

Figure 5.145 VisualizationTool
I I=] B3
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Edit Mode and Display Mode

The VisualizationTool may operate in two modes: Display mode or Edit
mode.

The Edit mode is for designing the workspace to suit your needs. In the
Display mode you can then use what you have done in the Edit mode, that
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IS, to view values, interact with your application and instruments, press
buttons, etc.

To switch between these two modes, you can use the toolbar, the context
menu, or the shortcut Ctrl+E.

Add New Instrument

Use the context menu (see Menu ) to add a new instrument.

Selection
The VisualizationTool allows several waysto select instruments.

Y ou can select asingle instrument by left clicking on it, and change the
selection by pressing the tab-key.

To make multiple selections, hold down the control key and left-click on
the desired instruments. Y ou can also left click, hold and move to create a
selection rectangle.

Move

There are two ways to move instruments. First, make your desired
selection. Y ou can then use the mouse to drag the instruments, or use the
cursor keysto move them step by step (hold down the control key to move
the instrument in steps of ten). The move process performed with the
mouse can be broken off by pressing the escape key.

Resize

When you select ainstrument, sizing handles appear at the corners and
along the edges of the selection rectangle. Y ou can resize an object by
dragging its sizing handles, or by using the cursor keyswhile holding down
the shift key. The resize process performed with the mouse can be broken
off by pressing the escape key. Only one instrument can beresized a a
time. Furthermore, each instruments has its own size minimum.

Menu

Once the Visualization Tool component has been launched, its menu
appears in the debugger menu bar.

The menu contains the entries described in Table 5.56.
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Table 5.56  Visualization Tool Menu Description

Menu entry

Description

Properties

Add New Instrument

Paste

Select All

Edit mode

Load Layout

Save Layout

Displays the properties of the currently selected instrument.
Shortcut: <Ctrl+P>

Enables to choose an instrument from the list and add it to the
view.

Pastes an instrument that has been previously copied.
Shortcut: <Ctrl+V>

Sdlects dl the instruments of the view.
Shortcut; <Ctrl+A>

Switches between Display mode and Edit mode. In Edit mode,
thisentry is checked.
Shortcut: <Ctrl+E>

Loads aVisualizationTool-Layout (*. vt | ). The actual
instruments will not be removed.
Shortcut: <Ctrl+L>

Savesthe current layout to afile (*. vt ).
Shortcut: <Ctrl+S>

Associated Popup Menu

The context menu of the VisualizationTool depends on the current
selection. It can contains the entries described in Table 5.57.

Table 5.57  VisualizationTool Popup Menu

Menu entry Context Description
Edit mode aways Switches between Display mode and Edit mode. In
Edit mode, this entry is checked.
Setup aways Shows the Setup dialog of the VisualizationTool.
Debugger Manual DM-231
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Menu entry Context Description
Load Layout Edit mode Loads aVisualizationTool-Layout (*. vt | ).
Save Layout aways Savesthe current layout to afile (*. vt | ).
Add New Edit mode Shows a new popup menu with all available
Instrument instruments.
Properties only one Shows up the property dialog box for the currently
instrument selected instrument.
selected Shortcut: Ctrl + P
Remove at least one Removes al currently selected instruments.
selection Shortcut: Delete
Copy at least one Copiesthe data of the currently selected
selection instruments into the clipboard.
Shortcut; Ctrl + C
Cut at least one Cuts the currently selected instruments into the
selection clipboard.
Shortcut: Ctrl + X
Paste Edit mode Adds instruments, which are temporary stored in
the clipboard, to the workspace.
Shortcut: Ctrl +V
Send to Back at least one Sends the current instrument to the back of the Z-
selection order.
Send to Front at least one Brings the current instrument to the front of the Z-
selection order.
Clone Attributes morethan one Clones the common attributes to all selected
selection instruments according to the last selected.
Shortcut: <Ctrl + Enter>
Align atleasttwo  Givesaccessto a new menu for alignment.
selections
Top Align Alignsthe instruments to the top line of the last

selected instrument.
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Menu entry Context Description

Load Layout Edit mode Loads aVisualizationTool-Layout (*. vt | ).

Save Layout aways Savesthe current layout to afile (*. vt | ).

Add New Edit mode Shows a new popup menu with all available

Instrument instruments.

Properties only one Shows up the property dialog box for the currently
instrument selected instrument.
selected Shortcut: Ctrl + P

Remove at least one Removes al currently selected instruments.
selection Shortcut: Delete

Copy at least one Copiesthe data of the currently selected
selection instruments into the clipboard.

Shortcut; Ctrl + C

Cut at least one Cuts the currently selected instruments into the
selection clipboard.
Shortcut: Ctrl + X

Paste Edit mode Adds instruments, which are temporary stored in
the clipboard, to the workspace.
Shortcut: Ctrl +V

Send to Back at least one Sends the current instrument to the back of the Z-
selection order.

Send to Front at least one Brings the current instrument to the front of the Z-
selection order.

Clone Attributes morethan one Clones the common attributes to all selected
selection instruments according to the last selected.
Shortcut: <Ctrl + Enter>

Align atleasttwo  Givesaccessto anew menu for alignment.
selections
Top Align Alignsthe instruments to the top line of the last

selected instrument.
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Menu entry Context Description

Bottom Align Alignstheinstrumentsto the bottom line of the last
selected instrument.

Left Align Aligns the instruments to the left line of the last
selected instrument.

Right Align Alignsthe instrumentsto the right line of the last
selected instrument.

Size Align Makesthe size of al selected instruments the same
asthe last selected.

Vertical Size Align Makes the vertical size of all selected instruments

Horizontal Size Align

the same as the last sel ected.

Makes the horizontal size of all selected
instruments the same as the last selected.

VisualizationTool Properties

Like other instruments, the VisualizationTool itself has got Properties.
There are several configuration possibilities for the VisualizationTool,
shown in Table 5.58. To view the property dialog box of the

VisualizationTool, use the shortcut <CTRL-P> or double click on the

background.

Table 5.58 VisualizationTool Properties

Menu entry Description

Edit mode Switches from Edit mode to Display mode.

Display Scrollbars Switches the scrollbars on, off, or setsit to automatic mode.

Display Headline Switches the headline on or off.

Backgroundcolor Specifies the background color of the VisualizationTool.
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Menu entry

Description

Grid Mode

Grid Size

Grid Color

Refresh Mode

Specifies the grid mode. There are four possibilities: ’ Off,’
"Show grid but no snap,” ’ Snap to grid without showing the
grid,” or * Show the grid and snap onit.’

Specifies the distance between two grid points (vertical,
horizontal).

Specifies the color of the grid points.

Specifies the way the window will be refreshed. Y ou may
choose between: “ Automatic, Periodical, Each access, Cpu

Cycles'.

Instruments

When you first add an instrument, it isin “move mode’. Placeit at the
desired location on the workspace. All new instruments are set to their
default attributes. To configure an instrument, right-click on an instrument
and choose ' Properties’, or double click oniit.

All instruments have these common attributes shown in Table 5.59.

Table 5.59 Instruments attributes

Attribute

Description

X-Position
Y -Position
Height
Width

Bounding Box

Specifies the X-coordinate of the upper left corner.
Specifies the Y -coordinate of the upper left corner.
Specifies the instruments height.
Specifies the instruments width.

Specifies the look of the bounding box.
Available displays are: No Box, Flat (outline only), Raised,
Sunken, Etched, and Shadowed.
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Attribute Description

Backgroundcolor Defines the color of the instrument’ s background. The
checkbox enablesto set a color or let the instrument be
transparent.

Kind of Port Specifies the kind of port to be used to get the value to display.
The location must be specified in the ' Port to Display’ field.

Port to Display Defines the location of the value be used for the instrument’s
visualization.

Here are some Examples:

Substitute: TargetObject.#210

Subscribe: TargetObject.#210

Subscribe: PORTB.PORTB (check exact spelling using
Inspector)

Variable: counter

Register: SP

Memory: 0x210

Size of Port If you use the Memory Port, you can also specify the width of
memory to display (up to 4 Bytes).

Analog

The Analog instrument (Figure 5.146) represents the classical pointer
instrument, also known as speedometer, voltage meter...

Figure 5.146  Analog Instrument

a1

Its attributes are shown in the Table 5.60.
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Table 5.60 Analog instruments attributes

Attribute Description

Low Display Value  Defines the zero point of the indicator. The values below this
definition will not be displayed.

High Display Value Definesthe highest position of the indicator. It defines the value
on which the indicator reads 100%.

Indicatorlength Defines the length of the small indicator. The minimal valueis
set to 20.
Indicator Defines the color of the indicator. The default color is red.
Marks Defines the color of the marks. The default color is black.
Bar

Vaues are displayed by a bar strip. Thisinstrument (See Figure 5.147)
may be used as a position state of a water tank.

Figure 5.147  Bar Instrument

[ I

Its attributes are shown in the Table 5.61

Table 5.61 Bar instruments attributes

Attribute Description

Low Display Value  Defines the zero point of the indicator. The values below this
definition will not be displayed.

High Display Value  Definesthe highest position of the indicator. It definesthe value
on which the indicator reads 100%.

Bardirection Sets the desired direction of the bar that displays the value.

Barcolor Specifies the color of the bar. Default color isred.
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Bitmap

Use this instrument to give a special look to your visualization (Figure
5.148), or to display awarning picture.

Figure 5.148 Bitmap Instrument

Additionally, it can also be used as a bitmap animation. Its attributes are
shown in the Table 5.62

Table 5.62 Bitmap instruments attributes

Attribute Description

Filename Specifies the location of the bitmap. With the button behind,
you can browse for files.

AND Mask Performs a bitwise-AND operation with thisvalue. AND the
value of the selected port. Default valueisO.

EQUAL Mask Thisvalueis compared to the result of the AND operation. The
bitmap is displayed only if both values are the same. Default
valueisO.

In general, for showing the bitmap, following condition has to be true:
(port_memory & ANDmask) == EQUAL mask

A practical example about using the AND and EQUAL masksisfollowing
example:

Y ou want to show in the visualization ataillight of acar. for this you need
bitmaps (e.g. from adigital camera) of all possible states of the taillight
(e.g. flasher on, brake light on, etc.). Usually the status of all lamps are
encoded into a port or memory cell in your application, and each bit in this
cell describesif alampison or not. E.g. bit O says that the flasher is on,
where bit 1 says that the brake light is on. So for your simple application
you need following bitmaps with their settings:

- no light on bitmap: AND mask 3, EQUAL mask 0
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- flasher on bitmap: AND mask 3, EQUAL mask 1
- brake light on bitmap: AND mask 3, EQUAL mask 2
- brake and flasher light on: AND mask 3, EQUAL mask 3

DILSwitch

Thisinstrument is also known as Dual-in-Line Switch (Figure 5.149). It is
mainly used for configuration purpose.

You can useit for viewing or setting bits of one to four bytes.

Figure 5.149  DILSwitch Instrument
PTETTAYL
Its attributes are listed in the Table 5.63.
Table 5.63  DIL Switch instruments attributes
Attribute Description
Display 0/1 When enabled, displays the value of the bit under each plot of
the DIL Switch instrument.
Switch Color Specifiesthe color of the switch.
Knob
Normally known as an adjustment instrument, for example the volume
control of aradio (Figure 5.150).
Figure 5.150 Knob Instrument

Its attributes are shown in the Table 5.64
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Table 5.64

Figure 5.151

Table 5.65

Attribute

Knob instruments attributes

Description

Low Display Vaue

High Display Value

Indicator Color

Knob Color

LED

Defines the zero point of the indicator. The values below this
definition will not be displayed.

Definesthe highest position of theindicator. It definesthe value
on which the indicator reads 100%.

Defines the color and the width of the pen used to draw the indi-
cator.

Defines the color of the knob side.

Thisinstrument is used for observing one definite bit of one byte (Figure
5.151). There are only two states: On and Off.

=

Led Instrument

Its attributes are shown in the Table 5.65

Attribute

LED instruments attributes

Description

Bitnumber to Display Defines the bit of the given byte to be displayed.

Color if Bit==

Color if Bit==

Defines the color if the given bit is set.

Defines the color if the given bit is not set.

7 Segment Display

The well known display instrument for numbers and characters: it has
seven segments and one point. These eight units represent eight bits of one
byte (Figure 5.152).
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Figure 5.152 7 Segment Instrument

:
0

Its attributes are shown in the Table 5.66

Table 5.66 7 Segment Display instruments attributes

Attribute

Description

Decimamode

Sloping

Display Version

Color if Bit==

Color if Bit==

Outlinecolor

Switch

Displaysthefirst four or the second four bits of one bytein
hexadecimal mode. When it is switched off, each segment will
represent one bit of one byte.

Switches the sloping on or off.

Selects the appearance of the instrument. There are two
versions available.

Defines the color of an activated segment. Y ou may also set the
color to transparent.

Defines the color of a deactivated segment. Y ou may also set
the color to transparent.

Definesthe color of the segment outlines. Y ou may also set the
color to transparent.

Use thisinstrument to set or view adefinite bit (Figure 5.153). The switch
instrument also provides an interesting debugging feature: you can let it
simulate bounces, and thus check wether your algorithm is robust enough.
Four different looks of the switch are available: slide switch, toggle switch,
jumper or push button.
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Figure 5.153  Switch Instrument

¥ 0 @

Its attributes are shown in Table 5.67.

Table 5.67 Switch instruments attributes.

Attribute Description

Bitnumber to Display Specifies the number of the bit you want to display.

Display 0/1 Enablesto display the value of the bit in its upper left corner.

Top Positionis Specifiesif the'up’ position is either zero or one. Especially
useful to easily transform the push button into a reset button.

Kind of Switch Changes the look of the instrument. Following kinds of
switches are available: Slide Switch, Toggle Switch, Jumper,
Push Button.
The behavior of the Push Button slightly differsfrom the others,
sinceit returnsto itsinitial state as soon as it has been released.

Switch Color Specifies the color of the switch.

Bounces If enabled, gives access to the following other attributes to
configure the way the switch will bounce.

Nb Bounces Specifies the number of bounces before stabilization.

Bounces on Edge

Type of Unit

Pulse Width (100ms)

Specifies wether the switch will bounce on falling, rising or
both edges.

Synchronizes the frequency of the bouncing either on the timer
of your host machine, or on CPU cycles.

Defines the duration of one bounce. This attribute should be
filledinif you chose “Host Periodical” in the “Type of Unit”
attribute.
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Attribute

Description

CPU Count

This attribute represents the number of CPU cycles to reach
before the switch changesiits state. It should befilled in if you
chose “CPU Cycles’ inthe “Type of Unit” attribute.

Text Instrument

Thisinstrument has several functions: Static Text, Value, Relative Value,
and Command (Figure 5.154).

Figure 5.154  Text Instrument

|1Falue:

Please use’ Text Mode' to switch between the five modes. Its common
attributes are shown in the Table 5.68

Table 5.68 Text instruments attributes

Attribute Description

Text Mode Specifies the mode. Choose among four modes : Static Text,
Value, Relative Value, and Command

Displayfont Defines the desired font. All installed Windows fonts are
available.

Horiz. Text Specifies the desired horizontal alignment of the text in the

Alignment given bounding box.

Vert. Text Alignment

Textcolor

Specifiesthe desired vertical alignment of the text in the given
bounding box.

Defines the color of the given text.

'Static Text’ isused for adding descriptions on the workspace. Its
attributes are shown in the Table 5.69
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Table 5.69  Static Text attributes

Attribute Description

Field Description Contains the text to be displayed.

"Value' isused for displaying avalue in different ways (decimal,
hexadecimal, octal, or binary). Its attributes are shown in the Table 5.70

Table 5.70 Value attributes

Attribute Description

Field Description Contains the additional description that will be displayed in
front of the value. Add a colon and/or space as you wish. The
default setting is"Value: "

Format mode Defines the format. Choose among this list: Decimal,
Hexadecimal, Octal, and Binary formats.

'Relative Valu€e' isused for showing avalue in arange of O up to 100% or

1000%e.. Its attributes are shown in the Table 5.71

Table 5.71 Relative value attributes

Attribute Description

Field Description Add the additional description text to be displayed in front of
the value. Add a colon and/or space if desired. The default
setting is"Value: "

Low Display Value  Fixesthe minimal value that will represent 0%. Values below
this definition will appear as an error: #ERROR.

High Display Value  Fixesthe maximal value that will represent 100%. Values
above this definition will appear as an error: #ERROR..

Relative Mode Switches between percent and permill.
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"Command’. With thisinstrument you can specify a command that will be
executed by clicking on thisfield. For more information about commands,
read the chapter * Simulator/Debugger Commands'. Its attributes are shown
inthe Table 5.72

Table 5.72 Command attributes

Attribute Description

Field Description Contains the text that will be displayed on the button.
Command Contains the command-line command to be executed after

pressing the button.

"CMD Callback’ The same as command, but with one difference: The
returned value will be shown as text instead of ' Field Description’. Its
attributes are shown in the Table 5.73

Table 5.73 CMD Callback attributes

Attribute Description
Field Description Warning: thereis no useto fill out hisfield as the text will be
overwritten the first time you execute the specified command.
Command Contains the command line command to be executed after
pressing the button.
Drop Into

In Edit mode, the drag and drop functionality supplies avery easy way to
automatically configure an instrument.

To assign avariable, simply drag it from the Data Window onto the
instrument.

The“kind of Port” isimmediately set on “Memory” and the “Port to
Display” field contains now the address of the variable. Now repeat the
drag-and-drop on a bare portion of the VisualizationTool window: a new
text instrument is created, with correct port configuration.
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Some other components allow this operation:

* The memory window: select bytes and drag-and-drop them onto the
instrument.

» The Inspector component: pick an object from the object pool.

Demo Version Limitations

If you work in demo mode, you will only be able to load one
VisudizationTool window. The number of instrumentsis limited to three.
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Control Points

This chapter provides an overview of the debugger breakpoints and
watchpoints.

Click any of the following links to jump to the corresponding section of
this chapter:

e Control points introduction

» Breakpoints setting dialog

» Define Breakpoints

» Watchpoints setting dialog

e General Rulesfor Halting on a Control Point
» Define Watchpoints

Control points introduction

There are two kinds of control points. breakpoints and watchpoints (also
called data breakpoints). Breakpoints are located at an address,
watchpoints are located at a memory range. Watchpoints start from an
address, have arange, and aread and/or write state. Breakpoints have an
address and can be temporary or permanent. Y ou can set or disable a
control point, set a condition and an optional command, and set the current
count and counting interval.

Y ou can see and edit control point characteristics through two dialogs: The
first oneisthe “Breakpoints setting dialog” and the second is

the" Watchpoints setting dialog”. These two dialogs have common
properties that allow you to interactively perform the following operations
on control points:

» Selecting asingle control point from alist box and clicking Delete.
» Selecting multiple control points from alist box and clicking Delete.

» Enabling/disabling a selected control point by checking/unchecking the
related checkbox.
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 Enabling/disabling multiple control points by checking/unchecking the
related checkbox.

» Enter or modify the condition of a selected control point.

» Enabling/disabling the condition of a selected control point by
checking/unchecking the related checkbox.

» Enter or modify the command of a selected control point.

» Enabling/disabling the command of a selected control point by
checking/unchecking the related checkbox.

 Enabling/disabling multiple control point commands by selecting
control points and checking/unchecking the related checkbox.

» Modifying the counter and/or limit of a single control point.

With breakpoints, the following operations are also available:

» Enabling/disabling halting on a single temporary breakpoint by
checking/unchecking the matching checkbox.

» Enabling/disabling halting on multiple temporary breakpoints by
checking/unchecking the matching checkboxes.

With watchpoints, the following operations are also available:

» Enabling/disabling halting on a single read and/or write access by
checking/unchecking the corresponding checkboxes.

» Enabling/disabling halting on multiple read and/or write accesses by
checking/unchecking the corresponding checkboxes.

* Defining the memory range controlled by the watchpoint.
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Breakpoints setting dialog

The Breakpoints setting dialog is shown in Figure 6.1

Figure 6.1

= Source _ O] x|

|C:4hivare \DEMO4estfibo.c |Line; 18

unsigned int Fibonacci(unsigned int n) { ¥ ;I
unsigned £ibl, £iba, fibao:

Breakpoints setting dialog

vhile (i <= n) {[FE
fibl + £ibZ:

tibl = fib&;

int i;
Breakpoints Setting
fibkl = 0: e
fib2 = 1; ‘FO35: fibo.o. Fibonacei+13 - E: 1
; . FO44; fibo.o. Fibonacci+28 ; E; 2
Hﬁl}f'jz_ 0 FO58; fibo. o Fibonacci+48 - E- 1,
T = &5 FOED; fibo.o Fibonacci+bE (E; T

- fibZ = fibo: — Breakpaint :
'gl}*‘“ Address: [1035 F Disable
Temparar
returnifibo) ; W Hex format
F I I I ame: Fibonacci
— Condition:
Conditior: Ifib'2'==1|:| " Digable
— Command:
[T Disable
Command: ISDC 0xC200 ™ Continue

— Counter:

Current |1 Irbersal:

add | Update | Delete |

—

General:
’]_ Save & Festore on load

(] I Cancell Help |

Breakpoint Symbols

Temporary breakpoint symbol: _[;.I
Permanent breakpoint symbol: _H
Disabled breakpoint symbol: mﬁ
A counting breakpoint symbol: -I-H
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Conditional breakpoint symbol: -[-H

Description of the Dialog

The Breakpoints setting dialog consists of ;

alist box that displaysthelist of currently defined breakpoints

a“Breakpoint:” group box that displays the address of the currently
selected breakpoint, name of procedure in which the breakpoint has
been set, state of the breakpoint (disabled or not), and type of
breakpoint (temporary or permanent).

a“Condition:” group box that displaysthe condition string to evaluate,
and the state of the condition (disabled or not).

a“Command:” group box that displaysthe command string to execute
and the state of the command (disable or continue after command
execution).

a“Counter:” group box that displays the current value of the counter
and interval value of the counter.

NOTE  Current and Interval values are limited to 2,147,483,647; if entering a
number greater than this value, a beep occurs and the character is not
appended.

TIP  Whenthe Interval value is changed, the Counter value is automatically set
to the Interval value.

a“Delete” button to remove the currently selected breakpoint.
an Update button to Update all modificationsin the dialog.

an Add button to add new breakpoints; specify the Address (in
hexadecimal when Hex format is checked or as an expression when
Hex format is unchecked).

an OK button to validate all modifications.
a Cancel button to ignore al modifications.
aHelp button to open related help information.
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Multiple selections in the dialog

The list box allows you to select multiple consecutive breakpoints by

clicking the first breakpoint then |7 Ehift I + click the last breakpoint
you want to select.

The list box allows you to select multiple breakpoints that are not
consecutive by clicking the first breakpoint then | Ctri ! + click
another breakpoint.

When multiple breakpoints are selected in the list box, the name of the
group box Breakpoint: is changed to Selected breakpoints..

When selecting multiple breakpoints, the Address (hex), Name;,
Condition:, Disable for condition, Command, Current:, and I nterval:
controls are disabled.

When multiple breakpoints are selected, the Disable and Temporary
controlsin the Selected breakpoints: group box are enabled and Disable
in the Command: group box is enabled.

Checking condition in dialog

Y ou can enter an expression in the condition edit box. The syntax of the
expression will be checked when you select another breakpoint in the list
box or click OK. The syntax is parameters = = expression. For aregister
condition the syntax is $Register Name = = expression.

If asyntax error has been detected, a message box is displayed:
“I'ncorrect Condition. Do you want to correct it?".
If you click OK, correct the error in the condition edit box.

If you click Cancdl, the condition edit box is cleared.
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NOTE

Listing 6.1

Saving Breakpoints

The Simulator/Debugger provides away to store all defined breakpoints of
the currently loaded application (. ABS file) into the matching breakpoints
file. The matching file has the same name as the loaded . ABS file but its
extensionis. BPT (for example, the FI BO. ABS file hasabreakpoint file
caled FI BO. BPT). Thisfileis generated in the same directory as the

. ABS file. Thisisatext file, in which a sequence of commandsis stored.
Thisfile contains the following information.

* The Save & Restoreon load flag (Save & Restore on load checkbox
in Breakpoints setting dialog): the SAVEBP command is used:
SAVEBP on when checked, SAVEBP off when unchecked.

See ad'so SAVEBP command in Appendix.

» List of defined breakpoints: the BS command is used, as shown in
Listing 6.1.

.BPT File Syntax

BS address [P| T[ state]][;cond="condition”[ state]]
[; cmd="command”[ state]][;cur=current|[ inter=interval]]
[; cdSz=codeSi ze[ sr Sz=sourceSi ze]]

addressisthe address where the breakpoint is to be set. This addressis
specified in ANSI C format. address can also be replaced by an
expression as shown in the example below.

P, specifies the breakpoint as a permanent breakpoint.

T, specifies the breakpoint as a temporary breakpoint. A temporary
breakpoint is deleted once it is reached.

stateisE, D or C where E isfor enabled (state is set by default to E if
nothing is specified), D isfor disabled and C for Continue.

condition is an expression. It matches the Condition field in the
Breakpoints setting dialog, for conditional breakpoint.

command is any debugger command. It matches the Command field in
the Breakpoints setting dialog, for associated commands.
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current isan expression. It matches the Current field (Counter) in the
Breakpoints setting dialog, for counting breakpoints.

interval isan expression. It matches the Interval field (Counter) in the
Breakpoints setting dialog, for counting breakpoints.

codeSizeisan expression. It isusually a constant number to specify (for
security) the code size of afunction where a breakpoint is set. If the size
specified does not match the size of the function currently loaded in the
ABSfile, the breakpoint is set but it is disabled.

sour ceSizeisan expression. It isusually a constant number to specify (for
security) the source (text) size of afunction where abreakpoint is set. If the
size specified does not match the size of the function in the source file, the
breakpoint is set but it is disabled.

» If Save & Restoreon load is checked and the user quits the Simulator/
Debugger or loads another .ABSfile, al breakpoints will be saved.

» If Save & Restoreon load is unchecked (default), only thisflag
(SAVEBP off) is saved.

Example
Case 1: if FI BO. ABSisloaded, and Save & Restore on load was

checked in aprevious session of the same . ABS file, and breakpoints have
been defined, the FI BO. BPT looks as shown in Listing 6.2.

Listing 6.2 Example of Breakpoint file with Save & Restore on load
checked.

savebp on

BS &fi bo. c: Fi bonacci +19 P E; cond = "fibo > 10" E, cdSz = 47 srSz
=0

BS &fi bo.c: Fi bonacci+31 P E; ¢cdSz = 47 srSz = 0

BS & ibo.c:main+l2 P E, cdSz = 42 srSz = 0

BS &fibo.c:main+21 P E; cond =" fiboCount==5" E; cmd =" Assembly < spc 0x800" E;
cdSz=42sSz=0

Case 2: if FI BO. ABSisloaded, and Save & Restore on load was
unchecked in a previous session of the same. ABS file and breakpoints
have been defined, the FI BO. BPT looks as shown below:

savebp on
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TIP

NOTE

Only the flag has been saved and breakpoints have been removed.

If only one or few functions differ after arecompilation, not all BP will be
lost. To achieve that, BPs are disabled only if the size of afunction has
changed. The size of afunction is evaluated in bytes (when it is compiled)
and in characters (number of characters contained in the function source
text). When a. ABS fileisloaded and the matching . BPT file exists, for
each BS command, the Simulator/Debugger checksif the code size (in
bytes) and the source size (in characters) are different in the matching
function (given by the symbol table). If thereisadifference, the breakpoint
will be set and disabled. If there is no difference, the breakpoint will be set
and enabled.

For more information about this syntax, see BS and SAVEBP commands.

Define Breakpoints

Breakpoints are control points associated with a PC value (i.e. program
execution is stopped as soon as the PC reaches the value defined in a
breakpoint). The Simulator/Debugger supports different types of
Breakpoints:

» Temporary breakpoints, which are activated next timetheinstructionis
executed.

» Permanent breakpoints, which are activated each time the instruction is
executed.

» Counting breakpoints, which are activated after the instruction has been
executed a certain number of times.

» Conditional breakpoints, which are activated when agiven condition is
TRUE.

Breakpoints may be set in a Source or Assembly component.

ldentify all Positions Where a Breakpoint Can
Be Defined

When using a high level language some compound statements (statement
that can be split in several base instructions) can be generated, as shownin
the following example.
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i Sourco [0/
| 85 ourcestibo.c |Lire; 241 |Fibonacei
i= 2: :I :I
while (1 <= n) {[F mr. r7, b
= fibl + fibZ: mr. ré, kb
fibhl = fibz; _| = addi rd, r4, 1
fibhZz = fibo: cuplu crfs, rd, k3
=] i+ ble crf5, Ox003f£czZ90
[ 1 mr. r3, k&
return(fibo) ; - blr
4| | v nflr rl ﬂ

The Simulator/Debugger helps you detect all positions where you can set a
breakpoint.

1. Right-click in the Sour ce component. The Source Popup Menu is
displayed on the screen.

2. Choose Marksfrom the Popup Menu. All statementswhere a
breakpoint can be set are identified by a special mark: #*]

To remove the breakpoint marks, right-click in the Source component and
choose Marks again.

Define a Temporary Breakpoint
A temporary breakpoint is recognized by the following icon: _[;:I
The Simulator/Debugger provides two ways to define atemporary
breakpoint:

* Use Popup Menu

1. Point at a C statement in the Source Component window and right-
click. The Sour ce Popup Menu is displayed.

2. Choose Run To Cursor from the Popup Menu. The application
continues execution and stops befor e executing the statement.

vy [
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Point at a C statement in the Sour ce Component Window, and x/Ej +

il
A temporary breakpoint is defined, the application continues

execution and stops befor e executing the statement.

Temporary breakpoints are automatically deleted once they have been
activated. If you continue program execution, it will no longer stop on the
statement that contained the temporary breakpoint.

Define a Permanent Breakpoint
A permanent breakpoint is recognized by the following icon: -H

The Simulator/Debugger provides two ways to define a permanent
breakpoint:
* Use Popup Menu

Point at a C statement in the Sour ce Component Window and right-
click. The Sour ce Popup Menu is displayed.

Select Set BreakPoint from the Popup Menu. A per manent breakpoint
mark isdisplayed in front of the selected statement.

. Use\./@ + P I
Point at a C statement in the Sour ce Component window, and x/Ej +

vl

A permanent breakpoint mark isdisplayed in front of the selected
statement.

Once a permanent breakpoint has been defined, you can continue program
execution. The application stops before executing the statement.
Permanent breakpoints remain active until they are disabled or deleted.

Define a Counting Breakpoint

A Counting breakpoint is recognized by the following icon: .|.H
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Counting breakpoints can only be set using the Breakpoints setting dialog.
There are currently three ways to open this dialog:

. uge~/Ej+IS_|

1. Point at a C statement in the Source Component Window, and x/Ej +

S |

2.  TheBreakpoints setting dialog box is opened and a new breakpoint is
inserted in thelist of breakpointsdefined in the application.
» Use Source Popup Menu

1. Point at a C statement in the Source Component window and right-
click. The Sour ce Popup Menu isdisplayed.

2. Choose Set BreakPoint from the Popup Menu. A breakpoint isdefined
on the selected instruction.

3. Point in the Sour ce Component window and right-click. The Source
Popup Menu isdisplayed on the screen.

4.  Choose Show Breakpointsfrom the Popup Menu. The Breakpoints
setting dialog is displayed.
¢ Choose Run>Breakpoints...
1. Point at a C statement in the Sour ce Component window and right-
click. The Sour ce Popup Menu isdisplayed on the screen.

2. Choose Set BreakPoint from the Popup Menu. A breakpoint isdefined
on the selected instruction.

3.  Choose Run>Breakpoints.... The Breakpoints setting dialog is
displayed.

Once the Breakpoints setting dialog is opened:

* You can select the breakpoint you want to modify by clicking on the
corresponding entry in the list of defined breakpoints.

* You can specify the interval for the breakpoint detection in the
Interval field.

» Then close the Breakpoints setting dialog box by clicking OK.

If you continue program execution, the content of the Current field is
decremented each time theinstruction containing the breakpoint is reached.
When Current isequal to O, the application stops. If the checkbox
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Temporary is unchecked (not atemporary breakpoint), Current is
reloaded with the value stored in interval in order to enable the counting
breakpoint again.

Define a Conditional Breakpoint

A conditional breakpoint is recognized by the following icon: '['H

Conditional breakpoints can only be set using the Breakpoints setting
dialog. There are three ways to open this dialog:

. U%\/@ + S I
Point at a C statement in the Sour ce Component window, and x/Ej +

5]

The Breakpoints setting dialog box is opened and a new breakpoint is
inserted in thelist of breakpointsdefined in the application.

» Use Source Popup Menu

Point at a C statement in the Sour ce Component window and right-
click. The Sour ce Popup Menu isdisplayed.

Select Set BreakPoint from the Popup Menu. A breakpoint is defined
on the selected instruction.

Point in the Sour ce Component window and right-click. The Sour ce
Popup Menu isdisplayed.

Select Show Breakpoints from the Popup Menu. The Breakpoints
Setting dialog is displayed.
¢ Choose Run>Breakpoints...

Point at a C statement in the Sour ce Component window and right-
click. The Sour ce Popup Menu is displayed.

Choose Set BreakPoint from the Popup Menu. A breakpoint isdefined
on the selected instruction.

Choose Run>Breakpoints... The Breakpoints Setting dialog is
displayed.

Once the Breakpoints setting dialog is opened:
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* You can select the breakpoint you want to modify by clicking on the
corresponding entry in the list of defined breakpoints.

* You can specify the condition for breakpoint activation in the field
Condition. The condition must be specified using the ANSI C syntax
(Example counter == 7). Y ou can use register values in the breakpoint
condition field with the following syntax: $Register Name (Example
$RX == 0x10)

» Then you can close the Breakpoints setting dialog box by clicking OK.

If you continue program execution, the condition will be evaluated each
time the instruction containing the conditional breakpoint isreached. When
the condition is TRUE, the application stops.

Delete a Breakpoint

The Simulator/Debugger provides four ways to delete a breakpoint:
» UseDelete Breakpoint from Popup Menu

1. Inthe Source component, point at a C statement where a breakpoint
has previously been defined and right-click. The Source Popup Menu
isdisplayed.

2.  Choose Delete Breakpoint from the Popup Menu. The breakpoint is
deleted.

. Use\./@'l' D I
1. Inthe Source Component, point at a C statement wher e a breakpoint

has previously been defined, and x/Ej + D |

2.  Thebreakpoint isdeleted.
» Choose Show Breakpoints... from Source Popup Menu

1.  Paint in the Source Component Window and right-click. The Source
Popup Menu isdisplayed.

2. Choose Show Breakpoints from the Popup Menu. The Breakpoints
Setting dialog is displayed.

In thelist of defined breakpoints, select the breakpoint to delete.

Click Delete. The selected breakpoint isremoved from thelist of
defined breakpoints.

5.  Click OK to closethe Breakpoints Setting dialog box.
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» Choose Run>Breakpoints...

Choose Run>Breakpoints... The Breakpoints Setting dialog is
displayed.

Select the breakpoint to deletein the list of defined breakpoints.

Click Delete. The selected breakpoint isremoved from thelist of
defined breakpoints.

Click OK to closethe Breakpoints setting dialog box. Theicon
associated with the deleted breakpoint isremoved from the sour ce
component.

Associate a Command with a Breakpoint

Each breakpoint (temporary, permanent, counting or conditional) can be
associated with a debugger command. This command can be specified in
the Breakpoints setting dialog box. There are two ways to open this dialog
box:

» Choose Show Breakpoints... from Source Popup Menu.
Point in the Sour ce Component Window and right-click. The Source
Popup Menu isdisplayed.
Choose Show Breakpoints from the Popup M enu. The Breakpoints
setting dialog is displayed.

» Choose Run>Breakpoints...
Choose Run>Breakpoints... The Breakpoints setting dialog is
displayed.
Once the Breakpoints Setting dialog is opened:

— You can select the breakpoint to modify by clicking on the
corresponding entry in the list of defined breakpoints.

— You can enter the command in the Command field. The
command is asingle debugger command (at this level, the
commands G, GO and STOP are not allowed). A command file
can be associated with a breakpoint using the command CAL L
or CF (Example: CF breakCmd.cmd).

— Click OK to close the Breakpoints setting dialog box.

When the breakpoint is detected, the command is executed and the
application will stop.
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The Continue check button allows the application to continue after the
command is executed.

Demo Version Limitations

Only 2 breakpoints can be set.
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Watchpoints setting dialog

Figure 6.2 shows the dialog used to set Watchpoints.

Figure 6.2 Watchpoints setting dialog
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Description of the Dialog

The Watchpoints Setting dialog is based on:

» alist box that displaysthelist of currently defined watchpoints.

» a“Watchpoint:” group box that displays the address of the currently
selected watchpoint, size of the watchpoint, name of the procedure or
variable on which the watchpoint has been set, state of the watchpoint
(disabled or not), read access of the watchpoint (enabled or not) and
write access of the watchpoint (enabled or not).
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NOTE

TIP

* a“Condition:” group box that displays the condition string to evaluate
and the state of the condition (disabled or not).

» an Update button to Update all modificationsin the dialog.

» a“Command:” group box that displaysthe command string to execute
and state of the command (disabled or continue after command
execution).

» Delete: Click delete button to remove currently selected watchpoint
and select the watchpoint that is below the removed watchpoint.

e OK: Click OK to validate all modifications.

» Add button: adds new watchpoints; specify the Addressin
hexadecimal when Hex for mat is checked or as an expression when
Hex for mat is unchecked.

» Counter: group box that displays the current value of the counter and
interval value of the counter.

Current and Interval values are limited to 2,147,483,647. A beep occurs
and the character is not appended, if anumber greater than thisvalueis
entered.

When the Interval value is changed, the Counter value is automatically set
to the Interval value.

» Cancd: Click cancel button to ignore all modifications.

» Help: Click help button to display help file and related help
information.

Multiple selections in the dialog
For breakpoints, you can do multiple selections with |7 Shift I and

ctrl ! .

When multiple watchpointsin the list box are selected, the name of the
group box “Watchpoint:” is changed to “ Selected watchpoints.”.

When multiple watchpoints are selected, the Address (hex), Size:, Name:,
Condition:, Disable for condition, Command, Current:, and I nterval:
controls are disabled.

Debugger Manual

DM-263

For More Information: www.freescale.com



wr
PR

contwrol Points

Freescale Semiconductor, Inc.

General Rules for Halting on a Control Point

When multiple watchpoints are selected in the list box, the Disable, Read
and Write controls in the Selected watchpoints: group box are enabled.

When multiple watchpoints are selected, Disable in the Command: group
box is enabled.

Click Delete when multiple watchpoints are selected to remove
watchpoints from the list box.

Checking condition in the dialog

Y ou can enter an expression in the condition edit box. The syntax of the
expression will be checked when you select another watchpoint in the list
box or by clicking OK.

If asyntax error has been detected, a message box is displayed:
“I'ncorrect Condition. Do you want to correct it?".
Click OK to correct the error in the condition edit box.

Click Cancel to clear the condition edit box.

Demo Version Limitations

Only 2 watchpoints can be set.

General Rules for Halting on a Control Point

Counting Control Point: If theinterval property is greater than 1, a
counting control point has been defined. When the ssmulator is running,
each time the control point is reached, its current value is decremented and
the simulator will halt when the value reaches zero (0). When the simulator
stops on the control point, acommand will be executed (if defined and
enabled).

Conditional Control Point: If a condition has been defined and enabled
for acontrol point that halts the simulator, acommand will be executed (if
defined and enabl ed).

Control Point with command: When the simulator halts on the control
point, a specified command is executed.
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NOTE

Watchpoints are control points associated with amemory range. Program
execution stops when the memory range defined by the watchpoint has
been accessed. The Simulator/Debugger supports different types of
watchpoints:

» Read Access Watchpoints, which are activated when aread access
occurs inside the specified memory range.

» Write Access Watchpoints, which are activated when awrite access
occurs inside the specified memory range.

» Read/Write Access Watchpoints, activated when aread or write access
occurs inside the specified memory range.

» Counting watchpoint, activated after a specified number of accesses
occur inside the memory range.

» Conditional watchpoints, activated when an access occurs inside the
memory range and a given condition is TRUE.

Watchpoints may be set in a Data or Memory component.

Due to hardware restrictions, the watchpoint function might not be
implemented on hardware targets.

Defining a Read Watchpoint

A green vertical bar isdisplayed in front of a variable associated with a
read access watchpoint.

The Simulator/Debugger provides two ways to define a read access
watchpoint:

* Use Popup Menu

Point at avariablein the Data Component Window and right-click.
The Data Popup Menu isdisplayed.

Choose Set Watchpoint from the Popup Menu. A Read/Write
Watchpoint is defined.

Point in the Data Component Window and right-click. The Sour ce
Popup Menu isdisplayed.

Choose Show WatchPoints from the Popup Menu. The Watchpoints
setting dialog is displayed.
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Select the watchpoint you want to define as read access.
Select the Read typein the dropdown box.
A read access watchpoint isdefined for the selected variable.

. Use\./@'l' R I
Point at a variablein the Data Component Window and x/Ej + R |

A read access watchpoint isdefined for the selected variable.

Once aread access watchpoint has been defined, you can continue program
execution. The application stops after detecting the next read access on the
variable. Read access watchpoints remain active until they are disabled or
deleted.

Defining a Write Watchpoint

A red vertical bar isdisplayed in front of avariable associated with awrite
access watchpoint.

The Simulator/Debugger provides two ways to define awrite access
watchpoint:

* Use Popup Menu

Point at a variable in the Data Component Window and right-click.
The Data Popup Menu isdisplayed.

Choose Set Watchpoint from the Popup Menu. A Read/Write
Watchpoint is defined.

Point in the Data Component Window and right-click. The Sour ce
Popup Menu isdisplayed.

Choose Show WatchPoints from the Popup Menu. The Watchpoints
setting dialog is displayed.

Select the watchpoint you want to define aswrite access.

Select the Writetypein the dropdown box.

A write access watchpoint is defined for the selected variable.

. ugex/Ej{M
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Point at a variablein the Data Component Window and ~/Ej + W |
A write access watchpoint isdefined for the selected variable.

Once awrite access watchpoint has been defined, you can continue
program execution. The application stops after the next write access on the
variable. Write access watchpoints remain active until they are disabled or
deleted.

Defining a Read/Write Watchpoint

A yellow vertical bar isdisplayed in front of avariable associated with a
read/write access watchpoint.

The Simulator/Debugger provides two ways to define a read/write access
watchpoint:
* Use Popup Menu

Point at avariablein the Data Component Window and right-click.
The Data Popup Menu isdisplayed.

Choose Set Watchpoint from the Popup Menu.
A read/write access watchpoint isdefined for the selected variable.

. U%\/@"‘ E I
Point at a variablein the Data Component Window and ~/Ej + B |

A read/write access watchpoint isdefined for the selected variable.

Once aread/write access watchpoint has been defined, you can continue
program execution. The application stops after the next read or write access
on the variable. Read/write access watchpoints remain active until they are
disabled or deleted.

Defining a Counting Watchpoint

A counter can be associated with any type of watchpoint described
previoudy (read, write, read/write).

The Simulator/Debugger provides two ways to define a counting
watchpoint:
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* Use Popup Menu

1. Point at avariablein the Data Component Window and right-click.
The Data Popup Menu isdisplayed.

2. Choose Set Watchpoint from the Popup Menu. A Read/Write
Watchpoint is defined.

3. Point in the Data Component Window and right-click. The Source
Popup Menu isdisplayed.

4.  Choose Show WatchPoints from the Popup Menu. The Watchpoints
setting dialog is displayed.
Select the watchpoint you want to define as a counting watchpoint.
From the dropdown box, select the type of access you want to track.

Intheinterval field, specify theinterval count for the watchpoint.
Close the Watchpoints Setting dialog box by clicking OK.

8. A counting watchpoint isdefined for the selected variable.

Choosex-/Ej+ S |
1. Point atavariableintheDataComponentWindowand~/Ej+ S |

The Watchpoints setting dialog is displayed.
Select the watchpoint you want to define as a counting watchpoint.

From the dropdown box, select the type of accessyou want to track.

Intheinterval field, specify theinterval count for the watchpoint.
Close the Watchpoints setting dialog box by clicking OK.

5. A counting watchpoint isdefined for the selected variable.
If you continue program execution, the Current field is decremented each
time an appropriate access on the variable is detected. When Current is

equal to 0, the application stops. Current is reloaded with the value stored
in the interval field to enable the counting watchpoint again.

Defining a Conditional Watchpoint

A condition can be associated with any type of watchpoint described
previously (read, write, read/write).
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The Simulator/Debugger provides two ways to define a conditional
watchpoint:

* Use Popup Menu

Point at avariablein the Data Component Window and right-click.
The Data Popup Menu isdisplayed.

Choose Set Watchpoint from the Popup Menu. A Read/Write
Watchpoint is defined.

Point in the Data Component Window and right-click. The Sour ce
Popup Menu isdisplayed.

Choose Show WatchPoints from the Popup Menu. The Watchpoints
setting dialog is displayed.

Select the watchpoint you want to define as a conditional watchpoint.
From the dropdown box, select the type of accessyou want to track.

Specify the condition for the watchpoint in the Condition field. The
condition must be specified using the ANSI C syntax (Example:
counter ==7). Close the Watchpoints setting dialog box by clicking
OK.

A conditional watchpoint is defined for the selected variable.

° U%\/@+ S I
Point at a variablein the Data Component Window and ~/Ej + |8 |

The Watchpoints setting dialog is displayed.

Select the watchpoint you want to define as a conditional watchpoint.

From the dropdown box, select the type of accessyou want to track.

» Specify the condition for watchpoint activation in the Condition field.
The condition must be specified using the ANSI C syntax (Example:
counter == 7). You can use register valuesin the breakpoint condition
field with the following syntax: $Register Name (Example $RX ==
0x10)

Close the Watchpoints setting dialog box by clicking OK.
A conditional watchpoint is defined for the selected variable.
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If you continue program execution, the condition will be evaluated each
time an appropriate access on the variable is detected. When the condition
iIs TRUE, the application stops.

Deleting a Watchpoint

The Simulator/Debugger provides four ways to delete a watchpoint:
» Use Delete Breakpoint from Popup Menu

In the Data Component, point to a variable where a watchpoint has
been defined and right-click. The Data Popup Menu isdisplayed.

Select Delete Watchpoint from the Popup Menu. The watchpoint is
deleted and the vertical bar in front of the variableisremoved.

. uSex/Ej+ID_|

In the Data Component, point at a variable where a watchpoint has

been defined and \-/Ej + |D |

Thewatchpoint isdeleted and the vertical bar in front of the variable
isremoved.

» Choose Show Watchpoints from Data Popup Menu
Point in the Data Component Window and right-click. The Data
Popup Menu isdisplayed.
Choose Show Watchpoints from the Popup Menu. The Watchpoints
setting dialog is displayed.
Select the watchpoint you want to delete.

Click Delete. The selected watchpoint isremoved from the list of
defined watchpoints.

Click OK to close the Watchpoints setting dialog box. The watchpoint
isdeleted and the vertical bar in front of the variableisremoved.

» Choose Run>Watchpoints menu command

Choose Run>Watchpoints.... The Watchpoints setting dialog is
displayed.

Select the watchpoint you want to delete.

Click Delete. The selected watchpoint isremoved from the list of
defined watchpoints.
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4. Click OK to closethe Watchpoints setting dialog box. The watchpoint
isdeleted and the vertical bar in front of thevariableisremoved.

Associate a Command with a Watchpoint

Each watchpoint type (read, write, read/write, counting, or conditional) can
be associated with a debugger command. This command can be specified
in the Watchpoints setting dialog box. There are two ways to open this
dialog box:

* Choose Show Watchpoints... from Data Popup Menu
1. Point in the Data Component Window and right-click. The Data
Popup Menu isdisplayed.
2. Select Show Watchpoints from the Popup Menu. The Watchpoints
setting dialog is displayed.
¢ Choose Run>Watchpoints...
1. Choose Run>Watchpoints.... The Watchpoints setting dialog is
displayed.
Once the Watchpoints setting dialog is open:
Click on the corresponding entry in the list of defined breakpointsto
select the watchpoint you want to modify.

4.  You can enter thecommand in the Command field. Thecommand isa
single debugger command. At thislevel, the commands G, GO and
STOP arenot allowed. A command file can be associated with a
breakpoint using the commands CALL or CF (Example CF
breakCmd.cmd).

Click OK to close the Watchpoints setting dialog box.

When the watchpoint is detected, the command will be executed and
the application will stop at this point. The Continue check button
allowsthe application to continue after command execution.
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Debugger Commands

The debugger supports scripting with the use of commands and command
files. When you script the debugger, you can automate repetitive, time-
consuming, or complex tasks.

Click any of the following links to jump to the corresponding section of
this chapter:

» Simulator/Debugger Commands

Simulator/Debugger Commands

Y ou do not need to use or have knowledge of commands to run the
Simulator/Debugger. However these commands are useful for editing
debugger command files, for example, after a recording session, to

generate your own command files, or to set up your applications and
targets, etc.

This section provides a detailed list of all Simulator/Debugger commands.
All command names and component names are case insensitive. The
command EBNF syntax is:

component [:component number] <] command

where component is the name of the component that you can read in each
component window title. For example: Data, Register, Source, Assembly,
etc. Component number isthe number of the component. This number
does not exist in the component window titleif only one component of this
typeisopen. For example, you will read Register or Memory. If you open
a second Memory component, the initial one will be renamed Memory:1
and the new one will be called Memory:2. A number is automatically
associated with a component if there are several components of the same
type displayed.
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Example:

in>Memory:2 < SMEM 0x8000,8

‘<* redirects a command to a specific component (in this example:
Memory:2). Some commands are valid for several or all components and
if the command is not redirected to a specific component, all components
will be affected. Also, a mismatch could occur due to the fact that a
command’ s parameters could differ for different components.

Syntax of Simulator/Debugger command

To display the syntax of a command, type the command followed by a
question mark.

Example:
I n>printf?
PRI NTF (<format>, <expression> <expression>, ...)
List of Available Commands
Commands described on the following pages are sorted in 5 groups,
according to their specific actions or targets. However, these groups have
no relevance in the use of these commands. A list of all commandsin their
respective group is given below:
Kernel Commands
Kernel commands are commands that can be used to build command
programs. They can only be used in a debugger command file, since the
Command Line component can only accept one command at atime. It is
possible to build powerful programs by combining Kernel commands with
Base commands, Common commands and Component specific commands.
Table 7.1 contains all available Kernel commands.
Table 7.1  List of Kernel Commands
Command, Syntax Short Description
A affectsavalue
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Command, Syntax

Short Description

AT
CALL fileName[;C][;NL]

DEFINE symbol [=]
expression

ELSE
EL SEIF condition

ENDFOCUS

ENDFOR
ENDIF

ENDWHILE

FOCUS component

FOR [variable =]range[“,”
step]

FPRINTF
(fileName,format, parameters)

GQOTO label

GOTOIF condition Label
IF condition
PAUSETEST

PRINTE (“Text:,” value])
REPEAT

RETURN

sets atime delay for command execution

executes acommand file

defines a user symbol

other operation associated withl F command

other conditional operation associated withl F
command

resets the current focus (refer to FOCUS
command)

exitsaFOR loop

exits an | F condition
exitsaWHILE loop

sets the focus on a specified component

FOR loop instruction

FPRINTF instruction

unconditional branch to alabel in a command
file

conditional branch to alabel in acommand file
conditional execution

displays a modal message box

PRINT instruction

REPEAT loop instruction

returns from a CALL command
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Command, Syntax Short Description

TESTBOX displays a message box with a string
UNDEF symbol | * undefines a userdefined symbol
UNTIL condition condition of aREPEAT loop

WAIT [time] [;] command file execution pause
WHILE condition WHILE loop instruction
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Base Commands

Base commands are used to monitor the Simulator/Debugger target
execution. Target input/output files, target execution control, direct
memory editing, breakpoint management and CPU register setup are
handled by these commands. Base commands can be executed independent
of components that are open. Table 7.2 contains all available Base

commands.

Table 7.2

Command, Syntax

Base Commands

Short Description

BC address}*

BS addressffunction
[P|T[state]]

CD [path]

CR [fileName][;A]
DASM
[addressjrange][; OBJ]
DB [address|range]
DL [addressrange]
DW [address|range]

G [address]

GO [address|

LF [fileName][;A]

LOG type [=] state{[,] type

[=] state}
MEM

deletes a breakpoint (breakpoint clear)

sets a breakpoint (breakpoint set)

changes the current working directory
opens arecord file (command records)

disassembles

displays memory bytes
displays memory bytes as longwords
displays memory bytes as words

starts execution of the application currently
loaded

starts execution of the application currently
loaded

opensalogfile

enables or disables logging of a specified
information type

displays the memory map
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Command, Syntax Short Description

MSrangelist sets memory bytes

NOCR closes the record file

NOLF closesthelog file

P [address] single assembly steps into program

RESTART restart the loaded application

RD [list]*] displays the content of registers

RS sets aregister

register[=]value{ register[=]va

lue}

S stops execution of the loaded application

STEPINTO stepping to the next source instruction of the
loaded application

STEPOUT executes program out of afunction call

STEPOVER stepping over the next source instruction of the
loaded application

STOP stops execution of the loaded application

SAVEBP on|off saves breakpoints

T [address|[,count] traces program instructions at the specified
address

WB range list writes bytes

WL rangelis writes longwords

WW range list writes words
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Table 7.3

Environment Commands

Simulator/Debugger environment commands are used to monitor the
debugger environment, specific component window layouts and
framework applications and targets. Table 7.3 contains all available
Environment commands.

Command, Syntax

Environment Commands

Short Description

ACTIVATE component
AUTOSIZE on|off
BCKCOLOR color
CLOSE component | *

DDEPROTOCOL
ON|OFF|SHOW/|HIDE|STATUS

FONT ‘fontName’
[size][color]

LOAD applicationName

LOADCODE
applicationName

LOADSYMBOLS
applicationName

OPEN component [[x y width

height][;][ijmax]]

OPENIO locomponentname

REGBASE <address> :R
REGFILE filename

activates a component window

autosize windows in the main window layout

set the background color
close a component

configure the Debugger/Simulator DDE
protocol

sets text font

load aframework application (code and debug
information)

load the code of aframework application

load debugging information of a framework
application

open a Windows component

open an 1/Os component
set the base address of the I/O register

load aregistration entriesfile
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Command, Syntax Short Description

SET targetName set anew target

SETCPU ProcessorName set anew cpu simulator

SLAY fileName save the general window layout

Component Commands

Component common commands are used to monitor component behaviors.
They are common to more than one component and for better usage, they

should be redirected (as explained in the introduction of Debugger

Commands). Table 7.4 contains al available Component commands.

Table 7.4  List of Component Command

Command, Syntax Short Description

CMDEFILE specify a command file state and full name
EXIT terminates the application

HELP displays alist of available commands
LOADMEM fileName loads a memory configuration file
RESET resets statistics

RESETCYCLES resets Simulator CPU cycles counter
RESETMEM resets all configured memory to ‘ undefined’
RESETRAM resets RAM to ‘ undefined’

RESETSTAT resets the statistical data

SHOWCYCLES returns executed Simulator CPU cycles
SMEM range shows a memory range
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Command, Syntax

Short Description

SMOD module

SPC address

SPROC level

VER

shows module information in the destination
component

shows the specified address in a component
window

shows information associated with the
specified procedure

displays version number of components and
engine

Component Specific Commands

Component specific commands are associated with specific components.
Table 7.5 contains all available Component Specific commands.

Table 7.5 Component Specific Commands

Command, Syntax

Short Description

ADCPORT (address|ident) (
address | ident ) ( address |
ident )

ADDCHANNEL ("Name")

ADDXPR “expression”
ATTRIBUTES list

BASE code | module
BD
CF fileName [;C][:NL]

CLOCK frequency

sets the ports addresses used by the Adc_Dac
component.

creates a new channel "Name" for the Monitor
component.

adds anew expression in the data component
sets up the display inside a component window
setsthe Profiler base

displaysalist of all breakpoints

executes acommand file

sets the clock speed
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Command, Syntax

Short Description

COPY MEM <Source addr
range> dest-addr

CPORT ( address|ident) (
address | ident ) ( address |
ident ) (‘address|ident )(
address | ident)

CYCLE on|off
DELCHANNEL ("Name")

DETAILS assembly|source
DUMP

E expression [;O|D|X|C|B]
EXECUTE fileName

FILL rangevalue

FILTER Options [<range>]

FIND “string” [;B] [;MC]
[;WWw]

FINDPROC ProcedureName
FOLD [*]

FRAMES number
GRAPHICS on|off

INSPECTOROUTPUT [name
{'subname} ]

INSPECTORUPDATE

ITPORT ( address | ident ) (
address | ident )

copy memory

setsthe 5 port addresses and control port
address of the |0_Ports component

switches cycles and milliseconds

deletes the channdl "Name" from the Monitor
component

sets split view

displays data component content
evaluates a given expression
executes a stimulation file
fillsamemory range with avalue
Select the output file filter options

finds and highlights a pattern

opens aprocedurefile

folds a source block

sets the maximum number of frames
switches graphic bars on/off

prints content of Inspector to Command
window

updates content of 1nspector

sets the line and column port addresses of the
IT_Keyboard component
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Command, Syntax Short Description

ITVECT (address |ident) sets the interrupt vector port address of the
IT_Keyboard component.

KPORT (address | ident ) ( sets the line and column port addresses of the
address | ident ) Keyboard component

LCDPORT (address|ident) ( setsthe data port and the control port address
address | ident ) of the Lcd component

LINKADDR (address|ident) setsthe componentsinternal port addresses
(address | ident ) ( address | used with the 10_Ports as memory buffers
ident )( address | ident )(

address | ident )

LS[symbol | *][;C|S] displays the list of symbols

NB [base] sets the base of arithmetic operations
OPENFILE fileName opens astimulation file

OUTPUT fileName redirects the coverage component results

PBPORT ( address | ident ) sets the port address of the Push_Buttons

component
PORT address sets the Led components port address
PTRARRAY on|off switches on /off the pointer as array display
RECORD on|off switches on/off the frame recorder

SEGPORT (address|ident) ( set the display selection port and the segment

address | ident selection port addresses of the 7-Segments
display component.
INE linenumber shows the desired line number
SAVE range fileName saves amemory block in S-Record format
[offset][;A]

SETCOLORS ("Name") (  changesthe colors attributes of the "Name"
Background) (Cursor) ( Grid channel from the Monitor component
) (Line) (Text)
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Command, Syntax Short Description

SETCONTROL ("Name") ( changesthe number of ticks and pixels for the

Ticks) (Pixels) "Name" channel from the Monitor component
SREC fileName [of fset] loads a memory block in S-Record format
TUPDATE onl|off switches on/off time update for statistics
UNFOLD [*] unfolds a source block

UPDATERATE rate sets the data and memory update mode
WPORT ( address|ident) ( sets the ports addresses of the Wagon

address | ident component

ZOOM address injout zoomsin/out avariable

NOTE

NOTE

Definitions of Terms Commonly Used in
Command Syntaxes

addr ess is a number matching amemory address. This number
must be in the ANSI format (i.e. $ or Ox for hexadecimal value, O for octal,
etc.).

Please see also Constant Standard Notation.

Example: 255, 0377, OxFF, $FF

addr ess can also be an “expression” if “constant address’ is not
specially mentioned in the command description. An “expression” can be:
Global variables of application, 1/0 registers defined in DEFAULT. REG
definitions in the command line, numerical constants. See also section
EBNF Notation for “Expression” Definition in EBNF.

Example: DEFINE IO_PORT = 0x210

WB IO_PORT OxFF
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range iscomposition of 2 addresses to define arange of memory
addresses. Syntax is shown below:

address..address

or

address, size

where sizeis an ANSI format numerical constant.
Example:

O0x2F00..0x2FFF

refers to the memory range starting at 0x2F00 and ending at Ox2FFF (256
bytes).

Example:
0x2F00,256

refers to the memory range starting at 0x2F00, which is 256 bytes wide.
Both previous examples are equivalent.

fileNane isaDOS file name and path that identifies afile and
its location. The command interpreter does not assume any file name
extension. Use backslash (\) or slash (/) as adirectory delimiter.

The parser is case insensitive. If no path is specified, it looks for (or edits)
the filein the current project directory, i.e. when no path is specified, the
default directory isthe project directory.

Example:

d: / deno/ nyfile.txt
Example:

| ayout . hwl

Example:
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d: /wor k/ pr oj ect. hwe

conponent is the name of a debugger component. A list of all
debugger componentsis given by choosing Component>Open... The
parser is case insensitive.

Example:
Memory
Example:
SoUrCe
About Module Names

Correct module names are displayed in the Module component window.
Make sure that the module name of a command that you implement is
correct:

If the. abs isin HIWARE format, some debug information isin the
object file (. 0), and module names have a. o extension (e.g., fibo. 0).

In ELF format, module name extensionsare. ¢, . cppor . dbg (. dbg for
program sources in assembler) (e.g., f i bo. ¢), since all debugging
informationiscontained inthe. abs file and object filesare not used.

Please consider or adapt the examples given in Appendix with your . abs
application file format.

A

Description ~ The A command assigns an expression to an existing variable. The quoted
expression must be used for string and enum expressions.

Usage A variable=vaueor A variable = "value"
Components  Debugger engine.

Example:

i n>a count er =8

The variable counter isnow equal to 8.
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I n>A dayl = "nonday_8U' (Monday_8U is defined in an Enunm

The variable day1 is now equal to monday_8U.

i n>A value = "3.3"

The variable value is now equal to 3.3

ACTIVATE

Description ~ ACTIVATE activates acomponent window asif you clicked on itstitle
bar. The window is displayed in the foreground and itstitle bar is
highlighted. If the window isiconized, itstitle bar is activated and
displayed in the foreground.

usage  ACTIVATE component
Components  Debugger engine.

Example:

I n>ACTI VATE Menory

Thiscommand activates the Memory Component and brings the window to
the foreground.

ADDCHANNEL

Description ~ The ADDCHANNEL command is used to create a new channel for the
Monitor component.

usage ADDCHANNEL ("Name")

Name is the name for the new channel.
Components  Monitor component.

Example:

i N>ADDCHANNEL "Leds. Port _Register bit 0"

A new channel Leds.Port_Register bit O will be created in the Monitor
component.
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ADCPORT

Description ~ The ADCPORT command is used to set the ports addresses used by the
Adc_Dac component.

Usage ADCPORT (address|ident) (address|ident) ( address |ident)

Addresslocates the port address value of the component ( many formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.
Components  ADC_DAC component.

Example:

I N>ADCPORT 0x100 0x200 0x300

The ports of the ADC_DAC component are now defined at the addresses
0x100, 0x200 and 0x300.

ADDXPR

uUsage ADDXPR “expression’

Where the parameter expression is an expression to be added and evaluated
in the data component.

Components  Data component.
Description ~ The ADDXPR command adds a new expression in the data component.

Example

i n>ADDXPR “counter + 10"

The expression “counter +10” is added in the data component.

ATTRIBUTES
This command effective for various component is described in the next
section.
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In the Command Component

Description ~ The ATTRIBUTES command allows you to set the display and state
options of the Command component window. The CACHESIZE command
setsthe cache size in lines for the Command Line window: The cache size
value is between 10 and 1000000.

NOTE  Usually thiscommand is not specified interactively by the user. However
this command can be written in acommand fileor alayout (" . HWL" ) file
to save and reload component window layouts. An interactive equivalent
operation istypically possible, using Simulator/Debugger menus and
operations, drag and drops, etc., as described in the following sectionsin
“Equivaent Operations’.

usage ATTRIBUTESIist
where list=command{ ,command} )

command=CACHESIZE vaue

Example

command < ATTRI BUTES 2000

In the Procedure Component

Description ~ The ATTRIBUTES command alows you to set the display and state
options of the Procedure component window. The VALUES and TYPES
commands display or hide the Values or Types of the parameters.

usage ATTRIBUTESIist
where liss=command{,command})

command=VALUES (ON|OFF)| TY PES (ON|OFF)
Example

Procedure < ATTRI BUTES VALUES ON, TYPES ON

In the Assembly Component

Description ~ The ATTRIBUTES command allows you to set the display and state
options for the Assembly component window. The ADR command
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displays or hides the address of a disassembled instruction. ON | OFF is
used to switch the address on or off. SMEM (show memory range) and
SPC (show PC address) scroll the Assembly component to the
corresponding address or range code location and select/highlight the
corresponding assembler lines or range of code. The CODE command
displays or hides the machine code of the disassembled instruction. ON |
OFF is used to switch on or off the machine code. The ABSADR
command shows or hides the absolute address of a disassembled
instruction like ‘branch to’. ON | OFF is used to switch on or off the
absolute address. The TOPPC command scrolls the Assembly component
in order to display the code location given as an argument on the first line
of Assembly component window. The SYM B command displays or hides
the symbolic names of objects. ON | OFF is used to switch the symbolic
display on or off.

usage ATTRIBUTESIist
where list=command{,command}

command= ADR (ON|OFF) | SMEM range | SPC address |
CODE(ON|OFF) | ABSADR (ON|OFF) | TOPPC address| SYMB
(ON|OFF)

NOTE Alsorefer to SMEM and SPC command descriptions for more detail about
these commands. The SPC command is similar to the TOPPC command
but also highlights the code and does not scroll to the top of the component
window.

Equivalent Operations
ATTRIBUTES ADR ~ Select menu Assenbl y>Di spl ay Adr

ATTRIBUTES SMEM ~ Select arange in Memory component window
and drag it to the Assembly component window.

ATTRIBUTES SPC ~ Drag aregister to the Assembly component
window.

ATTRIBUTES CODE ~ Select menu Assembly>Display Code

ATTRIBUTES SYMB ~ Select menu Assembly>Display Synbol i ¢
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Example

Assenbly < ATTRI BUTES ADR ON, SYMB ON, CODE ON, SMEM 0x800, 16

Description

Addresses, hexadecimal codes, and symbolic names are displayed in the
Assembly component window, and assembly instructions at addresses
0x800,16 are highlighted.

In the Register Component

The ATTRIBUTES command alows you to set the display and state
options of the Register component window.

The FORMAT command sets the display format of register values.

The VSCROL L POS command sets the current absolute position of the
vertical scroll box (the vposition valueisin lines: each register and bitfield
have the same height, which isthe height of aline). vposition isthe
absolute vertical scroll position. The value O represents the first position at
the top.

The HSCROL L POS command sets the position of the horizontal scroll
box (the hposition valueisin columns: acolumn is about atenth of the
greatest register or bitfield width). hposition is the absolute horizontal
scroll position. The value O represents the first position on the left.

The parameters vposition and hposition can be constant expressions or
symbols defined with the DEFINE command.

The COMPLEMENT command sets the display complement format of
register values: one sets the first complement (each bit is reversed), none
unselects the first complement.
An error message is displayed if:

* the parameter is a negative value

* thescroll box isnot visible

If the given scroll position is bigger than the maximum scroll position, the
current absolute position of the scroll box is set to the maximum scroll
position.

Equivalent Operations

ATTRIBUTES FORMAT ~ Select menu Register >Options
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ATTRIBUTES VSCROLLPOS ~ Scroll vertically in the Register
component window.

ATTRIBUTES HSCROLLPOS ~ Scroll horizontally in the Register
component window.

ATTRIBUTES COMPLEMENT ~ Select menu Register >Options
usage ATTRIBUTESIist

where list=command{,command})

command= FORMAT (hex|bin|dec|udec|oct) | VSCROLLPOS
vposition | HSCROLLPOS hposition | COMPLEMENT (nonejone)

Where vposition=expression and hposition=expression

Example

I n>Regi ster < ATTRI BUTES FORVAT BI N

Contents of registers are displayed in binary format in the Register
component window.

I n>Regi ster < ATTRI BUTES VSCROLLPGS 3

Scrolls 3 positions down. The third line of registersis displayed on the top
of the register component.

I n>Regi ster < ATTRI BUTES VSCROLLPGS 0

Returnsto the default display. Thefirst line of registersis displayed on the
top of the register component.

I Nn>DEFI NE vpos = 5
I n>Regi ster < ATTRI BUTES HSCROLLPOS vpos

Scrolls 5 positionsright. The second column of registersis displayed on the
left of the register component.

I n>Regi ster < ATTRI BUTES HSCROLLPGOS 0O
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Returns to the default display. Thefirst column of registersis displayed on
the left of the register component.

I n>Regi ster < ATTRI BUTES COMPLEMENT One

Description

NOTE

Sets the first complement display option. All registers are displayed in
reverse bit.

In the Source Component

The ATTRIBUTES command alows you to set the display and state
options of the Source component window. The SMEM (show memory
range) command and SPC (show PC address) command loads the
corresponding modul €' s source text, scrollsto the corresponding text range
location or text address location and highlights the corresponding
statements. The SMOD (show module) command |oads the corresponding
modul€e’ s source text. If the module is not found, a messageis displayed in
the Object Info Bar of the Simulator/Debugger Components. The SPROC
(show procedure) command loads the corresponding modul€’ s source text,
scrolls to the corresponding procedure and highlights the statement, that is
in the procedure chain of this procedure. The

number Associated T oProcedur e is the level of the procedure in the
procedure chain. The MARK S command (ON or OFF) displays or hides
the marks.

Also refer to SMEM SPC, SPROC and SMOD command descriptions for
more detail about these commands.

Equivalent Operations

ATTRIBUTES SPC ~ Drag and drop from Register component to Source
component.

ATTRIBUTES SMEM ~ Drag and drop from Memory component to
Source component.

ATTRIBUTES SMOD ~ Drag and drop from Module component to
Source component.

ATTRIBUTES SPROC ~ Drag and drop from Procedure component to
Source component.
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Usage

Example

ATTRIBUTES MARKS ~ Select menu Source>M arks.
ATTRIBUTESist

where liss=command{,command}

command= SPC address| SMEM range | SMOD module (without
extension) | SPROC number AssociatedToProcedure | MARK'S
(ON|OFF)

I n>Sour ce < ATTRI BUTES MARKS ON

Description

Usage

Marks are visible in the Source component window.

In the Data Component

The ATTRIBUTES command allows you to set the display and state
options of the Data component window. The FORMAT command selects
the format for the list of variables. The format is one of the following:
binary, octal, hexadecimal, signed decimal, unsigned decimal or symbolic.

ATTRIBUTES list
where liss=command{,command})

command=FORM AT (bin|oct|hex|signed|unsigned|symb)| SCOPE
(global|local|user) | MODE (automatic|periodical| locked|frozen) |
SPROC level | SMOD module | UPDATERATE rate|
COMPLEMENT (nonelone)] NAMEWIDTH width

The M ODE command selectsthe display mode of variables. In Automatic
mode (default), variables are updated when the target is stopped. Variables
from the currently executed module or procedure are displayed in the data
component.

In Automatic mode (default mode), variables are updated when target is
stopped.

In Locked and Frozen mode, variables from a specific module are
displayed in the data component. The same variables are always displayed
in the data component.
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NOTE

In L ocked mode, values from variables displayed in the data component
are updated when the target is stopped.

In Frozen mode, values from variables displayed in the data component
are not updated when the target is stopped.

In Periodical mode, variables are updated at regular time intervals when
the target is running. The default update rateis 1 second, but it can be
modified by steps of up to 100 ms using the associated dialog box or the
UPDATERATE command.

The UPDATERATE command sets the variables update rate (see also
UPDATERATE command).

The SPROC (show procedure) and SM OD (show module) commands
display local or global variables of the corresponding procedure or module.

The SCOPE command selects and displays global, local or user defined
variables.

The COMPLEMENT command sets the display complement format of
Data values. one sets the first complement (each bit is reversed), none
unselects the first complement.

The NAMEWIDTH command sets the length of the variable name
displayed in the window.

Refer to SPROC, UPDATERATE and SMOD command descriptions for
more detail about these commands.

Equivalent Operations

ATTRIBUTES FORMAT ~ Select menu Data>Format...
ATTRIBUTES MODE ~ Select menu Data>M ode...
ATTRIBUTES SCOPE ~ Select menu Data>Scope...

ATTRIBUTES SPROC ~ Drag and drop from Procedure component to
Data component.

ATTRIBUTES SMOD ~ Drag and drop from Module component to Data
component.
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Example

ATTRIBUTES UPDATERATE ~ Select menu Data>M ode>Periodical.
ATTRIBUTES COMPLEMENT ~ Select menu Data>Format...

ATTRIBUTES NAMEWIDTH ~ Select menu Data>Options...>Name
Width...

Data: 1 < ATTRI BUTES MODE FROZEN

Description

In Data: 1 (global variables), variables update is frozen mode. Variables
are not refreshed when the application is running.

In the Memory Component

The ATTRIBUTES command alows you to set the display and state
options of the Memory component window. The WORD command selects
the word size of the memory dump window. Theword size number can be
1 (for “byte” format), 2 (for “word” format - 2 bytes) or 4 (for “long”
format - 4 bytes). The ADR command ON or OFF displays or hides the
addressin front of the memory dump lines. The ASC command ON or
OFF displays or hides the ASCII dump at the end of the memory dump
lines. The ADDRESS command scrolls the corresponding memory dump
window and displays the corresponding memory address lines (memory
WORD isnot selected). SPC (show pc), SMEM (show memory) and

SM OD (show module) scroll the Memory component accordingly, to
display the code location given as argument, and select the corresponding
memory area (SPC selects an address, SMEM selects a range of memory
and SM OD selects the module name whom global variable would be
located in the window).

The FORMAT command selects the format for the list of variables. The
format is one of the following: binary, octal, hexadecimal, signed decimal,
unsigned decimal or symbolic.

The COMPLEMENT command sets the display complement format of
memory values. one sets the first complement (each bit is reversed), none
unselects the first complement.

The M ODE command selects the display mode of memory words. In
Automatic mode (default), memory words are updated when the target is
stopped. Memory words from the currently executed module or procedure
are displayed in the Memory component.
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NOTE

Usage

In Automatic mode (default mode), memory words are updated when
target is stopped.

In Frozen mode, value from memory words displayed in the Memory
component are not updated when the target is stopped.

In Periodical mode, memory words are updated at regular time intervals
when the target isrunning. The default update rateis 1 second, but it can be
modified by steps of up to 100 ms using the associated dialog box or
UPDATERATE command.

The UPDATERATE command sets the variables update rate (see also
UPDATERATE command).

Also refer to SMEM, SPC and SMOD command descriptions for more
detail about these commands.

Equivalent Operations

ATTRIBUTES FORMAT ~ Select menu M emor y>For mat
ATTRIBUTES WORD ~ Select menu M emory>Word Size
ATTRIBUTES ADR ~ Select menu Memory>Display>Address
ATTRIBUTES ASC ~ Select menu M emor y>Display>ASCI |
ATTRIBUTES ADDRESS ~ Select menu M emory>Address...
ATTRIBUTES COMPLEMENT ~ Select menu M emor y>For mat

ATTRIBUTES SMEM ~ Drag and drop from Data component (variable)
to Memory component.

ATTRIBUTES SMOD ~ Drag and drop from Source component to
Memory component.

ATTRIBUTES MODE ~ Select menu Memory>Mode...

ATTRIBUTES UPDATERATE ~ Select menu
Memory>M ode>Periodical

ATTRIBUTES list
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where liss=command{,command})

command=FORM AT (bin|oct|hex|signed|unsigned) | WORD number |
ADR (ON|OFF) | ASC (ON|OFF) | ADDRESS address| SPC address
| SMEM range| SMOD module | M ODE (automatic|periodical| frozen)
| UPDATERATE rate | COMENT (NONE|ONE)

Example

Menory < ATTRI BUTES ASC OFF, ADR OFF

ASCII dump and addresses are removed from the Memory component
window.

In the Inspector Component

Description ~ The ATTRIBUTES command allows you to set the display and state of
the Inspector component window.

usage ATTRIBUTESIist
where liss=command{,command})

command= COLUMNWIDTH columnname columnfield columnsize |
EXPAND [name {subname}] deep |

COLLAPSE name {subname}|

SELECT name {subname} |

SPLIT pos|

MAXELEM ( ON | OFF ) [number] |

FORMAT (Hex|Int)

The COLUMNWIDTH command sets the width of one column entry on
the right pane of the Inspector Window. The first parameter (columnname)
specifies which column. The following column names currently exist:

* Names- simple name list

* Interrupts - interrupt list

» Symbol TableFunction - function in the Symbol Table

» ObjectPool Object - Object in Object Pool without additional
information

» Events- event list
» Components - component list
» SymbolTableVariable - variable or differentiation in the Symbol Table
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» ObjectPoollOBase - Object in Object Pool with additional information
» Symbol TableModules - non |OBase derived Object in the Object Pool

The column field is the name of the specific field, which is also displayed
in the Inspector Window.

The following commands set the width of the function names to 100:

I nspect < ATTRI BUTES COLUVNW DTH Synbol Tabl eModul es Nane 100

NOTE Dueto the “inspect <* redirection, only the Inspector handles this
command.

The EXPAND command computes and displays all subitems of a specified
item up to agiven depth. An item is specified by specifying the complete
path starting at one of theroot itemslike “ Symbol Table” or “ Object Pool”.
Names with spaces must be surrounded by double quotes.

To expand all subitems of TargetObject in the Object Pool up to 4 levels,
the following command can be used:

I nspect < ATTRI BUTES EXPAND “ (bj ect Pool” Target Gbject 4

NOTE  Because the name Object Pool contains a space, it must be surrounded by
double quotes.

TIP  The symbol Table, Stack or other Items may have recursive information.
So it may occur that the information tree grows with the depth. Therefore,
specifying large expand values may use a large amount of memory.

The COLLAPSE command folds one item. The item name must be given.
The following command folds the TargetObject:

I nspect < ATTRI BUTES COLLAPSE “ (bj ect Pool” Target Qbj ect

The SELECT command shows the information of the specified item on
the right pane. The following command shows al Objects attached to the
TargetObject:
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N

I nspect

ATTRI BUTES SELECT “(bj ect Pool” Target Qbj ect

The SPLIT command setsthe position of the split line between the left and
right pane. The value must be between 0 and 100. A value of 0 only shows
theright pane, avalue of 100 showstheleft pane. Any value between 0 and
100 makes arelative split. The following command makes both panes the
same size:

N

I nspect

ATTRI BUTES SPLIT 50

The MAXELEM command sets the number of subitemsto display. After
the following command, the Inspector will prompt for 1000 subitems:

N

I nspect

ATTRI BUTES MAXELEM ON 1000

The FORMAT command specifies whether integral values like addresses
should be displayed as hexadecimal or decimal. The following command
specifies the hexadecimal display:

N

I nspect

ATTRI BUTES FORMAT Hex

Usage

Equivalent Operations

ATTRIBUTES COLUMNWIDTH ~ Modify column width with the
mouse.

ATTRIBUTES EXPAND ~ Expand any item with the mouse.
ATTRIBUTES COLLAPSE ~ Collapse the specified item with the mouse.
ATTRIBUTES SELECT ~ Click on the specified item to select it.

ATTRIBUTES SPLIT ~ Move the split line between the panes with the
mouse.

ATTRIBUTES MAXELEM ~ Select max. Elements... from the context
menu.

AT
AT time
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where time=expression and expression is interpreted in milliseconds.
Components  Debugger engine.

Description ~ The AT command temporarily suspends a command file from executing
until after a specified delay in milliseconds. The delay is measured from
the time the command fileis started. In the event that command files are
chained (one calling another), the delay is measured from the time the first
command fileis started.

NOTE  Thiscommand can only be executed from a command file. The time
specified is relative to the start of command file execution.

Example

AT 10 OPEN Command

This command (in command file) opens the Command L ine component
10 ms after the command file is executed.

AUTOSIZE

Description ~ AUTOSIZE enables/disables windows autosizing. When on, the size of
component windows are automatically adapted to the Simulator/Debugger
main window when it is resized.

Usage AUTOSIZE on|off
Components  Debugger engine.

Example

i N>AUTCSI ZE of f

Windows autosizing is disabled.

BASE

Description  Inthe Profiler component, the BASE command sets the profiler base to
code (total code) or module (each module code).

Usage  BASE codelmodule
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Components

Example

Profiler component.

in>BASE code

Description

NOTE

Usage

Components

Example

BC

BC deletes a breakpoint at the specified address. When * is specified, all
breakpoints are deleted.

Y ou can point to the breakpoint in the Assembly or Source component
window, right-click and choose Delete Breakpoint in the popup menu, or
open the Breakpoints setting dialog and choose Show Breakpoint, select
the breakpoint and click Delete.

Correct module names are displayed in the Module component window.
Make sure that the module name of your command is correct: if the . abs
isin HIWARE format, some debug information isin the object file (. 0),
and module names have a. o extension (e.qg., f i bo. 0). In ELF format,
module name extensionsare. ¢, . cpp or . dbg (. dbg for program
sources in assembler) (e.g., fi bo. c¢), since all debugging informationis
contained inthe . abs file and object files are not used. Adapt the
following examples with your . abs application file format.

BC address|*

addressisthe address of the breakpoint to be deleted. This addressis
specified in ANSI C or standard Assembler format. address can also be
replaced by an expression as shown in the example below.

When * is specified all breakpoints are deleted.
Debugger engine.

i n>BC 0x8000

This command deletes the breakpoint set at the address 0x8000. The
breakpoint symbol is removed in the source and assembly window. The
breakpoint is removed from the breakpoint list.
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Example

i n>BC &FI BO. C: Fi bonacci

Description

NOTE

Usage

Components

Example

In this example, an expression replaces the address. FIBO.C isthe module
name and Fibonacci is the function where the breakpoint is cleared.

BCKCOLOR
BCKCOL OR sets the background color.

The background color defined with the BCKCOL OR command isvalid for
all component windows. Avoid using the same color for the font and
background, otherwise text in the component windows will not be visible.
Also avoid using colors that have a specific meaning in the command line
window. These colors are:

Red: used to display error messages.
Blue: used to echo commands.

Green: used to display asynchronous events.

When WHITE is given as a parameter, the default background color for all
component windows is set, for example, the register component is

lightgrey.

BCKCOLOR color

Where color can be one of the following: BLACK, GREY, LIGHTGREY,
WHITE, RED, YELLOW, BLUE, CYAN, GREEN, PURPLE,
LIGHTRED, LIGHTYELLOW, LIGHTBLUE, LIGHTCYAN,
LIGHTGREEN, LIGHTPURPLE

Debugger engine.

I N>BCKCOLCOR LI GHTCYAN

The background color of all currently open component windowsis set to
Lightcyan. To return to the original display, enter BCKCOLOR WHITE.
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BD

Description  Inthe Command Line component, the BD command displaysthe list of al
breakpoints currently set with addresses and types (temporary, permanent).

Usage BD
Components  Debugger engine.

Example

i n>BD

Fi bonacci 0x805c T
Fi bonacci 0x8072 P
Fi bonacci 0x8074 T
main Ox8099 T

One permanent and two temporary breakpoints are set in the function
Fibonacci, and one temporary breakpoint is set in the main function.

NOTE Fromtheligt, it isnot possible to know if a breakpoint is disabled or not.

BS

Description ~ BSsetsatemporary (T) or a permanent (P) breakpoint at the specified
address. If no P or T is specified, the default is a permanent (P) breakpoint.

Equivalent Operation

Y ou can point at a statement in the Assembly or Source component
window, right-click and choose Set Breakpoint in the popup menu, open
the Breakpoints setting dialog and choose Show Br eakpoint, then select
the breakpoint and set its properties.

NOTE  Correct module names are displayed in the Module component window.
Make sure that the module name of your command is correct:
If the. abs isin HIWARE format, some debug information isin the
object file (. 0), and module nameshavea. o extension (e.g., fi bo. o).
In ELF format, module name extensionsare. ¢, . cpp or .dbg ( .dbg for
program sources in assembler) (e.g., fi bo. c), sinceall debugging
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Usage

information iscontained in the. abs file and object files are not used.
Adapt the following examples with . abs application file format.

BS address| function [{ mark}]

[P[T[ state]][;cond="condition”[ state]]
[;emd="command”[ state]][;cur=current| inter=interval]]
[;cdSz=codeSize] srSz=sourceSiz€]]

addressisthe address where the breakpoint is to be set. This addressis
specified in ANSI C format. addr ess can also be replaced by an
expression as shown in the example below.

function is the name of the function in which to set the breakpoint.

mark (displayed mark in Source component window) is the mark number
where the breakpoint is to be set. When mark is:

* >0: the position is relative to the beginning of the function.
» =0: the position is the entry point of the function (default value).
» < 0: the position is relative to the end of the function.

P, specifies the breakpoint as a permanent breakpoint.

T, specifies the breakpoint as a temporary breakpoint. A temporary
breakpoint is deleted once it is reached.

StateisE or D where E isfor enabled (state is set by default to E if nothing
is specified), and D isfor disabled.

condition is an expression. It matches the Condition field in the
Breakpoints setting dialog for a conditional breakpoint.

command is any Debugger command (at this level, the commands G, GO
and STOP are not allowed). It matches the Command field in the
Breakpoints setting dialog, for associated commands. For the Command
function, the states are E (enabled) or C (continue).

current isan expression. It matches the Current field (Counter) in the
Breakpoints setting dialog, for counting breakpoints.
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interval isan expression. It matches the I nterval field (Counter) in the
Breakpoints setting dialog, for counting breakpoints.

codeSizeisan expression. It isusually a constant number to specify (for
security) the code size of afunction where a breakpoint is set. If the size
specified does not match the size of the function currently loaded in the
ABSfile, the breakpoint is set but disabled.

sour ceSizeis an expression. It isusually a constant number to specify (for
security) the source (text) size of afunction where abreakpoint is set. If the
size specified does not match the size of the function in the source file, the
breakpoint is set but disabled.

Components  Debugger engine.

Example

I n>BS 0x8000 T

This command sets atemporary breakpoint at the address 0x8000.

i n>BS $8000

This command sets a permanent breakpoint at the address 0x8000.

BS &FI BO C:. Fi bonacci

In this example, an expr ession replaces the address. FI BO. Cisthe
module name and Fibonacci is the function where the breakpoint is set.

More Examples:

in>BS&main+22PE; cdSz=66 srSz =134

Sets abreakpoint at the address of the main procedure + 22, where the code
size of the main procedure is 66 bytes and its source size is 134 characters.

in>BS Fibo.c:main{ 3}

Sets a breakpoint at the 3rd mark of the procedure main, where main isa
function of the FI BO. C module.
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in>BS & counter + 5; cond ="fib1>fib2":cmd="hckcolor red"

Sets a breakpoint at the address of the variable counter + 5, where the
condition isfibl > fib2 and the command is " bckcolor red” .

in>BS & Fibo.c:Fibonacci+13

Sets a breakpoint at the address of the Fibonacci procedure + 13, where
Fibonacci isafunction of the FI BO. C module.

CALL

Description  Executes command in the specified command file.

NOTE If no path is specified, the destination directory is the current project
directory.

usage  CALL FileName[;C][;NL]
Components  Debugger engine.

Example

i n>cf \util\config.cnd

L oads the config command file.

CD

Description ~ The CD command changes the current working directory to the directory
specified in path. When the command is entered with no parameter, the
current directory is displayed.

The directory specified in the CD command must be avalid directory. It
should exist and be accessible from the PC. When specifying arelative
path in the CD command, make sure the path is relative to the project
directory.
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NOTE  When no path is specified, the default directory isthe project directory.
When using the CD command, all commands referring to afile with no
path specified could be affected.

Usage CD [path]

path: The pathname of a directory that becomes the current working
directory (case insensitive).

Components  Debugger engine.

Example
i n>cd. .
C. \ Metrower ks\ deno
i n>cd

C.\ Met r oner ks\ deno
i n>cd / Metrowerks/ prog
C.\ Metr ower ks\ pr og

The new project directory isC. \ Met r ower ks\ pr og

CF

Description ~ The CF command reads the commands in the specified command file,
which are then executed by the command interpreter. The command file
contains ASCII text commands. Command files can be nested. By default,
after executing the commands from a nested command file, the command
interpreter resumes execution of remaining commands in the calling file.
Any error halts execution of CF file commands. When the command is
entered with no parameter, the Open File dialog is displayed. The CALL
command is equivalent to the CF command.

NOTE If no path is specified, the destination directory is the current project
directory.

usage  CFfileName[;C][;NL]

Where fileName is afile (and path) containing Simulator/Debugger
commands.
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Components

Examples:

; C specifies chaining the command file. This option is meaningful in a
nested command file only.

When the ;C optionis given in the calling file, the command interpreter
quits the calling file and executes the called file. (i.e. in the calling file,
commands following the CF ... ;C command are never executed).

When the option is omitted, execution of the remaining commandsin the
caling fileis resumed after the commands in the called file have been
executed.

;NL: when set, the commands that are in the called file are not logged in
the Command Line window (and not to log file, when afile has been
opened with an LF command), even if the CMDFILE typeis set to ON
(see LOG command).

Debugger engine.

in>CF commands.txt

The COMVANDS. TXT fileis executed. It should contain debugger
commands like those described in the Debugger Commands chapter.

without “;C” option:

if acommandl. t xt file contains;

bckcol or green

cf commuand2. t xt

bckcol or white

if acommand?2. t xt file contains;

bckcol or red

Execution:

i n>cf commandl. t xt
executi ng commandl. t xt

'bckcol or green

I cf command2. t xt

DM-308

Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Debugger Commands
Simulator/Debugger Commands

executi ng command2. t xt

1! bckcol or red

1!

1!

done conmmand2. t xt

I bckcol or white
I

done conmmandl. t xt

with “;C” option:

if acommand1l.txt file contains:

bckcol or green
cf commmand2.txt ; C
bckcol or white

if acommand2.txt file contains:

bckcol or red

Execution:

I n>cf commandl. t xt
executi ng commandl. t xt

' bckcol or green
I'cf command2.txt ;C
executi ng command2. t xt

1! bckcol or red

1!

1!

done conmmand2. t xt

done conmmandl. t xt
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CLOCK
Description  In the SoftTrace component, the CLOCK command sets the clock speed.
usage CLOCK freguency

Where number is a decimal number, which isthe CPU frequency in Hertz.
Components  SoftTrace component.

Example

in>CLOCK 4000000

CLOSE

Description ~ The CLOSE command is used to close a component.

Component names are: Assembly, Command, Coverage, Data, | nspect,
IO _Led, Led, Memory, Module, Phone, Procedure, Profiler, Recorder,
Register, SoftTrace, Source, Stimulation.

usage CLOSE component | *
where * means “all components”.
Components  Debugger engine.

Example

I Nn>CLOSE Menory

The Memory component window is closed (unloaded).

COPYMEM

Description ~ The COPYMEM command is used to copy a memory rangeto a
destination range defined by the beginning address. This command works
on defined memory only. The source range and destination range are tested
to ensure they are not overlayed.

usage COPYMEM <Source address range> dest-address

Components  Memory.
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Example

I n>copynmem Ox3FC2A0. . 0Ox3FC2B0 0x3FC300

The memory from Ox3FC2A0 to 0X3FC2BO0 is copied to the memory at
Ox3FC300 to 0x3FC310. ThisMemory range appearsin red in the Memory
Component.

CMDFILE

Description ~ The CMDFILE command allows you to define all target specific
commands in acommand file. For example, startup, preload, reset, and
path of thisfile.

uUsage CMDFILE <Command File Kind> ON|OFF ["<Command File Full
Name>"]

Components  Simulator/target engine.

Example

in>cndfile postload on "c:\tenp\nyposl oadfile.cnd"

The myposloadfile command file will be executed after loading the absolute
file.
CPORT

Description ~ The CPORT command is used to set the 5 coupler port addresses and the
control port address of the coupler component.

Usage CPORT (address|ident) (address|ident) ( address|ident)...

Addr ess locates the port address value of the component ( many formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.
Components  Programmable parallel Couplers component.

Example:

I Nn>CPORT 0x100 0x200 0x300
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Description

NOTE

NOTE

Usage

Components

Example

The ports of the Programmable parallel Couplerswill be defined at
addresses 0x100, 0x200 and 0x300.

CR

The CR command initiates writing records of commands to an external
file.

Writing records continues until a close record file (NOCR) command is
executed.

Drag & drop actions are a so translated into commands in the record file.

If no path is specified, the destination directory is the current project
directory.

CR [fileName][;A]
If fileName is not specified, a standard Open File dialog is opened.

;A specifiesto open afilefileName in append mode. Records are
appended at the end of an existing record file.

If the ; A option is omitted and fileName is an existing file, thefileis
cleared before records are written to it.

Debugger engine.

i n>cr / Metrowerks/deno/ nyrecord.txt ;A

Description

Usage

Thenyr ecord. t xt fileisopenedin*“Append” mode for arecording
session.
CYCLE

In the SoftTrace component, the CY CL E command displays or hides
cycles. When cycleis off, milliseconds (ms) are displayed.

CY CLE on|off
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Components  Softtrace component.

Example

in>CYCLE on

DASM

Description ~ The DASM command displays the assembler code lines of an application,
starting at the address given in the parameter. If there is no parameter, the
assembler code following the last address of the previous display is

displayed.
This command can be stopped by pressing the [Esc] key.

Equivalent Operation

Right-click in the Assembly component window, select Address... and
enter the address to start disassembly in the Show PC diaog.

Usage DASM [addresgrange][;OBJ]

address: Thisis aconstant expression representing the addr ess where
disassembly begins.

range: Thisis an address range constant that specifies addresses to be
disassembled. When range is omitted, a maximum of sixteen instructions
are disassembled.

When address and range are omitted, disassembly begins at the address of
the instruction that follows the last instruction that has been disassembled

by the most recent DASM command. If thisisthefirst DASM command of
asession, disassembly begins at the current addressin the program counter.

;OBJ: Displays assembler code in hexadecimal.

Components  Debugger engine.

Example for PPC
I n>dasm 0x3f c2f0

3FC2F0 bl a 0x003fc27c

3FC2F4 |is r4, 64

3FC2F8 stw r3, -26624(r4)

3FC2FC addi r31, r31, 1
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3FC300 cnpwi crf5, r31, 25
3FC304 bl e crf5, 0x003fc2d4
3FC308 b 0x003fc2c4
3FC30C | wz r31, 12(r1l)
3FC310 addi rl, rl, 16
3FC314 | wz ro, 4(rl)

3FC318 ntlr ro

3FC31C bl r

NOTE  Depending on the target, the above code may vary.

Disassembled instructions are displayed in the Command Line component
window.

NOTE Itisnecessary to open the Command Line component before executing this
command to see the dumped code.

DB

Description ~ The DB command displays the hexadecimal and ASCII values of the bytes
in aspecified range of memory. The command displays one or more lines,
depending on the address or range specified. Each line shows the address
of thefirst byte displayed in the line, followed by the number of specified
hexadecimal byte values. The hexadecimal byte values are followed by the
corresponding ASCI| characters, separated by spaces. Between the eighth
and ninth values, a hyphen (-) replaces the space as the separator. Each
non-displayable character is represented by a period (.).

This command can be stopped by pressing the [Esc| key.
Usage DB [addresslrange]

When addr essand range are omitted, the first longword displayed is taken
from the address following the last longword displayed by the most recent
DB, DW, or DL command, or from address 0x0000 (for thefirst DB, DW,
DL command of a session).

Components  Debugger engine.
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Examples:

I n>DB 0x8000. . 0x800F

NOTE

8000: FE 80 45 FD 80 43 27 10-35 ED 31 EC 31 69 70 83
b_Ey_C.5ililipf

Memory bytes are displayed in the Command Line component window,
with matching ASCII characters.

It is necessary to open the Command Line component before executing this
command to see the dumped code.

i n>DB &TCR

Description

Usage

Components

0012:5A Z

displaysthe bytethat is at the address of the TCR 1/O register. 1/0 registers
are defined in a DEFAULT. REGfile.

DDEPROTOCOL

The DDEPROTOCOL command is used to configure the Debugger/
Simulator dynamic data exchange (DDE) protocol.

By default the DDE protocol is activated and not displayed in the
command line component.

DDEPROTOCOL ON|OFFISHOW|HIDE|STATUS

Where:

* ON enables the DDE communication protocol
» OFF disables the DDE communication protocol

» SHOW displays DDE protocol information in the command line
component

» HIDE hides DDE protocol information in the command line
component

» STATUSprovidesinformation if the DDE protocol is active (on or off)
and if display is active (Show or Hide)

Debugger engine.
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Example

in>DDEPROTOCOL ON
in>DDEPROTOCOL  SHOW
iIn>DDEPROTOCOL STATUS
DDEPROTOCCL ON - DI SPLAYI NG ON

NOTE

Usage
Components

Description

TIP

Example

The DDE protocol is activated and displayed, and statusis given in the
command line component.

For moreinformation on Debugger/Simulator DDE implementation, please
refer to the chapter Debugger DDE capabilities.

DEFINE
DEFINE symbol [=] expression
Debugger engine.

The DEFINE command creates a symbol and associates the value of an
expression with it. Arithmetic expressions are evaluated when the
command isinterpreted. The symbol can be used to represent the
expression until the symbol is redefined, or undefined using the UNDEF
command. A symbol is amaximum of 31 characterslong. In acommand
line, all symbol occurrences (after the command name) are substituted by
their values before processing starts. A symbol cannot represent a
command name. Note that a symbol definition precedes (and hence
conceals) a program variable with the same name.

Defined symbols remain valid when a new application isloaded. An
application variable or I/O register can be overwritten with aDEFINE
command.

This command can be used to assign meaningful names to expressions,
which can be used in other commands. This increases the readability of
command files and avoids re-evaluation of complex expressions.

i n>DEFI NE addr
i Nn>DEFINE |imt

$1000
= addr + 15
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First addr is defined as a constant equivalent to $1000. Then limit is
defined and affected with the value ($1000 + 15)

A symbol defined in the loaded application can be redefined on the
command line using the DEFINE command. The symbol defined in the
application is not accessible until an UNDEF on that symbol nameis
detected in the command file.

Example A symbol named ‘testCase’ is defined in the test application.

/* Loads application test.abs */
LOAD test.abs

/* Display value of testCase. */
DB t est Case

/ * Redefine synmbol testCase. */
DEFI NE t est Case = $800

/ *Di spl ay val ue stored at address $800. */
DB t est Case

/ * Redefine synbol testCase. */
UNDEF t est Case

/* Display value of testCase. */
DB t est Case

NOTE Alsorefer to examples given for the command UNDEF.

DELCHANNEL

Description ~ The DELCHANNEL command is used to delete a specific channel for the
Monitor component.

usage DELCHANNEL ( "Name")
Name is the name of the channel to delete.
Components  Monitor component.

Example:

i N>DELCHANNEL "Leds. Port_ Register bit 0"

The channel Leds.Port_Register bit O will be deleted in the Monitor
component.
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Description

Usage
Components

Example

DETAILS

In the Profiler component, the DETAIL S command opens a profiler split
view in the Source or Assembly component.

DETAILS assembly|source

Profiler components.

in>DETAILS source

Description

NOTE

Usage

Components

Example

DL

The DL command displays the hexadecimal values of the longwordsin a
specified range of memory. The command displays one or more lines,
depending on the address or range specified. Each line shows the address
of the first longword displayed in the line, followed by the number of
specified hexadecimal longword values.

When asizeis specified in the range, this size represents the number of
longwords that should be displayed in the command line window.

This command can be stopped by pressing the [Esc] key.

Open the Command Line component before executing this command to see
the dumped code.

DL [addresslrange]

When rangeis omitted, the first longword displayed is taken from the
addressfollowing the last longword displayed by the most recent DB, DW,
or DL command, or from address 0x0000 (for the first DB, DW, DL
command of a session).

Debugger engine.

I n>DL 0x8000. . 0x8007

8000: FE8045FD 80432710
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The content of the memory range starting at 0x8000 and ending at 0x8007
isdisplayed as longword (4-bytes) values.

i n>DL 0x8000, 2

Description

Usage
Components

Example

8000: FE8045FD 80432710

The content of 2 longwords starting at 0x8000 is displayed as longword (4-
bytes) values.

Memory longwords are displayed in the Command Line component
window.

DUMP

The DUMP command writes everything visible in the Data component to
the command line component.

DUMP

Data component.

in> Data: 1 < DUMP

Description

NOTE

DW

The DW command displays the hexadecimal values of the wordsin a
specified range of memory. The command displays one or more lines,
depending on the address or range specified. Each line shows the address
of the first word displayed in the line, followed by the number of specified
hexadecimal word values.

When asizeis specified in the range, this size represents the number of
words that should be displayed in the command line window.

This command can be stopped by pressing the [Esc] key.

Open the Command Line component before executing this command to see
the dumped code.
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Usage

Components

Example

DW [address | range]

When addressis an address constant expression, the address of the first
word is displayed.

When address and range are omitted, the first word displayed is taken
from the address following the last word displayed by the most recent DB,
DW, or DL command, or from address 0x0000 (for the first DB, DW, DL
command of a session).

Debugger engine.

i n>DW 0x8000, 4

Description

Usage

8000: FE80 45FD 8043 2710

The content of 4 words starting at 0x8000 is displayed as word (2-bytes)
values.

Memory words are displayed in the Command Line component window.

E

The E command evaluates an expression and displays the result in the
Command Line component window. When the expression is the only
parameter entered (no option specified) the value of the expressionis
displayed in the default number base. The result is displayed as asigned
number in decimal format and as unsigned number in al other formats.

E expression[;O|D|X|C|B]

where:

;O: displaysthe value of expression as an octal (base 8) number.

;D: displays the value of expression as adecimal (base 10) number.

; X: displays the value of expression as an hexadecimal (base 16) number.

;C: displays the value of expression as an ASCII character. The remainder
resulting from dividing the number by 256 is displayed. All values are
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displayed in the current font. Control characters (<32) are displayed as
decimal.

;B: displays the value of expression as a binary (base 2) number.

NOTE Refer to “Expression” Definition in EBNF in Appendix for more detail
about expr essi on.

Components  Debugger engine.

Example

i n>defi ne a=0x12
i n>defi ne b=0x10
i n>e a+b

i Nn>=34

The addition operation of the two previously defined variablesaand b is
evaluated and the result is displayed in the Command Line window. The
output can be redirected to afile by using the LF command (refer to LF
and LOG command descriptions).

ELSE

Description ~ The EL SE keyword is associated with the LF command.
Usage ELSE

Components  Debugger engine.

Example
i f CUR_TARGET == 1000 /* Condition */
set sim
el se set bdi /* Oher Condition */

ELSEIF
Description ~ The EL SEIF keyword is associated with the |F command.

Usage ELSEIF condition

where condition is same as defined in “C” language.
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Components  Debugger engine.
Example
i f CUR_TARGET == 1000 [* Simulator */
set sim
el seif CUR TARGET == 1001 /* BDI */
set bdi
ENDFOCUS
Description ~ The ENDFOCUS command resets the current focus. It is associated with
the FOCUS command. Following commands are broadcast to all currently
open components. This command isonly valid in acommand file.
Usage ENDFOCUS
Components  Debugger engine.
Example

FOCUS Assenbl y

ATTRI BUTES code on

ENDFOCUS
FOCUS Sour ce

ATTRI BUTES nmar ks on

ENDFOCUS

Description
Usage

Components

The ATTRIBUTES command isfirst redirected to the Assembly
component by the FOCUS Assembly command. The code is displayed
next to assembly instructions. Then the Assembly component is released
by the ENDFOCUS command and the second ATTRIBUTES command is
redirected to the Source component by the FOCUS Source command.
Marks are displayed in the Source window.

ENDFOR

The ENDFOR keyword is associated with the FOR command.
ENDFOR

Debugger engine.

DM-322

Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Debugger Commands
Simulator/Debugger Commands

Example
for i =1..5
define nulti5 =5 * |

endf or
After the ENDFOR ingtruction, i isequal to 5.
ENDIF

Description ~ The ENDIF keyword is associated with the |[F command.
Usage ENDIF

Components  Debugger engine.

Example

i f (CUR CPU == 12)
DW &count er

el se
DB &count er

endi f

ENDWHILE

Description ~ The ENDWHILE keyword is associated with the WHIL E command.
Usage ENDWHILE

Components  Debugger engine.

Example
while i <5
define multi5 =5 * |
definei =i + 1
endwhi | e
After the ENDWHILE instruction, i isequal to 5
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Description

Usage
Components

Example

EXECUTE

In the Stimulation component, the EXECUTE command executes afile
containing stimulation commands. Refer to the |/O Simulation document.

EXECUTE fileName

Stimulation component.

in>EXECUTE stimu.txt

EXIT
Description  Inthe Command line component, the EXIT command closes the Debugger
application.
usage EXIT
Components  Debugger engine.
Example
in>EXIT
The Debugger application is closed.
FILL
Description  Inthe Memory component, the FILL command fills a corresponding range
of Memory component with the defined value. The value must be asingle
byte pattern (higher bytes ignored).
Usage FILL rangevaue
the syntax for rangeis. LowAddress..HighAddress
Components  Memory component.

Equivalent Operation

The File Memory dialog is available from the Memory popup menu and
by selecting Fill... or Memory>Fill... menu entry.
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Example

I n>FI LL 0x8000. . 0x8008 OxFF

Description

Usage

Components

Example

The memory range 0x8000..0x8008 is filled with the value OxFF.

FILTER

In the Memory component, with the FILTER command, you select what
you want to display, for example modules: modules only, functions:
modules and functions, or lines: modules and functions and code lines.
Y ou can also specify arange to be logged in your file. Range must be
between 0 and 100.

FILTER Options [<range>]
Options = modul eslfunctions|lines

Coverage component.

I n>coverage < FILTER functions 25..75

Description

Usage

FIND

In the Source component, the FIND command is used to search a specified
pattern in the source file currently loaded. If the pattern has been found, it
is highlighted. The search is forward (default), backward (; B), match case
sengitive (;M C) or match whole word sensitive (;WW). The operation
startsform the currently highlighted statement or from the beginning of the
file (if nothing is highlighted). If the item isfound, the Source window is
scrolled to the position of the item and the item is highlighted in grey.

Equivalent Operation

Y ou can select Source>Find... or open the Source popup menu and select
Find... to open the Find dialog.

FIND “string” [;B] [;MC] [;WW]

Where string isthe “pattern” to match. It has to be enclosed in double
guotes. See the example below.
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Components

Example

:B the search is backwards, default is forwards.
:M C match case sensitive is set.

‘WW match whole word is set.

Source component.

in>FIND “this” ;B ;WW

Description

Usage
Components

Example

The “this’ string (considered as a whole word) is searched in the Source
component window. The search is performed backward.

FINDPROC

If avalid procedure name is given as parameter, the source file where the
procedure is defined is opened in the Source Component. The procedure’s
definition is displayed and the procedure’ stitle is highlighted.

Equivalent Operation

Y ou can select Source>Find Procedure... or open the Source popup
menu and select Find Procedure... to open the Find Procedur e dialog.

FINDPROC procedureName

Source component.

in>findpr oc Fibonacci

Description

The “Fibonacci” procedure is displayed and thetitle is highlighted.

FOCUS

The FOCUS command sets the given component (component) as the
destination for all subsequent commands up to the next ENDFOCUS
command. Hence, the focus command releases the user from repeatedly
specifying the same command redirection, especialy in the case where
command files are edited manually. Thiscommand isonly validina
command file.
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NOTE

Usage
Components

Example

It is not possible to visually notice that a component is“FOCUSed”.
However, you can use the ACTIVATE command to activate a component
window.

FOCUS component
Debugger engine.

FOCUS Assenbl y

ATTRI BUTES code on

ENDFOCUS
FOCUS Source

ATTRI BUTES nmar ks on

ENDFOCUS

Description

Usage

Components

Example

The ATTRIBUTES command isfirst redirected to the Assembly
component by the FOCUS Assembly command. The code is displayed
next to assembly instructions. Then the Assembly component is released
by the ENDFOCUS command and the second ATTRIBUTES command is
redirected to the Source component by the FOCUS Source command.
Marks are displayed in the Source window.

FOLD

In the Source component, the FOL D command hides the source text at the
program block level. Folded program text is displayed asif the program
block was empty. When the folded block is unfolded, the hidden program
text reappears. All text isfolded once or (*) completely, until there are no
more folded parts.

FOLD [*]
Where * means fold completely, otherwise fold only one level.

Source component.

iIn>FOLD *
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FONT
Description ~ FONT sets the font type, size and color.
Equivalent Operation
The Font dialog is available by selecting the Component>Fonts... menu
entry.
Usage FONT ‘FontName' [size][color]
Components  Debugger engine.
Example

FONT ‘Arial’ 8 BLUE
Thefont typeis“Aria” 8 points and blue.
FOR

Description ~ The FOR loop allows you to execute all commands up to the trailing
ENDFOR a predefined number of times. The bounds of the range and the
optional steps are evaluated at the beginning. A variable (either a symbol
or aprogram variable) may be optionally specified, whichis assigned to all
values of the range that are met during execution of the for loop. If a
variable isused, it must be defined before executing the FOR command,
with a DEFINE command.
Assignment happens immediately before comparing the iteration value
with the upper bound. The variable is only a copy of the internal iteration
value, therefore modifications on the variable don't have an impact on the
number of iterations.
This command can be stopped by pressing the [Esc| key.
Usage FORJvariable =]range[“,” step]

Where variableisthe name of adefined variable.
range: Thisis an address range constant that specifies addresses to be
disassembled.
step: constant number matching the step increment of the loop.
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Components  Debugger engine.

Example

DEFINE | oop = O
6

FOR loop = 1..6,1
T
ENDFOR

The T Trace command is performed 6 times.

FPRINTF

Description ~ FPRINTF isthe standard ANSI C command: Writes formatted output
string to afile.

usage FPRINTF (<filename>, <&format>, <expression>, <expression>, ...)
Components  Debugger engine.

Example

fprintf (test.txt,"% %d","The value of the counter
is:",counter)

The content of thefilet est . t xt is: The value of the counter is: 25

FRAMES

Description  Inthe SoftTrace component, the FRAM ES command sets the maximum
number of frame records.

Usage FRAMES number

Where number is adecima number, which is the maximum number of
recorded frames. This number must not exceed 1000000.

Components  SoftTrace component.

Example

FRAMES 10000
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Description

Usage

Alias
Components

Example

G

The G command starts code execution in the emulated system at the
current address in the program counter or at the specified address. Y ou can
therefore specify the entry point of your program, skipping execution of the
previous code.

G [address]

When no addressis entered, the address in the program counter is not
atered and execution begins at the address in the program counter.

GO
Debugger engine.

G 0x8000

Description

Usage

Alias
Components

Example

Program execution is started at 0x8000. RUNNING is displayed in the
status bar. The application runs until abreakpoint isreached or you stop the
execution.

GO

The GO command starts code execution in the emulated system at the
current address in the program counter or at the specified address. Y ou can
therefore specify the entry point of your program, skipping execution of
previous code.

GO [address]

When no addressis entered, the address in the program counter is not
atered and execution begins at the address in the program counter.

G
Debugger engine.

i n>G0 0x8000
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Program execution is started at address 0x8000. RUNNING isdisplayed in
the status bar. The application runs until abreakpoint isreached or you stop
execution.

GOTO

Description ~ The GOTO command diverts execution of the command file to the
command line that follows the Label. The Label must be defined in the
current command file. The GOTO command fails, if the Label is not
found. A label can only be followed on the same line by a comment.

Usage GOTO Labd
Components  Debugger engine.

Example

GOTO MyLabel

WLabeI: /1 comrents

When the instruction GOTO MyL abel is reached, the program pointer
jumps to MyL abel and follows program execution from this position.

GOTOIF

Description ~ The GOTOIF command diverts execution of the command file to the
command line that follows the label if the condition is true. Otherwise, the
command isignored. The GOTOIF command fails, if the conditionistrue
and the label is not found.

usage GOTOIF condition Label

where condition is same as defined in “C” language.
Components  Debugger engine.

Example

DEFI NE j ump = O

biEi:INEjurrp:jun‘p+1

GOTAO F junmp == 10 MyLabel
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T

MyLabel :

/] comrents

Description

Usage
Components

Example

The program pointer jumpsto MyLabel only if jump equals 10. Otherwise,
the next instruction (T Trace command) is executed.

GRAPHICS

In the Profiler component, GRAPHICS switches the percentages display
in the graph bar on/off.

GRAPHICS on|off

Profiler component.

IN>GRAPHICS off

HELP
Description  Inthe Command line component, the HEL P command displays all

available commands.
Subcommands from the ATTRIBUTES command are not listed.
Component specific commands, which are not open, will not be listed
either.

Usage HELP

Components  Debugger engine.
Example
IN>SHELP

HI - WAVE Engi ne:

VER
LF
NOLF
CR
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NOCR
IF
Description  The conditional commands (IF, ELSEIF, EL SE and ENDIF) allow you to
execute different sections depending on the result of the corresponding
condition. The conditional command may be nested. Conditions of the | F
and EL SEIF commands, respectively, guard all commands up to the next
ELSEIF, EL SE or ENDIF command on the same nesting level. The
EL SE command guards all commands up to the next ENDIF command on
the same nesting level. Any occurrence of a subcommand not in sequence
of “1F, zero or more EL SEIF, zero or one EL SE, ENDIF” isan error.
usage |F condition
Where condition is same as defined in “C” language.
Components  Debugger engine.
Example
DEFI NE junp =
DEFINE junp = junp + 1
IF ju == 10
T

DEFI NE jump = O

ELSEIF junp ==

100

DEFINE junp = 1

ELSE

DEFI NE jump = 2

ENDI F

The jump = = 10 condition is evaluated and depending on the test resullt,
the T Traceinstruction is executed, or the ELSEIF jump = =100 test is
evaluated.
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INSPECTOROUTPUT

Description  The Inspector dumps the content of the specified item and all computed
subitems to the command window. Uncomputed subitems are not printed.
To compute al information, the ATTRIBUTES EXPAND command is
used.

Usage INSPECTOROUTPUT [name {subname}]

The name specifies any of the root items. The subname specifies a
recursive path to subitems.

If a name contains a space, it must be surrounded by double quotes ().
Components  |nspector component.

Example

in>loadio swap
in>Inspect<ATTRIBUTES EXPAND 3
in>INSPECTOROUTPUT “Object Pool” Swap

Swap

*  Nane Value Address Init...
- 1O Reg_1 0xO0 0x1000 0x0 ...
- 1O Reg_2 0x0 0x1001 0x0 ...

INSPECTORUPDATE

Description  The Inspector displays various information. Some types of information are
automatically updated. To make sure that displayed values correspond to
the current situation, the INSPECTORUPDATE command updates all
information.

Usage INSPECTORUPDATE
Components  Ingpector component.

Example

IN>INSPECTORUPDATE
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ITPORT

Description ~ The I TPORT command is used to set the line and column port addresses of
the IT_Keyboard component.

Usage |TPORT (address|ident) (address|ident) (address|ident)...

Addresslocates the port address value of the component (various formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.
Components | T_Keyboard component.

Example:

i n>1 TPORT 0x100 0x200 0x300

Ports of the IT_Keyboard are now defined at addresses 0x100, 0x200 and
0x300.

ITVECT

Description ~ The ITVECT command is used to set the interrupt vector port address of
the IT_Keyboard component.

usage |ITVECT (address|ident).

Address locates the port address value of the component (various formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.
components  |T_Keyboard component.

Example:

i n>1 TVECT 0x400

The interrupt vector port address of the IT_Keyboard is now defined at
address 0x400.
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Description

Usage

Components

Example:

KPORT

The KPORT command is used to set the line and column ports addresses of
the Keyboard component.

KPORT ( address | ident ) ( address | ident ) ( address | ident)...

Addresslocates the port address value of the component (many formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.

Keyboard component.

I Nn>KPORT 0x100

0x200 0x300

Description

Usage

Components

Example:

The ports of the Keyboard are now defined at addresses 0x100, 0x200 and
0x300.

LCDPORT

The LCDPORT command is used to set the data port and the control port
address of the Lcd component.

LCDPORT ( address|ident) ( address|ident) ( address|ident)...

Address locates the port address value of the component (many formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.

L cd component.

I N>LCDPORT 0x100 0x200

The ports of the Lcd are now defined at addresses 0x100, 0x200 and
0x300.
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Description

Usage

Components

Example:

LINKADDR

The LINKADDR command is used to set the components internal ports
addresses used with the Programmable Couplers as memory buffers.

LINKADDR (address|ident) ( address|ident) ( address|ident)...

Addresslocates the port address value of the component (many formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.

Couplers, Adc_Dac, Keyboard, IT_Keyboard, 10_Led, Lcd,
Push_Buttons, 7-segments display, Wagon

I n>L1 NKADDR 0x100 0x200 0x300 0x400 0x500

Description

Usage

Now all components working with the Programmabl e Couplers have PortA
set to 0x100, PortB set to 0x200, PortC set to 0x300, PortD set to 0x400
and PortE set to 0x500.

LF

The LF command initiates logging of commands and responses to an
external file or device. While logging remainsin effect, any linethat is
appended to the command window is also written to the log file.

Logging continues until aclose log file (NOLF) command is executed.
When the LF command is entered with no filename, the Open File Dialog
is displayed to specify afilename.

Use the logging option (LOG) command to specify information to be
logged.

If apath is specified in the file name, this path must be avalid path. When
arelative path is specified, ensure that the path is relative to the project
directory.

LF [fileName][;A]

fileNameisaDOS filename that identifies the file or device where the log
iswritten. The command interpreter does not assume afilename extension.
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Components

Example

;A opensthe filein append mode. Logged lines are appended at the end of
an existing log file.

If the ; A option is omitted and fileName is an existing file, thefileis
cleared before logging begins.

Debugger engine.

in>f /nctuez/deno/logfile.txt ;A

NOTE

Description

Usage

The logfile.txt fileis opened asaLog Filein “append” mode.

If no path is specified, the destination directory is the current project
directory.

LOAD

The LOAD command loads a framework application (. abs file) for a
debugging session. When no application name is specified, the
L oadObjectFile dialog is opened.

If no target isinstalled, the following error message is displayed:
“Error: no target is installed”
If no target is connected, the following error message is displayed:

“Error: no target is connected”

LOADIapplicationName] [CODEONLY |[SYMBOLSONLY]
[NOPROGRESSBAR] [NOBPT] [NOXPR] [NOPRELOADCMD]
[NOPOSTLOADCMD] [DELAY]
[VERIFYFIRST|VERIFYALL|VERIFYONLY]

[VERIFY OPTIONS|SY MBOLSOPTIONS]

Where

» applicationName is the name of the application to load
» CODEONLY and SYMBOLSONLY loads only the code or symbols
* NOPROGRESSBAR loads the application without progress bar
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NOTE

NOTE

Components

Example

NOBPT loads the application without |oading breakpoints file (with
BPT extension)

NOXPR loads the application without playing Expression file (with
XPR extension)

NOPREL OADCM D loads the application without playing
PRELOAD file

NOPOSTLOADCMD loads the application without playing
POSTLOAD file

DELAY loads the application and waits one second

VERIFYFIRST matches the "First bytes only” code verification
option.

VERIFYALL matchesthe "All bytes' code verification option.

VERIFYONLY matches the "Read back only" code verification
option.

VERIFYOPTIONSdisplaysthe"Code Verification Options' group in
the"Load Executable File" dialog. If thisoption ismissing, thegroupis
not displayed. However, the verification mode can still be specified
with options above.

SYMBOL SOPTIONS displays the "Load Options' group in the
"Load Executable File" dialog. If thisoption is missing, the group is
not displayed. However, the code+symbols mode can still be specified
with options CODEONLY and SYMBOLSONLY.

By default, the LOAD command is"codet+symbols’ with no verification.

If the"SYMBOLSONLY" parameter is passed, verification parameters are
ignored and NO verification is performed.

Debugger engine.

LGAD FI BO ABS

NOTE

The FI BO. ABS application is |loaded.

If no path is specified, the destination directory is the current project
directory.
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Description

Usage
Components

Example

LOADCODE

This command loads code into the target system. This command can be
used if no debugging is needed. If no target isinstalled, the following error

message is displayed:
“Error: no target is installed”
If no target is connected, the following error message is displayed:

“Error: no target is connected”
LOADCODE [applicationName]
Debugger engine.

LOADCCDE FI BO. ABS

NOTE

Description
Usage

Components

Example

Code of the FI BO. ABS application is loaded.

If no path is specified, the destination directory is the current project
directory.

LOADMEM

This command loads a memory configuration file.
LOADMEM fileName

Simulator component.

Equivalent Operation

Y ou can select the Open button in the M emory Configur ation dialog box
to load amemory configuration file.

in>LOAD DEFAULT.MEM

The memory configuration file DEFAULT. MEMis |oaded.
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LOADSYMBOLS

Description ~ Thiscommand issimilar to theL OAD command but only |oads debugging
information into the debugger. This can be used if the code is already
loaded into the target system or programmed into a non-volatile memory
device.

If no target isinstalled, the following error message is displayed:
“Error: no target is installed”
If no target is connected, the following error message is displayed:

“Error: no target is connected”
usage LOADSYMBOLS [applicationName]
Components  Debugger engine.

Example

LOADSYMBOLS FI BO. ABS

Debugging information of the FI BO. ABS application is |oaded.

NOTE If no path is specified, the destination directory is the current project
directory.

LOG

Description ~ The LOG command enables or disables logging of information in the
Command Line component window (and to logfile, when it as been opened
with an LF command). If LOG isnot used, all typesare ON by default i.e.
al information islogged in the Command Line component and log file.

NOTE - about RESPONSES: Responses are results of commands. For example,
for the DB command, the displayed memory dump is the response of the
command. Protocol messages are not responses. - about ERRORS: Errors
are displayed in red in Command Line component. Protocol messages are
not errors. - about NOTICES: Notices are displayed in green in the
Command Line.
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usage LOG type[=] state{[,] type[=] state}
where typeis one of the following types:
CMDLINE: Commands entered on the command line.
CMDFILE: Commands read from afile.
RESPONSES: Command output response.
ERRORS: Error messages.
NOTICES: Asynchronous event notices, such as breakpoints.
where state is on or off.

stateisthe new state of type. When ON, enableslogging of the type; when
OFF, disableslogging of the type.

Components  Debugger engine.

Example

LOG ERRORS = OFF, CMDLINE = on

Error messages are not recorded in the Log File. Commands entered in the
Command Line component window are recorded.

More About Logging of IF, FOR, WHILE and REPEAT

When commands executed from a command file are logged, all executed
commandsthat arein alF block are logged. That is, acommand file
executed with the CF or CALL command without the NL option and with
CMDFILE flag of the LOG command set to TRUE. All commandsin a
block that are not executed because the corresponding conditionisfalse are
also logged but preceded witha*-".

Example  When executing the following command file:

define truth =1
IF truth

bckcol or bl ue

at 2000 bckcolor white
el se

bckcol or yel |l ow
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at 1000 bckcolor white

ENDI F

the following log file is generated:

define truth =1
IF truth
bckcol or bl ue

el se

!
!
!
!
!
- bckcol or yell ow
!

!

ENDI F

at 2000 bckcol or white

- at 1000 bckcolor white

When commands executed from a command file are logged, all executed
commands that are in the FOR loop are logged the number of times they
have been executed. That is, acommand file executed with the CF or

CALL command without the NL option and with the CM DFILE flag of

the LOG command set to TRUE.

Example  When executing the following file:

definei =1

FORi =1..3
l's

ENDFOR

the following log file is generated:

ldefinei =1
IFORi =1..3
I | s
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When commands executed from a command file are logged, all executed
commands that arein the WHIL E loop are logged the number of times
they have been executed. That is, acommand file executed with the CF or
CALL command without the NL option and with the CM DFILE flag of
the LOG command set to TRUE.

Example  When executing the following file:

definei =1
VWH LEi < 3

definei =i + 1
l's
ENDVHI LE

the following log file is generated:

ldefinei =1
IVHLEi < 3
! definei =i + 1
' |Is
[ 0x2 (2)
I ENDVHI LE
! definei =1 + 1
I |s
| 0x3 (3)
| ENDVH LE

When commands executed from a command file are logged, all executed
commands that are in the REPEAT loop are logged the number of times
they have been executed. That is, acommand file executed with the CF or
CALL command without the NL option and with the CM DFILE flag of
the LOG command set to TRUE.

Example  When executing the following file:

definei =1
REPEAT
definei =i + 1
l's
UNTIL i ==
the following log file is generated:
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r epeat
until condition
ldefinei =1
| REPEAT
! definei =i + 1
L IS
[ 0x2 (2)
FUNTIL i ==
! definei =1 + 1
' |Is
[ 0x3 (3)
FUNTIL i ==
! definei =1 + 1
I |s
[ 0x4 (4)
FUNTIL i ==

LS

Description  Inthe Command Line window, the L S command lists the values of
symbols defined in the symbol table and by the user. Thereis no limit to
the number of symbols that can be listed. The size of memory determines
the symbol table size. Use the DEFINE command to define symbols, and
the UNDEF command to delete symbols.

The symbolsthat are listed with the LS command are split in two parts:
Applications Symbols and User Symbols.

Usage LS[symbol | *][;C|]]

Where symbol is arestricted regular expression that specifies the symbol
whose values are to be listed.

* gpecifiestolist al symbols.

;C specifiesto list symbolsin canonical format, which consists of a
DEFINE command for each symboal.

;S specifiesto list symbol table statistics following the list of symbols.

Components  Debugger engine.
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Example
in>ls
User Symbols:
i 0x2 (2)

Application Symbols:
counter  Ox80 (128)
fiboCount 0x81 (129)

] 0x83 (131)

n 0x84 (132)

fibl 0x85 (133)

fib2 0x87 (135)

fibo 0x89 (137)
Fibonacci OxFOO0O (61440)
Entry OxF041 (61505)

When LSis performed on asingle symbol (e.g., in>Is counter) that isan
application variable as well as a user symbol, the application variable is
displayed.

Example with j being an application symbol as well as a user symbol:

in>ls |

Appl i cation Synbol :
] 0x83 (131)

MEM
Usage MEM
Components  Debugger engine.

Description ~ The MEM command displays a representation of the current system
memory map and lower and upper boundaries of the internal module that
contains the MCU registers.
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Example

i n>em

Type Addr esses Conment

IO 0 3F PRU or TOP  TOP board resource or the PRU

NONE 40 4F NONE

RAM 50 64F RAM

NONE 650 7FF  NONE

EEPROM  800.. A7F EEPROM

NONE A80. . 3DFF NONE

ROM 3E00. . FDFF ROM

IO FEOO. . FEIF PRU or TOP  TOP board resource or the PRU

NONE FE20. . FFDB NONE

ROM FFDC. . FFFE ROM

corP FFFF. . FFFF special ramfor cop

RT MEM 0 3FF (enabl ed)
MS

Description ~ The M'S command sets a specified block of memory to a specified list of
byte values. When the rangeiswider than thelist of byte values, thelist of
byte valuesis repeated as many times as necessary to fill the memory
block.
When the rangeis not an integer multiple of the length of thelist, the last
copy of thelist istruncated appropriately. Thiscommand isidentical to the
write bytes (WB) command.
Usage MSrangelist
range: is an address range constant that defines the block of memory to be
set to the values of the bytesin the list.
list: isalist of byte valuesto be stored in the block of memory.
Components  Debugger engine.
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Example

i n>MS5 0x1000.

. Ox100F OxFF

Usage

Components

Description

Table 7.6

Notation.

The memory range between addresses 0x1000 and 0x100F isfilled with
the OxFF value.

NB

NB [base]

where base is the new number base (2, 8, 10 or 16).
Debugger engine.

The NB command changes or displays the default number base for the
constant values in expressions. Theinitial default number base is 10
(decimal) and can be changed to 16 (hexadecimal), 8 (octal), 2 (binary) or
reset to 10 with this command. The base is always specified as a decimal
constant.

Independent of the default base number, the ANSI C standard notation for
constant is supported inside an expression. That means that independent of
the current number base you can specify hexadecimal or octal constants
using the standard ANSI C notation shown in Table 7.6.

ANSI C constant notation

Meaning

OX----

0----

Hexadecimal constant

Octal constant

Example
0x2F00, /* Hexadecimal Constant */

043, /* Octal Constant */

255 /* Decimal Constant */
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In the same way, the Assembler notation for constant is also supported.
That means that independent of the current number base you can specify
hexadecimal, octal or binary constants using the Assembler prefixes
shownin Table7.7.

Table 7.7 Assembler notation for constant
Notation. Meaning
$--- Hexadecimal constant
@---- Octal constant
%---- Binary constant
Example
$2F00, /* Hexadecimal Constant */
@43, /* Octa Constant */
%10011 /* Binary Constant */
When the default number base is 16, constants starting with aletter A, B,
C, D, E or F must be prefixed either by Ox or by $, as shown in Table 7.8.
Otherwise, the command line interpreter cannot detect if you are specifying
anumber or asymbol.
Table 7.8 Base is 16: constants starting with a letter A,B,C,D,Eor F
Notation. Meaning
5AFD Hexadecimal constant $5AFD
AFD Hexadecimal constant $AFD
Example
in>NB 16
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The number base is hexadecimal.

NOCR
Description The NOCR command closes the current record file. The record fileis
opened with the CR command.
usage NOCR
Components  Debugger engine.
Example
I N>NOCR
The current record fileis closed.
NOLF
Description The NOL F command closes the current Log File. Thelog file is opened
with the LF command.
usage NOLF
Components  Debugger engine.
Example
I n>NOLF
The current Log File is closed.
OPEN
Description ~ The OPEN command is used to open a window component.
Usage  OPEN "component” [x y width height][;! | ;MAX]

where;

» component is the component name with an optional path

» X isthe X-axis of the upper left corner of the window component
» yistheY-axisof the upper left corner of the window component
» width isthe width of the window component
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* height the height of the window component

When | is specified, the component window will be iconized; when MAX
is specified, the component window will be maximized.

Component names are: Assembly, Command, Coverage, Data, | nspect,
IO_Led, Led, Memory, Module, Phone, Procedure, Profiler, Recorder,
Register, SoftTrace, Source, Stimulation.

Components  Debugger engine.

Example

i Nn>CPEN Termnal 0 78 60 22

The Terminal component and window is opened at specified positions and
with specified width and height.

OPENFILE

Description  In the Stimulation component, the OPENFIL E command opens a
specified file to run a Stimulation.

usage OPENFILE fileName

Where fileName is name of stimulation file.
Components  Stimulation component.

Example

in>OPENFILEd: \ deno\ i o_deno. t xt

NOTE If no path is specified, the destination directory is the current project
directory.

OPENIO

Description ~ The OPENIO command is used to open al/O component (components
whose DLL filename hasa“.io” extension).

Usage  OPENIO "IOcomponentName"
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Where |OcomponentName is the name (with an optional path), without
extension, of the I/O component to open.

Components  Debugger engine.

Example

i Nn>OPENI O " denp"

The demo I/O component is opened.

I n>0OPENI O "c:\ Metrower ks\ prog\ nyi o\ Myi 0"

The Myio 1/0O component is opened.

OUTPUT

Description ~ With OUTPUT, you can redirect the Coverage component results to an
output file indicated by the file name and his path.

usage OUTPUT FileName
Where FileName is file name (path + name).
Components  Coverage component.

Example

I n>coverage < QUTPUT c:\ Metrowerks\ nyfile.txt

The Coverage output results are redirected to the filemyf i | e. t xt from
the directory C. \ Met r ower ks.

P

Description ~ The P command executes a CPU instruction, either at a specified address
or at the current instruction, (pointed to by the program counter). This
command traces through subroutine calls, software interrupts, and
operations involving the following instructions (two are target specific):

» Branch to SubRoutine (BSR)
» Long Branch to Subroutine (LBSR)
* Jump to Subroutine (JSR)
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Usage

Components

Example

Example for PPC

» Software Interrupt (SW1)
* Repeat Multiply and Accumulate (RMAC)

For example: if the current instruction is a BSR instruction, the subroutine
is executed, and execution stops at the first instruction after the BSR
instruction. For instructions that are not in the above list, thePand T
commands are equivalent.

When the instruction specified in the P command has been executed, the
software displays the content of the CPU registers, the instruction bytes at
the new value of the program counter and a mnemonic disassembly of that
instruction.

P [address]

address: is an address constant expression, the address at which execution
begins.

If addressis omitted, execution begins with the instruction pointed to by
the current value of the program counter.

Debugger engine.

I n>p

TRACED
STARTED
RUNNI NG
STOPPI NG
HALTED

RO=0x3FC1E8 R1=0x3F9AE8 R2=0x0 R3=0x18 R4=0xD R5=0xE9 R6=0x90
R7=0x90 R8=0x0 R9=0x0 R10=0x0 R11=0x0 R12=0x0 R13=0x0

R14=0x0 R15=0x0 R16=0x0 R17=0x0 R18=0x0 R19=0x0 R20=0x0
R21=0x0 R22=0x0 R23=0x0 R24=0x0 R25=0x0 R26=0x0 R27=0x0
R28=0x0 R29=0x0 R30=0x0 R31=0x17 FRO0=?7?7?? FR01=7?7? FR02=?77?7
FRO3=7??7?? FR04=77?7?7? FR05=?7?? FR06=7?7? FRO7=?77?7 FR08=7?777

FRO9=?7?77
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FR10=??7?? FR11=???7? FR12=?77?? FR13=7??7? FR14=?7?7?7 FR15=7??77
FR16=7?77

FR17=7??7?7? FR18=77?7?7? FR19=?77?? FR20=7?77? FR21=?7?7?7 FR22=7?7?77
FR23=7?7?77?

FR24=77?7?7? FR25=7?7?7?7? FR26=?77?7? FR27=77?7? FR28=?77?7 FR29=7??777
FR30=7?77

FR31=??7? CR=0x40000800

3FC298 7CA62B79 nr. re, r5

Contents of registers are displayed and the current instruction is
disassembled.

PAUSETEST
Description  Displays amodal message box shown in Figure 7.1 for testing purpose.

Figure 7.1 PAUSETEST message box

TestPase |

@ et test statement?

Usage PAUSETEST

Components  Debugger engine.

Example
in> pausetest
PBPORT
Description ~ The PBPORT command is used to set the port address of the Push_Buttons
component.

Usage PBPORT (address|ident)
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Address locates the port address value of the component ( various formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.
Components  Push_Buttons component.

Example:

I N>PBPORT 0x100 0x200

The ports of the Push_Buttons are now defined at addresses 0x100 and
0x200.
PORT
Description  Inthe Led components, the PORT command sets the port Led location.
Usage PORT address
Components  Led component.

Example

in> PORT 0x210

PRINTF

Description ~ The PRINTF isthe standard ANSI C command: Prints formatted output to
the standard output stream.

Usage PRINTF (“[Text |%format specification” , value)
Components  Debugger engine.

Example

in>PRI NTF(" The val ue of the counter is: %", counter)

The outputis: The val ue of the counter is: 2
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Description

Usage

Components

Example

PTRARRAY

The PTRARRAY command allows to specify if a pointer should be
displayed as an array.

PTRARRY on|off [nb]

Where
» on displays pointers as arrays.
» off displays pointers as usual (* pointer).
* nb isthe number of elementsto display in the array when unfolding a
pointer displayed as array.

Data component.

in>Ptrarray on 5

Description

NOTE

Usage

Display content of pointers asarray of 5 items.

RD

The RD command displays the content of specified registers. The display
of aregister includes both the name and hexadecimal representation. If the
specified register is not a CPU register, then it looks for thisregister in a
register fileasan I/O register. Thisfileiscaled: M CUIxxxx.REG (where
XXxX is anumber related to the MCU).

This command is processor/derivative specific and will not display banked
registersif the processor does not support banking.

RD { <list>|CPU | * }

wherelist isalist of registersto be displayed. Registersto be displayed are
separated by a space. When “RD CPU” is specified, al CPU registersare
displayed. If no CPU isloaded, “No CPU loaded” is displayed as an error

message.

When * is specified, the RD command lists the content of the register file
that is currently loaded. Y ou can load aregister file with the command
REGFILE. The address and size of each register is displayed. If no register
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fileisloaded, following error message is displayed: “No register file
loaded”.

When there is no parameter, the previous RD command is processed again.
If thereis no previous RD command, all CPU registers are displayed.

If list isomitted, the list and any other parameters of the previous RD
command are used.

For the first RD command of asession, all CPU registers are displayed.

Components  Debugger engine.

Example for PPC

in>d cpu

RO=0x3FC1E8 R1=0x3F9AE8 R2=0x0 R3=0xC R4=0x8 R5=0x15 R6=0x15
R7=0xD R8=0x0 R9=0x0 R10=0x0 R11=0x0 R12=0x0 R13=0x0 R14=0x0

R15=0x0
R23=0x0
R31=0xB
FR05=00
FR13=00
FR21=00
FR29=00

R16=0x0 R17=0x0 R18=0x0 R19=0x0 R20=0x0 R21=0x0 R22=0x0
R24=0x0 R25=0x0 R26=0x0 R27=0x0 R28=0x0 R29=0x0 R30=0x0
FROO=0x AAAAAAAAFF FR01=00 FRO2=00 FR03=00 FR04=007
FRO6=00 FRO7=00 FRO8=00 FR09=00 FR10=00 FR11=00 FR12=00
FR14=00 FR15=00 FR16=00 FR17=00 FR18=00 FR19=00 FR20=00
FR22=00 FR23=00 FR24=00 FR25=00 FR26=00 FR27=00 FR28=00
FR30=00 FR31=00 CR-=0x40000800

RECORD

Description  Inthe SoftTrace component, the RECORD command switches frame

recording on / off while the target is running.

usage RECORD on|off

Components  SoftTrace component.

Example

in>RECORD on
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REGBASE
Description  Thiscommand allows you to change the base address of the 1/O registersor
to set (Reset) this addressto 0.
Usage Regbase <Address><;R>
Where Addressis an address to define the base address of the |/O registers,
the 'R’ option sets this address to 0 (Reset).
Components  Debugger engine.
Example
in>regbase 0x500
Ox 500 is now the base address of the 1/0 registers.
REGFILE
Description ~ Thiscommand allowsyou to load afile containing I/O register descriptions
from aregister file.
Usage Regfile <filename>
Where Regfile is aregister filename (with a. REG extension).
Components  Debugger engine.
Example

iIn>REGFILE MDEF. REG

Description

Usage

Components

REPEAT

The REPEAT command allows you to execute a sequence of commands
until a specified condition istrue. The REPEAT command may be nested.

Pressthe [Esc] key to stop this command.
REPEAT
Debugger engine.
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Example

DEFI NE var = 0

REPEAT
DEFI NE var = var + 1

UNTIL var == 2

The REPEAT-UNTIL loop isidentical to the ANSI C loop. The operation
DEFINE var = var + 1 isdone twice, then var = = 2 and the loop ends.

RESET

Description  IntheProfiler and Cover age component, the RESET command resets all
recorded frames (statistics).

In the SoftTrace component, the RESET command resets statistics and
recorded frames.

NOTE Make surethat the RESET command is redirected to the correct
component. Targets also have their own RESET command and if RESET
isnot redirected, the target is reset.

Usage RESET
components  Profiler and Coverage.

Example

i n>Profiler < RESET

RESETCYCLES

Description  Thiscommand sets the Simulator CPU cycles counter to the user defined
value. If not specified, the value will be 0. The cycles counter is displayed
in the Debugger status and Register Component. This command does not
affect the context.

Usage RESETCYCLES<Vaue>
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where Value isthe desired cycles. This command affects only the internal
cycle counter from the Simulator/Debugger.

Components  Debugger engine.
Example
i N>SHOWCYCLES
133801
I N>RESETCYCLES
I N>SHOWCYCLES
0
i N>RESETCY CLES 5500
I Nn>SHOWCYCLES
5500
The Showcycles command in the Command Line component displays the
number of CPU cycles executed since the start of the ssimulation.
RESETMEM
Description ~ This command marks the given range of memory (RAM + ROM) as
uninitialized (* undefined’).
usage RESETMEM range
Components  Simulator component.
Example
i N>RESETMEM
DM-360
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After the RESETMEM command, all configured memory isinitialized to
‘undefined’.

I N>RESETMEM 0x100. . 0x110

This command resets the memory between 0x100 and 0x110 (if
configured) to 'undefined'.

I N>RESETMEM 0x003F

This command resets the memory location 0x003F (if configured) to
‘undefined'.

NOTE  Inthe memory configuration “Auto on Access’ the full memory is defined
as RAM, =0 in this case the command RESETMEM has the same effect as
RESETRAM.

RESETRAM

Description ~ Thiscommand marks all RAM as uninitialized (‘ undefined’).

NOTE Inthe memory configuration “Auto on Access’ the full memory is defined
as RAM, so in this case the command RESETMEM has the same effect as
RESETRAM.

Usage RESETRAM
Components  Simulator component.

Example

I N>RESETRAM

After the RESETRAM command, the content of RAM isinitialized as
undefined.

RESETSTAT

Description ~ This command resets the statistics (read and write counters to zero)
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Usage RESETSTAT
Components  Simulator component.
Example
I N>RESETSTAT
After the RESETSTAT command, al counters are initialized to zero.
RESTART
Description  Resets execution to thefirst line of the current application and executes the
application from this point.
Usage RESTART
Components  Engine component.
Example
i N>RESTART
After the RESTART command, the cycle counter isinitialized to zero.
RETURN
usage RETURN
Components  Debugger engine.

Description ~ The RETURN command terminates the current command processing level
(returns from a CALL command). If executed within acommand file,
control is returned to the caller of the command file (i.e. the first instance
that did not chain execution).

Example infiled: \ deno\cndl. t xt:

CALL d:\demp\ crd2. t xt

T

infiled: \ deno\ cnd2. t xt
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RETURN // returns to the caller

The command filecnd1. t xt callsasecond command filecnd2. t xt .
It is s0 necessary to insert the RETURN instruction to return to the caller
file. Thenthe T Trace instruction is executed.

RS

Description ~ The RS command assigns new values to specified registers. The RS
mnemonic isfollowed by register name and new value(s).
An equal sign (=) may be used to separate the register name from the value
to be assigned to the register; otherwise they must be separated by a space.
The contents of any number of registers may be set using asingle RS
command. If the specified register is not a CPU register, then theregister is
searched in aregister fileasan 1/O register. Thisfileis called:
MCUI xxxx. REG (where xxxx isanumber related to the MCU).
Usage RSregister[=]value{ register[=]value}
register: Specifies the name of aregister to be changed. String register is
any of the CPU register names, or name of aregister in the register file.
value: isan integer constant expression (in ANSI format representation).
Components  Debugger engine.
Example for PPC
i n>rs R4=0x8000
in>d R4
R4=0x8000
S
Description ~ The S command stops execution of the emulation processor. Use the Go G

command to start the emulator.
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NOTE The S command ends as soon asthe PC is changed.
Usage S
Alias  STOP
Components  Debugger engine.
Example
I n>s
STOPPI NG
HALTED
Current application debugging is stopped/halted.
SAVE
Description ~ The SAVE command saves a specified block of memory to a specified file
in Motorola S-record format. The memory block can be reloaded |ater
using the load S-record (SREC) command.
NOTE If no path is specified, the destination directory is the current project
directory.
usage SAVE rangefileName [offset][;A]
offset: an optional offset to add or subtract from addresses when writing S-
records. The default offset isO.
;A appendsthe saved S-recordsto the end of an existing file. If thisoption
is omitted, and the file specified by fileName exists, thefileis cleared
before saving the S-records.
Components  Debugger engine.
Example

I N>SAVE 0x1000. . 0x2000 DUWP. SX ; A
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The memory range 0x1000..0x2000 is appended to the DUMP. SXfile.

SAVEBP

Description ~ The SAVEBP command saves all breakpoints of the currently loaded
. ABS fileinto the matching breakpoints file. Also, the matching file has
the name of the loaded . ABS file but its extension is .BPT (for example,
the Fi bo. ABS file has abreakpoint file called FIBO.BPT. Thisfileis
generated in the same directory asthe . ABS file, when the user quits the
Simulator/Debugger or loads another . ABSfile.

If onisset, al breakpoints defined in the current application will be stored
in the matching .BPT file.

If off is set, all breakpoints defined in the current application will not be
stored in the matching .BPT file.

Thiscommand is only used in .BPT files and is related to the checkbox
Save & Restoreon load in the Breakpoints setting dialog. It is used to
store currently defined breakpoints (SAVEBP on) when the user quitsthe
Simulator/Debugger or loads another . ABSfile.

NOTE  For more information about this syntax, refer to BS command, Control
Points chapter, and Saving Breakpoints section.

Usage SAVEBP on|off
Components  Debugger engine.

Example  content of the FI BO. BPT file

savebp on

BS &fi bo. c: Fi bonacci +19 P E; cond = "fibo > 10" E, cdSz = 47 srSz
=0

BS &fi bo.c: Fibonacci +31 P E; ¢cdSz = 47 srSz = 0

BS & ibo.c:min+tl2 P E c¢cdSz = 42 srSz = 0

BS &f i bo. c: mai n+21 P E; cond = "fiboCount==5" E; cnd = "Assenbly <
spc 0x800" E; cdSz = 42 srSz = 0
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Description

Usage

Components

Example:

SEGPORT

The SEGPORT command is used to set the display selection port and
segment selection port addresses of the 7-Segments display component.

SEGPORT display selection port ( address | ident ) segment selection (
address | ident )

Address locates the port address value of the component (many formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.

7-Segments display.

I N>SEGPORT 0x100 0x200

The ports of the 7-Segments display are now defined at addresses 0x100
and 0x200.

SET
Description  Setsanew current target for the debugger by loading the targetName
component.
Usage  SET targetName
where targetName is name without extension of the target to set.
Components  Debugger engine.
Example
I Nn>SET Sim
The debugger’ s current target is Simulator.
SETCOLORS
Description ~ The SETCOL ORS command is used to change the colorsfor a specific
channel from the Monitor component.
DM-366 Debugger Manual
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Usage

Components

Example:

SETCOLORS ( "Name" ) ( Background) ( Cursor) (Grid) (Line) (
Text

Name is the name of the channel to modify.

Background is the new color for the channel background (the format is:
0x00bbggrr).

Cursor is the new color for the channel cursor (the format is. 0x00bbggrr).
Grid isthe new color for the channel grid (the format is: 0x00bbggrr).
Lineisthe new color for the channel lines (the format is. 0x00bbggrr).

Text isthe new color for the channel text (the format is: 0xO0bbggrr).

Monitor component.

I N>SETCOLORS "Leds. Port_Regi ster bit 0" 0x00123456 0x00234567
0x00345678 0x00456789 0x00567891

Description

Usage

Components

Example:

The color attributes from the channel Leds.Port_Register bit O will be
changed with these new values.

SETCONTROL

The SETCONTROL command is used to modify the number of ticks and
pixelsfor aMonitor component specific channel. Thiswill change the
horizontal scale of this channel.

SETCONTROL ("Name") (Ticks) (Pixels)
Name is the name of the channel to modify.
Ticksisthe new number of ticks for this channel.

Pixelsisthe new number of pixelsfor this channel.

Monitor component.

I N>SETCONTROL "Leds. Port _Register bit 0" 100 1
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The horizontal scale from the channel Leds.Port_Register bit O will be
defined with the value 100 for the Ticks value and 1 for pixels value.
SETCPU

Description  Load CPU awareness for the debugger.

Usage SETCPU ProcessorName

where ProcessorName is a supported processor (HC05, HC08, HC11,
HC12, HC16, M68K, M.CORE, XA,ST7 and PPC).

Components  Simulator component.

Example

I Nn>SETCPU PPC

The ssmulator PPC.sim is loaded.

SHOWCYCLES

Description ~ The SHOWCY CL ES command returns the number of CPU cycles already
done since the beginning of the simulation in the Command Line
component (RESETCY CLES s performed internally), or since the last
RESETCY CLES command. The number of cycles executed is also the
number displayed in the status bar (CPU cycles counter).

Usage SHOWCYCLES

Components  Debugger engine.

Example

I N>SHOWCYCLES

133801

IN>RESETCYCLES
I N>SHOWCYCLES
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This command displays the number of CPU cycles executed since the last
RESETCY CLES command in the Command Line component.

SLAY

Description ~ The SLAY command is used to save the layout of all window components
in the main application window to a specified file.

TIP  Layout filesusually have a . HWL extension. However, you can specify
any file extension.

NOTE If no path is specified, the destination directory is the current project
directory.

usage SLAY fileName
Components  Debugger engine.

Example

i n>sl ay / hi wave/ deno/ nyl ayout . hwi

The current debugger layout is saved to the nyl ayout . hwl fileinthe
/ hi wave/ deno directory.

SLINE

Description  With the SLINE command, aline of the source file is made visible. If the
lineis not currently visible, the source will scroll so that it appears on the
first line. If thelineis currently in afolded part, it is unfolded so that it
becomes visible.

NOTE  Thegiven line number should be between 1 and number of linesin source
file, or else an error message is displayed.
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usage  SLINE line number
Components  Source component
Example
i n>sline 15
SMEM

Description

Usage
Components

Example

In the Sour ce component, the SMEM command |oads the corresponding
modul€’ s source text, scrolls to the corresponding text location (the code
address) and highlights the statements that correspond to this code address
range.

In the Assembly component, the SMEM command scrolls the Assembly
component, shows the location (the assembler address) and select/
highlights the memory lines of the address range given as the parameter.

In the M emory component, the SMEM command scrolls the memory
dump component, shows the locations (the memory address) of the address
range given as the parameter.

SMEM range

Source, Assembly and Memory components.

I n>Menory < SMEM 0x8000, 8

Description

The Memory component window is scrolled and specified memory
addresses are highlighted.

SMOD

In the Sour ce component, the SMOD command loads/displays the
corresponding modul €' s source text. If the module is not found, a message
isdisplayed in Command Line window.

In the Data component, the SM OD command |oads the corresponding
modul€’ s global variables.
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NOTE

Usage

Components

Example

In the Memory component, the SMOD command scrolls the memory
dump component and highlights the first global variable of the module.

Correct module names are displayed in the Module component window.
Make sure that the module name of your command is correct. If the. abs is
in HIWARE format, some debug informationisin the object file (. 0), and
module names have a. o extension (e.g., f i bo. 0). In ELF format,
module name extensionsare. ¢, . cppor. dbg (. dbg or program
sourcesin assembler) (e.g., f i bo. c¢), since al debugging information is
contained in the . abs file and object files are not used. Please adapt the
following examples with your . abs application file format.

SMOD module

Where module is the name of a module taking part of the application. The
module name should contain no path. The module extension (i.e. . DBGfor
assembly sourcesor . Cfor C sources, etc.) must be specified.

The module name is searched in the directories associated with the
GENPATH environment variable. An error message is displayed:

* If the module specified does not take part of the current application
loaded.

 If no application isloaded.

Data, Memory and source components,

in>Data:1 < SMOD fibo.c

Description

Global variablesfound inthef i bo. ¢ module are displayed in the Data: 1
component window.

SPC

In the Sour ce component, the SPC command |oads the corresponding
modul€’ s source text, scrolls to the corresponding text location (the code
address) and highlights the statement that corresponds to this code address.

In the Assembler component, the SPC command scrolls the Assembly
component, shows the location (the assembler address) and select/
highlights the assembler instruction of the address given as parameter.
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In the Memory component, the SPC command scrolls the memory dump
component, shows the location (the memory address) of the address given
as parameter.

Usage SPC address
Components  Assembler, Memory and Source component.
Example
in>Assembly < SPC 0x8000

The Assembly component window is scrolled to the address 0x8000 and
the associated instruction is highlighted.
SPROC

Description  In the Data component, the SPROC command shows local variables of
the corresponding procedure stack level.
In the Sour ce component, the SPROC command |oads the corresponding
modul€’ s source text, scrolls to the corresponding procedure and highlights
the statement of this procedure that isin the procedure chain.
level = O isthe current procedure level. level = 1 isthe caller stack level
and so on.

TIP  Thiscommand is relevant when “C-source” debugging.

NOTE  When aprocedure of alevel greater than O is given as parameter to the
SPROC command, the statement corresponding to the call of the lower
procedure is selected.

usage SPROC level

Components  Dataand Source components.
Example

i n>Source < SPRCC 1

DM-372

Debugger Manual

For More Information: www.freescale.com



b -
L |

Freescale Semiconductor, Inc.

Debugger Commands
Simulator/Debugger Commands

Description

NOTE

Usage

Components

Example

This command displays the source code associated with the caller function

in the Source component window.

SREC

The SREC command initiates the loading of Motorola S-Records from a

specified file.

If no path is specified, the destination directory is the current project

directory.

SREC fileName [offset]

offset: isasigned value added to the load addresses in the file when

loading the file contents.

Debugger engine.

I N>SREC DUMWP. SX

The DUVP. SXfileisloaded into memory.

STEPINTO
Description ~ The STEPINTO command single-steps through instructionsin the

program, and enters each function call that is encountered.

NOTE  This command works while the application is paused in break mode
(program iswaiting for user input after completing a debugging
command).

Usage STEPINTO

Components  Debugger engine.
Example
i Nn>STEPI NTO
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STEP | NTO

TRACED
TRACED in the status line indicates that the application is stopped by an
assembly step function.
STEPOUT

Description ~ The STEPOUT command executes the remaining lines of afunctionin
which the current execution point lies. The next statement displayed isthe
statement following the procedure call. All of the code is executed between
the current and final execution points. Using this command, you can
quickly finish executing the current function after determining that abug is
not present in the function.
NOTE  This command works while the application is paused in break mode
(program is waiting for user input after completing a debugging
command).
Usage STEPOUT
Components  Debugger engine.
Example

i Nn>STEPOQUT

STEP OUT

STARTED

RUNNI NG

STOPPED
STOPPED in the status line indicates that the application is stopped by a
step out function.
STEPOVER

Description ~ The STEPOVER command executes the procedure as a unit, and then

steps to the next statement in the current procedure. Therefore, the next
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statement displayed is the next statement in the current procedure
regardless of whether the current statement is a call to another procedure.

NOTE  This command works while the application is paused in break mode
(program iswaiting for user input after completing a debugging
command).
Usage STEPOVER
Components  Debugger engine.
Example
i N>STEPOVER
STEP OVER
STARTED
RUNNI NG
STOPPED
STEPPED OVER (or STOPPED) in the status line indicates that the
application is stopped by a step over function.
STOP
Description ~ The STOP command stops execution of the emulation processor. Use the
Go G command to start the emulator.
The STOP command ends as soon as the PC is changed.
Usage STOP
Alias S
Components  Debugger engine.
Example
i Nn>STOP
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STOPPI NG
HALTED

Description

Usage

Components

Example for PPC

Current application debugging is stopped.

T

The T command executes one or more instructions at a specified address,
or at the current address (the address in the program counter). The T
command traces into subroutine calls and software interrupts. For example,
if the current instruction is a Branch to Subroutine instruction (BSR), the
BSR istraced, and execution stops at the first instruction of the subroutine.
After executing the last (or only) instruction, the T command displays the
contents of the CPU registers, the instruction bytes at the new addressin
the program counter and a mnemonic disassembly of the current
instruction.

This command can be stopped by typing the [Esc] key.
T [address|[,count]

address:. is an address constant expression, the address where execution
begins. If addressis omitted, the instruction pointed to by the current value
of the program counter isthe first instruction traced.

count: isan integer constant expression, in the decimal integral interval [1,
65535], that specifies the number of instructions to be traced. If count is
omitted, one instruction is traced.

Debugger engine.

i n>t

TRACED

RO=0x3FC1E8 R1=0x3F9AE8 R2=0x0 R3=0xC R4=0x8001 R5=0x15 R6=0x15
R7=0xD R8=0x0 R9=0x0 R10=0x0 R11=0x0 R12=0x0 R13=0x0

R14=0x0 R15=0x0 R16=0x0 R17=0x0 R18=0x0 R19=0x0 R20=0x0
R21=0x0 R22=0x0 R23=0x0 R24=0x0 R25=0x0 R26=0x0 R27=0x0
R28=0x0 R29=0x0 R30=0x0 R31=0xB FR00=?7?7?? FR01=7?7?? FR02=??77?
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FRO03=??7?? FR04=???7? FR05=???? FR06=???? FRO7=?7?? FR08=77?777?
FRO9=?777

FR10=???? FR11=?7?7?? FR12=?7??7? FR13=??7?? FR14=??7?? FR15=?7?77
FR16=7??77

FR17=??7?7? FR18=?7??? FR19=??7?? FR20=??7?? FR21=???? FR22=?7?77
FR23=?7?77

FR24=7??77? FR25=?7??7? FR26=??7?? FR27=?7?7?7? FR28=?7??? FR29=77?777
FR30=?7?77

FR31=??7?? CR=0x40000800

3FC2A0 7E841840 cnplw crf5, r4, r3

Contents of registers are displayed and current instruction is disassembl ed.

TESTBOX

Description  Displays amodal message box shown in Figure 7.2 with a given string.

Figure 7.2 TESTBOX message box

Testboc |

& Step 1: init all vars

Usage TESTBOX "<String>"

Components  Debugger engine.

Example

IN>TESTBOX "Step 1: init all vars'

TUPDATE

Description  In Profiler and Coverage components, the TUPDATE command

switches the time update feature on/ off.

Usage TUPDATE on|off
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components  Profiler and Coverage components.
Example

in>TUPDATE on

UNDEF
Description ~ The UNDEF command removes a symbol definition from the symbol
table. This command does not undefine the symbols defined in the loaded
application.
Program variables whose names were redefined using the UNDEF
command are visible again. Undefining an undefined symbol is not
considered an error.
Usage UNDEF symbol | *
If * is specified, all symbols defined previously using the command
DEFINE are undefined.
Components  Debugger engine.
Example

DEFI NE test = 1

UNDEF t est
When the test variable is no longer needed in acommand program, it can
be undefined and removed from the list of symbols. After UNDEF test, the
test variable can no longer be used without (re)defining it.

NOTE  Seeaso examplesof the DEFINE command.

Examples  Thevalue of an existing symbol can be changed by applying the DEFINE
command again. In this case, the previous valueisreplaced and lost. It is
not put on a stack. Then when UNDEF is applied to the symboal, it no
longer exists, even if the value of the symbol has been replaced several
times:
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i n>DEFI NE apple O
i n>LS

appl e 0x0 (0) /1l apple is equal to O

i n>DEFI NE apple = apple + 1
i n>LS

appl e Ox1 (1) /1l apple is equal to 1

I Nn>DEFI NE apple = apple + 1
i n>LS

appl e 0x2 (2) /1l apple is equal to 2

i n>UNDEF appl e

i n>LS
Il apple no longer exists
In the next example, we assume that the FI BO. ABS sampleisloaded. At
the beginning, no user symbol is defined:

i n>UNDEF *

i n>LS

User Synbol s: /'l there is no user synbo

Appl i cation Synbol s: /'l synmbols of the |oaded application

fi boCount 0x800 (2048)

count er 0x802 (2050)

_startupData 0x84D (2125)

Fi bonacci 0x867 (2151)
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mai n
I nit
_Startup

0x896 (2198)
0x810 (2064)
0x83D (2109)

I n>DEFI NE counter =1

i n>LS

User Synbols: // there is one user synbol: counter
count er Ox1 (1)

Appl i cation Synbol s:

fi boCount
count er
_startupDat a
Fi bonacci
mai n

Init
_Startup

/1 synmbols of the | oaded application
0x800 (2048)
0x802 (2050)
0x84D (2125)
0x867 (2151)
0x896 (2198)
0x810 (2064)
0x83D (2109)

i n>undef counter

i Nn>LS

User Synbol s:

Appl i cation Synbol s:

/[l there is no user synbol
/'l synbols of the |oaded application

fi boCount 0x800 (2048)

count er 0x802 (2050)

_startupData 0x84D (2125)

Fi bonacci 0x867 (2151)

mai n 0x896 (2198)

I nit 0x810 (2064)

_Startup 0x83D (2109)
UNFOLD

Description  In the Source component, the UNFOL D command is used to display the

contents of folded source text blocks, for example, source text that has
been collapsed at program block level. All text is unfolded once or (*)
completely, until no more folded parts are found.
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usage UNFOLD [*]
Where * means unfolding completely, otherwise unfolding only one level.
Components  Source component.
Example
in>UNFOLD *
UNTIL
Description ~ The UNTIL keyword is associated with the REPEAT command.
usage UNTIL condition
Where condition isdefined asin “C” language definition.
Components  Debugger engine.
Example
r epeat
open assenbly
wait 20
definei =i + 1
until i==
At the end of the loop, i isequal to 3.
UPDATERATE
Description  In the Data component and Memory component, the UPDATERATE
command is used to set the data refresh update rate. This command only
has an effect if the Data or Memory component to which it appliesisset in
Periodical Mode.
usage UPDATERATET rate
where rate is a constant number matching a quantity of timein tenths of a
second, between 1 and 600 tenth of second (0.1 to 60 seconds).
Components  Dataand Memory component.
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Example

i n>Menory < updaterate 30

This commands sets the Memory component updaterate to 3 seconds.

VER
Description ~ The VER command displays the version number of the Debugger engine
and components currently loaded in the Command line window.
Usage VER
Components  Debugger engine.
Example

I n>ver

HI - WAVE 6. 0. 27

HI - WAVE Engi ne 6. 0. 49

Sour ce 6. 0. 20

Assenbl y 6.0. 14

Procedure 6.0. 10

Regi st er 6.0.14

Menory 6.0.19

Dat a 6. 0. 27

Dat a 6. 0. 27

Si mul ator Target 6.0.17

Conmand Li ne 6.0. 16

Description

In the Command Line component window, Debugger engine and
components versions are displayed.

WAIT

The WAIT command pauses command file execution for atime in tenths
of second or pauses until the target is halted when the option “;s” is set.

When no parameter is specified, it pauses for 50 tenths of a second (5
seconds).

DM-382
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When only timeis specified, execution of the command fileis halted for
the specified time.

When only ;sis specified, execution of the command fileis halted until the
target is halted. If the target is already halted, command file execution is
not halted.

When time and ;s are specified:

If the target is running, command file execution is halted for the specified
time only if the target is not halted. If the target is halted during the
specified period of time (while command file execution is pending), the
time delay isignored and the command fileis run.

If thetarget is already halted, command file execution is not halted (time
delay isignored).

NOTE  TheWait instruction ends as soon as the PC is changed.
Usage  WAIT [time] [;9]
Components  Debugger engine.
Example
VAI T 100
T
Pauses for 10 seconds before executing the T Trace instruction.
WB
Description ~ The WB command sets a specified block of memory to a specified list of
byte values. When the range is wider than the list of byte values, the list of
byte values is repeated as many times as necessary to fill the memory
block. When the range is not an integer, a multiple of the length of the list
and the last copy of the list is truncated accordingly. This command is
identical to the memory set (MS) command.
Usage WB rangelist
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range: is an address range constant that defines the block of memory to be
set to the values of the bytesin thelist.

list: isalist of byte valuesto be stored in the block of memory.
MS
Debugger engine.

I n>WB 0x0205. . 0x0220 OxFF

Description

Usage

Components

Example

This command fills up the memory range 0x0205..0x0220 with the OxFF
byte value.

WHILE

The WHILE command allows you to execute a sequence of commands as
long as a certain condition is true. The WHIL E command may be nested.

This command can be stopped by pressing the [Esc] key.
WHILE condition

Where condition isdefined asin “C” language definition.
Debugger engine.

DEFI NE j ump = O

VWHI LE junp < 20
DEFI NE junmp =

ENDVWHI LE

T

jump + 1

While jump < 100, the jump variable is incremented by the instruction
DEFINE jump = jump + 1. Then the loop ends and the T Trace instruction
IS executed.
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WL

Description ~ The WL command sets a specified block of memory to a specified list of
longword values. When the range iswider than the list of longword values,
thelist of longword valuesisrepeated as many times as necessary to fill the
memory block. When the range is not an integer or amultiple of the length
of the list, the last copy of thelist is truncated accordingly.

When a size is specified in the range, this size represents the number of
longwords that should be modified.

Usage WL rangelist

range: is an address range constant that defines the block of memory to be
set to the longword valuesin thelist.

list: isalist of longword valuesto be stored in the block of memory.

Components  Debugger engine.

Example

i n>W. 0x2000 OxOFFFFFOF

This command fills up memory starting at address 0x2000 with the
OXOFFFFFOF longword value. The addresses 0x2000 to 0x2003 will be
modified.

i n>W. 0x2000, 2 OxOFFFFFOF

This command fills up the memory area 0x2000 to 0x2007 with the
longword value OXxOFFFFFOF.

WPORT

Description ~ The WPORT command is used to set the port addresses of the Wagon
component.

Usage WPORT (address|ident) (address|ident)

Addresslocates the port address value of the component (various formats
are allowed), the default format is hexadecimal.

Ident isaknown identifier, its content will define the port address.

Debugger Manual DM-385

For More Information: www.freescale.com



'
A

Freescale Semiconductor, Inc.

veovugger Commands
Simulator/Debugger Commands

Components

Example:

Wagon

I N>WPCORT 0x100 0x200

Description

Usage

Components

Example

Ports of the Wagon are now defined at addresses 0x100 and 0x200.

Ww

The WW command sets a specified block of memory to a specified list of
word values. When the range is wider than the list of word values, the list
of word values is repeated as many time as necessary to fill the memory
block. When the range is not an integer or a multiple of length of thelist,
the last copy of thelist istruncated accordingly.

WW range list

range: is an address range constant that defines the block of memory to be
set to the word valuesin the list.

list: isalist of word values to be stored in the block of memory.

Debugger engine.

I n>WV 0x2000.

. 0x200F OxAFOO

Description

This command fills up the memory range 0x2000..0x200F with the
OxAFO00 word value.

ZOOM

In the Data component, the ZOOM command is used to display the
member fields of structures by ‘diving’ into the structure. In contrast to the

UNFOLD command, where member fields are not expanded in place. The

display of the member fields replaces the previous view. The ZOOM out
command is used to return to the nesting level indicated by the given
identifier.

DM-386
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TIP

NOTE

Usage

Components

Example

Addresses are not needed to zoom out. Simply type “ZOOM out”.

This command is relevant when “ C-source” debugging.

ZOOM addressinjout

Where addr essis the address of the structure or pointer variable that
should be zoomed-in or zoomed-out, respectively.

Data component.

in>ZO0OM Ox1FEQ in

The variable structure located at address Ox1FEOQ is zoomed in.

in>zoom & _startupData

zoomsinthe _startupData structure (& _startupData isthe address of the
_startupData structure).

Debugger Manual
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8

True Time I/O Stimulation

The Simulator/Debugger 1/0 Stimulation component is afacility to trigger
I/O events. With the Stimulation component loaded, interrupts and register
modifications invoked by the hardware can be simulated. In this tutorial,
examples of stimulation files are introduced and explained.

Click any of the following links to jump to the corresponding section of
this chapter:

e Stimulation Program examples
e Stimulation Input File Syntax

Stimulation Program examples

Running an Example Program Without
Stimulation

1. Runthe Simulator/Debugger.
The Main Window is shown in Figure 8.1.

DM-388 Debugger Manual
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Figure 8.1  Simulator/Debugger I/O-Simulation main window
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Choose Simulator > Set > Sim.
Choose Component > Open > o _led.
The 10_Led component is shown in Figure 8.2.

Figure 8.2 10_Led Component window

nlelnlelele 1o ley

POET=00 DDE=00

4. Choose Component > Open >Template.
The Template component is shown in Figure 8.3.
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Figure 8.3 Template component window
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Choose Smulator>Load io _demo.abs.

Choose Run>Sart/Continue or click the'green arrow' icon.

If the program haltsin startup, click the Start/Continue command
again.

8. Choose Run > Halt to stop execution after a few seconds.
The Template component isaview linked to a specific memory location in

TargetObject. In the source code of the test program, you can find a
variable associated with it:

#define PORT_DATA (*((volatile unsigned char *)0x0210))/ * Val ue wi th range
0..255 */

The Template component polls this value and displaysit in a speedometer
like outlook.

In the procedure |O_Show ini o_deno. ¢ shownin Listing 8.1, this
valueisincremented or decremented, depending on the raise direction. The
raise direction depends on a global variable dir, that is turned back, when
the top or bottom value is reached.

Listing 8.1 IO_Show procedure in io_demo.c

static void | O Showmvoid) {
for (;;) { /1 endl ess | oop
dir = 1;
do {
Del ay() ;
PORT_DATA++;
} while ((dir == 1) && (PORT_DATA != 255));
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dir = -1;
do {
Del ay() ;
PORT_DATA- -;
} while ((dir == -1) && (PORT_DATA !'= 0));
}
}
Example Program with Periodical Stimulation
of a Variable
Choose Simulator >Reset.
Choose Smulator | Load 1o _demo.abs.
Choose Component | Open | Simulation
The Stimulation component is shown in Figure 8.4.
Figure 8.4 The Stimulation component window
i Stimulation =]

logoooaa

def a = TargetObject.#210.E;:

N o g b

Activate Stimulation Window by clicking on it.

Choose Simulation > Open Fileio_var .txt.

Choose Simulation > Execute.

Choose Run > Sart/Continue.

The Stimulation component executing i 0_var . t xt accesses
TargetObject at the address 0x210 associated with PORT_DATA in the

source. Y ou can observe this by watching the Template component. The
arrow is not raising with continuity, but jumping around. The value of

Debugger Manual
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PORT_DATA isnow handled from “outside’, from our Stimulation
component.

Using an editor, openthefilenamedi o_var . t xt inthe simulator demo
directory. Thisfilelooks like Listing 8.2.

Listing 8.2 io_var.txt

/* Define an identifier a, which is |ocated at address 0x210*/
/* This identifier is 1 Byte wide.*/
def a = Target Obj ect. #210. B;

/* After 200 000 cycl es have expired, repeat 50 tine */
/* the code sequence specified between the keywords */
/* PERI ODI CAl and END. */
PERI CDI CAL 200000, 50:
50000 a = 128; /* After 50 000 cycles, wite 128 at address
0x210. */
150000 a = 4; [* After 150 000 cycles, wite 4 at address
0x210. */
END

10000000 a = 0; /* After 10 000 000 cycles, wite O at address
0x210. */

First, the simulated object is defined. This object islocated at address
0x210 and is 1 byte wide. Once 200,000 cycles have been executed, the
memory location 0x210 is accessed periodically 50 times. First the
memory location is set to 128 and then 100,000 cycleslater, it is set to 4.

Example Program with Stimulated Interrupt
Choose Simulator>Reset.

Activate Stimulation Window by clicking on it.

Choose Simulation>Open File i o_i nt . t xt.

Select the Sour ce component window.

Choose Source>Open Modulei o_deno. c.

© g s~ W DN P

Scroll into the procedure Interrupt_Routine.
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7. Set abreakpoint in the Interrupt_Routine as shown below.
The Source component window is shown in Figure 8.5.

Figure 8.5 Source component window

i Source o =] 3
[M:\DEMOa_demo.c |Line: 21

i -1 =» decreasing ﬂ

interrupt woid Interrupt Routine (woid) {[F

K dir *= -1: £f operation to be executed oh interrupt J
&}
static woid Delay(woid) {[F S4 Wait for a short time

wvolatile char cnt = 0;
while [ecnt < DELAT) cnt4+;

=) ||
Activate Stimulation Window by clicking on it.

Choose Simulation>Execute.
10. Choose Run>Sart/Continue.

After about 300,000 cycles the simulator stops on the breakpoint in the
interrupt routine and the corresponding source lineis highlighted. The
interrupt has been called. Start the smulator. It stops approximately each
100,000 cycles on the same breakpoint. Restart and repeat these actions
until 1,200,000 cycles. Start again, the simulator runs until 10,000,000
cycles and stops on the breakpoint. Start the ssmulator. It continues to run.
The stimulation is finished.

The interrupts have been invoked by the Stimulation component source
i0_int.txt. Thelisting of the Stimulation fileisgivenin Listing 8.3.

Listing 8.3 io_int.txt

def a = Target Obj ect. #210. B;
PERI CDI CAL 200000, 10:

100000 RAISE 7, 3, "test_interrupt”;
END

10000000 RAISE 7, 3, "test_interrupt”;
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In thefirst line, the stimulated object is defined. The interrupt israised
periodically 10 times. The RAISE command takes the number of the
interrupt in the interrupt vector map asthe first argument. This number, “7”
in our exampleis arbitrarily chosen. To export this example to a different
target, take alook at the interrupt vector map in the technical data manual
of the matching MCU. Using an editor, openthe i o_deno. pr mfilein
the same demo directory. Y ou can see at the end of thisfile how to set the
interrupt vector (adapt it to your needs).

VECTOR 7 Interrupt _Function /[/* set vector on Interrupt 7 */

If theinterrupt vector addressis not specified in the prm file, the simulator
will stop when interruption is generated. The exception mnemonic
(matching the interrupt vector number) is displayed in the status bar of the
Simulator/Debugger.

The second argument specifies the interrupt priority and the third argument
is afree chosen name of the interrupt.

Thefilei o_i nt . t xt isusedto generate 11 interrupts. 10 periodica
interrupts are generated every 100° 000 CPU cycles from 200’ 000 +

100’ 000 = 300" 000 to 1' 200’ 000 CPU cycles. A last oneis generated when
the number of CPU cycles reaches 10’ 000’ 000.

Example of a Larger Stimulation File

Listing 8.4 contains this example and is commented below. This example
file may not work as expected if the variables defined here do not refer to a
port in TargetObject. In our example, we have only defined the objects
TargetObject.#210 and #212 over the lo_led component. Definitions of b,
c and pbitsare only herefor illustration. Remove these definition lines and
the lines that refer to them, if the example presented here is not executable.

Listing 8.4 Example file io_ex.txt.
def a = Target Obj ect. #210. B;
def x = Target Obj ect. #212;
def b = Target Obj ect. #216. W
def ¢ = Target Obj ect. #220. L;
def pbits Leds. Port _Register.B[7:3];

#10000 pbits

3;

DM-394
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20000 a = O;
+20000 b = pbits + 1;

PERI ODI CAL 100000, 10:
10000 a = 128;
30000 RAISE 7, 3, "test_interrupt”;
END

1000000 RAISE 7, 3, "test_interrupt”;

Detailed Explanation

def a = Target Obj ect. #210. B;
defines a as byte mapped at address 0x210 in TargetObject.
def x = Target Obj ect. #212;
defines x as byte mapped at address 0x212 in TargetObject. Size can be
omitted, .B for byte is default.
def b = Target Obj ect. #216. W
defines b asword (.W) mapped at address 0x216 in TargetObject.
def ¢ = Target Obj ect. #220. L;

defines c aslong (.L) mapped at address 0x220 in TargetObject.

def pbits = Leds.Port_Register.B[7:3];

defines pbitsas bits 5,6 and 7 in the byte (.B) register named
Port_Register in Leds. (In the Smulator, names of target objects can be
specified. In our example, it is the name of the port register defined by the
|O-Led component).

#10000 pbits = 3;

setsthe 3 bits of L eds. Port_Register accessed with pbitsto binary 011.
Other bits are unaffected. The new value of Port_Register will be 0x75, if

Debugger Manual DM-395
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theinitial value was 0x55. Values outside the valid BitRange of phitsare
truncated (in this example only values from 0 to 7 are allowed for phits).
The # means that the time of execution of the instruction is 10000 cycles
after the start of the simulation.

20000 a = O;

NOTE

setsa to 0. Without # or + in front of the time marker, thetimerefersto the
absolute time after starting execution of the Stimulation file.

In aperiodical loop, the time marker without operator isinterpreted as +.

+20000 b = pbhits + 1;

reads phits (3 bitsin Leds. Port_Register), increments this value and
writesit to b. The + in front of the time marker refersto thetimerelativeto
the last encountered time value in the Stimulation file.

PERI CDI CAL 100000, 10:

executes the following block

10000 a = 128;
30000 RAISE 7, 3, "test_interrupt”;

10 times. Starts execution 100000 cycles after the start of the ssmulation.

10000 a = 128;

assigns 128 to a, 10000 cycles after each start of the periodical event.

30000 RAI SE 7,

3, "test _interrupt”;

raises an interrupt with priority 3 with vector number 7, 40000 cycles (1)
after each start of the periodical event. The time specification in the
PERIODICAL loop isaways relative. So 30000 means +30000. The
raised interrupt has the name "test_interrupt"”. This name is not important
for the interrupt functionality.
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END

end of the periodical block. The block islooped again after finishing. So
the loop restarts after 10000 + 30000 = 40000 cycles.

1000000 RAISE 7, 3, "test _interrupt”;

raises the interrupt for the last time. This instruction marks the terminating
point of the Stimulation, if there are no pending periodical events |eft.

Stimulation Input File Syntax

EBNF

StimulationFile= { IdDeclaration | TinmedEvent |
Peri odi cEvent }.
“def” (bjectld “=" (bjectField

| dDecl ar ati on

jectField = O’:)j ectSpec [ “[” BitRange “]”
].

B t Range = StartBit “:” NoOIBits.

Ti medEvent = [ “+ | “("] Tine

Assi gnment Li st.
AssignnentList= { Assignnent | Exception}.

Peri odi cEvent “PERI CD CAL” Start NoTines “:”
{ PerTinmedEvent } “END’ .

Per Ti nedEvent= [“+"] Ti me Assignment Li st

Except i on = “RAISE’ Vector “,” Priority
[“,” ArbPrio] [*,” Nane] “;” .

Assi gnnent = ( (hjectld | hjectField) “=
Expression “;”.

’\b.rre: un { Char aCt er} “wnn

Expr essi on = a standard ANSI - C expressi on.

The expressi on accepts obj ect
identifiers previously defined
(hj ect Spec and (bj ect Fi el d).
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Ti me = a nunber which represents a
nunber of cycle.
bj ect Spec = the nanme of an object as

defined in Requirenent
specification for (bject Pool.

Vector= the exception vector nunber .

Priority= the exception priority nunber .

ArbPrio= the arbitration priority of the
exception .

Start= the nunber of cycle when the peri odi cal
event nust be called for the
first time after the initial
time.

NoTi mes= the nunber of time the periodical
event has to be called (0 =
infinity).

Remarks

If bitRangeis omitted, all bits of the object register are affected. If
bitRangeis specified, the mask defined by this bitRange appliesto the
value calculated with the Expression. Only the bits of the object
register defined in the bitRange are affected by this value.

Bits are numbered from right to left (in abyte, bit 7 isthe most left bit).
So in bitRange, noOfBitsis awaysless or equal than StartBit +1.

ObjectSpec is defined in Requirement specification for Object Pool as
below:

bj ect Spec: : =Chj ectNane [“.” Fi el dNane] .

oj ect Nane: : =l dent [“:” Index].

Fiel dNane:: =ldentNum ( [“..” ldentNunj |
[“.” Size] ).

ldentNum: = Ident | “#* HexNunber.

Size ::= “B | “W | “L".

Theidentifiers declared in |dDeclar ation are stored in a table of
identifiers and can be also used in Expression.

If “#" is specified, the timeis absolute: it isthe number of cycles since
the Simulator was started.

If “+” is specified, thetime isrelative to the previous time
specification.

If nothing is specified, timeis the number of cycles since execution of
the Stimulation file.
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* If sizeisomitted, the default sizeis byte (B).

» The periodical event issent for the first time at initial time + start +
time specified in periodical timed event.

* Inthe Per TimedEvent declaration, the “+” is optional. If specified or
not, the following time is interpreted exactly the same way.

» The periodical events are not displayed in the stimulation screen.
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Real Time Kernel
Awareness

The Simulator/Debugger allows you to load and control applications on the
target system (or applications ssmulated on the host). It also alows you to
inspect the state of the application, which includes global variables,
processor registers and the procedure call chain including the local
(automatic) variables.

This chapter describes how applications built of several tasks are handled
by a generic awareness support and an OSEK awareness.

Click any of the following links to jump to the corresponding section of
this chapter:

* Read Time Kerndl Awareness Introduction

e Task description language

» Example of application

 |nspecting data structures of the Kernel

* Reqgigter assignments for the RTK awareness
e OSEK Kernel Awareness

Real Time Kernel Awareness Introduction

Often operating systems (Real Time Kernels) are used to coordinate the
different tasks in more complex systems. This chapter describes how
applications built of several tasks can be handled with the Simulator/
Debugger. There are two main topics to be considered:
» Debugging of any task in the system (e.g., viewing the state of any task
in the system). When using the origina basic versions of the Simulator/
Debugger, only the current task can be inspected. Due to this extension,
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Real Time Kernel Awareness Introduction

it is possible to switch the debugging context from the current task to
any other task and between any tasks in the system.

* Real time kernels use data structures to describe the state of the system
(scheduling information, queues, timers,...). Some of these data
structures are interesting for the user of an operating system too and
will be described in this chapter.

Inspecting the state of a task

Each multitasking operating system will store the context of each task at a
specific location, usually called the task descriptor. This context consists of
the CPU context (CPU registers) and the content of the associated stack.
There will be more information in the task descriptor, depending on the
specific implementation of the kernel.

The Simulator/Debugger allows you to inspect the CPU registers and stack
containing al procedure activation frames (return addresses, parameters,
local variables). Therefore, it has to get thisinformation for each task to be
debugged. Since thisinformation is specific to the kernel used, thereisan
universal way to specify the location where and how to collect this data.
Thisinformation is read from afile with the name 'OSPARAM PRM. This
file describes the algorithm on how to get all needed data from the target
memory (from the task descriptors). To describe this algorithm, asimple
procedural language is used. The only parameter to the algorithm is an
address specified by the user, which identifies the task to be inspected. The
result will be the CPU context (CPU registers) and status of the task, which
allowsthe debugger to display the procedure activation stack in asymbolic

way.
RTK interface

When the application is halted, the debugger displays the state of the
current task. To identify the task to be inspected, the user has to follow
these steps.

Make the task descriptor or a pointer to it visible in any of the debugger's
data windows.

Pressthe IF‘ | key while clicking the left mouse button on a variable of
type "pointer to task descriptor".
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Now the current state of the selected task and procedure chain of that task
isdisplayed in the 'Procedure Chain' window. By clicking on the
procedures in the call chain list, the local data of that function is displayed
inthe'Datal’ window. All the usual debugging functions are also available
to inspect this task now (including displaying the register contents).

Task description language

To perform debugging on any task, afile named " OSPARAM PRM' hasto
be created and must be stored in one of the directories specified in
GENPATH

Thefile "OSPARAM PRM' describes the algorithm to collect the context
information for a specific task (the PC, SP, DL, SR and registers).

The following syntax has to be used to specify the algorithm (in EBNF):

St at Sequence = [Statenent] {';'
Statenent; }.

St at enent = Assignnent | ErrorMsg | If.

Assi gnnent = I dent ':=" Expression.

Error Msg = 'MSG ':= String.

| f Statenen = 'IF Bool Expr ' THEN
St at Sequence {ELSI FPart}
[ ELSEPart] 'END .

ELS| FPar t = 'ELSIF Bool Expr ' THEN
St at Sequence.

ELSEPar t = "ELSE St at Sequence.

String = '"" {char} """.

Bool Expr = Expressi on Rel O
Expr essi on.

Expr essi on = Term{Q Tern}.

Term = Ident | Function | Nunber.

| dent = 'a..'z" | "ROO".."R31" |
‘DL | 'SP | "SR | "PC |
"'STATUS | 'B.

Functi on = (‘M| "MV | "M | "MY)
"[' Expression ']"'.

Rel Op = <] e |
e

o3 R
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The terminal symbols have the following meaning:

B is the given reference to the task descriptor (initialized upon

start).

MB
MW
MD

MA
WORD.

DL
same as SP).

are variables for intermediate storage.

gets value of memory BY TE at given address.
gets value of memory WORD at given address.
gets value of DOUBLE WORD at given address.

getsvalue at given address interpreted as DOUBLE

is the program counter to be set.
isthe stack pointer to be set.
isthe status register value to be set.

isdynamic link (data base) to be set (if not available,

STATUS error number to be set (refer to manual).

Rnn

registers see manual).

processor registers to be set (mapping to CPU

MSG iserror message (has to be specified if N >= 1000).

On activation of the task debugging command, the file" OSPARAM PRM'
is opened and the selected addressis stored in variable 'B'. Then the
commands in the file are interpreted. The CPU context of the task is then
expected in the variables PC, SP, SR, DL, Rnn and EN. EN describes the
status of the task. If 'EN' is bigger than 1000 the status is expected in the

string MSG.
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Example of application

Listing 9.1 shows an example of " OSPARAM PRM' file for SOOM
System/REM.

Listing 9.1 OSPARAM.PRM file

{ File OSParam PRM i nplenentation for SOOM Syst enl REM }
{ RO..R7 = DO..D7, R8..R15 = A0..A7 }
{ M5G = nessage displayed in Procedure Chain w ndow }

DL :=MDX(B+8);{ A6 in PD, dynamc |ink }
SP :=MD(B+4);{ A7 in PD, stack pointer }
PC :=MD(B+14);{ PC in PD, programcounter }
SR c=MA(B+12);{ SR in PD, status register }

STATUS: =1000;{ Initialized with 1000 }
|F MA(B+18) = 1 THEN

{ IF (registers are saved in task Control Bl ock) THEN }
RO := MD(B+22); Rl := M) B+26); R2 : = MD(B+30);
R3 := MD(B+34); R4 := M)(B+38); R5 : = M) B+42);
R6 := MD(B+46); R7 : = NMD(B+50); R8 : = MD(B+54);
RO : = I\/D( B+58) ; R10 : = MD(B+62); R11 : = MD(B+66);
R12 := M) B+70)

END;

R13 := B;

R14 : = DL;

R15 .= SP;

I = MB(B+112);{ i contains the current state of the selected

task }

I F i = OTHEN MSG : = " Readyl nCQSc"

ELSIF i = 1THEN MSG : = "Bl ockedByAccept"

ELSIF i = 2THEN MSG : = "Wi t For DRepl y"

ELSIF i = 3THEN MSG : = "Wait For Mai | "

ELSIF i = 4THEN MSG : = "Del ayQueue"

ELSIF i = 5THEN MSG : = "Bl ockedByRecei ve"

ELSIF i = 6THEN MSG : = " Wi t For Semaphor e"

ELSIF i = 7THEN MSG : = " Dunmy"

ELSIF i = 8THEN M5G : = " SysBl ocked”

ELSE MSG : = "invalid"

END;

For More Information: www.freescale.com
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Inspecting data structures of the Kernel

To alow the debugger to display the data structures of the operating
system, the corresponding symbol information has to be available. Thisis
the case when using SOOM System/REM. When another kernel isused its
source code would have to be available and would have to be compiled.
However, if only the object code is available, the needed symbol
information can be generated in the following way:

» Thekernel data structures of interest have to be described using ANSI-
C language, as shownin Listing 9.2.

Listing 9.2  kernel data structures description

typedef struct PD {
i nt status;
struct PD *next,;
| ong regs[6];

} PD;

Thisis an example of the definition of a simple task descriptor.

» Variables can be collected in a structure and have to be assigned to a
segment (for example, 'OS_DATA' shown in Listing 9.3).

Listing 9.3 OS_DATA structure

#pragma DATA_SEG OS_DATA

struct {
PD *readyli st; [* list of tasks ready to be executed */
char filler[6]; [ * uninmportant variables */
I nt processes; /* total nunber of tasks */
PD processes[10]; /* the 10 possible tasks */
} OS_DATA;
This structure should be defined in away to fit the same layout as the
operating system used. It might be necessary to introduce filler variablesto
get the correct alignment.
» Thissegment has to be placed by the linker to the correct address by
using the PRM file shown in Listing 9.4:
Debugger Manual DM-405
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Listing 9.4 Linker PRM file
NAMES ... rtk.o+ ... END
SECTI ONS
RTK_SEC = NO_INIT 0x1040 TO 0x1F80;
END
PLACENMENT
OS_DATA | NTO RTK_SEC;
END
The source file (for example, 'rtk.c") has to be compiled and listed in the
NAMES section of the linker parameter file. To force linking, the name of
the object file has to be immediately followed by a'+'. In this example the
variable islinked to the address 0x1040.
If an application is prepared in thisway, al declared variables may be
inspected in the data windows of the Simulator/Debugger. Thereisno
restriction in the complexity of the structures to describe the global data of
the kernel.
NOTE  Wedo not recommend opening the terminal window during testing. Errors

detected during reading of aPRM file are written to this window.

Register assignments for the RTK awareness

OSEK Kernel Awareness

OSEK Kernel provides aframework for building real-time applications.

OSEK Kernel awareness within the debugger allows you to debug your
application from the operating system perspective.

The CodeWarrior Debugger supports OSEK ORTI (OSEK Run Time
Interface) compliant real-time operating systems and offers dedicated

DM-406
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kernel awareness, by using the information stored in your application's
ORTI file.

With the CodeWarrior OSEK kernel awareness, you can monitor kernel
task information, semaphores, messages, queues, resources allocations,
synchronization, communicating between tasks, etc.

ORTI isintended for the description of applicationsin any OSEK
implementation. It describes a set of attributes for system objects and a
method for interpreting the data obtained.

OSEK ORTI

The OSEK Run Time Interface (ORTI) isintended as an interface for
development toolsto the OSEK Operating System. It isapart of the OSEK
standard (refer to www.osek-vdx.org).

OSEK ORTI Definition

The OSEK ORTI intends to enable the attached tool to evaluate and
display information about the operating system, its state, its performance,
the different task states, the different operating system objects etc.

The ORTI file contains dynamic information as a set of attributes that are
represented by formulas to access corresponding dynamic values.
Formulas for dynamic data access are comprised of constants, operations,
and symbolic names within the target file. The given formula can then be
evaluated by the debug tool to obtain internal values of the required OS
objects.

Debugger Manual DM-407
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Figure 9.1

ORTI Aware debugging system

oAam
Operating System Information:
dalivers names and meaning
ol O5-Proparlias

ORTI
File

Compiler/
Linker

Targel Symbol
Infarmation

N

Wariabla info Regas!

Task 2; Keybaard Entry running
Task 3: Motor Contred  walting

Task 4: Control progmpted
Stack Usagpe: A%

Wariatile Info

Two types of data shall be made available to the CodeWarrior debug tool.
One type shall describe static configuration data that will remain
unchanged during program execution. The second type of data shall be
dynamic and this datawill be re-evaluated each time by Code Warrior. The
static information is useful for display of general information and in
combination with the dynamic data. The dynamic data gives information
about the current status of the system.The information given to
CodeWarrior is represented in atext (ORTI-File). The file describes the
different objects configured in the OS and their properties. Theinformation
isrepresented in direct text, enumerated values, Symbolic names, or an
equation that may be used for evaluating the attribute.

The ORTI Fileis generated when building the project through the OSEK
System Generator. The generated file has the same name and the same
location as executable file but its extension is .ort.

ORTI File Structure

The ORTI file structure builds on top of the structure of the OSEK OIL
file. It consists of the following parts:

* Version Section - This section describes the version of the ORTI
standard used for the current ORTI file.

DM-408
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» Implementation Definition Section - This section describes the method
that should be used to interpret the data obtained for the value. This
section may also detail the suggested display name for a given attribute.

» Application Definition Section - This section contains information on
all objectsthat are currently available for a given system. This section
also describes the method that shall be used to reference or calculate
each required attribute. Thisinformation shall either be supplied asa
static value or else aformulathat shall be used to calculate the required
value.

An OSEK ORTI File Sampleis described in Appendix.

OSEK RTK Inspector component

OSEK awareness is described through the Code Warrior RTK Inspector
component as show in Figure 9.2.

Inspector window is displayed by clicking on Component>Open... menu
entry and then by clicking on I nspect icon in the “ Open Window
Component” window.

When the RTK componentsicon is selected in the hierarchical content of
the items, the right side displays various information about OSEK Aware-
ness.
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Figure 9.2 Code Warrior RTK Inspector

] Inspect !EI m

El Components Marne Stack Start Address | Stack End Address | Stack Size
- [H] WatchPaints MAIN_STACK 0300 0900 0100
-H BreakPaoints ISR _STACK 0x911 0x951 x40
Stack, MokarDriveTask_STACK  0x979 0x2dd 064
___EEEE Symbol Table ConkrolTask_STACK Dx9de Oxadz D64
o Events
=85 RTK

i oo

oo 2%

GG
13 TASK

----- BE MaotorDriveTask

=

----- BE TnitTask

----- BE TnpukTask

----- BE | nckTask

=-88 MESSAGE

----- BE Man_Input

----- B nﬁn Msg_Lock
----- 4 Exceptions

-3 Object Pool

The OSEK RTK Inspector providesall theseinformation. Asdefined in the
ORTI file, objects of the same type are grouped and can be viewed
together.

o Task

» Stack
SystemTimer
Alarm
Message.

Below you can find a description of typical objects along with their
attributes and how they are presented:
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NOTE Beaware that objects and their attributes depend on the OSEK
implementation and OSEK configuration, and therefore may differ from
this description.

Task

The Task shown in Figure 9.3 displays the current state of OSEK task
trace.

Figure 9.3 Inspector Task

Task Priority | Task State Events State | ‘Waited Events | Task Event Masks | Current Task Stack | Task Properties

MotorDriveTask 10 WAITING 0x0 0x7 UP_EVENT =, 5...  MotorDriveTask_... EXTEMDED, F...
ControlTask 20 WAITING 0x0 0x1f KEY_EVENT =, ... ControlTask_STACK EXTEMDED, F...

InitTask. 30 SUSPEMDED 00 00 MATN_STACK BASIC , MOMP...
InputTask o SUSPEMDED 00 00 MATN_STACK BASIC , FULL...
LockTask 5 SUSPEMDED 00 00 MATN_STACK BASIC , FULL...

L
BB InitTask
BB InputTask

When selecting Task in the hierarchical tree on the left side, additional
information concerning tasks is displayed on the right side:

* Name: displays the name of the task

e Task priority: displaysthe priority of the task.

* Task State: describesthe current state of the task. Possible values are
READY, SUPENDED, WAITING, RUNNING or INVALID_TASK.
The ORTI file defines the different states.

» Events States: the event is represented by its mask. The event mask is
the number which range is from 1 to OxFFFFFFFF. When the event
mask valueis set tol, the event is activated. When it is set to O, the
event is disabled.

» Waited Events: when the bit is set to 0, the event is not expected.
When the bit is set to 1, the event is expected.

* Task Event Mask: describes the current task event mask.

* Current Task Stack: displays the name of the current stack used by
the task.

» Task Priorities: describes task priorities. Possible value are BASIC/
EXTENDED, NONPREMPT/FULLPREMPT, Priority value, AUTO.
The ORTI file defines the possible values.

Stack

The Stack shown in Figure 9.4 displays the current state of OSEK stack
trace.

For More Information: www.freescale.com
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Figure 9.4

]| Inspect
=-BE STacK

----- BE MaotarDriveTask_STACK
BB ControlTask_STACK  w

Inspector Stack

W= Stack Start Address | Stack End Address | Stack Size
MAIM_STACE Qx300 0300 Ox100
1 ISR _STACK Ox911 0951 D40
MokorDriveT,., 0x979 xx2dd 64
ControlTask_... Ox9de a4z 64
| v

Figure 9.5

| Inspect

When selecting Stack in the hierarchical tree on the |eft side, additional
information concerning task are displayed on the right side:

* Name: displays the name of the stack.

» Stack Start Address: displays the start address of the stack.
» Stack End Address: displays the end address of the stack.

» Stack Size: displays the size of the stack.

SystemTimer

The SystemTimer shown in Figure 9.5 displays the current state of OSEK
SystemTimer trace.

Inspector SystemTimer
=1 E3

i.BE SYSTEMTIMER & IName Ma%ALLOWEDYALLE | TICKSPERBASE | MIMCYCLE | Current Yalue | Activated Alarm

- LS ALARM _|;| SYSTEMTIMER. OxFFFF 10 0
3

Ol ALARM

When selecting SystemTimer in the hierarchical tree on the left side,
additional information concerning task are displayed on the right side:
» Name: displays name of the system timer.

* MaxAllowedValue: displays the maximum allowed counter value.
When the counter reaches this value it rolls over and starts count again
from zero.

» TicksPerBase: displaysthe number of ticks required to reach a
counter-specific value.

* MinCycle: displays the minimum allowed number of counter ticks for
acyclic aarm linked to the counter.

» Current Value: displays the current value of the system timer.
» Activated Alarm: displays associated alarms.
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Alarm

The Alarm shown in Figure 9.6 displays the current state of OSEK alarm

trace.
Figure 9.6 Inspector Alarm
— Inspect !E m
= L] | | Mame Alarm State | Assigned Counter | Motified Task | Event ko set | Time ko expire | Cwcle period
-5k HALF_SEC_AL HALF_SEC_aL  ALARMSTOP  SYSTEMTIMER ControlTask  HALF_SEC... Oxfed4 il
---EEEE POLLIMPUTS AL POLLIMPUTS_AL - ALARMRLIN SYSTEMTIMER InputTask 0=3 03

BB srall Enp_AL — |STALLEND_AL  ALARMSTOP  SYSTEMTIMER
B8O REVERSE_AL _lj REVERSE_AL  ALARMSTOP  SYSTEMTIMER
»

ControlTask  STALL_EM... Oxfed4 0x0
ControlTask  REVERSE_... Oxfedd4 0x0

When selecting Alarm in the hierarchical tree on the left side, additional
information concerning task are displayed on the right side:

Name: displays the name of the alarm.

Alarm State: displays the current state of the alarm. Possible values
are ALARMRUN and ALARMSTOP.

Assigned Counter: based on counters, the OSEK OS offers alarm
mechanism to the application software. Assigned Counter is the name
of the counter used by alarm.

Notified Task: the alarm management allows the user to link task
activation to a certain counter value. The assignment of an alarmto a
counter, as well as the action to be performed when an alarm expires.
Notified Task defines the task to be notified (by activation or event
setting) when the alarm expires. Notified Task defines the task to be
notified (by activation or event setting) when the alarm expires.

Event to Set: the alarm management allows the user to link event
setting to a certain counter value. The assignment of an alarmto a
counter, as well as the action to be performed when an alarm expires.
Event to set specifies the event mask to be set when the alarm expires.

Timeto expire: displays time remaining before the time expires and
the event is set.

Cycle Period: displays period of atick.

Message

The Message shown in Figure 9.7 displays the current state of OSEK

message trace.
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Figure 9.7

] Inspect

SR E 5S4 GE

Inspector Message

.0 8 Msg_Lock -
4] | >

Mame Message Tvpe Motified Task Event to be set
Mag_Inpuk MQUELED ConkralTask KEY_EVEMT

Mag_Lock MQIUELED LockTask,

When selecting Message in the hierarchical tree on the left side, additional
information concerning task are displayed on the right side:

Name: displays the name of the message.

M essage Type: displays message type. Possible values are:
UNQUEUED/QUEUED.

Notified Task: displays the task that shall be activated when the
message is sent.

Event to be set: displaysthe event which isto be set when the message
IS sent.
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Environment

This chapter describes the environment variables used by the Simulator/
Debugger. Some of these environment variables are also used by other
tools (for example, Linker), so also consult their respective manual.

Click any of the following links to jump to the corresponding section of
this chapter:

Debugger environment

Local Configuration File (usually project.ini)
ABSPATH

DEFAULTDIR
ENVIRONMENT

GENPATH

LIBRARYPATH

OBJPATH

IMP

USELIBPATH

Searching order for sourcesfiles
Files of the Simulator/Debugger

Debugger environment

Various parameters of the Simulator/Debugger may be set in an
environment using environment variables. The syntax is always the same:
Par anet er = KeyNane "=" Par anDef.

NOTE  Normally no blanks are allowed in the definition of an environment
variable.

Example

Debugger Manual
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GENPATH=C: \ | NSTALL\ LI B; D: \ PRQIECTS\ TESTS:; /usr/l ocal /11 b;/ hone/ me/
nmy_proj ect

NOTE

NOTE

NOTE

These parameters may be defined in several ways.
Using system environment variables supported by your operating system.

Putting the definitionsin afile called DEFAULT. ENV in the default
directory.

The maximum length of environment variable entriesin the
DEFAULT. ENV/ . hi def aul t s is4096 characters.

Putting definitionsin afile given by the value of the system environment
variable ENVIRONMENT.

The default directory mentioned above can be set by using the system
environment variable DEFAUL TDIR: Default Current Directory.

When looking for an environment variable, all programsfirst search the
system environment, then the DEFAULT. ENV file and finally the global
environment file given by ENVIRONMENT. If no definition can be found,
adefault value is assumed.

Ensure that no spaces exist at the end of environment variables.

The Current Directory

The most important environment for all toolsis the current directory. The
current directory is the base search directory where the tool begins to
search for files (for example, the DEFAULT. ENV / . hi def aul t s file)

Normally, the current directory of atool is determined by the operating
system or program that launches another one (for example, WinEdit).

For MS Windows based operating systems, the current directory definition
IS more complex.

DM-416
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* If thetool islaunched using a File Manager/Explorer, the current
directory isthe location of the executable launched.

* If thetool islaunched using an Icon on the Desktop, the current
directory isthe one specified and associated with the I con.

 If thetool islaunched by dragging afile on the icon of the executable
under Windows 95, 98, Windows NT 4.0 or Windows 2000, the
desktop isthe current directory.

 If thetool islaunched by another tool with its own current directory
specified (for example, WinEdit), the current directory isthe one
specified by the launching tool (for example, current directory
definition in WinEdit).

» For the Simulator/Debugger tools, the current directory isthe directory
containing the local project file. Changing the current project file also
changes the current directory, if the other project fileisin a different
directory. Note that browsing for a C file does not change the current
directory.

To overwrite this behavior, the environment variable DEFAULTDIR:
Default Current Directory may be used.

Global Initialization File (MCUTOOLS.INI) (PC
only)

All tools may store global datain MCUTOCLS. | NI . Thetool first searches
for thisfilein the directory of the tool itself (path of executable). If thereis
no MCUTOOLS.INI filein this directory, the tool looks for the filein the

MS Windows installation directory (for example, C. \ W NDOWE).

Example

C. \ W NDOWS\ MCUTOQLS. | NI
D: \ I NSTALL\ PROG MCUTOOLS. | NI

If atool isstartedinthe D: \ | NSTALL\ PROG\ DI RECTORY, the project
file in the same directory as the tool is used
(D: \ I NSTALL\ PROG\ MCUTOOLS. | NI).

If thetool is started outside the D: \ | NSTALL\ PROG directory, the
project file in the Windows directory is used
(C: \ W NDOWB\ MCUTQOCOLS. | NI').
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Local Configuration File (usually project.ini)

For more information about MCUTOOLS. | NI entries, see the compiler
manual.

Local Configuration File (usually project.ini)

The Simulator/Debugger does not changethe def aul t . env file. Its
content isread only. All configuration properties are stored in the
configuration file. The same configuration file can be used by different
applications.

The shell uses the configuration file with the name “project.ini” in the
current directory only. That iswhy this nameis also suggested to be used
with the Simulator/Debugger. Only when the shell usesthe samefile asthe
compiler, the editor configuration written and maintained by the shell can
be used by the Simulator/Debugger. Apart from this, the Simulator/
Debugger can use any file name for the project file. The configuration file
has the same format aswindows. i ni files. The Simulator/Debugger
stores its own entries with the same section name as in the global

ncut ool s. i ni file.

The current directory is always the directory containing the configuration
file. If aconfiguration filein adifferent directory isloaded, then the current
directory also changes. When the current directory changes, the

def aul t. env fileisreloaded. Always when a configuration fileis
loaded or stored, optionsin the environment variable COMPOPTIONS are
reloaded and added to the project options. Beware of this behavior when a
different def aul t . env fileexistsin different directories, which contain
incompatible optionsin COMPOPTIONS.

When aproject isloaded using the first def aul t . env, its
COMPOPTIONS are added to the configuration file. If this configuration
isstored in adifferent directory, whereadef aul t . env file exists with
incompatible options, the Simulator/Debugger adds options and marks the
inconsistency. Then a message box appears to inform the user that the
default.env options were not added. In such a situation the user can either
remove the option from the configuration file with the option settings
dialog or remove the option from default.env with the shell or atext editor,
depending on which options should be used in the future.

At startup there are three ways to load a configuration:
 use the command line option prod

DM-418
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Listing 10.1

 theproject.ini filein the current directory
» or Open Project entry from the file menu.

If the option prod is used, then the current directory isthe directory the
project fileisin. If prod is used with a directory, the project.ini filein this
directory isloaded.

Configuration of the Default Layout for the
Simulator/Debugger: the PROJECT.INI File

The default layout activated when starting the Simulator/Debugger is
defined in the PROQJECT. | NI file located in the project directory, as
shownin Listing 10.1. All default layout related parameters are stored in
section[DEFAULTS)].

Example content of PROJECT.INI:

[ HI - WAVE]
W ndowO=Sour ce

0O O 60 30

W ndowl=Assenbly 60 0 40 30
W ndow2=Procedure 0 30 50 15
W ndow3=Ter m nal 0O 45 50 15
W ndow4=Regi ster 50 30 50 30

W ndows=Menory
W ndow6=Dat a
W ndow7=Dat a
Tar get =Si m

50 60 50 30
0 60 50 15
0O 75 50 15

Target: Specifies the target used when starting the Simul ator/Debugger
(loadsthefile <tar get> with a.tgt extension), for example, Target=Sim for
Simulator, or Target=Motosil, Target=Bdi.

Window<n>: Specifies coordinates of the windows that must be open
when the Simulator/Debugger is started. The syntax for awindow is:

Window<n>=<component> <XPos> <Y Pos> <width> <height>

where n istheindex of the window. Thisindex isincremented for each
window and determines the sequence windows are opened. Thisindex is
relevant in case of overlapping windows, because it determines which
window will be on top of the other. Values for the index have to be in the
range 0..99.
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NOTE

NOTE

component specifies the type of component that should be opened, for
example, Source, Assembly, etc.

XPos specifiesthe X coordinate of the top left corner of the component (in
percentage relative to the width of the main application client window).

Y Pos specifiesthe Y coordinate of the top left corner of the component (in
percentage relative to the height of the main application client window).

width specifies the width of the component (in percentage relative to the
width of the main application client window).

height specifies the height of the component (in percentage relative to the
height of the main application client window).

Example:
Window5=Memory 50 60 50 30

Window number 5 isaMemory component, its starting position is at: 50%
from main window width, 60% from main window height. Itswidth is 50%
from main window width and its height 30% from main window height.

Other parameters

» Itispossibletoload aprevioudy saved layout from afile by inserting
the following linein your PROQIECT. | NI file:

L ayout=<L ayoutName>

where LayoutName is the name of the file describing the layout to be
loaded,

for example, Layout=lay1.hwl

The layout path can be specified if the layout is not in the project directory.

Please see section Window Menu for more information about Layouts.

If Layout isdefined in PROQJECT. | NI , the Layout parameter overwrites
any Window<n> definition, describing the default windows layout.

» Itispossibletoload apreviously saved project from afile by inserting
the following linein your PROQIECT. | NI file:
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Pr oj ect=<Pr oj ectName>

where Proj ectName is the name of the file describing the project to be
loaded,

for example, Project=Proj1l.hwc

The project path can be specified if the project is not in the project
directory. This option can be used for compatibility with the old .hwp
format (Project=oldProject.hwp) and will be opened as a new project file.

See File Menu section for more details about Projects.

If Layout and Project are defined in PRQJECT. | NI , the Project
parameter overwrites the L ayout parameter, also containing layout
information.

MainFrame=<nbr.>,<nbr.>,<nbr.>,<nbr.>,<nbr.>,<nbr.>,
<nbr.><nbr.>,<nbr.>,<nbr.>
This variable is used to save and load the Simulator/Debugger main

window states. positions, size, maximized, minimized, iconized when
opened, etc. Thisentry is used for internal purposes only.

» Thetoolbar, status bar, heading line, title bar and small border can be
specified in the default section:

The toolbar can be shown or hidden with the following syntax:
Tooolbar = (0] 1)

If 1 is specified, the toolbar is shown, otherwise the toolbar is hidden.
The status bar can be shown or hidden with the following syntax:
Statusbar = (0| 1)

If 1is specified, the status bar is shown, otherwise the toolbar is hidden.

Title bars can be shown or hidden with the following syntax:

For More Information: www.freescale.com
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NOTE

Hidetitle= (0] 1)

If 1isspecified, thetitle bars are hidden, otherwise they are shown.
The heading lines can be shown or hidden with the following syntax:
Hideheadlines= (0| 1)

If 1isspecified, the heading lines are hidden otherwise they are shown.
The border can be reduced with the following syntax:

Smallborder = (0] 1)

If 1isspecified, borders are thin otherwise they are normal.

» The environment variable BPTFILE authorizes the creation of
breakpoint files; they may be enabled or disabled. All breakpoints of
the currently loaded 'abs file are saved in a breakpointsfile. BPTFILE
may be ON (default) or OFF. When ON, breakpoint files are created.
When OFF, breakpoint files are not created.

BPTFILE =(On | Off)

Target specific environment variables can also be defined in the
PRQIECT. | NI file. Refer to the specific target manual for details.

Ini file activation

When aproject file (PRQIECT. | NI ) is activated, the following occurs

(from first action to last):

1. The old Project file is closed.

2. Target Conponent is unl oaded

3. The environnent variable (Path) is added from
the Project file.

Select HI-WAVE section to retrieve value from:

if an entry 'Windows0' or "'Target' can be retrieved from section [HI-
WAVE] then

use [HI-WAVE]

DM-422
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elseif an entry 'Windows0' or 'Target' can be retrieved from section
[DEFAULTS] then

use [DEFAULTS]

else use [HI-WAVE]

4. The environnent variables are | oaded fromthe
default.env file.

5. If an entry ’Layout=I11" exists, the |ayout
file lll.hwl is |oaded and execut ed.

6. The target is set ( if entry 'Target=ttt'
exists load target "ttt').

7. If an entry ' Project=ppp’ exists, the conmand
file "ppp’ is executed.

8. The configuration file (*.hw) is |oaded (entry
configuration=*. hwc).

Paths

Most environment variables contain path lists indicating where to search
for files. A path list isalist of directory names separated by semicolons
following the syntax below:

PathList = DirSpec {";" DirSpec}.
DirSpec =["*"] DirectoryName.

Example:

GENPATH=C: \ | NSTALL\ LI B; D: \ PRQJECTS\ TESTS; / usr/ | ocal / hi wave/ | i b;/
home/ me/ ny_pr oj ect

If adirectory nameis preceded by an asterisk ("*"), the programs
recursively search the directory tree for afile, not just the given directory.
Directories are searched in the order they appear in the path list.

Example:

GENPATH=.\; *S; O

Debugger Manual DM-423
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NOTE

Some DOS environment variables (like GENPATH, LIBPATH, etc.) are
used.

We strongly recommend working with WinEdit and setting the
environment by means of aDEFAULT.ENV filein your project directory.
This'project directory' can be set in WinEdit's 'Project Configure..." menu
command. Thisway, you can have different projectsin different
directories, each with its own environment.

When using WinEdit, do not set the system environment variable

Def aul t di r . If you do and this variable does not contain the project
directory given in WinEdit' s project configuration, files might not be put
where you expect them.

Line Continuation

It is possible to specify an environment variable in an environment file
(default.env/.hidefaults) over multiple lines by using the line continuation
character ‘\':

Example:

OPTIl ONS=\
-W2
- Wpd

Thisisthe same as

OPTI ONS=-\W2 - Whd

Be careful when using the line continuation character with paths, for
example,

GENPATH=.

TEXTFI LE=. \ t xt

\

will resultin

GENPATH=. TEXTFI LE=. \ t xt

DM-424
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To avoid such problems, use asemicolon’;’ at the end of apath, if thereisa
‘\" at the end:

GENPATH=. \;
TEXTFI LE=. \ t xt

Environment Variable Details

The remainder of this section is devoted to describing each of the
environment variables available for the Simulator/Debugger. The options
are listed in alphabetical order and each is divided into several sections
described in the Environment Variable Details.

Table 10.1 Environment Variable Details

Topic Description

Tools Lists of other toolsthat are using this variable

Synonym Fore some environment variables a synonym also exists.
The synonyms may be used for older releases of the
Simulator/Debugger and will be removed in the future. A
synonym has lower precedence than the environment
variable.

Syntax Specifies the syntax of the option in EBNF format.

Arguments Describes and lists optional and required arguments for the
variable.

Default Shows the default setting for the variable or none.

Description Provides a detailed description of the option and how to
useit.

Example Gives an example of usage and effects of the variable
where possible. The examples show an entry in the
default.env file for PC.

Seealso Names related sections.
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ABSPATH

ABSPATH: Absolute Path

Tools

SmartLinker, Debugger
Synonym

None

Syntax

ABSPATH=" {<pat h>}.

Arguments

<path>: Paths separated by semicolons, without spaces.

Description

When this environment variable is defined, the SmartLinker will store the
absolute files it producesin the first directory specified. If ABSPATH is
not set, the generated absolute fileswill be stored in the directory the
parameter file was found.

Example

ABSPATH=\ sources\ bin;..\..\headers;\usr\local\bin

See also

None
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DEFAULTDIR

DEFAULTDIR: Default Current Directory

Tools

Compiler, Assembler, Linker, Decoder, Librarian, Maker, Burner,
Debugger.

Synonym
None.

Syntax

" DEFAULTDI R=" <directory>.

NOTE

Arguments

<directory>: Directory specified as default current directory.

Default

None.

Description

With this environment variable the default directory for al tools may be
specified. All toolsindicated above will take the directory specified astheir
current directory instead of the one defined by the operating system or
launching tool (for example, editor).

Thisis an environment variable at the system level (global environment
variable). It CANNOT be specified in adefault environment file
(DEFAULT.ENV/.hidefaults).

Example

DEFAULTDI R=C: \ | NSTALL\ PRQJECT

Debugger Manual
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See also

The Current Directory and Global Initialization File (MCUTOOLS.INI)
(PC only)

ENVIRONMENT

NOTE

ENVIRONMENT: Environment File
Specification

Tools

Compiler, Linker, Decoder, Librarian, Maker, Burner, Debugger.
Synonym

HIENVIRONMENT

Syntax

"ENVIRONMENT=" <file>.

Arguments

<file>: file name with path specification, without spaces
Default

None.

Description

This variable hasto be specified at the system level. Normally the
application looks in the The Current Directory for an environment file
named def aul t . env. Using ENVIRONMENT (for example, set in the
autoexec.bat for DOS), adifferent file name may be specified.

Thisis an environment variable at the system level (global environment
variable). It CANNOT be specified in adefault environment file
(DEFAULT.ENV/.hidefaults).
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GENPATH

Example

ENVI RONVENT=\ Met r ower ks\ pr og\ gl obal . env

GENPATH

See also

None:

GENPATH: #include “File” Path

Tools

Compiler, Linker, Decoder, Burner, Debugger.
Synonym

HIPATH

Syntax

" GENPATH=" {<pat h>}.

NOTE

Arguments

<path>: Paths separated by semicolons, without spaces.
Default

Current directory

Description

If aheader fileisincluded with double quotes, the Simulator/Debugger
searchesin the current directory, then in the directories given by
GENPATH and finally in the directories given by LIBRARYPATH.

If adirectory specification in this environment variable starts with an
asterisk (“*”), the whole directory treeis searched recursively. All
subdirectories and their subdirectories are searched. Within onelevel in the
tree, search order is random.
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Example

GENPATH=\ sources\include;..\..\headers;\usr\local\lib

See also

Environment variable LIBPATH

LIBRARYPATH

LIBRARYPATH: ‘include <File>' Path

Tools

Compiler, ELF tools (Burner, Linker, Decoder)
Synonym

LIBPATH

Syntax

" LI BRARYPATH=" {<pat h>}.

Arguments

<path>: Paths separated by semicolons, without spaces.
Default

Current directory
Description

If aheader fileisincluded with double quotes, the Compiler searchesin the
current directory, then in the directories given by GENPATH and finally in
directories given by LIBRARYPATH.

NOTE If adirectory specification in the environment variables starts with an
asterisk (“*”), the whole directory treeis searched recursively. All
subdirectories and their subdirectories are searched. Within onelevel in the
tree, search order israndom.
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Example

LI BRARYPATH=\ sources\include;..\..\headers;\usr\local\lib

OBJPATH

See also
Environment variable GENPATH

Environment variable USEL IBPATH

OBJPATH: Object File Path

Tools

Compiler, Linker, Decoder, Burner, Debugger.
Synonym

None.

Syntax

" OBJPATH=" <pat h>.

Default

Current directory

Arguments

<path>: Path without spaces.

Description

If atool looks for an object file (for example, the Linker), then it first
checks for an object file specified by this environment variable, then in
GENPATH and finally in HIPATH.

Example

OBJPATH=\ sour ces\ obj

Debugger Manual
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TMP

See also

None.

TMP: Temporary directory

Tools

Compiler, Assembler, Linker, Librarian, Debugger.
Synonym

None.

Syntax

"TMP=" <directory>.

Arguments

<directory>: Directory to be used for temporary files.

Default

None.

Description

If atemporary file hasto be created, normally the ANSI function tmpnam()
isused. Thislibrary function stores the temporary files created in the
directory specified by this environment variable. If the variable is empty or
does not exist, the current directory is used. Check thisvariableif you get
an error message “Cannot create temporary file”.

NOTE Thisisan environment variable at the system level (global environment
variable). It CANNOT be specified in adefault environment file
(DEFAULT.ENV/.hidefaults).

Example
TWMP=C:. \ TEMP
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See also

Section ‘ The Current Directory’

USELIBPATH

USELIBPATH: Using LIBPATH Environment
Variable

Tools

Compiler, Linker, Debugger.
Synonym

None.

Syntax

"USELI BPATH=" ("OFF" | "ON' | "NO' | "YES")

Arguments

"ON", "YES": The environment variable LIBRARYPATH isused to look
for system header files <*.h>.
"NO", "OFF": The environment variable LIBRARY PATH is not used.

Default
ON
Description

This environment variable allows aflexible usage of the LIBRARY PATH
environment variable, because LIBRARYPATH may be used by other
software (for example, version management PVCYS).

Example

USEL| BPATH=ON

See also

Environment variable LIBRARYPATH
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Searching order for sources files

Searching order for sources files

o » 0w N PRE

This section describes the searching order (from first to last) used by the
debugger.

Searching Order in the Simulator/Debugger for
C source files (*.c, *.cpp)

Path coded in the absolute file (.abs)
Project filedirectory (wherethe .pjt or .ini fileislocated)

Paths defined in the GENPATH environment variable (from left to
right)

AbsFiledirectory

Searching Order in the Simulator/Debugger for
Assembly source files (*.dbg)

Path coded in the absolute file (.abs)
Project filedirectory (where .pjt or .ini fileislocated)

Paths defined in the GENPATH environment variable (from left to
right)

AbsFiledirectory

Searching Order in the Simulator/Debugger for
object files (HILOADER)

Path coded in the absolute file (.abs)
AbsFiledirectory

Project filedirectory (where .pjt or .ini file islocated)
Path defined in the OBJPATH environment variable

Paths defined in the GENPATH environment variable (from left to
right)
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Files of the Simulator/Debugger

The Simulator/Debugger comes with several program, application,
configuration files and examples. These files are listed in the following

table.

Table 10.2  Simulator/Debugger and Metrowerks files extension.

Filename.

Description.

*

*

. ABS

. ASM
. BBL

. BPT

.C *.CPP
. CHM
. VD
. CNF
. CNT
. CPU

. DBG

Absolute framework application file e.g.,
fibo.abs

Assembler specific file e.g., macrodem.asm
Burner Batch Language file e.g, fibo.bbl

Simulator/Debugger Breakpoint file e.q.,
fibo.bpt

C and C++ sourcefiles

Compiled HTML helpfile

Command File Script, for example, Reset.cmd
Specific cpu configuration file

Help Contents File, for example, cxa.cnt
Central Processor Unit Awareness file

Debug listing files, for example, Fibo.dbg

DEFAULT. ENV Simulator/Debugger Default Environment file.
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Filename.

Description.

*. DLL

* . H

HI WAVE. EXE

* . HWL

* . FPP

* . HLP

*. 1 SU

* PIT

*I'N

*. LST

A .DLL filethat contains one or more functions
compiled, linked, and stored separately from the
processes that use them. The operating system
maps the DLLs into the process's address space
when the processis starting up or whileit is
running. The process then executes functionsin
the DLL.

The DLL of the Simulator/Debugger is provided
for supported library and extended functions.

Header file

The Simulator/Debugger for Windows
executable program.

Simulator/Debugger Layout file, for example,
default.hwil

Simulator/Debugger Configuration file
(project.hwc)

Other Windows executable program, for
example, LINKER.EXE

Flash Programming Parameters files (CPU
specific) for example, mcu0e36.fpp

Application Help file, for example, Hiwave.hip
I/O’ssimulation file, for example, samplell.io
Uninstall Application File

Debugger configuration Settings File, for
example, Project.pjt

Debugger configuration Settings File, for
example, Project.ini

Assembler Listing File, for example, fibo.lst
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Filename.

Description.

*

Proj ect. | ni

*

. MCP

. MAK

. MAP

. MEM

. MON

.0
. PDF

. PRM

. REC
. REG
.SI'M
. SX

. TXT

TGT

. XPR

Metrowerks CodeWarrior IDE project file
Make file, for example, demo.mak
Mapping file, for example, macrodem.map

Memory Configuration file, for example,
000p4v0l.mem

Firmware loading, file for allowing to load a
specified target, for example, Firm0508.mon

Object file code, for example, Fibo.o

Portable Document Format file.

Linker parameter file, for example, f i bo. prm
Simulator/Debugger Project Initialization File
Recorder File

Register Entriesfiles, for example, mcu0O8le.reg
CPU simulator file, for example, st7.sim
Motorola S-Record file, for example, fibo.sx
General Text Information file.

Target File for the Simulator/Debugger, for
example, xtend-g3.tgt

Simulator/Debugger Window Component File,
for example,, recorder.wnd

Simulator/Debugger User Expression file, for
example, Fibo.xpr
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How To Configure the Simulator/Debugger

11

How To ...

This chapter provides answers to frequently asked questions.

Click any of the following links to jump to the corresponding section of
this chapter:

How To Configure the Simulator/Debugger

How To Start the Simulator/Debugger
Automating startup of the Simulator/Debugger
How To Load an Application

How To Start an Application

How To Stop an Application

How To Step in the Application

How To Work on Variables

How To Work on Register

How to Modify the content of a Memory Address
How to Modify the content of a Memory Address

How to Consult Assembler | nstructions Generated by a Source
Statement

How To view Code
How to Communicate with the Application
About startup.cmd, reset.cmd, prel oad.cmd, postload.cmd

How To Configure the Simulator/Debugger

If you have installed the Simulator/Debugger under Windows 95, 98, NT
4.0 and Windows2000 or higher, the Simulator/Debugger can be started
from the desktop, from the Start menu, or external editor (WinEdit,
CodeWright, etc.). In order to work efficiently (find all requested
configuration and component files), the Simulator/Debugger must be
associated with aworking directory.
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How To Start the Simulator/Debugger

How To Configure the Simulator/Debugger for
Use from Desktop on Win 95, Win 98,Win NT4.0
or Win2000

When starting the Simulator/Debugger from Windows 95 or Windows NT
V4.0 (for example, without WinEdit), the working directory can be defined
in the file MCUTOOLS.INI, located in the Windows directory.

Defining the Default Directory in the MCUTOOLS.INI

When starting from the desktop or Start menu, the working directory can
be set in the configuration file MCUTOOLS. | NI .

The working directory including the path is defined in the environment
variable DefaultDir in the [Options| group or WorkDir
[WorkingDirectory].

How To Start the Simulator/Debugger

This section describes various ways to start the Debugger.

How To Start the Simulator/Debugger from
WinEdit

The Simulator/Debugger can be started by selecting Project>Debug or
clicking the Debugger icon (bug) in WinEdit tool bar (when configured).
The Window looks like Figure 11.1.
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Figure 11.1  Simulator/Debugger after startup

_ True-Time Simulator & Real-Time Debugger

Fil= “Wiew Bun Simulator Component TestTerm  window  Help
= = R = et e L N = P B SR
= Souree RE

B Procedure M=l ES || = Register M=
[ |CPU Cycles: 0 | Hex
B TestTerm =] E3
B Data:1 = O] =] I
| | [ Auto [Symb | Global
i Memory O] x|
[ | Auto
00000000 —- —— —- ——  ——— o
i Data:2 =00} |noanaong —= = —— = ———- j
| [ | Auto [Symb | Local 0oooonoas -- -- == -= ----
Q00000AC —= —= —= —= —-mo
00000010 —- —- —- —— —-——
Q0000014 —= —= —= —= —mmo hd
For Help. press F1 ] |SIM_READY i

READY displayed in the status bar indicates that the simulator is ready.

Automating startup of the Simulator/Debugger

Often the same tasks have to be performed after starting the Simulator/
Debugger. These tasks can be automated by writing a command file that
contains all commands to be executed after startup of the Simulator/
Debugger, asshownin Listing 11.1.

Listing 11.1 Example of acommand file to automate tasks

load fibo.abs
bs&maint

g
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Thisfilewill first load an application, then set atemporary breakpoint at
the start of the function main and start the application. The application will
then stop on entering main (after executing the startup and initialization
code).

There are severa ways to execute this command file:

» gpecify the command file on the command line using the command line
option -c: Thisisdone in the application that starts the Simulator/
Debugger (for example, Editor, Explorer, Make utility, ...).

Example:

\Metrowerks\PROG\HIWAVE.EXE -c init.cmd

When the Simulator/Debugger is started with this command line, it will
execute the command specified inthefile i nit. cnd after loading the
layout (or project file).

» Calling the command file from the project file (Listing 11.2). The
project file where the layout and target component can be saved (File
>Save...) isanormal text file that contains command line commands to
restore the context of a project. Thisfile, once created by the save
command, can be extended by a call to the command file (CALL
INIT.CMD). When this project isloaded by the File >Open...
command or by the corresponding entry in the Configuration of the
Default Layout for the Simulator/Debugger: the PROJECT.INI File),
commands in thisfile are executed.

Listing 11.2 Calling a command file from the project file:

set Sim

CLCSE *

cal | \Metrower ks\DEMD\t est . hwl
call init.cmd

» Calling the command file when the Target Component is loaded. M ost
target components will execute the command file STARTUP. CVD
once the target component is loaded and initialized. By adding the call
command filein thisfile (for example, CALL INIT.CMD), it will
automatically execute when the target component is loaded.

NOTE Refer to section Starting the Debugger from a Command Line.
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How To Load an Application

How To Load an Application

1.
2.
3.

Figure 11.2

Choose Simulator > Load .... The LoadObjectFile dialog box is opened.
Select an application (for example FIBO.ABYS).

Click OK. Thedialog box is closed and the application isloaded in the
Simulator/Debugger (Listing 11.2).

Loading of an application in the debugger.

FTlue-Time Simulator & Real-Time Debugger C:\Metrowerksidemo\PPC\Projects\PPC555_fiboram._pjt M= 3 I
File “iew Hun Simulator Component Data  Window Help
D] ] 2w o= |w]2|e]4] 9]
[/ Source ] | e S =S P =] B3
. ASourceshfibo.c Line: 20 Fibonacei
fibo = n; 5 2
i=2; ble crff, Ox003£cz90
while (i SIS nr. r3, r5
fibo = fibl + fibZ; blr
fibl = fihz; hd| mflr i -
I Procedure =] | Rl S GiEE S M [=]E3
PFC CPU Cycles: 736256 Auto
Fibonacci (n=14) ﬂ PC | aFczan  cr [40000E00  XEA
main ) 5P 3F9AES Status | NPZE0C CT.
Start ()
-
Startun (1 _I n [ aAnnn RE [ n .
i Data:1 P ] B3 _DI_I‘ 407
fibo.c Auto Symb Global I Memory M [=]E3
fiboCount 233 unsigned int Auto
Eounter 14 wnsigned int 00000000 uu uu Ul Ul uua =
00000004 uu uu Ul Ul uu
000000058 uu uu Ul ua uua
Data: 2
00000000 uu uu ul ua uua
Fibonacei Auta Symb Local 00000010 g i wd ud uuuu
n 14 unsigned int A 100000014 wa U ul Ul uuua
fibl 1 unsigned int 00000016 uu Wl ul ud
£ib2 1 unsiemed int || |000000LC v wn ua ua LI
For Help, press F1 [736'256 [HALTED 2

The Source component contains source from the module containing the
entry point for the application (usualy the startup module). The
highlighted statement is the entry point.

The Assembly component contains the corresponding disassembled code.
The highlighted statement is the entry point.

The Global Data component contains the list of global variables defined in
the module containing the application entry point.

The Loca Data component is empty.

The PC in the Register component isinitialized with the PC value from the
application entry point.
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How To Start an Application

There are two different ways to start an application:
1. Choose Run>Sart/Continue

2. Click the Sart>Continueicon in the debugger tool bar _|

RUNNING in the status line indicates that the application is running.

The application will continue execution until:
* you decide to stop the execution (See How To Stop an Application).
» abreakpoint or watchpoint has been reached.
* an exception has been detected (watchpoints or breakpoints).

How To Stop an Application

There are two different ways to stop program execution:
1. Choose Run >Halt

2. Click on theHalt icon in the debugger tool bar |i|

HALTED in the status line indicates that execution has been stopped.

The blue highlighted line in the source component is the source statement
at which the program was stopped (next statement to be executed).

The blue highlighted line in the Assembly component is the assembler
statement at which the program was stopped (next assembler instruction to
be executed).

Data window with attribute Global displays the name and values of the
global variables defined in the module where the currently executed
procedure isimplemented. The name of the module is specified in the Data
info bar.

Datawindow with attribute L ocal displaysthe name and values of the local

variables defined in the current procedure. The name of the procedureis
specified in the Datainfo bar.

For More Information: www.freescale.com
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How To Step in the Application

How To Step in the Application

Listing 11.3

The Simulator/Debugger provides stepping functions at the application
source level and assembler level (Listing 11.3).

How to step on Source Level

Stepping on source level.

F True-Time Simulator & Real-Time Debugger C:\Metrowerks\demo\PPCAProjects
File %iew Bun Simulator Component  Azsembly  Window  Help

Il == e e LA e S 3 A R )

ml Source M =1 B3 || Aszembly M=l B3
| %5 ourcestibo.c |Line: 23 Fibonacci
fibo = £ibl + fibZ; ;I iE. ;I
fibl = fibZ: addi rd, rd, 1
= fibo; cuplw crfsh, r4d, 3
i++: ble crfh, Ox003£czZo0
=} —I mr. r3, 5
returni(fiba) ; blr
[} wflr rl
- st rl, 4(rl)
4| | 2 Ehmiubl rl, -l6irl) j

How to Step on the next source instruction

The Simulator/Debugger provides two ways of stepping to the next source
instruction:

Choose Run>Single Step

Click the Single Sep icon from the Simulator/Debugger tool bar |i|

STEPPED in the statuslineindicatesthat the application isstopped by
a step function.

If the application was previously stopped on a subroutine call instruction, a
Single Step stops the application at the beginning of the invoked function.

The display in the Assembly component is always synchronized with the
display in the Source component. The highlighted instruction in the

DM-444
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Assembly component isthe first assembler instruction generated by the
highlighted instruction in the Source component.

Elements from Register, Memory or Data components that are displayed in
red are the register, memory position, local or global variables, and which
values have changed during execution of the source statement.

How to Step Over a Function Call (Flat Step)

The Simulator/Debugger provides two ways of stepping over afunction
call:

Choose Run >Sep Over
Click the Step Over icon from the Simulator/Debugger tool bar EI

STEPPED OVER (or STOPPED) in the status line indicates that the
application is stopped by a step over function.

If the application was previously stopped on a function invocation, a Step
Over stops the application on the source instruction following the function
invocation.

The display in the Assembly component is always synchronized with the
display in the Source component. The highlighted instruction in the
Assembly component isthe first assembler instruction generated by the
highlighted instruction in the Source component.

Elements from Register, Memory or Data components that are displayed in
red are the register, memory position, local or global variables, and which
values have changed during execution of the invoked function.

How to Step Out from a Function Call

The Simulator/Debugger provides two ways of stepping out from a
function call:

Choose Run>Step Out

Click the Step Out icon from the debugger tool bar |:"'|

STOPPED in the status line indicates that the application is stopped by a
step out function.

For More Information: www.freescale.com
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If the application was previously stopped in afunction, a Step Out stops
the application on the source instruction following the function invocation.

The display in the Assembly component is always synchronized with the
display in the Source component. The highlighted instruction in the
Assembly component isthe first assembler instruction generated by the
highlighted instruction in the Source component.

Elements from Register, Memory or Data components that are displayed in
red are the register, memory position, local or global variables, and which
values have changed since the Step Out was executed.

How to Step on Assembly Level

The Simulator/Debugger provides two ways of stepping to the next
assembl er instruction:

1. Choose Run>Assembly Step

2. Click the Assembly Sep icon from the debugger tool bar |£|

TRACED in the status line indicates that the application is stopped by an
assembly step function.

The application stops at the next assembler instruction.

The display in the Source component is always synchronized with the
display in the Assembly component. The highlighted instruction in the
Source Component is the source instruction that has generated the
highlighted instruction in the Assembly component.

Elements from Register, Memory or Data components that are displayed in

red are the register, memory position, local or global variables, and which
values have changed during execution of the assembler instruction.

How To Work on Variables

This section shows the different methods to work on variables.

DM-446 Debugger Manual
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How to Display Local Variable from a Function

The Simulator/Debugger providestwo different waysto seethelist of local
variables defined in a function:

» Using Drag and Drop

Drag a function name from the Procedur e component to a Data
component with attribute local.

» Using Double-click
Double-click a function name in the Procedur e component.

The Data component (with attribute local that is neither fr ozen or locked)
displaysthe list of variables defined in the selected function with their
values and type.

How to Display Global Variable from a Module

The Simulator/Debugger providestwo waysto see alist of global variables
defined in amodule:

* Opening Module Component

Choose Component>Open. Thelist of all available componentsis
displayed on the screen.

Double-click theentry Module. A module component is opened, which
containsthelist of all modules building the application.

Drag a module name from the M odule component to a Data
component with attribute Global.

» Using Popup Menu
Right-click in a Data component with attribute Global.

Choose Open Module in Popup Menu. A dialog box isopened, which
containsthelist of all modules building the application.

* Double-click on amodule name. The Data component with attribute
global, which is neither frozen nor locked is the destination
component.

The destination Data component displaysthelist of variables defined in the
selected module with their values.
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Table 11.1

Menu entry

How to Change the Format for the Display of
Variable Value

The Simulator/Debugger alows you to see the value of variablesin
different formats. Thisis set by entriesin Format menu (Table 11.1).

Debugger Display Format

Description

Hex
Oct
Dec
UDec
Bin

Symbolic

Variable values are displayed in hexadecimal format.
Variable values are displayed in octal format.

Variable values are displayed in signed decimal format.
Variable values are displayed in unsigned decimal format.
Variable values are displayed in binary format.

Displayed format depends on variable type.

Valuesfor pointer variables are displayed in hexadecimal for mat.
Valuesfor function pointer variables are displayed as function name.

Valuesfor character variablesaredisplayed in ASCI| character and
decimal format.

Valuesfor other variablesare displayed in signed or unsigned decimal
format depending on the variable being signed or not.
Format menu is activated as follows:

Right-click in the Data component. The Data Popup Menu isdisplayed
on the screen.

Choose Format from Popup Menu. Thelist of all formatsisdisplayed
on the screen.

The format selected isvalid for the whole Data component. Valuesfrom all
variablesin the data component are displayed according to the selected
format.
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How to Modify a Variable Value

The Simulator/Debugger alows you to change the value of avariable, as
shown in Figure 11.3.

Modify a Variable Value

Figure 11.3 Modifying a Variable Value
I Data:2 Mi=] E3

| |Fibonacei | Ao |Symb | Local
n EE| . umsimmed int =
fibhl 957 %nsigned int
fibZ 1597 unsigned int
fibo 1597 unsigned int
i 18 int

=]

The Simulator/Debugger allows you to change the value of avariable.

Double-click on avariable. The current variable value is highlighted and
can be edited.

1. Formatsfor theinput valuefollow therulefrom ANSI C constant
values (prefixed by Ox for hexadecimal value, prefixed by O for octal
values, otherwise consider ed as decimal value). For example, if the
data component isin decimal format and if avariableinput valueis
0x20, thevariableisinitialized with 32. If avariableinput value is 020,
thevariableisinitialized with 16.

3. If aninput value has been validated by |Tak =, !thevalueofthe next
variablein the component isautomatically highlighted (this value can
also be edited).

4. Torestorethe previousvariable value, press [Esc] or select another
variable.
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How To Work on Variables

A local variable can be modified when the application is stopped. Since
these variables are located on the stack, they do not exist aslong as the
function where they are defined is not active.

How to Get the Address Where a Variable is
Allocated

The Simulator/Debugger provides you with the start address and size of a
variable if you do the following:

Point to a variable namein a Data Component

Click the variable name

The start address and size of the selected variable is displayed in the Data
info bar.

How to Inspect Memory starting at a Variable
Location Address

The Simulator/Debugger provides two ways to dump the memory starting
at avariable allocation address.
» Using Drag and Drop

Drag a variable name from the Data Component to Memory
component.

. Usingx/Ej+IA_|

Point to a variable namein a Data Component.

Pressthe left mouse button and x/Ej + |A |

The memory component scrolls until it reaches the address where the
selected variable is allocated. The memory range corresponding to the
selected variable is highlighted in the memory component.

How to Load an Address Register with the
Address of a variable

The Simulator/Debugger allows you to load a register with the address
where avariableis allocated.
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1. Dragavariable namefrom the Data Component to Register
component.

The destination register is updated with the start address of the selected
variable.

How To Work on Register

This section describes how to work with the Register.

How to Change the Format of the Register
display

The Simulator/Debugger alows you to display the register content in
hexadecimal or binary format.

1. Right-click in the Register component. The Register Popup Menu is
displayed on the screen.

2.  Choose Options.. from the Popup Menu. The pull down menu
containing the possible formatsis displayed.

3. Select @ther binary or hexadecimal format.

Theformat selected isvalid for the Register component. The contents from
all registers are displayed according to the selected format.

How to Modify a Register Content

The Simulator/Debugger allows you to change the content of indexes,
accumulators or bit registers.

How to Modify an Index or Accumulator Register Content

Double-click aregister. The current register content is highlighted and may
be edited.
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Figure 11.4  Modifying an Index or Accumulator Register Content
i Begister M=l E3
|PPC |CPU Cycles: F92224 | Auto
PC ZFCz90 CR EE *EE 45 MaE 2000 ﬂ
3P JFoAES Status | NPEZS0C [%ETR 0 LE 3JFCZF4
RO ZFC1E& Ra 0 Rle 0 R2d 0
Rl JFoAES RS 0 Rl7 0 BRZ5 0
RZ 0 REl0 0 Rl& 0 RZ6 0
R3 19 Ell 0 Ela 0 R27 0
R4 T Rl:Z 0 EZ0 0 RZ8 0 ;I

1. Theformat of theinput value dependson the for mat selected for the
data component. If thefor mat of the component isHex, theinput value
istreated asaHex value. If theinput valueis 10 the variable will be set
to 0x10 = 16.

Tak =5 |, or select another register.

3. If aninput value has been validated by |Tak = !,thecontent of the

next register in the component isautomatically highlighted. This
register can also be edited).

4. Torestorethepreviousregister content, press [Esc|.

How to Modify a Bit Register Content

In abit register, each bit has a specific meaning (a Status Register (SR) or
Condition Code Register (CCR).

Mnemonic characters for bitsthat are set to 1 are displayed in black,
whereas mnemonic characters for bits that are reset to O are displayed in

grey.

Single bitsinside the bit register can be toggled by double-clicking the
corresponding mnemonic character.

DM-452 Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

How To ...
How To Work on Register

How to Get a Memory Dump starting at the
Address where a Register is pointing

The Simulator/Debugger provides two ways to dump memory starting at
the address aregister is pointing to.

» Using Drag and Drop
1. Dragaregister from the Register Component to Memory component.
* Choose Address..

Figure 11.5 Memory menu Display Address

i Memory - (O] x|
| [ Auto
00000840 20 13 FC 08 02 C3 00 01 wuvwn.. i’

W N izplay Address
oooor
oooor

ao0on Address: IM hex
oooor

00001 15 Hmw Format ok | cacel | Hep |

aooor
0O0000BED —= —= —= —= == —— —— = e
QOQ0OBES -- ——= —= —= —= —— —— —— LI

1. Right-click in the Memory component. The Memory Popup Menu is
displayed.

2.  Choose Address... from the Popup Menu. The Memory ... dialog box
shown in Eigure 11.5 isopened.

3. Enter theregister content in the Edit Box and choose OK to close the
dialog box.

The memory component scrolls until it reaches the address stored in the
register.

This feature allows you to display a memory dump from the application
stack.

NOTE If “Hex Format” is checked, numbers and letters are considered to be
hexadecimal numbers. Otherwise, expressions can be typed and Hex
numbers should be prefixed with “Ox” or “$”. Refer to Constant Standard
Notation section.
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How to Modify the content of a Memory Address

The Simulator/Debugger allows you to change the content of a memory
address.

Double-click the memory address you want to modify. Content from the
current memory location is highlighted and can be edited.

Theformat for theinput value depends on the format selected for the
Memory component. If the format for the component isHex, the input
valueistreated asaHex value. If input valueis 10 thememory address
will be set to 0x10 = 16.

Once a value has been allocated to a memory word, it isvalidated and
the next memory addressisautomatically selected and can be edited.

To stop editing and validate the last input value, you can either press

ZE"M \ or |Tak = ! or select another variable.

To stop editing and restore the previous memory value, press [Esc].

How to Consult Assembler Instructions
Generated by a Source Statement

The Simulator/Debugger provides an on-line disassembly facility, which
allows you to disassemble the hexadecimal code directly from the
Simulator/Debugger code area.

Online disassembly can be performed in one of the following ways:

» Using Drag and Drop
In the Sour ce component, select the section you want to disassemble.
Drag the highlighted block to the Assembly component.

. Usingx/Ej?M

In the Sour ce component, point to theinstruction you want to
disassemble.
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2 JEj;JR_l

The disassembled code associated with the selected source instruction is
greyed in the Assembly component.

How To view Code

The Simulator/Debugger allows you to view the code associated with each
assembl er instruction.

Figure 11.6  Viewing code associated with an assembler instruction.
i Azzembly [_ (O] %]
|Fibonacei

LY. Set Breakpoint :I

addi rd, rd, 1 Fun To Cursar

cup 1 crfs, rd, 3 Shaow Breakpoints

hle crf5, O0x003£czZo0 &l Lasaliam

mr. r3, k5

hlr Address. .

iz o [ Dspiyeie )y ]

stu rd, 4(rl) Dizplay Spmbalic

:Ewm i;i _EEE; Dizplay Address

nop d v Dizplay Absolute Address j

Online disassembly can be performed in one of the following ways:
» Using Popup Menu
Point in the Assembly component and right-click. The Assembly
Popup Menu isdisplayed.
Choose Display Code (Figure 11.6).
» Using Assembly Menu

Click thetitle bar of the Assembly component. The Assembly menu
appearsin the debugger menu bar.

Choose Assembly > Display Code

The Assembly component displays the corresponding code on the left of
each assembler instruction.
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How to Communicate with the Application

How to Communicate with the Application

The Simulator/Debugger has a pseudo-terminal facility. Use the
component window to communicate with the application using specific
functions defined in the TERM NAL. H file and used in the calculator
demo file.

Start the Simulator/Debugger and choose Open... from the Component
menul.

Open the Component.

Choose Load... from the Simulator menu.

L oad the program CALC.ABS.

Dataentered in the component window through the keyboard will be
fetched by the target application with the ‘Read’ function. The target

application can send data to the Terminal component window of the host
with the “Write' function.

Refer to sections TestTerm Component and Terminal Component for more
information.

About startup.cmd, reset.cmd, preload.cmd,
postload.cmd

Thecommandfiles st art up. cnd, reset.cnd, prel oad. cnd,
and post | oad. cnd are Simulator/Debugger system command files. All
these command files do not exist automatically. They could be installed
when installing a new target.

However, the Simulator/Debugger is able to recognize these command
files and execute them.

» startup. cnd isexecuted when atarget isloaded (the target defined
in the proj ect.ini file or loaded when you select Component>Set
Tar get).

* reset.cnd isexecuted whenyou select “ Target Name” >Reset in
the menu (Target Name is the real name of the target, such as
MM DS0508, SDI, etc.).

» prel oad. cnd isexecuted beforeloading a. ABS application file or
Srecords file (when you select “ Target Name” >L oad... in the menu).
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» postl oad. cnd isexecuted after loading a. ABS application file or
Srecords file (when you select “ Target Name” >L oad... in the menu).

Depending on the target used, other command files can be recognized by
the Simulator/Debugger. Refer to the appropriate target manual for
information and properties of these command files.
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CodeWarrior Integration

This chapter provides information on how to use and configure the
Simulator/Debugger within CodeWarrior.

Click any of the following links to jump to the corresponding section of
this chapter:

* Requirements
* Debugger Configuration

Requirements

CodeWarrior IDE - version 4.1 or later

Debugger V6.1 or later

NOTE  Thischapter provides information on how to use and configure the

Simulator/Debugger within the CodeWarrior IDE, for more information,
refer to the CodeWarrior documentation.

Debugger Configuration

To configure the Real Time Debugger and True Time Simulator, in the
CodeWarrior IDE open the Tar get Settings Panel and select Build Extras
(Figure 12.1).

In the Build Extr as pane check the Use External Debugger checkbox. In
the Application field, type the Debugger path, for example,
{Compiler}prog\hiwave.exe and arguments, for example,

%targetFilePath -Target=sim in the Argument field. Click on Apply to
validate these changes.
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Figure 12.1  IDE Build Extras Panel
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Debugger DDE capabilities

NOTE

This chapter provides information on debugger capabilities and how to use
and configure the Simulator/Debugger within CodeWarrior.

The DDE capabilities of the Debugger are deprecated. Future versions
of the Debugger will have no DDE capabilities. Its recommended to use the
Component Object Model (COM) Interface. See the chapter Scripting for
more information about this.

Click the following link to jump to the corresponding section of this
chapter:

» Debugger DDE Server

Debugger DDE Server

DDE introduction

The DDE isaform of interprocess communication that uses shared
memory to exchange data between applications. Applications can use DDE
for one-time data transfers and for ongoing exchanges in applications that
send updates to one another as new data becomes available.

Debugger DDE implementation

The Simulator/Debugger integrates a DDE server and DDE client
implementation in the KERNEL.

The DDE application name of the IDF server is"HI-WAVE".

The Simulator/Debugger DDE support allows you to execute almost any
command that would be available from within the debugger (from

DM-460
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NOTE

Command line). There are also special DDE items for more commonly
performed tasks.

This section describes topics and DDE items available to CodeWright
clients. In addition to the required System topic, CurrentBuffer and the
names of all CodeWright non-system buffers (documents) are available as
topics.

Driving the Simulator/Debugger through DDE

The DDE implementation in the Debugger alows you to drive it easily by
using the DDE command.

For this, you have to use a program that can send a DDE message (a DDE
client application) like DDECLient.exe from Microsoft.

The service name of the Simulator/Debugger DDE Server is"HI-WAVE"
and the Topic name for the Simulator/Debugger DDE Server is
"Command".

The following example is done with DDECLient.exe from Microsoft.

Run the Simulator/Debugger and in the " Service" field in the
DDEClient type: "HI-WAVE"

Inthe" Topic" field type" Command"

Push the " Connect” button of the DDECIient. The following message
will appear in DDECLient: " Connected to HI-WAVE|Command" .

Inthe" Exec" field of DDECL ient type a Simulator/Debugger
command, for example " open recorder” and click the" Exec" button.
The command is executed by way of DDE and you'll see a new
recorder component in the Simulator/Debugger .

Y ou can disconnect the DDE in the Simulator/Debugger. The Simulator/
Debugger can be started without DDE (thisis saved in the project file). To
view the current state, open a command line component and type the
following command: "DDEPROTOCOL STATUS". The state must be:
"DDEPROTOCOL ON" to ensure the DDE works properly.
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Synchronized debugging
through DA-C IDE

This chapter provides information on how to use and configure
Metrowerks tools within DA-C IDE.

Click any of the following links to jump to the corresponding section of
this chapter:

* Requirements

Configuring DA-C IDE for Metrowerks Tool Kit
Debugger Interface

Synchronized debugaing

Troubleshooting

Requirements

DA-C - version 3.5 build 555 or later - (Development Assistant for C -
RistanCASE).

Simulator/Debugger V6.0 or later.

NOTE  Thischapter provides information on how to use and configure
Metrowerks tools within DA-C IDE. For more information on DA-C, refer
to the "Development Assistant for C" documentation v 3.5.

Configuring DA-C IDE for Metrowerks Tool Kit

Install the DA-C software. The Metrowerks CD contains a demo version
located in\ Addons\ DA- C. Run Setup to install the Typical installation.
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Configuring DA-C IDE for Metrowerks Tool Kit

A few configurations are required in order to make efficient use of
Metrowerks Tools within DA-C IDE.

» Create anew project

» Configure the working directories

» Configure thefiletypes

» Configuration of the Metrowerks library path

» Adding filesto project

* Building the Database

» Configure thetools

In the following sections, we assume that the Metrowerks tool kit is
installed in "C:\Metrowerks" directory. Y ou may have to adapt the paths to
your current installation. An example configuration for the M68k CPU is
provided, which can be adapted to each CPU supported by Metrowerks.

Creating a new project

Start DA-C.exe and choose Project>New Project... from the main menu.
Browse to the directory and enter a project file name, for example

" C.\ Met r ower ks\ wor k\ <pr ocessor >c\ nypr oj ect "

and change the <processor> field to your CPU). A specific project fileis
created with". dcp" extension (for example "nypr oj ect . dcp").

Configure the working directories

Choose Options>Project from the main menu of DA-C. The dialog box
shown in Figure 14.1 contains options, which establish directories for the
project.
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Figure 14.1

DA-C Project Options dialog

Project Options EE |

Directaries I File T_I,Ipesl Mames I b anager I Miscellanenusl

Project root directory
|. Browsze. .

Referential project root directary

| Browsze. ..

Database directomn
I Browsze. .

zer Help file
IE:"-.HIW.-'i‘-.F!E"sF'FEDG"-.HitDDIS.hIp Browsze. ..

FEER

] I Cancel Help

* Project root directory

Determines the project root directory. The full path is expected, or asingle
dot can be entered, which stands for the same directory where the project
fileresides. All filesthat belong to the project are considered relative to the
Project root directory, if the full path of the fileis not given. In our case,
keep the single dot for the project root directory.

» Referential project root directory

If not empty, specifies alternate Project Root Path for searching files not
found in the original project path. Filenamesin the original path with
referential extensions are tried before those in the referential path.
Specified path may be either full or relative to project root, and it may not
specify a subdirectory in the project root directory tree. Leave thisfield
empty.

» Database directory
Determines the directory where the symbols and software metrics database

will be saved. This directory can be absolute or relative to the Project Root
Directory. Leave thisfield empty.

* User helpfile
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Figure 14.2

Determines the user help file, for example compiler help file. The hot key
for User Help File can be defined in the Keyboard definition file (default
Ctrl-Shift-F1). Browsein the "\prog" directory of your Metrowerks
installation and select the help file matching your CPU.

» Configure thefiletypes
In the previous menu choose "File Types' to configure the basic file types.
Thisdialog box contains options, which determine file types of the project.

For an efficient use of Metrowerkstools, Figure 14.2 showsfile extension
types that can be defined.

Definition of file types extension

Project Options E |

Directaries  File Types | Mames I b anager I Miscellanenusl

— Referential
C Source File Original  Refer.
|-c [

Azzembler Source File
[L2sm |
Header File
b [
Diacurment File
|.|:||:u: | |
Text File
|.du:p.t:-:t.prm.ini.env.hwl.hwc.lst.mak.bpt | |

] I Cancel | Help |

Configuration of the library path

An additional configuration path must be defined to specify the location of
library header files (needed for DA-C symbol analysis). This can be done
by choosing Options>Analysisfor Symbols... >C Sourceinthe main
menu of DA-C. The dialog box shown in Figure 14.3 contains options that
determine parameters of the C source code analysis.

Debugger Manual
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syncnronized debugging through DA-C IDE
Configuring DA-C IDE for Metrowerks Tool Kit

Figure 14.3

Analysis for Symbols Options dialog

Analysis for Spmbols Options [ 7 | x| |

General C Source |

— Source

b aximur identifier lenagth I a0
|HIW/ARE MEBer/CPU32YED v ]

[ Special table processing

— Preproceszor
Definesz/Cantral file

I Browsze.., |

Header Directories

IE:"-.HIW.-'i‘-.HEHLIEHMEEKE'\incIudE Browsze. .. |
Preinzlude file

IT:'\D.-’-'-.-E'\F'INELLIDE"\HIW.-’-'-.HE MEER-CPU32 W5 0K Browsze. . |

[T Mested Comments W C++ Comments [ Traditionat [ |gnore #line

ak. I Cancel Sy | Help |

e Source

The supported C diaects of the C language used in the current project can
be selected in thisfield. In our example we chose the Metrowerks M 68k
language (adapt it to your needs).

* Preprocessor | Header Directories

Determines the list of directoriesthat are to be searched for files named
within the "#include" directive. A semicolon separates directories. Only
listed directories are searched for files, named between "<" and ">".
Searching for files, named between quotation marks ("), startsin the
directory of the source file containing "#include" directive.

The list of header directories can be assigned in afile. In that case, this
field contains the file name (absolute or relative in relation to the project

DM-466
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root) with prefix @. Directories are separated with a semi-colon or new
line.

Define the library path matching your CPU (assuming Metrowerks tools
areinstalled on"C: \ Met r ower ks"):

C.\ Metrower ks\|i b\ <processor>c\i ncl ude.

* Preprocessor | Preinclude file

Determines the name of the file that will be included automatically at the
beginning of every source module during analysis, in the same way asif
#include "string" were present in thefirst line. The preinclude file can be
used to specify predefined macros and variable and function declarations
for a particular compiler, which are not set by default in DA-C analysis.
We have selected the one corresponding to our example: M68k preinclude
file (adapt it to your needs).

Adding files to project

In the Project Manager's window the Explorer View replacesthe Window's
Explorer and supplies you with additional information on directories
containing project files. It also gives you the option to add files into the
project. For example, we will now set all files needed to run the "fibo"
example.

In the Explorer View, browse to the

">Metrowerks>WORK ><processor>c" directory of your Metrowerks
installation and select "f i bo. c" file. Then right-click mouse button and
choose"Add to Project”. Thefileisnow added in the current project and a
green mark appearsin front of it (Figure 14.4).
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Figure 14.4  Adding files to project with the Explorer View
el Project (_ [O] x|
5 Explorer Wiew ||:| Folder Viewl [1 Logieal Viewl
-3 fleslm o ||l C:¥HiwareNwork MBSk Y
,_:_|D Hiwsare M arme: Sizel Tupe | Modified
- Demo fibo. abs 817 10/14/99
Ei-0 Dosu o Fibo.c 1017 CSouwceFile 5/20/928
{:l Lib « Mpproject.dcp 1.07KE Developme.. 11/5/99 2
: . w default eny 211 11/56/33 3
- Monitors + pioject ini 1017 Configuratin..  11/5/39 9
-] Prog + fibo.mak 140 n R
- Tutorials Il fiboMaP E.29KB 71221939
=g Werk Default mem 160 7177 8
i I fibo.o 533 OFile 10/14/99
-] Logitech + Fibo.prm 400 2/18/97 1
F-{ Piogram Fies + Feadme tat 567 TextDocum.. B/26/981
-{_7] Recycled
EEI--i;l Temp j 4| | _;I
In the same way, select "f i bo. pr nt' fileand add it to this project.
Y ou can aso add a directory to the project in the following way:
» Select Explorer view in Project Manager.
* Intheleft section, select the directory with files to be added to the
project (files from subdirectories may also be added to the project).
* From popup menu choose "Add to project”.
This operation may also be performed from Folder view, if the directory is
in the left section.
NOTE  When adding entire directory to the project only files with extensions

defined in Options>Pr oj ect>File types (as described in section
"Configure the file type") will be added to the project.

Building the database

Development Assistant for C provides the static code analysis of C source
files, aswell as generating various data based on the results.

Analysis of the project source files and generation of the database are
divided into two phases: the analysis of individual program modules and
generation of data about global symbols usage. Results of the analysis are
saved in database files on the disk, which enablestheir later usein DA-C.
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Y ou can choose between the unconditional analysis of all project files and
the analysis of changed sourcefilesonly, using Sart> Build database and
Sart>Update database commands. The latter one will optionally check if
the include files used in program modules are changed as well.

To build the database in our example use Star t>Build database command,
which makes the unconditional analysis of all project files and creates a
database containing information about analyzed source code. Errors and
Warnings detected during this operation are displayed in the Messages
window asillustrated in Figure 14.5 (for Fi bo. ¢ samplefile):

Figure 145 DA-C Message Window
dy Messages Hi=] E3

Analvsiz for Symbals |

Fibo.o W arning EIE flI:u:uEDunt GI:::I:uaI ||:Ient||er seu:l it u:unl_l,l ahe mu:u:lule

* Fibo.c 16 | Warning 302 counter: Global identifier uzed in only one module
* Fiboc 18 | Warning 302 Fibonacct: Global identifier used in only one module

|4 warnings, 0 erar: detected

After the analysis of al project files, the new database file containing
information about global symbolsis constructed. Refer to the DA-C
manual for more information on how symbol information can be used.

In the Project Manager's window of DA-C, select the Logical View
property page shown in Figure 14.6 and unfold al fields, you will now
have the overview of your project.
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E DA-C - myproject - [Project] M=l B3
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Logical View

%Eile Edit Search Browse Graph Metricz Stat Project Options  Window  Help

 ob

B 7

B C

=18 x|

= E:-:plnrer\n"iewl [ Folderview [ Logical ‘v"iEWI

=+ myproject

=3 Default (folders]
B- C] Project Root
[ default =y
- fibo.mak
[ Fibo.prm
D myproject.dep
D project.ini
--[] Readme. st

I'_'IC] Dac

=3 Plnclude
D HIMWARE WBSuss-CPU 32 VB0

B3 Drive C
E-{Z3 HIWARE

=-Cg LB
=3 MESKE
23 include
~[q Hidefh
[ Stddsfh
D Stdtypes.h

= C] Default [lypes]
=8 {:] C Saurce Files

[ Fibo.c

{:] Azzembler Source Files
12 Header Files
{22 Document Filez
EI {:] Mizcellaneous Files
o] defaulter
D fibio. k.
[ Fibo.prm
D myproject.dep
D project.ini
D Readme. tat

Symbalz I Messagesl Wersion Infol Dependenciesl Da-C Prnpertiesl

FF=IelTim

I LineI Mame |
16 counter

19 fibl

139 fib2

19 fibo

15 fiboCount

|CAPS |NUM

Double-click on "Fi bo. c" fileto openit.

Configuring the tools

We will now configure the compiler and maker into DA-C IDE.
Procedures are defined in Project>User Defined Actions... from themain

menu of DA-C.
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Compiler

InMenu " Sart" Actions, click on new and fill in the New Action box
with "C&ompile", then press ENTER (Figure 14.7). In the Toolbar field,
you can associate a bitmap with each tool, for example click on the Picture
radio button and browse to the "\Bitmap" directory of your current DA-C
installation and choose Compiler.omp. Thisis adefault bitmap delivered
with DA-C IDE (here you are able to add your own bitmap).

Figure 14.7 DA-C Compiler Settings

User Defined Actions Ed |

Menu "Start" Actions | Menu ' File ferzsion Control Spstems'' Actions I

— Menu

CEompiler

Mew | Qeletel Eenamel

Up | [ Use compiler
template
Do |

— Toal bar

= Mone
© Text I
' Picture |EDmpiIer.BMF’

1

|mn)

[ONZE |

— Action zcript
ZlfxHazModuleE 2% CurrFile), M ezzageMat 2 module filel1EZCancel] j

ESavedl

o hhivareprogemBEk. exe ZCurnFile

ZEEwistedowt], ZMeszage(Mo Meszages found! | % Cancel]
ZEnCICormpiler]

ZEnGetledout Compiler]

ZResetZCunFile) -
4] _*|_I

] I Cancel Apply | Help |

Now fill inthe Action Script field in order to associate related compiler
actions. Copy the following lines shown in Listing 14.1 in the Action
Script field and change the directory to where the compiler is located.
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Listing 14.1  Script for compiler action association
. % f (%HasModul eExt (%CurrFile),, %kessage(Not a nodul e
file!)%Cancel)

. YSaveAl |

.Cc:\ Met rower ks\ prog\ cn68k. exe %CurrFil e

. % f (%Exi st (edout), , %vkessage(No Messages found!) % Cancel)
.o%Errdr(Conpiler)

. %&r r Cet (edout , Conpi |l er)

. UReset (YCurrFile)

Click on OK to validate these settings. Select "Fi bo. c" file. Click onthe
"Compiler" button (or from the main menu of DA-C select
Sart>Compile). Thisfileis now compiled and the corresponding object
file("Fi bo. 0") is generated.

Linker

In the same way, you can now configure the linker asillustrated in Figure
14.8. Inthe Menu " Start" Actions, click on new and fill in the created
New Action box with" &Link", then validate with ENTER. After setting
the corresponding bitmap, copy the following lines shown in Listing 14.2
in the Action Script field and change the directory to where the linker is
located.

Listing 14.2  Script for Linker action association

+c:\ Metrower ks\ prog\ | i nker. exe fibo.prm

. % f (%Exi st (edout), , %vkessage(No Messages found!) % Cancel)
LYErrdir()

. %Er r Cet (edout)
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Figure 14.8 DA-C Linker Settings
Uszer Defined Actions HE

Menu "Start™ Actions | kenu "Fileersion Control Systems".ﬁ.ctiansl

— Menu
CEompiler Mew | Delete | Eenamel
Up | [ Use compiler
template
Do |
— Tool bar
= Mone
= Teut I -l
& Picture ILinker.BMF‘ %l
— Action zonipt
o hhivaresprogilinker. exe fibo. prm ;I

ZiEEwiztjedowt], Mezzage(Mo Meszzages found! )% Cancel]
AZECI]
ZEnGetedout]

" o

] I Cancel Apply | Help |

Maker

In the same way, you can now configure the maker asillustrated in Figure
14.9. IntheMenu " Sart" Actions, click on new and fill in the created
New Action box with" & M ake", then press ENTER. After setting the
corresponding bitmap, copy the linesfrom Listing 14.3 in the Action
Script field and change the directory to where the maker is located.

Listing 14.3  Script for Maker action association

+c: \ Met r ower ks\ prog\ maker . exe fi bo. mak

. % f (%Exi st (edout), , %vkessage(No Messages found!) % Cancel)
LYErrdr()

. %Er r Get (edout)
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Figure 14.9 DA-C Maker Settings

Uszer Defined Actions EE |

Menu "Start™ Actions | kenu "Fileersion Control Systems".ﬁ.ctiansl

— Menu
CEompiler Mew | Delete | Eenamel
Linker .
Up [ Use compiler
_I template
Do |
— Tool bar
= Mone
E = Teut I -l
& Picture IMakE.BMF‘ Browse |
— Action zonipt
o hhiwaresprogimaker. exe fibo.mak ;I

ZiEEwiztjedowt], Mezzage(Mo Meszzages found! )% Cancel]
AZECI]
ZEnGetedout]

" o

] I Cancel Apply | Help |

Debugger Interface

DA-C v3.5iscurrently integrating a DAPI interface (Debugging support
Application Programming Interface). Through thisinterface DA-Cis
enabled to exchange messages with the Simulator/Debugger. The
advantages of such connection show that it is possibleto set or delete break
points from within DA-C (in an editor, flow chart, graph, browser) and to
execute other debugger operations. DA-C isfollowing Simulator/Debugger
inits operation, sinceit is aways in the same file and on the same line as
the debugger. Thus, usability of both the DA-C and Simulator/Debugger is
increased. Some configurations are required in order to make an efficient
use of this Debugger Interface:

* |nstallation of communication DLL
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» Configuration of Debugger properties
» Configuration of the Simulator/Debugger project file

Principle of Communication between DA-C IDE
and Simulator/Debugger

DA-C and the Simulator/Debugger are both Microsoft Windows
applications and communication is based on the DDE protocol (Figure
14.10). The whole system contains.

DA-C
Simulator/Debugger

cDAPI interface implementation DLL - which is used by DA-C
(Cdgen32.dil)

NDAPI communication DLL (provided by DA-C), which is used by
Simulator/Debugger

Simulator/Debugger specific DLL for bridging itsinterface to
debugging environment and DA-C's nDAPI (DAC.wnd)
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Principle of Communication between DA-C IDE and Simulator/
Debugger

HI-WAVE
Debugger

Command messaging Dar wnd

p| (HI-WAVE DLL)

Cdgend2 dll
(DA-C DLL)

l

NDAPLAl
(D&-C DLL)

Motification messaging

Installation of communication DLL

As described previously, the Simulator/Debugger needs the nDAPI
communication DLL (provided by DA-C IDE). Thisdll (called Ndapi.dll)
isautomatically installed during the Metrowerks Tool Kit installation.
However, if you install a new release of DA-C you have to follow this
procedure:

Inthe"\ Pr ogr anm' directory of your DA-C installation, copy the
"Ndapi 32. dl | " (Ndapi 32. dl | verson 1.1or later) and pasteitin
your current "Met r ower ks\ PROG' directory (where Simulator/
Debugger islocated). Then renameit to "Ndapi . dl | ".

Configuration of Debugger properties

In the DA-C main menu, choose Options>Debugger, the dialog shown in
Figure 14.11 is opened.
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Figure 14.12
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DA-C Debugger Options

Debugger Options H |
il About |

Debugger |@ HIWARE HIwWAYE 6.0

— Startup
Switches I
Load binary |E:'xHIWf-‘-.HE'xWEIHKHM B3k.CAfibio.abs Browse. .. |

[ Ask before sending to debugger

Timeouts |2EI [=]

[V Check debugging through non-project files

ok | Cancel | Help |

In the "Debugger"” combo-box, select the corresponding debugger: "HI -
WAVE 6.0". Now specify the binary file to be opened: in our example we
want to debug the "f i bo. abs" file.

Then click on the Setup... button. The dialog shown in Figure 14.12 is
opened.

DDE Debugger Setup

Genenc DDE Debugger Setup [HIWARE HI-'WAYE 6.0] |

Browsze. . |
k. I Cancel | Help |

Program to start

Specify the path to the "hiwave.exe" file or use the Browse... button then
click on OK.

Configuration of the Simulator/Debugger project file

Before configuring the project file, close DA-C. Open Simulator/Debugger
(for example, from a shell) and select File>Open Project... from the main
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menu bar. Select the"Pr oj ect . i ni " file from the currently defined
working directory (in our case

"C. \ Met r ower ks\ WORK\ <pr ocessor >c\ project.ini").We
will now add in the layout of the project the Simulator/Debugger DAC
component ("dac. wnd"). In the Simulator/Debugger select Component
>0Open from the main menu bar and choose "Dac", as shown in Figure
14.13.
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Figure 14.13 DA-C component opening

HI-'WAYE C:AHIWAREAMWORKAMGBK Chproject.ini

File “iew Bun Simulator Component Data Window Help
(] ] 2% =l==e=0] 3

= Source i =] = Assembly —|O
| [ [

DOpen Window Component x|

Azzembly a

Command (n

Eoveraie -
Cancel |

Drats
Inzpect

lo_led
= Procedure Logde I | Register o] =]
b ermany i
[ Mictoe Help | [ |CPU Cycles: 0 Hex

b odule
Phone
Frocedure LI

= Data:1 I [=]

| | [ Auta [Symb | Global

= Memory o] =]

[ | Aua |

00000000 i ua u ﬂ
00000004 wi ul u o uaa
000000058t wil un u
00000008 wu wi ua u
00000010 wa wi un u o uaa
00000014 wu wi un ua
= Data:2 =10 x| 00000018 wu wi un ua
| | [ Aute [Symb | Local  [|0000001C ww wa wm wa wmam
00000020 wu wil un u o uaa
00000024 wu wil ul u o uaa
00000025 wtu wi un ua
00000020 wu wi un ua o
00000030 U il Ul u
00000034 i Ui uu aun
00000038 U il Ul ul uun j

For Help, press F1 |0 |SIM_READY i

The Simulator/Debugger DAC window, which is needed for
communication with DA-C IDE is now opened (Figure 14.14).
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DA-C Window

S DA-C Link |

Y ou have to save this configuration by selecting File>Save Project from
the main menu of the Simulator/Debugger. This component will be
automatically loaded the next time this project is called. Close the
Simulator/Debugger.

Synchronized debugging

Figure 14.15

NOTE

We can now test the synchronization between DA-C IDE and Simulator/
Debugger. Run DA-C.exe and open the project previoudy created. Open
"Fibo.c" if it's not already open. Right-click mouse button on "Fi bo. c"
source window and select "main” in the popup menu. The cursor points to
the "void main(void) {" statement. In the main menu from DA-C, select
Debug>Set Breakpoint (or click on the corresponding button on the
debug toolbar), the selected lineis highlighted in red, indicating that a
breakpoint has been set. Then select Debug>Run, the Simulator/Debugger
isnow started and after a while stops on the specified breakpoint. Up to
now, you can debug from DA-C IDE with the toolbar, as shown in Figure
14.15 or from the Simulator/Debugger.

DA-C toolbar
[ E S A 7]

In case of changesto your source code, don't forget to rebuild the Database
when generating new binary files to avoid misalignment between the
Simulator/Debugger and DA-C source positions.

Troubleshooting

This section describes possible trouble when trying to connect the
Simulator/Debugger with the DA-C IDE.

When loading DAC component into the Simulator/Debugger, if the
message box shown in Eigure 14.16 isdisplayed:
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Synchronized debugging through DA-C IDE
Troubleshooting

Figure 14.16 DA-C component loading error.

Component Loading E rror |

Could not load component V'dac.whnd' or one aof itz libranes.
[Ermrar code 12E]

check if theNdapi . dl | islocated inthe"\ pr og" directory of your
current Metrowerks installation. If not, copy the specified DLL into this
directory.

2. If themessage box shown in Eigure 14.17 isdisplayed in DA-C IDE:

Figure 14.17 DA-C debugger support.

Debugger support E |
External debugger tred to
connect with DA-C iz not the
zame like configured!

This means that the current name specified in the Options>Debugger
main menu of DA-C doesn't match the debugger name specified in the
Simulator/Debugger. Open the setup dialog in the Simulator/Debugger by
clicking on the DA-C Link component and choose DA-C Link>Setup...
from the main menu. The "Connection Specification" dialog is opened

(Figure 14.18).

Debugger Manual DM-481
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syncnronized debugging through DA-C IDE
Troubleshooting

Figure 14.18 DA-C connection specification

Connection Specification |

Debugger Mame: |HIWﬁHE HI“wig/E E.0

™ Show Protocol |2 Cancel Help

Compare the "Debugger Name" from this dialog with the selected
Debugger in DA-C IDE (Options>Debugger ), shown in Figure 14.19.

Figure 14.19 DA-C Debugger Options
Debugger Options @

i About... |

Debugger |@ HIWARE HI‘waWE 6.0

— Startup
Switches I
Load binary |E:'xHIWf-‘-.HE'xWEIHKHM B3k.CAfibio.abs Browse. .. |

[ Ask before sending to debugger

Timeouts |2EI [=]

[V Check debugging through non-project files

ak. Cancel Help

Both must be the same. If it's not the case, change it in the Simulator/
Debugger "Connection Specification” and click OK. Thisimplies anew
connection to be established and the " Connection Specification” to be

saved inthe current "Pr o] ect . i ni " filein the section shown in Listing
14.4.

DM-482 Debugger Manual
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Synchronized debugging through DA-C IDE
Troubleshooting

Listing 14.4

DA-C section in project file.

[ DA- (]

DEBUGGER_NAME=HI - WAVE 6. 0

SHOWPROT=1

Debugger Manual
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syncnronized debugging through DA-C IDE
Troubleshooting

DM-484

Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-485



b -

Freescale Semiconductor, Inc.

DM-486

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-487



b -

Freescale Semiconductor, Inc.

DM-488

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-489



b -

Freescale Semiconductor, Inc.

DM-490

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-491



b -

Freescale Semiconductor, Inc.

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-493



b -

Freescale Semiconductor, Inc.

DM-494

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-495



b -

Freescale Semiconductor, Inc.

DM-496

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-497



b -

Freescale Semiconductor, Inc.

DM-498

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-499



b -

Freescale Semiconductor, Inc.

DM-500

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-501



b -

Freescale Semiconductor, Inc.

DM-502

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-503



b -

Freescale Semiconductor, Inc.

DM-504

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-505



b -

Freescale Semiconductor, Inc.

DM-506

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

DM-508

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-509



b -

Freescale Semiconductor, Inc.

DM-510

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

Debugger Manual

For More Information: www.freescale.com

DM-511



b -

Freescale Semiconductor, Inc.

DM-512

For More Information: www.freescale.com

Debugger Manual



b -
|

Freescale Semiconductor, Inc.

Scripting
The Component Object Model Interface

15

Scripting

This chapter explains how to use the Debugger’s Component Object
Model (COM) Interface. The Debugger’s Interface inherits from
IDispatch. This enables the feature to control the Debugger from external
scripts. The script language can be any language that supports the
Component Object Model: e.g. Visua Basic Script, Perl, Java Script, etc.

This chapter contains the following sections:
e The Component Object Model Interface
e Manua Reqgistration
» Scripting Example
» Remote Scripting another HI-WAVE

The Component Object Model Interface

Listing 15.1

The Interface Nameis” Met r ower ks. Hi wave” and consists of two
methods. Both make the same except that the later one returns the result
message that the given command will produce.

Interface Methods

HRESULT ExecuteCnd([in] BSTR comand);
HRESULT Execut eCndRes([in] BSTR command,

[out, retval] BSTR *result);

Parameters:

command

For this command you can use the debugger commands that are specified
in the chapter Debugger Commands.
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result

Returns the result message that the command produced. Thisisthe same
message you would see in the command window when executing the
command.

Return Values:

If the method succeeds, the return valueis S _OK.
If the method fails, the return value is an error.

Manual Registration

NOTE

The Component Object Model Interface will be automatically registered
during the installation.

When executing the batch file bin/regser ver s.bat the Component Object
Model Interface from the Code Warrior Debugger will be explicitly
registered. Or use prog/hiwave.exe /[RegServer.

Scripting Example

Listing 15.2

The following Visual Basic Script demonstrates the use of the Component
Object Model Interface from the CodeWarrior Debugger. This small
example will start the CodeWarrior Debugger (HI-WAVE), open a
command window, set the target interface to ssmulator and loads an
application named “filbo.abs’.

example.vbs

* Code Warrior Debugger COM Scri pting Exanpl e

Dim h

Set h = CreateCbject("Mtrowerks. H wave")

h. Execut eCnd( " open comrmand")

Dimresult

result = h. ExecuteCndRes("set sint)

DM-514
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If result <> "" Then
nmsgbox result
End | f

h. Execut eCrd( "l oad fi bo. abs")

Remote Scripting another HI-WAVE

Its also possible to remote control another HI-WAVE from within a
running HI-WAVE. To do so open the component ComMaster. This will
add additional commands. Y ou can see them by entering help in the
command window.

NOTE  Make surethat the HI-WAVE you want to remote control is registered.

COM_START

Description ~ The COM_START command starts another HI-WAVE. Its only possible
to start one HI-WAVE at once. If you want to have several remote HI-
WAVE applications ssimply open severa ComMaster components.

usage COM_START
Components  ComMaster component.

Example

in>COM_START

The remote Debugger application is started.

COM_EXIT

Description  Thiscommand will quit the started reomte HI-WAVE.
Usage COM_EXIT

Components  ComMaster component.
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Example

in>COM_EXIT

The remote Debugger application is closed.

COM_EXE
Description  With this command you can send commands to the remote HI-WAVE
Usage COM_EXE "<MyCommand>"
Components  ComMaster component.

Example

in>COM_EXE “load fibo.abs"

L oads an application named “fibo.abs* in the remote Debugger.
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Appendix

This chapter contains the followings sections:
» Messagesin Status Bar
« EBNF Notation
» Constant Standard Notation
» Register Description File
e OSEK ORTI File Sample

» Bug Reports
» Technical Support

Messages in Status Bar

This section describes debugger status messages.

Status Messages
This section describes the different status messages.
READY

The Simulator/Debugger is ready and waits until a new target or
application isloaded. This message is generated once the Simulator/
Debugger has been started.

HALT

Program execution has been stopped by a request of the application. The
predefined macro HALT (defined in HI DEF. H) has been reached in the
application code during execution of the application.
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RUNNING
The application is currently executing in the Simulator/Debugger.
HALTED

Execution has been stopped on user request. The menu entry Run>Halt or
the Halt icon in the tool bar has been selected.

RESET

This message is generated when the Simulator/Debugger has been reset on
user request. The menu entry Simulator >Reset or the Reset icon in the
tool bar has been selected, or the reset command has been used.

HARDWARE RESET

This message is generated when the Simul ator/Debugger has been Reset on
user request and when atarget is specified. The menu entry

Simulator >Reset or the Reset icon in the tool bar has been selected, or the
Reset command has been used.

Stepping, Breakpoint and Watchpoints
Messages

This section describes the different Stepping, Breakpoint and Watchpoints
messages.

STEPPED

Program execution has been stopped after asingle step at source level. The
menu entry Run>Single Step or the Single Step icon in the tool bar has
been selected.

STEPPED OVER

Execution has been stopped after stepping over afunction call. The menu
entry Run>Step Over or the Step Over icon in the tool bar has been
selected.

STOPPED

Execution has been stopped after stepping out of afunction call. The menu
entry Run>Sep Out or the Step Out icon in the tool bar has been sel ected.
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TRACED

Execution has been stopped after asingle step at assembler level. The
menu entry Run>Assembly Sep or the Assembly Sep icon in thetool bar
has been selected.

BREAKPOINT

Program execution has been stopped because a breakpoint has been
reached.

WATCHPOINT

Execution has been stopped because a watchpoint has been reached. The
format from this message is:

Watchpoint at address: size

Where:

» addressisthe start address in memory where the watchpoint has been
defined.

» sizeisthe size of the memory area where the watchpoint has been
defined.

The name of the variable is displayed (if available).

CPU Specific Messages

Some error messages depend on the CPU used. These are messages related
to exceptions. The Simulator/Debugger make a distinction between
predefined exceptions (which have a specific meaning for all derivativesin
the CPU family) and user defined exceptions (which can be freely
configured by the user or does not have the same meaning for all
derivativesin the CPU family).

Format for exception messageis:
Exception string | number

Where:

* string describes the reason for the exception. Thisstring isonly
specified when a predefined exception is detected.
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* number isthe entry in the vector table that generates the exception.
This number isonly specified when a user defined exception is
detected.

Two exceptions are treated differently; the address error and the bus error
exception.

ADDRESS ERROR

An address error exception for the target processor has been generated.
Check your hardware manual for the reason of the Address Error
Exception.

BUS ERROR

A bus error exception for the target processor has been generated. Check
your hardware manual for the reason of the Bus Error Exception.

OTHER EXCEPTION

An exception has been generated for avector that is not associated with an
interrupt function.
Possible reasons:

* You haveforgotten to disable an interrupt source. Insert code to disable
the interrupt source in your application.

* You have forgotten to initialize the corresponding entry in the vector
table with the address of the function associated with the interrupt.
Initialize the vector table.

Target Specific Messages

Some messages are closely related to the debugging interface used
(Simulator, Emulator,...).

These messages are listed in the corresponding Target Manual.
Examples: Simulator/Debugger Simulator Messages

This section describes the different Simulator/Debugger Simulator
messages.

DM-520

Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Appendix
Messages in Status Bar

SIM_READY

The Simulator/Debugger ssmulator is ready and waits for user commands.
This message is generated when an application has been loaded into the
Simulator/Debugger Simulator.

More Simulator Peculiar Messages: Memory
Access Messages

This section describes the different Simulator Peculiar M essages. Memory
Access Messages

READ UNDEFINED

The Simulator/Debugger detects aread accesson aRAM area, wherethere
was no previous write access. This alows you to track read access on
uninitialized local variables.

NO MEMORY

The Simulator/Debugger has detected an attempt to access amemory area
that is not defined (no memory).

Possible reasons;

* Your codeisnot correct and triesto access an addresswhere thereisno
memory available. Correct your code.

* Your memory configuration is not correct. Check the current
configuration in the Memory Configuration dialog box.

PROTECTED
The Simulator/Debugger has detected a write access on aROM area.

Possible reason:

* Your codeisnot correct and triesto writein a ROM area. Correct your
code.

* Your memory configuration is not correct. Check the current
configuration in the Memory Configuration dialog box.
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EBNF Notation

This chapter gives a short overview of the EBNF notation, whichis
frequently used in this manual to describe file formats and syntax rules.

Introduction to EBNF

Extended Backus—Naur Form (EBNF) is frequently used in this reference
manual to describe file formats and syntax rules. Therefore, a short
introduction to EBNF isgivenin Listing 16.1.

Listing 16.1 EBNF Example

ProcDecl =PROCCEDURE " (" ArgList ")".

ArgLi st =Expression {"," Expression}.
Expressi on=Term ("*"|"/") Term

Ter m=Fact or AddOp Fact or.

AddQp="+"|"-".

Factor=(["-"] Nunber)|"(" Expression ")".

The EBNF language is aformalism that can be used to express the syntax
of context-free languages. An EBNF grammar is a set of rules called
productions of the form:

Lef t HHndSi de=Ri ght HandSi de.

The left hand side is a so-called nonterminal symbol, the right hand side
describes how it is composed.

EBNF consists of the following symbols:

* Termina symbols (terminals for short) are the basic symbols, which
form the language described. In above example, the word PROCEDURE
isaterminal. Punctuation symbols of the language described (not of
EBNF itself) are quoted (they are terminals, too), while other terminal
symbols are printed in boldface.

* Nontermina symbols (nonterminals) are syntactic variables and have
to be defined in aproduction. They have to appear on the left hand side
of a production somewhere. In above example, there are many
nonterminals, for example, ArgLigt or AddOp.

» Thevertica bar "[' denotes an adternative; either the left or theright side
of the bar can appear in the language described, but one of them hasto
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appear. For example, the 3™ production above means “an expression is
aterm followed by either a"*" or a"/" followed by another term”.

» Parts of an EBNF production enclosed by "[" and "]" are optional. They
may appear exactly once in the language, or they may be skipped. The
minus sign in the last production above is optional, both -7 and 7 are
allowed.

* Therepetition is another useful construct. Any part of a production
enclosed by "{" and "}" may appear any number of timesin the
language described (including zero, that is, it may also be skipped).
ArgLig aboveisan example: an argument list isasingle expression or a
list of any number of expressions separated by commas. (Note that the
syntax in the example does not allow empty argument lists...)

* For better readability, normal parentheses may be used for grouping
EBNF expressions, as is done in the last production of the example.
Note the difference between the first and the second left bracket: the
first oneis part of EBNF itself, the second oneisaterminal symbol (it
is quoted) and therefore may appear in the language described.

A production is always terminated by a period.
EBNF-Syntax

We can now give the definition in EBNF:

Producti on=NonTerm nal "=" Expression
Expression=Term {"|" Ternt}.

Ter m=Fact or {Factor}.

Fact or =NonTer m nal

| Term nal

| "(" Expression ")"

| "[" Expression "]"

| "{" Expression "}".

Term nal =l dentifier | “"*“ <any char>
NonTer m nal =l dentifier.

The identifier for a nonterminal can be any name you like; termina
symbols are either identifiers appearing in the language described or any
character sequence that is quoted.

Extensions
In addition to this standard definition of EBNF, we use the following
notational conventions;

* The counting repetition: Anything enclosed by "{" and "}" and
followed by a PP expression x must appear exactly x times. x may
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also be anonterminal. In the following example, exactly four stars are
allowed:

Stars = {"*"}*.

» Thesizein bytes. Any identifier immediately followed by a number n
in square brackets ("[" and "]") may be assumed to be a binary number
with the most significant byte stored first, having exactly n bytes.
Example:

Struct = Ref No Fil ePos|[4].

* |n some examples, we enclose text by "<" and ">". Thistext isameta—
literal. Whatever the text says may be inserted in place of the text. (cf.
<any char> in the above example, where any character can be inserted).

“Expression” Definition in EBNF

expressi on= | or Expr.
| or Expr= | andExpr {"||" landExpr} // logical OR
| andExpr = orExpr {"&&" orExpr} // |ogical AND
or Expr = xorExpr {"|" xorExpr} // bitwse OR
xor Expr= andExpr {""" andExpr} // bitw se XOR
andExpr = eqExpr {"&" eqExpr} // bitwi se AND
egExpr = rel Expr {("==" | "!=") rel Expr}
rel Expr = shiftExpr {("<" | ">" | "<=" | ">=")
shi ft Expr}

shift Expr = addExpr {("<<" | ">>") addExpr}
addExpr = mul Expr {("+" | "-") mul Expr}
Mul Expr = castExpr {("*" | "/" | "% ) castExpr
cast Expr=["~" | "I" | "+" | "-" ] parenExpr
par enExpr= "(" expression ")"

| cOhject

| synbol

| register

| variable

| string

| nunber
cObject=["(" cType ")"] expression

| "&" itemNanme

| "*" itemNane

| 1temName {(("." | "->")identifier)]
("[" expression "]")}
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cType= [qualifier] [specifier] type
| [qualifier] specifier

| specifier
| "void *"
qualifier= "const" | "volatile"
specifier= "signed" | "unsigned"
type= "char" | "short" | "long" | "int" |
"float"” | "double"

synbol defined with the DEFINE conmmand
regi ster= 10OReg

vari abl e= bj ect Reg

(bj ect Reg= ["OBIJPOOL: : "] bj ect Spec

bj ect Spec= bj ectNane ["." Fiel dNane].

Cbj ect Nane= ident [":" I|ndex].

Fi el dNanme= IdentNum ( [".." ldentNunj | ["." Size] ).
[ dent Num= ident | "#" HexNunber.

Size= "B" | "W | "L".

i dent isanidentifier asdefined in ANSI-C

|OReg= ["IOREG : "] group | regNane
gr oup refer to the silicon vendor 1/O register file definition
r egNanme refer to the silicon vendor Register Name definition

itemName = nodule |[[nodule] ":"] procedure
[[nmodul e] ":" [procedure] ":"] variable

variable = ident { "." ident | nunber }

nodule = ident ["." extension]

procedure = ident

ext ensi on isanidentifier asdefined in ANSI-C
nunmber isanumber asdefinedin ANSI-C
i dent isanidentifier asdefined in ANSI-C

Module names can have an extension. If no extension is specified, the
parser will look for the first module that has the same name (without
extension).

NOTE  Correct module names are displayed in the Module component window.
Make sure that the module name of your command is correct. If the. abs
isin HIWARE format, some debug information isin the object file (. 0),
and module names have a. o extension (e.qg., f i bo. 0). In ELF format,
module name extensionsare. ¢, . cpp or. dbg ( . cpp for program
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sourcesin assembler) (e.g., f i bo. c¢), since al debug information is
contained in the . abs file and object files are not used. Please adapt the
following examples with your . abs application file format.

Semantic

A scope represents either amodule or a procedure. A scope is recognized
by the presence of the double colon which terminates the scope. If the
scope identification contains at least one colon, it isassumed to represent a
procedure, otherwise a module.

Empty module or procedure names represent the current module or
procedure, respectively. The current procedure is the procedure that the pc
of the smulator pointsinto. The current module is the module that contains
the current procedure.

Items are identified either absolutely or relatively, corresponding to the
presence or absence of a scope.

Anitem isidentified absolutely by specifying its scope, that is, the module
and/or procedure where the item is located.

Anitemisidentified relatively, if ascopeisomitted. In this case, the item
isassumed to be located in the current procedure.

Examples

fibo.c:Fibonacci:fib1l matches the local variable fib1 of the procedure
Fibonacci in the module fibo.

:main matches the procedure main in the current module.
start12: Startup matches the procedure _Startup in the module start12.
::counter matches global variable counter of the current module.

:Fibonacci:fib1l matches the local variable fib1 of the procedure
Fibonacci of the current module.

fibo.c::counter matches the global variable counter of the module fibo.

fib1 matches the local or global variable or module of the current
procedure and/or the current module.
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startupData.flags matches the field flags of the local or global variable
startupData (which is a structure) of the current module or procedure.

Constant Standard Notation

Inside an expression, the ANSI C standard notation for constant is
supported. That means that independently from the current number base
you can specify hexadecimal or octal constants using the standard ANSI C
notation.

Example

Notation M eaning
Ox----  Hexadecimal constant
0----  Octal constant

In the same way, the Assembler notation for constant is supported. That
means that independently from the current number base you can specify
hexadecimal, octal or binary constants using the assembler prefixes.

Example

Notation Meaning
$---  Hexadecimal constant
@ Octal constant

% Binary constant

When the default number baseis 16, constants starting with aletter A, B,
C, D, E or F must be prefixed either by Ox or $. Otherwise, the command
line detects a symbol and not a number.

Example
Notation Meaning
5AFD  Hexadecimal constant $5AFD.

AFD Symbol, whose name is AFD.
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Register Description File

When loading a Simulator/Debugger target, the definition of the I/O
registersisloaded from afile. This alows you to use the names of these
registers as parameters of the commands or as operands in an expression.
The syntax of the fileis given below.

There may be several different files depending on the MCU used. The
name of the correct file is derived from the MCU identification number
(MCUID) in the following way:

MU xxxx. REG

where nnnisthe MCUID in hexadecimal representation. Thisfileis
expected to be found in the directory where the program files are located
(eg., ..\ PROG. If thisfileis not found, afile with the name

" DEFAULT. REG issearched for and loaded, if found. If no fileisfound,
an error message is displayed.

File format

The register description file contains the following information (for details
refer to the EBNF definition in Appendix). First, a header contains the
name, identification number and location of the register block of the MCU.
The header isfollowed by alist of module descriptors. Each of those
contain register definitions and optionally a memory map specification.
Theregister definitions may be grouped under agroup name. Each register
definition defines the name, address and size of an 1/O register. The
memory map specification is used by the MEM command to display the
configured memory of that module.

Description using EBNF.

The format of the register fileisdescribed in Listing 16.2 in EBNF.

Listing 16.2  Register file description EBNF.

MCUDescr i pti on=Header {Modul e}.

Header =" MCU' McuNanme Mcul d RegBase RegSi ze.

Modul e="MODULE" Modul eNane {RegDef} {G oupDef | MapDef}.
G oupDef =" GROUP" G oupNane {RegDef}.

RegDef =RegNane RegOfi fset Size.
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MapDef =" MEMVAP" Bl kNane BaseMapDef {MapSecifier}.
BaseMapDef =" BASE" Exp "SI ZE" Exp "ENABLED' Exp.

MapSpeci fi er =" SPECI FI ER" [ Label ] Exp.

Exp=CExpression | Sw tchExpr.

Swi t chExpr =CExpression ":" {CaseSpec}.

CaseSpec="[" ConstValue ":" (CExpression | StringDef) "]".

McuNanme=Stri ngDef.//nanme of the MCU

Mcul d=Const Val ue. //identification nunber of the MCU
RegBase=Const Val ue. // base address of the registers after reset
Modul eNanme=Nane. // name of the nodul e

G oupNane=Nane.// nane of a group of registers

RegNane=Nane. //nane of the register

Reg(O f set =Const Val ue.// of fset fromthe regi ster base address
Si ze=Const Val ue.//size of the register in bits.
Bl kNanme=Nane. // nane of the nenory bl ock.
Label =StringDef.//nanme to be used to | abel the specifier
CExpression=// expression as defined in ANSI-C which
contains integer values only.
Const Val ue=// constant value as defined in ANSI-C
Nanme=// identifier as defined in ANSI-C
StringDef=// any nunber of printable character in double quotes

(")

[1] evaluation of expressionsis done using signed 32 bit arithmetic.
[2] al non-printable characters are interpreted as white spaces.
Example

Listing 16.3 describes a hypothetical MCU. It contains the modules ABC,
SQIM and FLASH. The SQIM hastwo groups of registers, the PORTS and
CHIPSELECTS.

Listing 16.3 MCU examples

MCU "MY_MCU' O0x07A5 OxFFFOOO 0x1000
MODULE ABC
ABCMCR 0x700 16
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PORTABC 0x706 16

MODULE SQ M
SQ MCR 0xA00 16
SYNCR 0xA04 16
GROUP PORTS
PORTA 0xAl10 8
PORTB OxAll 8
GROUP CHI PSELECTS
CSPARO 0xA44 16
CSBARA 0xA60 16
CSCRA OxA62 16
MEMVAP CSA

BASE ( CSBARA & OxFFF8) << 8
S| ZE CSBARA & 7
[ 0: 0x800] [1:0x2000] [2:0x4000]
[ 3: 0x10000] [ 4: 0x20000] [5:0x40000]
[ 6: 0x80000] [ 7: 0x80000]
ENABLED (CSPARO & 3) >= 2
SPECI FI ER "ACCESS" (CSORA >> 11) & 3 :
[0:"None"][1l:"Read"]
[2:"Wite"][3:"Both"]
SPECI FI ER "BYTE" (CSCRA >> 13) & 3 :
[0:"None"][1:"Lower"]
[2: " Upper"][3:"Both"]
SPECI FI ER (CSORA >> 4) & 3 :
[0:"None"][1:"Lower"]
[2: " Upper"][3:"Both"]
MODULE FLASH

FEEMCR 0x820 16
FEEBAH 0x824 16
FEEBAL 0x826 16

VEMVAP FLASH
BASE ( FEEBAH << 16)
SI ZE 0x8000
ENABLED ( FEEMCR & 0x8000) ==
<eof >

DM-530 Debugger Manual

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

Appendix
OSEK ORTI File Sample

OSEK ORTI File Sample

When building an OSEK project in CodeWarrior, the OSEK ORTI fileis
automaticaly generated by the the OSEK System Generator. The generated
file has the same name and the same location as exucutable file but its
extension is.ort.

Listing 16.4 OSEK ORTI File Sample

| MPLEMENTATI ON Mot or ol a_ORTl _OSEKt urbo_0S12 2 1 1 17 {

s {

ENUM U NT8 [ "NO TASK" =
"MotorDriveTask"” = 1,
"Control Task" = 2,

"I nit Task" = 3,
"I nput Task" = 4,
"LockTask" =5

] RUNNI NGTASK, "Running Task ldentification";

ENUM U NT8 [ "NO SERVICE" =0, "Start(0S" = 0x01, "ShutdownOS"

= 0x02,

0,

"CGet ActiveApplicati onMbde" = 0x03,
/* task managenent services*/
"Activat eTask"” = 0x10, "Term nateTask" = 0x11
"Chai nTask" = 0x12,
"Schedul e" = 0x13, "GetTaskld" = 0x14, "GetTaskState" =
0x15,
/* interrupt handling services*/
"Enterl SR' = 0x20, "Leavel SR' = 0x21,
"Enabl el nterrupt” = 0x22, "D sablelnterrupt" = 0x23,
"CetlInterruptDescriptor” = 0x24,
"ResuneCSI nterrupts” = 0x25, "SuspendCSInterrupts”

0x26,
"Enabl eAl | I nterrupts" = 0x27, "Di sableAlllnterrupts" =
0x28,
/* resource managenent services*/
"Get Resource" = 0x30, "Rel easeResource" = 0x31
/* event control services*/
"Set Event" = 0x40, "Cl earEvent" = 0x41, "GCetEvent"
0x42, "WaitEvent" = 0x43,
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/ * messages services*/
"SendMessage" = 0x50, "ReceiveMessage" = 0x51,
/* counters and al arns services*/
"Cet Al ar nBase"” = 0x60, "Get Al armi' = 0x61, "SetRel Al arnt

0x62,
"Set AbsAl arm’ = 0x63, "Cancel Al arnt = 0x64,
/* OSEK OS v1.0 specs*/
"I'nitCounter"” = 0x65, "CounterTrigger" = 0x66,
"CGet Count er Val ue" = 0x67, "Get Counterlnfo" = 0x68,
/* hook routines*/
"ErrorHook" = 0x70, "PreTaskHook" = 0x71, "PostTaskHook"
= 0x72,
" St artupHook” = 0x73, " ShutdownHook" = 0x74,
[* extra services*/
"1 dl eLoopHook" = 0x75] CURRENTSERVI CE, "OS Services
Wat ch";

ENUM U NT8 [ "TASK LEVEL" = 0
, "SYSTEM TI MER'" =1

, "Stalllnt" =3
] RUNNI NG SR, "Executed | SR Identification";
b
TASK {

ENUM U NT8 [ "O" =1, "5" =2, "10" = 3, "20" = 4, "30" = 5]
PRICRITY, "Task Priority";

ENUM U NT8 [ "RUNNING' = 0, "WAITING' = 1, "READY" = 2,
"SUSPENDED' = 3 ] STATE, "Task State";

U NTS8EVENTS, "Events State":
U NT8WAI TEVENTS, "Waited Events";
STRI NG MASKS, "Task Event Masks";

ENUM ADDRESS [ "MAI N STACK' = "& GsOrti StackStart”,
"Mot or DriveTask STACK' = "QOsMt orDriveTaskStack+1",
"Cont rol Task_STACK" = "(OsControl TaskSt ack+1",
"NO _STACK" = 0 ] STACK, "Current Task Stack";
STRI NG PROPERTY, "Task Properties";

}s
STACK {
ADDRESSSTARTADDRESS , "Stack Start Address”;
ADDRESSENDADDRESS , "Stack End Address";
U NT16SI ZE , "Stack Size";
DM-532
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}

COUNTER{
STRI NGVAXALLONEDVALUE, " MAXALLOWEDVALUE";
STRI NG Tl CKSPERBASE, " Tl CKSPERBASE" ;
STRING M NCYCLE, "M NCYCLE";
U NT16 VALUE, "Current Val ue";

ENUM UI NT8[ "NO ALARM' = 0, "ALARM' = 1] STATE, "Activated

Al arnt:
}s

ALARM
ENUM Ul NT8 [ "ALARMSTOP' = 0, "ALARVRUN' =
State";
STRI NG COUNTER, "Assigned Counter";
STRI NG TASK, "Notified Task";
STRI NG EVENT, "Event to set”;
U NT16 TIME, "Tine to expire";
U NT16 CYCLE, "Cycle period";

b

VESSAGE{
STRI NG TYPE, "Message Type";
STRI NG TASK, "Notified Task";
STRI NG EVENT, "Event to be set”;

s
s

/* Application Description Part */

CS os {

RUNNI NGTASK = " GsRunni ng";

CURRENTSERVI CE = "GsOrti Runni ngServi cel d";
RUNNI NG SR = "OsOrti Runni ngl SRI d”;

b

TASK MotorDriveTask {
PRICRITY = "3";

1] STATE, "Alarm

STATE = "( GsRunning !'=1) * ( ( ( OsTaskStatus[1l] & 0x02 )
I=0) + ( ( OCsTaskStatus[1l] & 0x02 ) == 0 )* ( ( OsTaskStatus[1]
& 0x04 ) '=0) * 2 + ( OGsTaskStatus[1l] == 0) * 3 )";
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STACK = "OCsMot or Dri veTaskSt ack+1";

EVENTS = "OsTaskSet Event[0]" ;

WAl TEVENTS = "OsTaskWait Event[0] " ;

MASKS = "UP_EVENT =, STOP_EVENT = , DOM EVENT = ";
PROPERTY = "EXTENDED, FULLPREEMPT, Priority: 10 ";

1

TASK Control Task {

PRIORI TY = "4";

STATE = "( GsRunning '=2 ) * ( ( ( OsTaskStatus[2] & 0x02 )
I=0) + ( ( OCsTaskStatus[2] & O0x02 ) == 0 )* ( ( OsTaskStatus| 2]
& 0x04 ) '=0) * 2 + ( OGsTaskStatus[2] == 0) * 3 )";

STACK = "GsControl TaskSt ack+1";

EVENTS = "OsTaskSet Event[1]" ;

WAl TEVENTS = "OsTaskWaitEvent[1]" ;

MASKS = "KEY_EVENT = , HALF_SEC EVENT =, STALL_EVENT = ,
STALL_END EVENT = , REVERSE EVENT =

PROPERTY = "EXTENDED, FULLPREEMPT, Priority: 20 ";

3
TASK | nitTask {
PRIORI TY = "5";

STATE = "( GsRunning '=3 ) * ( (
I=0) * 2 + ( OsTaskStatus[3] == 0)
STACK = "& GsOrti StackStart™;

EVENTS = "0" ;
WAl TEVENTS = "0" ;
MASKS = "";
PROPERTY = "BASI C , NONPREEMPT, Priority: 30 , AUTOSTART";

( OsTaskStatus[3] & 0x04 )
* ) .

1
TASK | nput Task {
PRIORI TY = "1";

STATE = "( GsRunning '=4) * ( ( ( OsTaskStatus[4] & 0x04 )
l=0) * 2 + ( OsTaskStatus[4] == 0 ) * 3 )";

STACK = "& OsOrti StackStart™;

EVENTS = "0" ;

WAl TEVENTS = "0" ;

MASKS = "";

PROPERTY = "BASIC , FULLPREEMPT, Priority: 0 ";

1
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TASK LockTask {
PRIORI TY = "2";

STATE = "( GsRunning '=5) * ( (
I=0) * 2 + ( OCsTaskStatus[5] == 0 )
STACK = "& GsOrti StackStart”;

EVENTS = "0" ;
WAl TEVENTS = "0" ;
MASKS = "";

Cs
3

T
)

askStatus[5] & 0x04 )

PROPERTY = "BASIC , FULLPREEMPT, Priority: 5",

}s
STACK MAI N_STACK {

STARTADDRESS = "& OsOrti StackStart";

ENDADDRESS = "& GsOrti Start”;

b

STACK | SR STACK {

STARTADDRESS = "Osl sr St ack":
ENDADDRESS = "OslsrStack + 64"
SI ZE = "64";

b

STACK Mot or Dri veTask_ STACK {

STARTADDRESS = "OsMbtorDri veTaskSt ack+1":
ENDADDRESS = "OsMotor Dri veTaskSt ack + 101";

SI ZE = "100";
}s

STACK Control Task_STACK {

STARTADDRESS = "OsControl TaskSt ack+1";
ENDADDRESS = "GOsControl TaskStack + 101";

SI ZE = "100";
}s

COUNTER SYSTEMTI VER{
MAXALLOWEDVALUE = " OxFFFF";
TI CKSPERBASE = " 10";

M NCYCLE = "0";

SIZE = "& GsOti Start - & GOti StackStart™;
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VALUE
STATE

b

ALARM HALF_SEC AL({
STATE = "(GsAl nLink[0] !'= 0)";
COUNTER = " SYSTEMII MER";
TASK = "Control Task";
EVENT = "HALF_SEC EVENT () ";
TIME = "CGsAl nVal ue[0] - GsCtrValue[GsAl nCxr[0]] +
((OCsAl nval ue[0] - OCsCtrValue[GsAInCtr[0]]) < 0)*(OxFFFF+1)";

CYCLE = "GsAl nCycl e[ 0] ";

}.

ALARM POLLI NPUTS_AL({
STATE = "(GsAl nLink[1] = 1)";
COUNTER = " SYSTEMII MER";
TASK = "I nput Task";
EVENT = " ";
TIME = "GsAl nVal ue[1] - GsCtrValue[GsAI nCir[1]] +
((OCsAl nval ue[ 1] - CsCtrValue[OGsAInCtr[1]]) < 0)*(OxFFFF+1)";
CYCLE = "GsAl nCycle[1]";
}.

ALARM STALL_END AL{
STATE = "(GsAInLink[2] = 2)";
COUNTER = " SYSTEMII MER";
TASK = "Control Task";
EVENT = "STALL_END EVENT () ";
TIME = "CGsAlnVal ue[ 2] - GsCtrValue[GsAInCxir[2]] +
((OCsAl nval ue[ 2] - CsCtrValue[OGsAInCtr[2]]) < 0)*(OxFFFF+1)";
CYCLE = "CsAl nCycle[2]";
}.

ALARM REVERSE AL{
STATE = "(OGsAnLink[3] = 3)";

COUNTER = " SYSTEMII MER";

TASK = "Control Task";

EVENT = "REVERSE EVENT () ";

TIME = "CGsAlnVal ue[ 3] - GsCtrValue[GsAI nCxir[3]] +
((OCsAl nval ue[ 3] - CGsCtrValue[OGsAInCtr[3]]) < 0)*(OxFFFF+1)";
CYCLE = "GCsAl nCycl e[ 3] ";
1

"OsCtrValue[0]";
"(CsCtrLink[0] !'= OxFF)";
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MESSACGE Msg_| nput {
TYPE = " UNQUEUED";
TASK = "Control Task ";
EVENT = "KEY_EVENT ";

H

MVESSAGE Msg_Lock {

TYPE = " UNQUEUED";

TASK = "LockTask ";

EVENT = "";

};
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Bug Reports

If you cannot solve your problem, you may need to contact our Technical
Support Department. Isolate the problem — if it's a Debugger problem,
write a short program reproducing the problem. Then send us a bug report.

Send or fax your bug report to your local distributor, it will be forwarded to
the Technical Support Department.

The report type gives us a clue how urgent a bug report is. The
classification is:

Information

Things you' d like to see improved in a future major release, that would be
handy, but you can live without.

Bug

An error for which you have awork around or would be satisfied for the
time being if we could supply awork around. If you already have awork
around, we' d like to know it, too. Bugs will be fixed in the next release.

Critical Bug

A grave error that makes it impossible for you to continue with your work.

Electronic Mail (email) or Fax Report Form

If you send the report by fax or email, the following template can be used:
Metrowerks REPORT FORM

Fill thisform and send it to Metrowerks:

EMail: support_europe@metr ower ks.com

Fax : +(41) 61 690 75 01

CUSTOMER INFORMATION

DM-538
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Customer Name:
Company :
Customer Number:
Phone Number:
Fax Number:

Email Address;

Product (HI-CROSS+, Simulator/Debugger, SmileLine,...):

Host Computer (PC, ...):

OS/Window Manager (WinNT, Win95,Win98, Win2000, Win XP ...):
Target Processor:

Language (C, C++, ...):

Tool (Compiler, Linker, ...):
Version Number (VX.X.XX):
Options Used:

For the Simulator/Debugger only: Target Interface Used:
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REPORT INFORMATION

Report Type (Bug, Wish, I nfor mation):

Severity Level (O: Higher, ... 5: Lower):

(O : Noworkaround, development stopped.

1 : Workaround found, can continue development, problem seemsto
be a common one,

2 : Workaround found, problem with very special code.

3 : Hasto beimproved.

4 : Wish

5 @ Information

)

Description:

DM-540 Debugger Manual
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Technical Support

The following methods are available to receive technical support for the
CodeWarrior Interactive Development Environment (IDE). Whichever
method you choose, we at Metrowerks listen and act.

Click any of the following links to jump to the corresponding section of

this chapter:

e “E-mall”
 “FAX”

e “Support by MAIL”
e “Internet”
E-mail

The best way to get technical support isthrough e- mail. Y ou can attach
examples to the email using a compression utility or smply uuencode.

The email addresses are;

EUROPE: support_europe@metrowerks.com
USA: support@metrowerks.com
ASIA/PACIFIC: j-emb-sup@metrowerks.com
FAX

Y ou can fax your problem to the following numbers:
EUROPE: Fax: +41 61 690 7501

USA: Fax: +512 997 4901

ASIA/PACIFIC: +3-3780-6092

Support by MAIL

To reach technical support by normal mail, use the addresses below:
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EUROPE: M etrower ks Eur ope - Riehenring 175 - CH-4058 Basel
(Switzerland)

USA: Metrowerks- 9801 Metric Blvd - Austin, TX 78758

ASIA/PACIFIC: Metrowerks Japan - Metrowerks Co., Ltd., Shibuya
Mitsuba Building 5F, Udagawa-cho 20-11, Shibuya-ku, Tokyo 150-0042
Japan

Internet
For the latest updates and product-enhancement information, go to:

http://www.metr ower ks.com
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Index

Symbols

.absfile 71
.cmd 88
.hidefaults 416, 427, 428, 432
.hwl 420
.HWP 37
.hwp 421
INI 37
.PJT 37
.rec 163
.sim 49

gt 48
\WND 72
wnd 61
xpr file 101

A

A 285
About Box 59
About True Time Simulator and Real Time
Debugger 59
ABSPATH 426
ACTIVATE 286
ADCPORT 287
Add New Instrument 231, 232, 233
ADDCHANNEL 286
Address 114, 116
ADDRESS ERROR 520
Address... 81
ADDXPR 287
Align 232, 233
All Text Folded At Loading 189
Analog 235
AND Mask 238, 239, 242
Appendix 517
Application
Assembly Step 446
Embedded 23
Loading 442
Starting 443
Step In 444

Step Out 445
Step Over 445
Stopping 443
Target 23
ArbPrio 398
Arrange Icons 58
ASCII 116
Assembly Step 44
Assembly Step Out 45
Assembly Step Over 44
Assignment 397
AssignmentList 397
Associated Commands 125
AT 299
ATTRIBUTES 287
Auto 168
Automatic 103, 116
AUTOSIZE 300

B

Background Color 56

Backgroundcolor 234, 236

Bar 235

Barcolor 237

Bardirection 237

BASE 300

BC 301

BCKCOLOR 302

BD 303

Bin 104, 115, 168, 448

Binary 448, 451

Bit Reverse 115, 168

Bitnumber to Display 240

BitRange 397

Bottom 234

Bounding Box 235

BREAKPOINT 519

Breakpoint 80, 179
BREAKPOINT 519
Checking condition 251
Command 260
Conditional 258, 264
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Counting 256, 264
Definition 247
Deleting 259
Message 518
Multiple selection 251
Permanent 247, 256
Position 254
Temporary 247, 255

breakpoint 393

Breakpoint with Register Condition 259

Breakpoints... 45

BS 303

BUS ERROR 520

Byte 114

C

-C 32
CALL 306
Call Chain 151
Cascade 58
CD 306
CF 307
CLOCK 310
Clone Attributes 232, 233
CLOSE 310
-Cmd 32
CMDFILE 311
CodeWarrior Integration 458
Color if 241
Color if Bit 240
COM 513
Command 245
Syntax 211, 272
Command File Dialog 52
Command File menu entry 52
Command File Playing 88
Command Line 31
COMPLEMENT
DATA Component 294
Memory Component 295
Register Component 290
Component
Analog Meter 211
Assembly 80, 442, 443
Associated Menus 61
Command Line 86

Coverage 91
CPU 71
DAC 96
Data 98, 442, 443, 446
Framework 27,28, 71
Inspector 213
I0_Led 222
LED 224
Led 224
Main Menu 61
Memory 111, 454
MicroC 144
Module 149
Phone 226
Pop Up Menu 61
Procedure 151
Profiler 154
Recorder 162
Register 166, 442, 451
SoftTrace 175
Source 178, 442, 443
Stimulation 192
Target 72
Termina 456
VisualizationTool 229
Window 71
Component Object Model 513
Components File 61
COMPOPTIONS 418
Configuration 37
Control Point
Definition 247
Diaogs 247
Control Points 247
Copy 232,233
COPYMEM 310
CopyMem 114
Copyright 59
Copyrights 17
CPORT 311
CPU
Cycle 34
cycle 166
CPU Message 519
ADDRESS ERROR 520
BUS ERROR 520
CR 312
Cross-debugging 23
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Index
Ctrl+E 231 Debugger Start Option -
Ctrl+L 231 Instance=%currentTargetName 31
Ctrl+S 231 Debugger Start Option -Nodefaults 32
CTRL-P 234 Debugger Start Option -Prod 32
Current Directory 416, 427 Debugger Start Option -T 31
Customize 39 Debugger Start Option -Target 31
Cut 232,233 Debugger Start Option -W 31
CYCLE 312 Debugging 23
Cycle 176 Dec 104, 115, 168, 448
Cycles 396 Decimal 448
Decimalmode 241
D DEFAULT.ENV 416, 427, 428, 432
DAC DEFAULT.REG 528
communication DLL 476 DEFAULTDIR 427
Configure the file types 465 DefaultDir 439
Configuring 462 DEFINE 316
Configuring the tools 470 DELCHANNEL 317
database 468 Delete Breakpoint 83, 184
Database directory 464 Demo Version Limitations 125
Debugger Interface 474 DETAILS 318
FDeguggg name 481 Disable Breakpoint 83, 184
library path 465 Display 113
Ndapi il 481 D!splay Absolute Address 82
new project 463 D!splay Adress 8_2
Preprocessor | Header Directories 466 Display Adress Dialog 117
Preprocessor | Preinclude file 467 Display Code 82
Project root directory 464 Display Headline 234
Referential project root directory 464 Display Scrollbars 234
Requirements 462 Display Symbolic 82
rue Time Simulator and Real Time Debugger Display Version 241
project file 477 Displayfont 243
Source 466 DL 318
smchronized_ debugging 480 Drag Out 125
Troubl&eho_otlng 480 Dragging 62, 63
User .help f|le 464 Driving True Time Simulator and Real Time Debugger
working directories 463
trough DDE 461
DASM 313
Drop Into 125
DB 314 DUMP 319
DDE DW 319
HI-WAVE server 460
DDEPROTOCOL 315 E
Debugger DDE Server 460
Debugger Start Option -C 32 E 320
Debugger Start Option -Cmd 32 EBNF 522
Debugger Start Option -ENVpath 32 Editing
Memory 454
Register 451
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Variable 449 FILTER 325
Editmode 231, 234 FIND 325
Editor 99 Find 185, 187
ELSE 321 Find Procedure 185, 188

ELSEIF 321

Enable Breakpoint 83, 184

ENDFOCUS 322

ENDFOR 322

ENDIF 323

ENDWHILE 323

Environment
ABSPATH 426
DEFAULTDIR 427
ENVIRONMENT 416
File 416
GENPATH 429, 431
HIENVIRONMENT 428
HIPATH 429, 431
LIBPATH 430, 433
LIBRARYPATH 431
OBJPATH 431
TMP 432
USELIBPATH 433
Variable 425

-ENVpath 32

EQUAL Mask 238, 242

Events 388

Exception 397

EXECUTE 324

EXIT 324

Exit 37

Explorer 417

Expression 397

Expression Command File 101

Expression definition (EBNF) 524

Expression Editor 99

Extended Backus-Naur Form, see EBNF

F

Field Description 244, 245
File

Environment 416
File Manager 417
Filename 238
FILL 324
Fill Memory Dialog 117

FINDPROC 326
FLEXIm 28
Float 168
FOCUS 326
FOLD 327

Fold 189

Fold All Text 189

Folding 182

Mark 182
Folding Menu 188
Foldings 185
FONT 328
Fonts 56
FOR 328, 342
Format 113, 448, 451
Format mode 244
Format... 103
FPRINTF 329
FRAMES 329
Frames 175
Frozen 103, 105, 116

G

G 330

GENPATH 429, 431

Globa 103

Global Variable
Displaying 447

GO 330

GoToLine 188

GotoLine 185, 186, 187

GOTO 331

GOTOIF 331

Graphic bar 91, 154

GRAPHICS 332

Grid Color 235

Grid Mode 235

Grid Size 235

H
HALT 517
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HIENVIRONMENT 428

High Display Value 237, 240, 244
HIPATH 429

Horiz. Text Alignment 243
Horizontal Size 234

How To ... 438

IdDeclaration 397
IDF 460
IDispatch 513
IF 333,342
I-LOGIX 144
Important 17
Indicatorcolor 237, 240
Indicatorlength 237
init.cmd 441
INSPECTORUPDATE 334
-Instance=%currentTargetName 31
Instruction Syntax 273
Interrupt

Example 392

Stimulated 392
Interrupt_Function 392
interruption 122
Introduction 23
io_demod 390
lo_demod.abs 391
i0_ex.txt 394
io_int.txt 392, 393, 394
10_Led 389
10_Show 390
io_var.txt 391, 392
iodemo.c 392
|O-Simulation

Index
Halt 43 Main window 389
HALTED 518 IPATH 431
Hardware 23 ITPORT 335
Height 235 ITVECT 335
HELP 332
Help Topics 59 J
Hex 104, 115, 168, 448, 452 j-emb-sup@metrowerks.com 541
Hexadecimal 448, 451, 455
Hide Headline 39 K
Hide Tile 39 keyword DAC

True Time Simulator and Real Time Debugger
project file 477
Kind of Port 236
KPORT 336

L

Layout 29, 420
Layout - Load/Store 58
LCDPORT 336
Led 222
Leds 394
Left 234
LF 337
LIBPATH 433
LIBRARYPATH 430, 431
Line Continuation 424
LINKADDR 337
LOAD 338
Load Application 36
Load Layout 231, 232, 233
Load Target 46, 48
LOADCODE 340
Loading an Application 442
LOADMEM 340
LOADSYMBOLS 341
Local 103
Local Variable

Displaying 447
Locked 103, 105
LOG 341
Low Display Value 237, 240, 244
LS 345
Lword 114
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M

Main Menu Bar 35
MainFrame 421
Marks 185
MCUID 528
MCUIONnnn.REG 528
MCUTOOLS.INI 417,439
MEM 346
Memory
Dump 111
Word 111
Memory Access Message 521
NO MEMORY 521
PROTECTED 521
READ UNDEFINED 521
Menu
Help 58
Run 42
Target 45, 56
View 39
Window 57
MicroC 144
Mode 113
Module 149
MS 347
ms 176

N

Name 397

NB 348

NbTimes 398

New 36

NO MEMORY 521
NOCR 350
-Nodefaults 32
NOLF 350
NoOfBits 397

O

Object 27
Object Info Bar 34
ObjectField 397

Oct 104, 115, 168, 448
Octal 448
OPEN 350
Open Component 56
Open Configuration 37
Open Source File 185
OPENFILE 351
OPENIO 351
Options 439

Pointer As Array. 103
Options - Autosize 58
Options - Component Menu 58
OSEK Kernel Awareness 406
OSEK ORTI 407
OSEK RTK Inspector 409
OSPARAM.PRM 401
Outlinecolor 241
OUTPUT 352

P

P 352

Paste 232, 233

PATH 423

Pause 163

PAUSETEST 354
PBPORT 354
Percentage 91, 154
PERIODICAL 193, 397
Periodical 103, 116, 391
PeriodicEvent 397
PerTimedEvent 397, 399
Play 162

Pointer as Array 103, 106
PORT 355

Port to Display 236
PORT_DATA 390, 391, 392
Port_Register 395
Postload command file 54
postload.cmd 457
Preference panel 38
Preferences dialog 37
Preload command file 54

Objectld 397 preload.cmd 456

ObjectSpec 397, 398 PRINTF 355

OBJPATH 431 Priority 398
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prm file 394 Right 234
Procedure Chain 151 RS 363
-Prod 32 Run To Cursor 83, 184
Project 421 RUNNING 518
PROJECT.INI 45,419
project.ini 419 S
Properties 232, 233 S 363
PROTECTED 521 SAVE 364

PTRARRAY 356
PVCS 433

R

RAISE 393

RD 356

READ UNDEFINED 521
READY 517

real time 23

Rea Time Kernel Awarness 400

Real Time Kernels 400
RECORD 357
Record 162
REGBASE 358
REGFILE 358
Register 166
Register values 259, 269
Registers 528
Description file 528
Registration 59
Relative Mode 244
Release Notes 20
Remove 232, 233
REPEAT 342, 358
Replay 164
RESET 359
Reset command file 53
Reset Target 46, 49
reset.cmd 456
RESETCYCLES 359
RESETMEM 360
RESETRAM 361
RESETSTAT 361
RESTART 362
Restart 43
RETURN 362
RHAPSODY 144

Save Configuration 37

Save Configuration As 37

Save Layout 231, 232, 233

SAVEBP 365

Scope... 103

SDI 72

search order 434

Searching Order
Assembly source files 434
C sourcefiles 434
Object files source files 434

SEGPORT 366

Send to Back 232, 233

Send to Front 232, 233

SET 366

Set Breakpoint 83, 184

Set Target 56

Set Zero Base 177, 192

SETCOLORS 366

SETCONTROL 367

SETCPU 368

Setcpu command file 54

Setup 231

Show Breakpoints 83, 184

Show Location 84, 185

SHOWCYCLES 368

SIM_READY 521

Simulation 23

Simulator 72

Simulators File 49

Single Step 44

Size 234

Size of Port 236

SLAY 369

SLINE 369

Sloping 241

Small Borders. 39
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SMEM 370 File 394

SMOD 370 StimulationFile 397

Source 393 STOP 375

SPC 371 STOPPED 518

Splitting View 91 Stopping an Application 443

SPROC 372 Support

SREC 373 FAX 541

ST1619-HDS MAIL 541
Postload command file 54 support@metrowerks.com 541
Preload command file 54 support_europe@metrowerks.com 541
Reset command file 53 Symbolic 104, 448
Startup command file 53

Start 164, 398 T

Start/Continue 43 T31

Start!Blt 397 o T 376

Starting an Application 443 “Target 31

startup 418 Target files 48

Startup command file 53
startup.cmd 456
Statistics 156
Status Bar 34, 39
Message 517
Status Message 517
HALT 517
HALTED 518
Hardware Reset 518
READY 517
Reset 518
RUNNING 518
Status register bits 166
Step In 444
Assembly Instruction 446
Source Instruction 444
Step Out 44, 444
Function Call 445
Step Over 44, 444, 445
STEPINTO 373
STEPOUT 374
STEPOVER 374
STEPPED 518
STEPPED OVER 518

Stepping Message 518

Target Message 520
SIM_READY 521

TargetObject 390, 391, 393, 394

task 400

Template 390

TESTBOX 377

Text 240

Text Mode 243

Textcolor 243

Tile 58

Time 398

TimedEvent 397

Timer Update 93

TMP 432

Toolbar 33, 39
Customizing 40

Tool Tips 185

Tool Tips Activation 180

Tool Tipsformat 180

Tool Tips mode 180

Top 232,233

TRACED 519

Trademarks 17

True Time 1O Stimulation 388

STEPPED 518 True Time Simulator and Real Time Debugger
STOPPED 518 Concept 26
TRACED 519 Configuration 438
Stimulation 391 Default Layout Configuration 419
Example 392 Demo Version Limitations 28
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User 104

Vv

VA 386
Variable 391
Address 450
Displaying Global Variables 447
Displaying Local Variables 447
Editing Vaue 449
Format 98
Local and Globa 98
Mode 103
Scope 98
Showing Location 450
Type 98
Value 448
Vector 398
VER 382

Index
Drag and Drop 64 Version number 59
Engine 24 Vert. Text Alignment 243
Execution framework 25, 26 Vertical Size 234
Framework component 27 VisualizationTool
Layout 420 i
Objects and Services 27 Zmrgeg;g ey 240
Project 421 Bar 237
project.ini 419 Bitmap 238, 239
Running from a command line 31 Demo 246
Smart User Interface 62 Demo limitation 246
Tool tip 34 Demo Version Limitations 246
Toolbar 33 DILSwitch 239
User Interface 29, 62 Instrument 235
Using on Windows 95 or Windows NT 4.0/ Knob 239
WIN2000 439 LED 240
TUPDATE 377 Setup 234
Switch 241
U Text 243
UDec 104, 115, 168, 448 Vppoff command file 55
UNDEF 378 Vppon command file 55
UNFOLD 380
Unfold 189 W
Unfold All Text 189 -W 31
Unfolding 182 WAIT 382
Mark 182 Warranty 18
Unsigned Decimal 448 WATCHPOINT 519
UNTIL 381 Watchpoint
UPDATERATE 381 Checking condition 264
USELIBPATH 433 Command 271

Conditional 264, 268
Counting 264, 267
Definition 247
Deleting 270
Message 518
Read 265
Read, Write 248
Read/Write 267
WATCHPOINT 519
Write 266

Watchpoints... 45

WB 383

WHILE 342, 384

Width 235

Windows 416

WinEdit 416, 417

WL 385

Word 114

Debugger Manual

For More Information: www.freescale.com

DM-551



'
A

maex

Freescale Semiconductor, Inc.

Word size 113
WorkDir 439
WorkingDirectory 439
WPORT 385

WW 386

X
X-Position 235

Y
Y -Position 235

Z

ZOOM 386
Zoomin 103
Zoomout 103

DM-552

For More Information: www.freescale.com

Debugger Manual



b -

Freescale Semiconductor, Inc.

CodeWarrior

True-Time Simulator & Real-Time
Debugger

For More Information: www.freescale.com



b -

Freescale Semiconductor, Inc.

For More Information: www.freescale.com



	Table of Contents
	Important Notice
	Copyrights
	Trademarks
	Warranty

	Overview
	About This Guide
	Highlights
	Read the Release Notes
	Document Conventions

	Introduction
	What Is the Simulator/Debugger?
	What Is a Simulator/Debugger Application?
	What Is a Simulator/Debugger Execution Framework?
	Understanding the Simulator/Debugger Concept
	The Simulator/Debugger Execution Framework
	Objects and Services
	Framework Components
	Demo Version Limitations Components


	Simulator/Debugger User Interface
	Introduction
	Application Programs
	Start the Debugger
	Start the debugger from the IDE
	Starting the Debugger from a Command Line

	Simulator/Debugger Main Menu Bar
	Simulator/DebuggerSimulator/Debugger Toolbar
	Simulator/Debugger Status Bar
	Object Info Bar of the Simulator/Debugger Components
	Function of the Main Menu Bar
	File Menu
	View Menu
	Run Menu
	Target Menu
	Simulator Menu
	Component Menu
	Window Menu
	Help Menu

	Component Associated Menus
	Component Main Menu
	Component Popup Menu

	Highlights of the User Interface
	Smart User Interface: Activating Services with Drag and Drop
	To Drag and Drop an Object
	Drag and Drop Combinations
	Selection Dialog Box


	Framework Components
	Component Introduction
	CPU component
	Window components
	Target components

	Components Window
	General Component
	Adc_Dac component
	Assembly Component
	Command Line Component
	Coverage Component
	DAC Component
	Data Component
	Memory Component
	IT_Keyboard
	Keyboard
	LCD Display Component
	Monitor components
	Push Buttons components
	MicroC Component
	Module Component
	Procedure Component
	Profiler Component
	Programmable IO_Ports
	Recorder Component
	Register Component
	Seven segments display component
	SoftTrace Component
	Source Component
	Stimulation Component
	TestTerm Component
	Terminal Component
	Wagon Component

	Visualization Utilities
	Analog Meter Component
	Inspector Component
	IO LED Component
	LED Component
	The Phone Component
	VisualizationTool


	Control Points
	Control points introduction
	Breakpoints setting dialog
	Breakpoint Symbols
	Description of the Dialog
	Multiple selections in the dialog
	Checking condition in dialog
	Saving Breakpoints

	Define Breakpoints
	Identify all Positions Where a Breakpoint Can Be Defined
	Define a Temporary Breakpoint
	Define a Permanent Breakpoint
	Define a Counting Breakpoint
	Define a Conditional Breakpoint
	Delete a Breakpoint
	Associate a Command with a Breakpoint

	Watchpoints setting dialog
	Description of the Dialog
	Multiple selections in the dialog
	Checking condition in the dialog

	General Rules for Halting on a Control Point
	Define Watchpoints
	Defining a Read Watchpoint
	Defining a Write Watchpoint
	Defining a Read/Write Watchpoint
	Defining a Counting Watchpoint
	Defining a Conditional Watchpoint
	Deleting a Watchpoint
	Associate a Command with a Watchpoint


	Debugger Commands
	Simulator/Debugger Commands
	List of Available Commands
	Definitions of Terms Commonly Used in Command Syntaxes
	A
	ACTIVATE
	ADDCHANNEL
	ADCPORT
	ADDXPR
	ATTRIBUTES
	AT
	AUTOSIZE
	BASE
	BC
	BCKCOLOR
	BD
	BS
	CALL
	CD
	CF
	CLOCK
	CLOSE
	COPYMEM
	CMDFILE
	CPORT
	CR
	CYCLE
	DASM
	DB
	DDEPROTOCOL
	DEFINE
	DELCHANNEL
	DETAILS
	DL
	DUMP
	DW
	E
	ELSE
	ELSEIF
	ENDFOCUS
	ENDFOR
	ENDIF
	ENDWHILE
	EXECUTE
	EXIT
	FILL
	FILTER
	FIND
	FINDPROC
	FOCUS
	FOLD
	FONT
	FOR
	FPRINTF
	FRAMES
	G
	GO
	GOTO
	GOTOIF
	GRAPHICS
	HELP
	IF
	INSPECTOROUTPUT
	INSPECTORUPDATE
	ITPORT
	ITVECT
	KPORT
	LCDPORT
	LINKADDR
	LF
	LOAD
	LOADCODE
	LOADMEM
	LOADSYMBOLS
	LOG
	LS
	MEM
	MS
	NB
	NOCR
	NOLF
	OPEN
	OPENFILE
	OPENIO
	OUTPUT
	P
	PAUSETEST
	PBPORT
	PORT
	PRINTF
	PTRARRAY
	RD
	RECORD
	REGBASE
	REGFILE
	REPEAT
	RESET
	RESETCYCLES
	RESETMEM
	RESETRAM
	RESETSTAT
	RESTART
	RETURN
	RS
	S
	SAVE
	SAVEBP
	SEGPORT
	SET
	SETCOLORS
	SETCONTROL
	SETCPU
	SHOWCYCLES
	SLAY
	SLINE
	SMEM
	SMOD
	SPC
	SPROC
	SREC
	STEPINTO
	STEPOUT
	STEPOVER
	STOP
	T
	TESTBOX
	TUPDATE
	UNDEF
	UNFOLD
	UNTIL
	UPDATERATE
	VER
	WAIT
	WB
	WHILE
	WL
	WPORT
	WW
	ZOOM


	True Time I/O Stimulation
	Stimulation Program examples
	Running an Example Program Without Stimulation
	Example Program with Periodical Stimulation of a Variable
	Example Program with Stimulated Interrupt
	Example of a Larger Stimulation File

	Stimulation Input File Syntax

	Real Time Kernel Awareness
	Real Time Kernel Awareness Introduction
	Inspecting the state of a task

	Task description language
	Example of application
	Inspecting data structures of the Kernel
	Register assignments for the RTK awareness
	OSEK Kernel Awareness
	OSEK ORTI
	OSEK RTK Inspector component


	Environment
	Debugger environment
	The Current Directory
	Global Initialization File (MCUTOOLS.INI) (PC only)

	Local Configuration File (usually project.ini)
	Configuration of the Default Layout for the Simulator/Debugger: the PROJECT.INI File
	Paths
	Environment Variable Details

	ABSPATH
	ABSPATH: Absolute Path

	DEFAULTDIR
	DEFAULTDIR: Default Current Directory

	ENVIRONMENT
	ENVIRONMENT: Environment File Specification

	GENPATH
	GENPATH: #include “File” Path

	LIBRARYPATH
	LIBRARYPATH: ‘include <File>’ Path

	OBJPATH
	OBJPATH: Object File Path

	TMP
	TMP: Temporary directory

	USELIBPATH
	USELIBPATH: Using LIBPATH Environment Variable

	Searching order for sources files
	Searching Order in the Simulator/Debugger for C source files (*.c, *.cpp)
	Searching Order in the Simulator/Debugger for Assembly source files (*.dbg)
	Searching Order in the Simulator/Debugger for object files (HILOADER)

	Files of the Simulator/Debugger

	How To ...
	How To Configure the Simulator/Debugger
	How To Configure the Simulator/Debugger for Use from Desktop on Win 95, Win 98,Win NT4.0 or Win2000

	How To Start the Simulator/Debugger
	How To Start the Simulator/Debugger from WinEdit

	Automating startup of the Simulator/Debugger
	How To Load an Application
	How To Start an Application
	How To Stop an Application
	How To Step in the Application
	How to step on Source Level
	How to Step on Assembly Level

	How To Work on Variables
	How to Display Local Variable from a Function
	How to Display Global Variable from a Module
	How to Change the Format for the Display of Variable Value
	How to Modify a Variable Value
	Modify a Variable Value
	How to Get the Address Where a Variable is Allocated
	How to Inspect Memory starting at a Variable Location Address
	How to Load an Address Register with the Address of a variable

	How To Work on Register
	How to Change the Format of the Register display
	How to Modify a Register Content
	How to Get a Memory Dump starting at the Address where a Register is pointing

	How to Modify the content of a Memory Address
	How to Consult Assembler Instructions Generated by a Source Statement
	How To view Code
	How to Communicate with the Application
	About startup.cmd, reset.cmd, preload.cmd, postload.cmd

	CodeWarrior Integration
	Requirements
	Debugger Configuration

	Debugger DDE capabilities
	Debugger DDE Server
	DDE introduction
	Debugger DDE implementation


	Synchronized debugging through DA-C IDE
	Requirements
	Configuring DA-C IDE for Metrowerks Tool Kit
	Creating a new project
	Configure the working directories

	Debugger Interface
	Principle of Communication between DA-C IDE and Simulator/Debugger

	Synchronized debugging
	Troubleshooting

	Scripting
	The Component Object Model Interface
	Parameters:
	Return Values:

	Manual Registration
	Scripting Example
	Remote Scripting another HI-WAVE
	COM_START
	COM_EXIT
	COM_EXE


	Appendix
	Messages in Status Bar
	Status Messages
	Stepping, Breakpoint and Watchpoints Messages
	CPU Specific Messages
	Target Specific Messages
	More Simulator Peculiar Messages: Memory Access Messages

	EBNF Notation
	Introduction to EBNF
	“Expression” Definition in EBNF

	Constant Standard Notation
	Register Description File
	OSEK ORTI File Sample
	Bug Reports
	Technical Support
	E-mail
	FAX
	Support by MAIL
	Internet


	Index

